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DataCAD 22 

DataCAD 22.01.14 

Fixes 

• The new Batch Plot interface was not using the correct Default or Custom Quick Layout 

Name. This has been corrected. 

• Quick o2c windows were not remembering their size and position. This has been corrected. 

• The ‘none’ material was not using the corresponding entity / layer palette color, it was using 

the default diffuse color which is white. This has been corrected. 

• Some of the persistent dialogs such as the Color Palette were not remembering their size and 

position when closed and reopened during the same DataCAD session. This has been 

corrected. 

• The new File Open dialog used for selecting PDFs and Bitmaps was not launched modally so 

it was possible to return to DataCAD before closing it. This has been corrected. 

• The new File Open dialog used for selecting Bitmaps was only displaying BMP and JPG files 

when Files of Type was set to all supported types (*.bmp; *.jpg; *.jpeg; *.gif; *.tif; *.tiff; *.tga; 

*.png; *.pcx; *.eps; *pcd). This has been corrected. 

 

DataCAD 22.01.12 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

Batch Printing Enhancements 

A major update to the batch printing interface provides features that automate the steps 

required to create PDF files from drawing layouts; Quick Layout, GoTo Views, and MSP Sheets. 

These include custom sorting, naming based on rules, and merging multiple documents into a 

single file. 

Note: Batch Printing can be performed 'internally' from an individual drawing or 'externally' when no 

drawings are open. Once a drawing has been setup for internal batch printing, it can then be selected, 

along with other drawings, from the external Batch Printing dialog. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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Destination 

Layouts you select can be output to a printer, a PDF document, or a plot file. When the output 

destination is set to a printer, two new options, Collate and Reverse, are available. 

Collate 

By default, DataCAD prints each layout times the number of copies you've set, and in the order 

they appear in the list. So, if you print three copies of three layouts, you will have to manually 

collate them into sets. When printing multiple copies, check the Collate option to have 

DataCAD print each layout one at a time, and in order. 

Reverse 

If you need to print your layouts in the opposite order they appear in the list, check Reverse. 

Layout Selection & Print Order 

There are three types of drawing layouts, the Quick Layout, GoTo Views, and MSP Sheets. A 

new Layouts group box allows you to check the type to appear in the list. So, if you only need to 

print MSP Sheets, you can uncheck Quick and GoTo Views so only MSP Sheets are displayed. 

By default, the order of layouts is the order they appear in the GoTo View or MSP Sheets 

menus. You can now sort the list alphabetically by clicking on the list column heading. An 

arrow indicating the sort direction (ascending or descending), appears at the top of the column 

you sorted. Click on the header more than once to reverse the current sort order. You can also 

set the order of the layouts by clicking and dragging them up or down in the list. 

Note: You can use the keyboard shortcut [Ctrl] + [A] to check all of the layouts to select them for 

printing. You can press [F5] to refresh the out filenames list. Press [Ctrl] + [F5] to reload the out 

filenames list from the drawing (prior to any changes you may have made since opening the dialog). 

Out File Names 

If you are printing to PDF or PLT files, you can now customize the default names that are 

generated by DataCAD. For example, an MSP Sheet named 1st Floor will have an out filename 

of Drawing Name-Sheet-1st Floor where Drawing Name is the name of the current Drawing. 

To customize this name, click on the item to enable the edit field. Then modify the name as you 

wish. 

Note: The following characters are not allowed in Windows' filenames and the edit field will prevent you 

from typing them. [ \ ], [ / ], [ : ], [ * ], [ ? ], [ " ], [<], [>], [ | ] 

Out File Naming Rules 

Instead of manually changing each out filename, you can enable and define naming rules, so 

they are customized automatically to suit your needs. 

In the Naming Rules group box, check Use Rules to display the Naming Rules dialog. A list of 

available rules appears on the left, and rules you add appear on the right. The rules are applied 

in the order they appear in the list. Click on a rule to highlight it, then use the up/down arrow 
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buttons to change the order. A sample of the name appears in the Out Filename Preview section 

of the dialog. 

Count 

To include an automatically incrementing number in the name, add the Count rule. By default, 

the count starts at one, and is applied, in order, to the selected layouts. If more than 9 layouts 

are selected, single digit numbers will be padded with a zero (i.e., 01, 02, 03, …). For more than 

99 layouts, two zeros will be added (i.e., 001, 002, 003, …). 

You can customize the Count rule by right-clicking over the rule to display its options. 

Start Count At 0 

Select this option to start the count at zero instead of one. 

Start Count At 1 

This is the default setting. 

Start Count At Custom 

To start the count at a custom number, select Start Count At Custom. An input dialog appears. 

Enter the new value to start the count. For example, if the set printed from the current drawing 

will be output along with files from other drawings, you may want to start the count relative to 

those. 

Count Increment 

To increment the count by a custom value, select Count Increment. For example, you may want 

to count in increments of 100 (i.e., 100, 200, 300, …). In this case, you'll also want to change the 

Start Count At Custom value to 100. 

Drawing Name & Layout Name 

To include the Drawing Name and/or Layout Name verbatim, add either or both rules. If you 

would like spaces in these names to be replaced with another character (i.e., [_] underscore by 

default), right-click on the Drawing Name or Layout Name item. In the popup menu that 

appears, select Substitute [Space] with. Then, enter the character you would like to replace 

spaces with. 

Date 

By default, the date format for the Date rule is Year-Month-Day. If you would like to use a 

different format, right-click on the Date rule and select one of the other presets; Month-Day-

Year or Day-Month-Year. Select Edit Rule if you'd like to use a custom format. 

The formatting string can include a mix of ordinary characters that remain unchanged and 

formatting characters that are replaced with specific date strings. The following formatting 

character strings can be used. 

Year: 

yy = 21 

yyyy = 2021 
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Month: 

m = 1, 2, 3, ... 10, 11, 12 

mm = 01, 02, 03, ... 10, 11, 12 

mmm = Jan, Feb, Mar, ... Oct, Nov, Dec 

mmmm = January, February, March, ... October, November, December 

Day: 

d = 1, 2, 3, ... 29, 30, 31 

dd = 01, 02, 03, ... 29, 30, 31 

ddd = Sun, Mon, Tue, ... Thu, Fri, Sat 

dddd = Sunday, Monday, Tuesday, ... Thursday, Friday, Saturday 

ddddd = Short Date: 21/08/2021 

dddddd = Long Date: 21 August 2021 

Time 

Like the Date rule, the time can also be included in the name of file. The default time format is 

hh.mm.ss (Hours.Minutes.Seconds). The following formatting character strings can be used. 

Hours 

h = 1, 2, 3, … 22, 23, 24 

hh = 01, 02, 03, … 22, 23, 24 

ampm = AM … PM 

Minutes 

n = 1, 2, 3, … 57, 58, 59 

nn = 01, 02, 03, … 57, 58, 59 

Seconds 

s = 1, 2, 3, … 57, 58, 59 

ss = 01, 02, 03, … 57, 58, 59 

Note: If you need to include formatting characters that should not be replaced, enclose them in ["] 

quotation marks so they will not be interpreted as date or time elements. 

Stamp 

The Stamp rule allows you to use DataCAD's existing stamps to populate the filename. The 

default stamp is @USERNAME. You can change this string to any of the Stamps defined in 

DCADWIN.ini. 

Custom 

If you would like to insert your own characters into the filename, add the Custom rule, then 

edit the string as needed. 

Separator 

Identical to Custom but included for convenience, add the Separator rule wherever you need 

to. You can edit the default string of "-" dash to a different string. 
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Notes About Naming Rules: The Count, Drawing Name, and Layout Name rules can only be added 

once. The other rules can be added multiple times. 

PDF Options 

When printing to PDFs, several new options can be enabled. 

Merge PDFs 

If you would like DataCAD to merge all the layouts you've selected into a single document, 

check Merge PDFs in the Merging section. Click on the file folder icon to select the destination 

for the merged document. The default name is the same as the drawing name. 

Out File Naming Rules 

To define naming rules for the merged document, check Use Rules in the Naming Rules 

section. The merge file naming rules are independent from the layout filename rules. 

Note: The internal merge name rules do not include Count or Layout. The external merge name rules do 

not include Count, Drawing, or Layout. 

Security 

If you only want to require an Open Password (i.e., no other restrictions) to access your 

document, then check Require Open Password in the Security section. You will be prompted to 

provide the password that will be required to open the PDF files that are created during the 

batch session. 

If you also want to restrict certain document-related functions such as high-resolution printing 

or content copying, then check Set Document Restrictions. The PDF Restrictions dialog will 

appear. Check the items you want to disallow. 

Note: You can now set the Encryption Level. Previously, 256-bit AES (the highest available) was always 

used and requires Acrobat X or later. 

Your previously set PDF Restrictions are saved to the PDF Security section of DCADWIN.ini. 

For internal batch printing, these settings are stored on a per-drawing basis. For external batch 

printing, these settings are saved to the SET file. 

Watermark 

If you would like to apply a bitmap to the background of the pages in your PDF files, then 

check Apply Watermark. You will be prompted to select a bitmap. By default, the image you 

select will be placed behind the drawing, at 50% transparency, and will be centered to fit as 

large as possible on the page. 

You can customize the settings DataCAD uses to create the watermark by changing the 

folowing keys in the [PDF Watermark] section of DCADWIN.ini. 

Transparency 

Sets the Transparency from 0 (completely opaque) to 100 (completely transparent) 
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Blend Mode 

Can be set to one of the following values: Normal, Multiply, Screen, Overlay, Darken, Lighten, 

ColorDodge, ColorBurn, HardLight, SoftLight, Difference, Exclusion, Hue, Saturation, Color, or 

Luminosity. 

Apply Watermark 

True if Apply Watermark is checked or False otherwise. 

Watermark Image 

The path to the bitmap. 

Watermark Text 

(For future use, not currently used) 

Image Left 

Sets the left edge of the bounding box (in percent of the page) that contains the image. A value 

of 50 will put the left edge of the watermark at the middle of the page. 

Image Top 

Sets the top edge of the bounding box. 

Image Width 

Sets the width of the bounding box (in percent of the page) that contains the image. A value of 

50 will set the width of the image box to half the width of the page. 

Image Height 

Sets the height of the bounding box. 

Image Align Horizontal 

Sets the horizontal alignment of the image inside the bounding box. You can set the horizontal 

alignment to either Left, Center, or Right. 

Image Align Vertical 

Sets the vertical alignment of the image. You can set the vertical alignment to either Top, 

Middle, or Bottom. 

Image Rotate 

(For future use, not currently used) 

Show Preview / Preview Time 

Previously, the Skip Screen Redraws option would suppress both the drawing window and the 

print preview. Now the print preview can be enabled separately by checking Show Preview. 

When Show Preview is enabled, you can also set the time (in seconds) the print preview will 

remain open before automatically closing, allowing the batch process to continue. You can also 

click the Close button at any time prior to the preview time elapsing. 
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Note: In the Subscription Edition, you can restore the previous Batch Printing interface by setting the key, 

New Batch Printing, to False in the [DEBUG] section of DCADWIN.ini. 

o2c Quick Enhancements 

Form settings for individual o2c Quick windows are now saved to o2cQuick.gui 

Note: Each new window is stored in a corresponding section [Fo2cQuickForm], [Fo2cQuickForm_1], 

[Fo2cQuickForm_2], and so on. These are not currently associated with specific drawing files. 

The o2c setting Remember Last View is now supported by Quick o2c. 

Multi-View Window Enhancements 

 

Magnetic Windows 

It's now possible to 'magnetize' Multi-View Windows so they 'snap' to each other and the edges 

of your monitor(s). By default, Multi-View Windows are not magnetic. A Snap Distance key 

has been added to the [MultiView Windows] section of DCADWIN.ini. Set this key to a value 

greater than zero (i.e., 24) to enable magnetic windows. This value defines the proximity in 

pixels where tool windows will snap to each other or the edge of the screen. 

Customizable Dock Sites 

You can now set which edge (Top, Bottom, Left, Right) of DataCAD's program window Multi-

View Windows will dock to. The following keys have been added to the [MultiView Windows] 

section of DCADWIN.ini. By default, Multi-View Windows will dock to all four sides of 

DataCAD's program window. Set any key to FALSE to prevent the tool window from docking 

to the corresponding edge. 

[MultiView Windows] 

Dockable to Top=TRUE 

Dockable to Bottom=TRUE 

Dockable to Left=TRUE 

Dockable to Right=TRUE 

Docked Width & Height 

You can now set the docked width and height of Multi-View Windows. Previously, the docked 

height and width were set to 9% of the monitor's resolution. The following keys have been 

added to the [MultiView Windows] section of DCADWIN.ini. 

[MultiView Windows] 

Docked Width= 

Docked Height= 
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Minimum Width & Height 

You can now set the minimum width and height of Multi-View Windows. The default is 32 

pixels for both. The following keys have been added to the [MultiView Windows] section of 

DCADWIN.ini. 

[MultiView Windows] 

Min Width= 

Min Height= 

Extended Character Codes 

Extended Character Codes have been added for the Polyline Cover toggle. 

3050# Polyline Cover Toggle On 

3051# Polyline Cover Toggle Off 

Fixes 

• An error that would prevent the Persistent Layer Manager from updating when the Logging 

key in the [General] section of DCADWIN.ini was set to 0 has been corrected. 

• An error that would cause the drawing to close instead of returning after clicking Cancel in 

the Confirm File Close & Save dialog has been corrected. 

• o2c was not restoring the last view when 'Remember Last View=TRUE' (used when creating a 

new drawing only) and the current drawing setting was True. This has been corrected. 

• Mixed-Mode Dpi Awareness has been enhanced to transform the previous display settings 

(when possible) to avoid resetting DataCAD's interface when the desktop has changed. 

• A typo on line 4370 in the Spanish-language DCADWIN.msg ('. dlt' instead of '.dlt') was 

causing the current drawing to close when you selected Manage from the Line Types menu. 

• An error that was causing the display of distances to be incorrect when using the Metric scale 

type has been corrected. 

• A typo that was preventing the Show Drawing Origin setting from being saved to 

DCADWIN.ini after closing the Program Preferences dialog has been corrected. 

• AEC File Import: MSP Sheets are now selected for import by default. 

• The procedure that writes coordinate data to the drawing uses DCADWIN.msg lines 5046 - 48 

for the X, Y, and Z strings. In the case of adding individual coordinates for X, Y, or Z, hard-

coded values were being used. This has been corrected to use the strings from the message file. 

DCADWIN.ini 

For potential improvements in performance, and for consistency within DataCAD's source, 

DCADWIN.ini is now accessed exclusively from memory during program operation. The 
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caveat to this change is that all manual edits to DCADWIN.ini have to be made while DataCAD 

is not running. Otherwise, they will be overwritten when the program is closed. 

 

DataCAD 22.00.08 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

SketchUp 2020 / 2021 

The SketchUp translator has been updated to support reading and writing SketchUp 2020 and 

2021 formats. 

Fixes 

1. Layer Manager 

- An error in the Persistent Layer Manager that would cause a crash when deleting 

layers has been corrected. 

- An error that would cause the Layer Manager to crash when trying to display a blank 

layer name has been corrected. 

- The height of the Status Bar at the bottom of the Layer Manager was too short. This has 

been corrected. 

2. An error that could cause the license file to become corrupted after deactivating 

DataCAD remotely while the corresponding installation was still running has been 

corrected. 

3. A change to the handling of unhandled application errors was causing error message 

dialogs to display that were not displayed previously. For testing purposes, these errors 

can be displayed by setting the key Show Exception Errors to TRUE in the [General] 

section of DCADWIN.ini. This key is FALSE by default. 

Note: If Show Exception Errors is set to TRUE when Logging is set to 1, the message returned 

by the error handler will be written to the log file. Logging is off by default. 

4. The default path for PDF bitmaps was incorrectly set to the toolbar bitmaps path. This 

has been corrected to be the default bitmaps path. 

5. The RoofIt macro is now installed with pre-loaded messages and labels to avoid 

corruption that may occur on the local machine. If you need to customize the messages 

and labels for translation purposes, please contact help@datacad.com for assistance. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
mailto:help@datacad.com
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6. The License Actions menu has been removed from the Help pull-down menu. 

Deactivate this Computer and Show Registration Information are now available in the 

main part of the Help menu. 

7. A menu item for the Smart Entities Tutorial has been added to the Help pull-down 

menu. 

8. A menu item for the Softlock Reference has been added to the Help pull-down menu. 

9. In the Paths tab of Program Preferences, sorting the path list would cause the items to 

lose their ellipses (browse icon). This has been corrected. 

10. During a new installation, and choosing to transfer previous settings, the path for 

DataCAD's program defaults was being transferred from versions prior to DataCAD 12. 

Since the default path for DataCAD's program defaults changed between DataCAD 11 

and DataCAD 12, this would prevent a new installation of DataCAD 22 from running 

when upgrading from a version prior to DataCAD 11. This has been corrected. 

11. Customer registration is now required to run DataCAD. Customers who purchase 

directly from DATACAD's online store are automatically registered. Customers who 

purchase from one of DataCAD's distributors will now be prompted to register when 

they activate the program. 

12. The link to purchase DataCAD from the Evaluation Dialog was still directed to the 

product page for DataCAD 21. This has been corrected. 

13. The material load buttons were not excluded from the form resize logic that sets the top 

of the other buttons. This caused them to disappear from the panel they were located on. 

DataCAD 22 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 22, please click: 

What's New? from the Help pull-down menu in DataCAD. 
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DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

Mixed-Mode DPI Awareness 

DataCAD automatically sets the scaling factor and font height for dialogs and toolbars based on 

their corresponding monitor's display scaling percentage. Previously, DataCAD would only 

adapt the program interface for whichever display was designated by Windows as the Primary 

(a.k.a. Main). Now when you drag dialogs from one monitor to another, DataCAD will rescale 

them if necessary so they display consistently. 

If, in addition, you would like dialogs and their interface text to appear even larger, you can 

apply an enlargement beyond the default size. 

In Program Preferences, on the Interface Tab, you can use the Dialog Box Size slider to make 

dialogs appear larger. In addition, you can customize the font that is used in dialogs by 

modifying the [Dialogs] section of DCADWIN.ini. 

  [Dialogs] 

  FontName=Segoe UI 

  Point_Size=9 

  Style= 

The default dialog font is Segoe UI with a size of 9 points. If you would like text to appear 

larger, you could change Point_Size=9 to Point_Size=11. 

Note: This setting is independent of the dialog enlargement setting, so if you increase the font size above 

the default value of 9, you'll need to set the dialog enlargement to at least 125% (approx. 11 / 9) to 

accommodate the larger text. 

Quick o2c 

With all of the features that have been added to the Object Viewer, some of you have requested 

an option to display a 'plain' o2c window when you want to just get a 'quick' view of your 

model, and don't require all of the other interactive features. 

To display a 'Quick' o2c Player, hold down the [Ctrl] key while launching the Object Viewer 

from a toolbar icon or menu and DataCAD will show your model in a stripped-down o2c 

window. This window is modeless and will remain open while you continue to work in 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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DataCAD. You can also launch multiple Quick o2c windows based on different views of your 

model. Quick o2c windows that are still open when you exit DataCAD will be closed 

automatically, and their size and position is not remembered. 

Note: Extended character code 3049# has been added so you can launch Quick o2c from a custom 

toolbar icon. 

Eye Dropper 

An Eye Dropper icon has been added to DataCAD's Color Picker dialog and the Edit Color 

toolbar in the Object Viewer. Whenever you want to set the current color based on a pixel 

anywhere on your desktop, click the Eye Dropper icon, then move the cursor over the point on 

your desktop you'd like to match, then click to 'grab' the color. For reference, a preview box of 

the current eye dropper color is displayed while you move the eye dropper cursor. 

Note: You can use the [Ctrl] key to toggle between the color preview and a magnified box surrounded by 

the current color. 

Drawing Window Opacity 

A new option, Drawing Window Opacity has been added to the Drawing Context Menu. To 

access this feature, [Ctrl] + Right-click on a blank area of your drawing (i.e., not over an entity), 

and select Drawing Window Opacity. A dialog appears where you can enter a value from 10 to 

100 to set the drawing window's opacity. Values less than 100 will cause other drawing 

windows to 'show through' when the transparent window is on top. This setting is remembered 

on a per-drawing basis and can be used to compare two drawings by placing one over the 

other. 

Enhancements 

1. You can now set the Hint Font Size in the [Hints] section of DCADWIN.ini. Previously, the 

size was hard-coded to be 80% of the menu font size. 

[Hints] 

Point_Size=7 

2. A new option, Text Cursor, has been added to the Utility --> Settings menu. If toggled on 

(the default), DataCAD will display a Carat (i.e. Text Cursor) when you are entering text. If 

toggled off, the standard drawing cursor will be displayed instead. When entering either 

PText or MText, this toggle is also displayed in the menu at S8. This setting is remembered 

on a per-drawing basis. 

3. The Color Palette dialog is now resizable. 

4. The DXF/DWG Color Mapping dialog is now resizable. 

5. A new key, Delete to Recycle Bin, has been added to the [SymbolBrowser] section of 

DCADWIN.ini. Setting this key to TRUE will cause DataCAD to send files to the Recycle Bin 

rather that deleting them. 
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[SymbolBrowser] 

Delete to Recycle Bin=FALSE 

6. A new key, Disallow No On Layers in Symbols, has been added to the [General] section of 

DCADWIN.ini. Setting this key to FALSE will allow symbols, with Per Instance Layer 

Control enabled, to have no On Layers. 

[General] 

Disallow No On Layers in Symbols=TRUE 

7. Setting the background color in the Object Viewer now displays the DataCAD Color Palette 

and Custom option for the Color Picker w/ Eye Dropper instead of the Windows standard 

Color Picker. 

8. Added support for DMX macros when using 'M' action code in toolbars. The string for M= 

in the DTB file can be MyMacro, MyMacro.dcx, or MyMacro.dmx. A popup message will 

appear when the macro specified cannot be found. 

9. Dialog-related hotkeys: 

 

[Shift] Restore dialog to default size and center position 

Pressing and holding the [Shift] key when invoking and displaying a form will reset the 

dialog to its default size and position. 

Pressing and holding the [Shift] key when launching DataCAD will reset the application 

window to its default size and position. 

[Ctrl] + [Shift] Restore dialog to center using previous size 

Pressing and holding the [Ctrl] & [Shift] keys when invoking and displaying a form will 

restore and center the dialog over DataCAD's application window, or the form that is 

currently open. 

Note: Pressing and holding the [Ctrl] & [Shift] keys when launching any Windows program will cause 

the application to run as administrator. 

10. A 'Custom' radio button and corresponding edit field has been added to PDF to Image 

Settings Dialog's Resolution radio group. You can use this option to specify a custom PDF to 

Image conversion resolution ranging from 72 to 1200 dpi. 

11. A 'Custom' menu option has been added to the PDF to Image Tools, Reconvert menu 

located in the [Ctrl] + Right-click context menu for PDF to Image filled polylines. 

12. New keys, Default Image Type, and Default Image Resolution have been added to the [PDF] 

section of DCADWIN.ini. 

[PDF] 

Default Image Type= 

Default Image Resolution= 
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The Default Image Type is PNG. Valid values are BMP, GIF, JPG, PNG, and TIF (not case-

sensitive). The Default Image Resolution is 300. Valid values are 72 to 1200 (dots per inch). 

Note: If the resolution used to convert the image is not one of the predefined values (100, 200, 300, 

400, 500, or 600) then the menu item 'Custom: ' will appear followed by the user-defined resolution. 

Otherwise, only the predefined values will be shown. 

13. A new key, MaxChunkSize, has been added to the [Bitmaps] section of DCADWIN.ini. 

[Bitmaps] 

MaxChunkSize= 

The default value is 52428800 kb (50 MB). This value determines the largest portion (a.k.a. 

'Chunk') of a bitmap to convert into metafile data for printing (and saving to PDF, WMF, 

and EMF). 50MB should be large enough to process each bitmap in its entirety. The result 

should be one metafile element per image. Previously, this value was a very tiny at 16 kb. 

So, PDF files that contained bitmaps would end up with thousands of elements and related 

'bloat.' This change should fix that. 

14. A new key, Sort Paths In Preferences, has been added to the [General] section of 

DCADWIN.ini. 

[General] 

Sort Paths In Preferences=False 

The default value is False. Set this key to True to have the list of program paths sorted 

alphabetically in the Paths tab of Program Preferences. 

15. For new (a.k.a. 'clean') installations, the Full installer will copy your previous program paths 

from the prior version if you have chosen to transfer your previous settings. For any path 

that cannot be validated, the default path will be used. 

Fixes 

1. The Drawing Repair routine was incorrectly flagging Visible Attribute Text as invalid and 

deleting it. The test for invalid Visible Attribute Text has been removed for now. 

2. When displaying the properties of a 'flat' (i.e., non-sloped) polygon or slab in the Entity 

Properties Editor, activating any field then clicking Apply or OK would cause the slope of 

the entity to be set to 0.209 instead of remaining at zero. This has been corrected. 

3. The Pen Table to Scale assignment file/pathname was getting truncated to 80 characters. 

This has been corrected so up to ~255 characters are supported. 

4. The time required to generate the Program Preferences dialog has been greatly reduced. 

5. In the Drawing Information dialog, long color names are now truncated so they do not 'step' 

on the Entity Count column of values. 

6. The drawing repair routine now tests Helplines. 
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7. The settings for Show Materials In Sub-Folders, Show Textures In Sub-Folders, and Large 

Thumbnails on the Object Viewer's Materials Toolbar are now remembered. The values are 

stored in the [o2cViewer] section of DCADWIN.ini. 

[o2cViewer] 

Show Materials In Sub-Folders=TRUE 

Show Textures In Sub-Folders=TRUE 

Large Thumbnails=TRUE 

 

21.02.09 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

Insert PDF as Bitmap 

A new option, PDF, has been added to the Insert pull-down menu. By default, the pages of the 

PDF file you select will automatically be converted to 300 dpi bitmaps in PNG format, and 

located in the same folder as the original(s). The converted file(s) will have the same name with 

a ' PDF_Pg-01 (300dpi)' suffix. 

For example: 

PDF File: MyDesign.pdf 

PDF Bitmap: MyDesign PDF_Pg-01 (300dpi).png 

Note: If necessary, you will be prompted to provide a Document Open and Document Permissions 

password before inserting or reconverting password-protected PDF documents. 

There are two methods you can use to place a PDF bitmap in your drawing: Dynamically Sized 

and Fixed Size. If you choose Dynamically Sized, you will be prompted to select the first point 

of the bitmap rectangle followed by the second point for each page in the PDF document. For 

multi-page documents, you can right-click after placing a page to skip inserting subsequent 

pages. 

If you choose Fixed Size, you will be presented with a bounding rectangle that is scaled based 

on the PDF's paper size and the current plot scale. So, if the PDF's paper size is 24x36 and the 

current plot scale is 1/4" = 1'-0", DataCAD will enlarge the rectangle 48 times, to be 96' x 144'. 

You can use the menu option Print Scale, or the hotkey combination [Shift] + PgUp/PgDn to 

change the current plot scale before placing the bitmap. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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As with Dynamically Sized, you will be prompted to pick the location for the center of each 

page in the PDF document. For multi-page documents, you can right-click after placing a page 

to skip inserting subsequent pages. If you would like the document to resize automatically 

when you change your plot scale, toggle on the Lock Size option before placing the image. For 

convenience, you can use the Abs. Zero option to place the center of the document at the origin 

of the drawing. 

To control the image type and resolution of the converted PDF pages, use the Insert > PDF to 

Image Management > Settings menu. In the PDF to Image Settings dialog, select the image 

type (BMP, GIF, JPG, PNG, or TIF) and the image resolution in dots per inch (100, 200, 300, 400, 

500, or 600). 

Note: If the conversion process fails due to insufficient memory, try using a lower resolution. 

If the source files have changed, and you need to update the PDF images in your drawing, use 

the Insert > PDF to Image Management > Reconvert All option to reconvert all the PDF pages 

in your drawing. 

Note: This operation may take a long time depending on the number and resolution of the images. 

To modify a single PDF image, [Ctrl] + Right-click on the image to access the context menu. 

Highlight PDF to Image Tools to either Reconvert, or if the boundary was dynamically sized, 

Resize the image. Reconvert allows you to change the resolution of the image. A checkmark is 

displayed next to the current resolution. Resize allows you to resize the bounding rectangle. 

PDF Tools 

Two PDF Tools have been added to the File pull-down menu: PDF Merge and PDF Security. 

PDF Merge 

Use PDF Merge to combine several PDF files into a single document. At first, you are 

prompted to enter the name of the master document that will contain the merged files. 

The second step is to select the PDF files to merge. In the file dialog, multi-select the files 

to merge then click Open. 

Note: The merge function does not allow combining password-protected files. Prior to 

attempting the merge, the files you select are checked for passwords and the process will be 

cancelled if any of them require one. 

PDF Security 

Use the PDF Security options to set document restrictions or to password protect 

existing PDF files. 

PDF Restrictions 

To set restrictions, select File > PDF Security > Restrictions. In the file dialog, select the PDF 

file(s) you would like to apply restrictions to then click Open. In the PDF Restrictions dialog, 

check the document restrictions to apply. 
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The PDF Restrictions dialog options conform with Adobe Acrobat's permission options. The 

items you check will be restricted (not allowed) by Acrobat, and third-party viewers that adhere 

to these standards. 

Printing 

Check Printing to prevent the document from being printed. 

High Resolution 

Check High Resolution to restrict printed output to 150 dots per inch. 

Content Copying 

Check Content Copying to prevent the document's contents from being copied. 

Content Accessibility 

Check Content Accessibility (not recommended) to prevent text access for screen reader 

devices for the visually impaired. 

Changing the Document 

Check Changing the Document to prevent changes to the document's contents. 

Commenting 

Check Commenting to prevent adding annotation to the document. 

Form Filling 

Check Form Filling to prevent form field fill-in or signing. 

Document Assembly 

Check Document Assembly to prevent combining or attachment with other documents. 

Page Extraction 

Note: Page Extraction is the minimum restriction for password-protected documents. 

To set or change restrictions on the document(s) you select, you will be required to 

provide, if necessary, a Document Open and Permissions Password. Passwords cannot 

be blank, and the Open and Permissions Passwords must be unique. 

PDF Password Protect 

To apply a password, select File > PDF Security > Password Protect. In the file dialog, select the 

PDF file(s) you would like to create a password for then click Open. In the Password dialog, 

enter the password to apply and click OK. Files that are already password-protected will be 

skipped. 

PDF Watermark 

Use PDF Watermark to overlay a custom bitmap on each page of PDF file(s) you select. The 

bitmap you select will be made 50% transparent and will fit into a square, expanded to the 

extents of the page width. 
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To add a watermark to each page of a PDF document, select File > PDF Watermark. In the File 

dialog, select the PDF file you would like to watermark then click Open. In the Select Image 

dialog, select a bitmap to use as a watermark then click Open. 

PDF-Related Key Codes 

The following PDF-related extended key codes have been added: 

3039# : Insert a dynamically sized PDF Image  

3041# : Insert a fixed size PDF Image 

3043# : PDF Settings 

3045# : PDF Merge 

3047# : PDF Password 

3048# : PDF Permissions 

Object Viewer Enhancements 

Standard Toolbar 

The Standard Toolbar contains icons for material selection, copying, pasting, and undo, redo, 

and reset. When the selection icon is toggled on, navigation with the mouse is disabled. In 

selection mode, you can click on any surface of your model to make the corresponding material 

active for editing. You can then use the Material Properties and Material Color toolbars to 

customize the selected material. 

Note: You can toggle selection mode on and off using the [S] hotkey. 

You can copy the properties of one material and apply it to another by using the Copy Material 

and Paste Material icons. These functions are also available from the Edit pull-down menu, the 

Material Toolbar's context menu, or by using the [Ctrl] + [C] and [Ctrl] + [V] shortcuts. 

After making changes to a single material, you can use the Undo, Redo, and Reset icons to 

move backward and forward through the changes or reset the material to its original properties. 

Material Toolbar 

In the Material Toolbar, you can browse the material properties associated with the various 

objects within your model. The four icons along the top of this toolbar toggle what appears in 

the list. From left to right, the icons correspond to: Current Model's Materials, Available 

Material Definitions, Available Bitmap Textures, and Color Palettes. 

Views & Schemes Toolbar 

Use the Views & Schemes Toolbar for quick access to the views and material schemes you 

have saved for the current model. Clicking on a view name will immediately change the 

viewing position in the Object Viewer. Clicking on a scheme name will immediately change the 

material scheme of the entire model. Select the '<None>' scheme to restore the original materials 

and textures. 
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Material Properties Toolbar 

Use the Material Properties Toolbar to fine-tune the selected material's properties and its 

rendered display. There are five slider bars that let you control how the material's surface is 

affected by light. 

Material Color Toolbar 

You can control the diffuse and reflection colors of the selected material by clicking on the RGB 

Color Cube, using the Brightness slider, or entering new values in the Red, Green, and Blue 

value editors. A preview of the new color, surrounded by the old color, is shown to the left of 

the RGB value editors. One is for the diffuse color and the other is for the reflection color. 

Note: You can Right-click and Drag over the Color Cube to spin its orientation to reveal all eight corners 

which correspond to Red, Green, Blue, Cyan, Magenta, Yellow, White, and Black. 

Apply to All Materials Toggle 

When 'Apply to All Materials' is toggled on, the changes you make using the Material 

Properties and Material Color toolbars will apply to all the current project's materials and 

textures. 

Navigation Toolbars Speed Hotkeys 

Prior to Clicking and Holding on any of the navigation icons (Pan, Rotate, and Walkthrough) 

for continuous movement, you can press either or both of the [Ctrl] and [Shift] keys to adjust 

the speed. 

Click & Hold for Normal Speed 

[Ctrl] + Click & Hold for Half Speed 

[Shift] + Click & Hold for Double Speed 

[Ctrl] + [Shift] + Click & Hold for 5x Speed 

View Stats Toolbars 

The View Stats toolbars are now updated dynamically while you navigate using the mouse. 

View Manager 

You can manage your saved views and associate them with specific schemes and backgrounds 

with the View Manager. 

Slideshow 

Displays each of your saved views in sequence, one second at a time. 

Save Screen 

Use the Save Screen option to save the current view to a bitmap on your hard disk in either, 

BMP, EPS, GIF, JPG, PCX, PNG, TGA, or TIF formats. The output resolution of the image will 

match the current size of the Object Viewer window. Unlike Save Image, Save Screen is not 

limited to an output width of 2048 pixels. 
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Save Image 

Save Image has been enhanced so you can now render to EPS, GIF, JPG, PCX, PNG, TGA, and 

TIF formats. Previously, BMP was the only supported image format. 

Full Screen Mode 

Full Screen Mode displays the current view using the whole screen and hides the application 

title bar, menus, and all the toolbars that are currently displayed. Use the F11 hotkey to toggle 

Full Screen Mode on and off. 

Batch Rendering 

You can render multiple views all-at-once. Since this may take a lot of time (depending on the 

number of views you select, their complexity, the output resolution, and your computer's 

processing speed), you can schedule this to occur during a break or after hours. 

Material / Texture Filters & Effects 

You can use Filters & Effects to alter or enhance material properties and bitmap textures. You 

can use filters and effects such as Sepia and Newsprint for abstract presentation or make 

lighting adjustments by applying Bright for better clarity. 

In all, there are more than 35 filters and effects that can be applied to all materials at once, or 

one at time. 

None 

Select the 'None' filter to restore the material and texture properties to their original values. 

Artistic 

Bump 

Applies a waffle iron effect on textures. Set the Bump Factor to adjust the size. 

Checkerboard 

Replaces textures with a black and white checkerboard. Set the size of the squares in 

pixels. 

Edges 

Highlights edges in textures by intensifying outlines of high contrast areas and 

darkening areas of low contrast. You can set sensitivity of edge detection by value. 

Engrave 

Applies a woodcut effect to textures by removing the color and generalizing areas of the 

image into high and low tones. Set the factor from 1 (thin) to 10 (thick). 

Grid 

Applies a grid effect to textures by adding a white border around the image. Set the 

width of the gridlines in pixels. 

Metal 

Creates a metallic effect by applying all textures as reflection maps. 
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Newsprint 

Applies a halftone pattern to textures to simulate a continuous tone with dots. 

Spray Paint 

Applies a spray paint effect to textures by randomly choosing colors from the image. 

You can adjust the spray from 1 (fine) to 100 (coarse). 

Note: You can use the Seamless filter to remove the hard edges created by the Spray Paint filter. 

Threshold 

Transforms the RGB values of pixels in textures that fall above the threshold you set to 

255 and values that fall below to 0. 

Transparent 

Sets the Opacity of all materials to 10% (90% transparent). 

Color 

Bleed 

Intensifies the color of textures by expanding the image's color palette. 

Fewer Colors 

Reduces the color palette of textures down to 16 colors and dithers the resulting image. 

Huey 

Changes the hue, saturation, and brightness of textures to create an artistic effect. 

Invert 

Creates a negative image of material colors and textures by reversing the color values. 

Mix 

Changes the color of materials and textures by mixing the color you select with the 

diffuse, reflective, and image colors. 

Detail 

Blurry 

Softens textures by smoothing transitions between hard edges and shaded areas. 

Despeckle 

Removes noise from textures by filling in pixels that would otherwise appear as dots. 

The fill color is determined by the color of the surrounding pixels. 

Noisy 

Adds noise to textures by modifying the intensity of RGB values in randomly selected 

pixels. 

Sharp 

Sharpens the detail of textures by increasing the contrast around edges in the image. 
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Distort 

Mirror 

Reverses the horizontal orientation of textures. 

Motion 

Blurs textures in a horizontal direction to simulate movement. This is analogous to 

taking a picture of a moving object with a slow shutter speed. 

Wavy 

Applies a radial ripple effect to textures. 

Lighting 

Auto-Contrast 

Improves the image contrast of textures by making dark pixels blacker and light pixels 

whiter. 

Bright 

Brightens the entire model by pushing the material's Ambient and Diffuse properties to 

80%. 

Dark 

Darkens the entire model by pushing the material's Ambient and Diffuse properties to 

30%. 

Enhance 

Automatically adjusts the RGB values of pixels among areas of different colors and 

shades. 

Gamma 

Brightens the midtones of textures without dramatically altering the shadows and 

highlights. 

Lit 

Removes all shading from materials by enabling the Self-illuminate property. 

Painting 

Mosaic 

Applies a stained-glass effect to textures. 

Oil Paint 

Applies an oil paint effect to textures. Use a lower value to preserve more detail and a 

higher value to exaggerate the effect. 

Note: Using higher values will increase the time it takes to apply the effect. 
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Watercolor 

Applies a watercolor effect to textures by 'smearing' the pixels of the image. 

Retro 

Greyscale 

Converts the material and texture colors to monochrome shades of grey. 

RGB: 29.9%, 58.7%, 11.4% 

Sepia 

Converts the material and texture colors to monochrome shades of sepia. 

RGB: 112, 66, 20 

Text 

Text 

Adds a text string you enter in the font you select to the center of the texture's image. 

Special 

Seamless 

Removes the seam between tiles by quartering the image and duplicating the quadrants 

in opposite corners of the image. 

Edit Texture 

Highlight Edit Texture in the Material Toolbar's context menu to access options to change the 

orientation of a bitmap texture. 

Rotate 90 (Clockwise) 

Rotates the image 90 degrees clockwise. 

Rotate 90 (Counterclockwise) 

Rotates the image 90 degrees counterclockwise. 

Rotate 180 

Rotates the image 180 degrees. 

Mirror 

Reverses the horizontal orientation of the image. 

Flip 

Reverses the vertical orientation of the image. 

o2c Fixed Material Keys 

The MatFixed Flags key has been removed from the [o2cViewer] section of DCADWIN.ini. To 

force material settings that were previously set with the MatFixed Flags key, the following keys 

should be used instead: 

MatFixed Has Texture 
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Set this key to TRUE so all material sub-objects can accept a texture in the Object Viewer. 

Note: Except for bitmap textures that are applied as reflections, a material that has a texture cannot have 

smooth edges. 

MatFixed Texture Mask 

Set this key to TRUE so the color black (RGB 0,0,0) will render transparently in all materials. 

MatFixed Self-Illuminate 

Set this key to TRUE so all materials render without shading. 

MatFixed Texture Colorize 

Set this key to TRUE so all textures are colorized with the corresponding material's rendered 

color. 

MatFixed Render Backface 

Set this key to TRUE so all material sub-objects will be rendered on both sides. 

MatFixed Texture Reflection 

Set this key to TRUE so all textures will render as reflections. 

MatFixed Specular Reflection 

Set this key to TRUE so all materials can be rendered with reflections. 

MatFixed Smooth Edges 

Set this key to TRUE so all tangent polygons within the same sub-object will be rendered as a 

smooth surface (i.e. all the polygons that make up a sphere). By default, adjacent polygons with 

less than a 30-degree difference between their angles of orientation will be considered to be the 

same surface. This Edge Smoothing value can be set in the Rendering Settings dialog. 

Note: Except for bitmap textures that are applied as reflections, a material that has a texture cannot have 

smooth edges. 

MatFixed Texture Scale 

Set this key to a decimal value in meters so that all bitmap textures repeat with the same size 

tiles. 

MatFixed Texture Name 

Set this key to a fully qualified path to a bitmap texture so that all material sub-objects will have 

the same texture. 

Object Viewer Min/Max Width/Height Keys 

The following keys have been added to the [o2cViewer] section of DCADWIN.ini. Set these 

keys to restrict the minimum and maximum size/proportion of the Object Viewer client area. 
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o2c Max Width= 

o2c Max Height= 

o2c Min Width= 

o2c Min Height= 

Note: The 2048-pixel display width restriction has been removed from the o2c Client Area to 

accommodate 4K monitors. 

Productivity Enhancements 

Change Pitch, Angle, or Grade of Flat Polygons and Slabs 

You can now change the pitch of 'flat' polygons and slabs (parallel to the ground plane) via 3D 

Edit, Polygons / Slabs and the Entity Properties Editor. 

Symbol Explode Include Off Layers 

A new option, Include Off Layers, has been added to the Symbol Explode menu. This option is 

available when Symbol Layer Control is set to either Per Definition or Per Instance. When using 

Per Instance Layer Control and exploding symbol instances that include nested symbols, the 

on/off layer settings are transferred to the unexploded, nested symbols. 

Sun Shader & Symbol Layer Control 

The Sun Shader now recognizes on/off state of layers when Symbol Layer Control is set to either 

Per Definition or Per-Instance. 

Create Missing Folders 

DataCAD will no longer create missing folders by default. To control this behavior, a new key, 

Create Missing Folders, has been added to the [General] of DCADWIN.ini. 

[General] 

Create Missing Folders=FALSE 

If FALSE, the default, DataCAD will look in the corresponding default path, or if that 

fails, the DataCAD Program Folder, when the previous path cannot be found. If TRUE, 

DataCAD will try to recreate the previous path. 

Import Non-associative Hatch Dots 

DataCAD will now import zero-length lines (endpoints of lines with matching coordinates) as 

non-associative hatch dots. To control this behavior, a new key, Treat Zero-Length Lines As 

Dots, has been added to the [DXF_DWG] section of DCADWIN.ini. 

[DXF_DWG] 

Treat Zero-Length Lines As Dots=TRUE 

The default is TRUE. If FALSE, DataCAD will ignore zero-length lines during import. 

Custom Elevation: Bisect 

A Bisect option has been added to the New/Custom Elevation menu to make it easier to define 

an Elevation View along the bisector of the angle between two lines or walls. 
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Print Overshoots 

The key, Print Overshoots, has been added to the [Printer] section of DCADWIN.ini. Set this 

key to TRUE to always print overshoots, even if the attribute setting in the Utility, Display 

menu is toggled off. Set this key to FALSE to never print overshoots. Set this key to DEFAULT 

to use the current display setting. 

To Layer Color, Line Type, Line Spacing Toggles 

The following keys have been added to the [General] section of DCADWIN.ini to control the 

Layer Color, Line Type, and Line Spacing toggles in the Move To Layer and Copy To Layer 

menus: 

[General] 

Remember ToLayer Color=TRUE 

Remember ToLayer Linetype=TRUE 

Remember ToLayer Line Spacing=TRUE 

For each of the above, the following values are used: 

If TRUE, the associated menu toggle will always be On 

If FALSE, the associated menu toggle will always be Off 

If blank (or missing), the associated menu toggle will be remembered 

XREF: Show Hatch / Show Fill 

Two new options, Show Hatch, and Show Fill, have been added to the XREF Entity, XREF Tools 

context menu. Uncheck either of these options to suppress the display of hatches and fills on a 

per-XREF basis. These settings do not apply to Smart Wall hatches and fills. 

Multi-Scale Plotting Layout Divisions 

The maximum number of multi-scale plotting layout divisions has been increased from 99 to 

999. 

Symbol Insertion Point by Center 

A new option, By Center, has been added to the Save Symbol routine. This option appears 

when you are prompted to click an insertion point for the symbol. Picking this option will cause 

the symbol's insertion point to be located at the center of the selected entities' extents. This 

option is also available when you redefine a symbol. 

Scroll Zoom to Cursor 

A new key, Scroll Zoom to Cursor Position, has been added to the [General] section of 

DCADWIN.ini. Setting this key to TRUE will cause DataCAD to zoom in and out toward the 

cursor's current position rather than the endpoint of the rubber-band line. The default value is 

FALSE. 

Mask Selection in Geometry Offset 

The Mask selection option is now available in the Geometry, Offset menu. Use the Mask 

option to set which entity types and related properties should be included for the offset entity 

selection. 
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Fixes 

1. A correction has been made to address the display/print order of entities within an 

associative dimension where the text was placed manually with KnockOut enabled and the 

arrow style was set to filled. 

2. Due to a change in logic made in DataCAD 18, polygon normals within triangulated slabs 

and covered polylines were no longer being checked and corrected to point outward from 

the boundary and inward toward the center of voids. This change also disabled the 

correction of normals on 3D entities such as cylinders. As a result, 3D Boolean operations 

between these types of entities would not be calculated properly. This has been corrected. 

3. A license error related to UTF-8 path names has been corrected. 

4. The Identify readout would not appear if Multi-View Windows were displayed and at least 

one of them had Auto Update enabled. This has been corrected. 

5. An error that would cause a crash when using Copy then Paste has been corrected. 

6. Inserting a Symbol with Explode toggled on and Symbol Layer Control set to Per Instance 

would cause DataCAD to hang. This has been corrected. 

7. Corrected scaling of Windows Color dialog when displayed from the Menus tab of Program 

Preferences. 

8. Corrected issues related to Object Snapping to entities within Symbols when Symbol Layer 

Control is enabled. 

DCAL Enhancements 

DCAL for Delphi 

The following constants have been added: 

maxpolyfence = 512; { Should not be less than maxpoly } 

maxdiv = 128; { max Primary/Secondary divisions } 

PathGUI = 73; 

PathLayout = 74; 

Note: Patho2cimporttexture = 48 has been removed. 

The following functions have been added. 

Attribute Functions: 

Sys_Add_AtrStruct(aName : atrName; var struct; sz : byte) : attrib; 

Hdr_AddPut_AtrStruct(aName : atrName; var struct; sz : byte) : attrib; 

Get_AtrStruct(frstatr : lgl_addr; aName : atrName; var struct; sz : byte) : 

Boolean; 

Miscellaneous Functions: 

list_get(var list: list_type; addr: lgl_addr): boolean; 

This function is used to get a list of layers from a GoTo View or MSP Detail. 



48 | DataCAD 21 

21.02.09 

For Example: 

vaddr := pgsv.strtview; 

while view_get(view, vaddr) do begin 

  vaddr := view.Next; 

 

  if view.flag1 = 0 then f_wrstr(fl, 'GoTo View: ') 

  else if view.flag1 = 1 then f_wrstr(fl, 'MSP Detail: '); 

 

  f_wrstr(fl, view.name); { Long Name } 

 

  addr := view.frstlyr; 

  f_wrstr(fl, 'Layers: '); 

  f_wrln(fl); 

  try 

    while list_get(list, addr) do begin 

      addr := list.next; 

      for i := low(list.Data) to high(list.Data) do begin 

        if not isnil(list.Data[i]) then begin 

          getLongLayerName(list.Data[i], lname); 

          f_wrstr(fl, lname); 

          f_wrln(fl); 

        end; 

      end; 

    end; 

  except 

    on e: Exception do begin 

      f_wrstr(fl, 'DataCAD 21.02.00 or later required to get layer list.'); 

      f_wrln(fl); 

    end; 

  end; 

end; 

DCADPenToRGB(penNo: longint; var r: byte; var g: byte; var b: byte); 

Use this function to convert a DataCAD pen number to an RGB triplet. 

dwgpath(var str: str255); 

Use this function to get the path of current drawing. 

DataCAD_Version(): asInt; 

This function returns the current DCADWIN.exe version as an integer. 

Note: The drawing variable, PGSavevar.headerversion contains the version of DCADWIN.exe at the time 

the current drawing was last saved. 

The following sample macros have been added. 

Spiral 

Converted from DCAL for DOS 

TooSmall 

Converted from DCAL for DOS 
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Write_AEC 

Converted from DCAL for DOS 

The following sample macro has been updated. 

atrBrowserForm 

Now uses a single f_wrAtrStr function to extract Drawing, Entity, Symbol, GoTo View, MSP 

Detail, and Symbol Text attribute strings. 

DCAL for C++ 

The following constants have been added: 

#define maxpolyfence 512 /* Should not be less than maxpoly */ 

#define maxdiv 128 /* max Primary/Secondary divisions */ 

#define PathGUI 73 

#define PathLayout 74 

Note: Patho2cimporttexture 48 has been removed. 

The following functions have been added: 

list_get(list_type &list, lgl_addr &addr); 

This function is used to get a list of layers from a GoTo View or MSP Detail. 

DCADPenToRGB(longint penNo, byte &r, byte &g, byte &b); 

Use this function to convert a DataCAD pen number to an RGB triplet. 

dwgpath(ShortString &str); 

Use this function to get the path of current drawing. 

 

21.01.03 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

SketchUp 2019 Compatibility 

In addition to the existing support for SketchUp 7, 8, and 2013 through 2015 files, DataCAD's 

translators have been updated to support reading and writing SketchUp 2016 through 2019 

formats. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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Fat Cursor 

A new option, Fat Cursor, has been added to the 2D Settings menu. Toggle this option On to set 

the weight of the drawing cursor larger than the default of 1; the maximum value is 9. Setting 

the weight of the cursor to a value of 3 can be helpful when drawing over bitmaps and fills that 

otherwise make the cursor hard to see. 

Symbol Browser: Show Nested 

A new option, Show Nested, has been added to the Symbol Browser's Options menu. This is a 

per-folder setting. When enabled, only the top level of 'parent' symbols will be shown in the 

Symbol Browser. This option is especially useful when browsing Drawing symbols that contain 

many nested elements. 

RoofIt Macro Enhancements 

Two new options, Set Colors and Set Layers, have been added to the RoofIt macro's Settings 

menu. This allows you to specify the colors and layers for the various roof components. 

Previously, everything was modeled in the current color and on the current layer. 

Set Colors Menu 

Roof Color (Red) 

Attic Color (Yellow) 

Rake Color (Cyan) 

Fascia Color (Lt Grey) 

Soffit Color (Brown) 

Gable Color (Green) 

Gable In Clr (Lt Magenta) 

Note: Previously, the Gable Color was set by toggling On EndWall which has been renamed to Gable 

Walls. 

Set Layers Menu 

Roof Layer (RF Roof) 

Attic Layer (RF Attic) 

Rake Layer (RF Rake) 

Fascia Layer (RF Fascia) 

Soffit Layer (RF Soffit) 

Gable Layer (RF Gable) 

Gable In Lyr (RF Gable In) 

 

Extended Character Codes 

The following Extended Character Codes have been added for use in Icon Toolbars and 

Keyboard Macros. 

3035# : Load a material file (INI) 

3036# : Reload a material file (INI) 
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The following apply to DataCAD's DMF (DataCAD Material File) when rendering by color: 

3037# : Assign a material to a color index (Load) 

3038# : Assign a material to a color index (Reload) 

Toolbar Examples: 

[Load Brick100] 

Hint=Load Brick100 

Icon= 

A=^3035#^C:\DataCAD 21\Materials\Brick\Brick100$^ 

 

[Load Brick Materials] 

Hint=Load Brick Materials (reload) 

Icon=A=^3036#^C:\DataCAD 21\Materials\Brick\Brick100$^C:\DataCAD 

21\Materials\Brick\Brick101$^C:\DataCAD 

21\Materials\Brick\Brick200$^C:\DataCAD 

21\Materials\Brick\Brick300$^C:\DataCAD 21\Materials\Brick\Brick301$^ 

 

[Color 42 to Brick100 (load)] 

Hint=Change Material for Color 42 to Brick100 (load) 

Icon= 

A=^3037#^C:\DataCAD 21\materials\brick\brick100$^45$^ 

 

[Color 42 to Brick100 (reload)] 

Hint=Change Material for Color 42 to Brick100 (reload) 

Icon= 

A=^3038#^C:\DataCAD 21\materials\brick\brick100$^45$^ 

 

Fixes 

1. Removed logic for the enabled state of the Activate button in the Activate Online dialog. In 

some cases, the button would get 'stuck' in a disabled state. 

2. The message strings on the Evaluation dialog were not centered for non-English languages. 

This has been corrected. 

 

DCAL Enhancements 

DCAL for Delphi 

undoStartTransaction(); 

undoEndTransaction(); 

These procedures mark the beginning and end of what the undo system sees as a "transaction". 

 

DCAL for C++ 

undoStartTransaction(); 

undoEndTransaction(); 

These procedures mark the beginning and end of what the undo system sees as a "transaction". 
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DCAL for DOS 

The following functions were added to a previous version of DataCAD but were never 

documented. 

PROCEDURE UndoStartTransaction; BUILTIN 634; 

PROCEDURE UndoEndTransaction; BUILTIN 635; 

These procedures mark the beginning and end of what the undo system sees as a 

"transaction". 

For example, when creating a single line, the undo system sees the following: 

- An entity was added 

- It was drawn to the screen 

- It was marked as the end of a "group" 

These 3 steps are seen as a single "transaction" and will be "un-done" together. 

PROCEDURE getLongLayerName(pLayer : lgl_addr; Name : IN OUT str80); BUILTIN 

636; 

pLayer is the address of the layer being queried 

Name is the long name of that layer 

FUNCTION Lyr_Find_LongName(Name : str80; pLayer : lgl_addr); BUILTIN 637; 

Name is the layer name to look for 

pLayer is the address of the layer if found 

The function returns True if it found a layer by that Name 

FUNCTION Get_InpStyl : integer; BUILTIN 638; 

This function returns the index of the current input style where: 

0 = Relative Polar 

1 = Absolute Polar 

2 = Relative Cartesian 

3 = Absolute Cartesian 

4 = Direction/Distance 

PROCEDURE Set_InpStyl(InputStyle : integer); BUILTIN 639; 

This function sets the index of the current input style where: 

0 = Relative Polar 

1 = Absolute Polar 

2 = Relative Cartesian 

3 = Absolute Cartesian 

4 = Direction/Distance 

PROCEDURE Get_DimFont(Ent : Entity; FontName : IN OUT str80); BUILTIN 640; 

This procedure retrieves the name of the font used in the associative dimension, Ent 
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FUNCTION setMSPSheetToPlotByName(Name : str80) : boolean; BUILTIN 641; 

Name is the name of the MSP sheet to make current 

This function returns True if it was able to find a sheet with the Name provided 

FUNCTION setMSPSheetToPlotByNum(SheetNum : integer); BUILTIN 642; 

Makes SheetNum the current MSP sheet (1-256) 

This function returns True if a valid SheetNum was passed in 

FUNCTION GetMSPSheetName(SheetNum : integer; SheetName : IN OUT str80) : 

boolean; BUILTIN 643; 

SheetName is the name of the MSP sheet specified by SheetNum 

This function returns True if a valid SheetNum was passed in 

PROCEDURE setToPlotQuickLayout(DoQuickLayout : boolean); BUILTIN 644; 

DoQuickLayout tells DataCAD to default to plotting the Quick Layout rather than MSP 

FUNCTION plotOpen10(PenWidth : integer; WinPaperSize : integer; PaperSizeX, 

PaperSizeY : integer; NumCopies : integer; PlotToFileName : str80; 

ErrorMessage : IN OUT str80) : boolean; BUILTIN 645; 

PenWidth specifies the pen width in millimeters 

WinPaperSize is the index into the available paper sizes 

PaperSizeX/PaperSizeY specify the custom paper size in millimeters 

NumCopies is the number of copies 

PlotToFileName is the name of the plot file to create if plotting to file 

ErrorMessage is a string to receive any error message (i.e. the printer doesn't support the 

paper size specified in PaperSizeX/PaperSizeY 

FUNCTION plotMode10(Mode : IN OUT mode_type; paperMin, paperMax, WindowMin, 

WindowMax, RotationCenter : point; RotationAngle : real; MaintainAspect : 

boolean; ErrorMessage : IN OUT str80) : boolean; BUILTIN 646; 

Mode is what will be plotted 

PaperMin and PaperMax specifies the custom paper size in millimeters 

WindowMin and WindowMax specify the real-world coordinates of the viewport to be 

plotted 

RotationCenter is the real-world coordinate of the center of rotation if the printer is 

setup to rotate the print 

MaintainAspect should be set to True if no distortion of the X or Y axis is desired 

ErrorMessage is a string to receive any error message 

This function returns True if no errors were encountered 

PROCEDURE plotClose10; BUILTIN 647; 

This procedure should be called after calling plotMode10 

FUNCTION setPenTableNameToLoad(PenTableName : str80); BUILTIN 648; 
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PenTableName Name of Pen Table 

This function returns True if successful 

FUNCTION setPrinterByName(PrinterName : str80; ErrorMessage : IN OUT str80); 

BUILTIN 649; 

PrinterName Name of printer 

ErrorMessage is a string to receive any error message 

This function returns True if successful 

PROCEDURE GetPrinterNames(PrinterNamesArrary : IN OUT; TPrinterNamesArr; 

NumPrinters : IN OUT integer) BUILTIN 650; 

PrinterNamesArrary will contain the names of the printers available to the system. 

The type TPrinterNamesArr is declared as: type 

TPrinterNamesArr = ARRAY[1..50] of string[80]; 

NumPrinters is the number of printers found 

PROCEDURE SetMacroHints(DoHints : boolean); BUILTIN 651; 

DoHints tells DataCAD whether to display tooltips for the function key labels 

DataCAD 21 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 21, please click: 

What's New? from the Help pull-down menu in DataCAD. 

New Features 

AutoCAD R2018 – R2021 Compatibility (ALL EDITIONS) 

DataCAD 21 supports the ability to import and export AutoCAD R2018 through R2021 files in 

DXF and DWG format. This enables you to collaborate and share files with associates who use 

the latest version of AutoCAD. 
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DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. Added new options, Hatched, and Filled, to the Mask menu. These options are mutually 

exclusive. When Hatched is toggled (On), entities that are hatched will be selected. If Pattern 

is also toggled (On), only entities hatched with the selected pattern will be selected. When 

Filled is toggled (On), entities that are filled will be selected. 

2. Changes have been made to the way the z-coordinate is handled when you select an 

Insertion Point during Copy/Paste. Previously, the z-coordinate of the insertion point you 

defined was set at the current Z-Base. Now, the z-coordinate will always be set at zero. 

Note: This is the same behavior as defining an insertion point for a Symbol. When you Paste, the Z-

Offset sub-menu is now available if an insertion point has been defined. 

Note: To Paste using the Insertion Point, By Center must be toggled (Off). 

3. The current Base and Height setting for ClipCubes is now displayed on the error line while 

you are in the ClipCube menu. 

4. Enhanced XREF GTV linking to remember the state of the Reference File Manager's Smart 

Wall Hatch/Fill toggles "Show Hatch" and "Show Fill". This can be turned off by modifying 

the following key in the [XREFS] section of DCADWIN.ini: 

[XREFS] 

GTV-Link Remembers Smart Wall Hatch/Fill=TRUE 

Fixes 

1. Undo was not available during 3 Edge Polygon creation and polygons created in succession 

were treated as one undo. This has been corrected. 

2. It is no longer possible to draw lines when you are in the Dimensions (top-level) menu. 

3. The input fields of the new Color Picker have been revamped to make changing values 

using the keyboard easier. Now, when you tab between the HSB and RGB fields, the 

contents are automatically selected so you can change the value by typing. Since all the 
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components in the dialog are updated dynamically, the new value is applied as soon as you 

type. 

4. A new key, New Scale/Rotation, has been added to the [Symbols] section of DCADWIN.ini. 

If TRUE, X, Y, and Z scaling values will be applied to the entity's coordinate system, not the 

drawing's. So, if you insert a symbol with its X-coordinate enlarged, and place it rotated, 

changing the X-enlargement afterward will apply to the symbol's x-coordinate, not the 

drawing's. 

[Symbols] 

New Scale/Rotation=TRUE 

5. The top and bottom of the Parallel ClipCube was displayed when Ignore-Z was toggled on. 

This has been corrected. 

6. The state of the Ignore-Z toggle was not being remembered when defining a Parallel 

ClipCube. This has been corrected. 

7. The new Color Picker dialog would not restore its previous size and position. This has been 

corrected. 

8. The error message, 'no walls found to cut' was not displayed when trying to insert a smart 

door or window and no smart walls were found to cut. This has been corrected. 

9. A correction has been made so the Symbol Browser no longer 'double-draws' its contents 

when changing between folders with different Ortho/Iso view settings. 

10. A correction has been made for the area/fence selection of entities, with "Ignores Clip Cube" 

set, that are outside of the active clip cube. 

11. A correction has been made to "Fixed Decimal Pt.:" and "Sig. Digits:" in the property editor 

for associative dimensions. 

12. A correction has been made to the Font List drop-down not scaling correctly. 

13. MSP Detail "Make Curr" now updates the persistent Layer Manager if Real-Time Updating 

is enabled. 

14. Files containing orphaned, nested XREFs would cause the Pak-N-Go export to fail. This has 

been corrected. 

15. Minor corrections have been made to the ClipCube On/Off toggle. 

16. DataCAD's pull-down menu shortcut keys are trapped by the main application window and 

were not being sent to the persistent Layer Manager when editing a layer name. This has 

been corrected. 
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17. In some cases, plotting to a file would fail, and the output would be sent directly to the 

device instead. This has been corrected. 

18. The following DCADWIN.ini keys are no longer used as these settings have been 

permanently set to TRUE. 

[General] 

KB4054518=TRUE 

New Regen=TRUE 

NewSymbolExtents=TRUE 

Show PText/Mtext Boundary On Entry/Resize=TRUE 

[Symbol Attributes] 

New Database Linking=TRUE 

[Symbols] 

New Layer Control=TRUE 

[XREFs] 

New Check For Nested=TRUE 

New Clipped Area Selection=TRUE 

 

DCAL for DOS Enhancements 

Added the following BUILTIN procedure: 

PROCEDURE SetKnockOut(Ent : In Out entity; TurnOn : boolean); BUILTIN 678; 

20.02.03 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

Improved Symbol Layer Control 

In the first implementation of Symbol Layer Control, whenever a Symbol was added to a 

drawing, its list of On/Off Layer Attributes were added to the symbol instance. This happened 

regardless of whether Symbol Layer Control was set to None, Per Definition, or Per Instance. In 

a drawing with hundreds of symbol instances, this created a lot of unnecessary overhead. 

Handling this data could significantly slow down File, Exit and Save, and saving a symbol from 

the Symbol Editor back to its parent drawing. Additionally, when Per Instance layer control 

was enabled, GoTo View Link Attributes were being added to symbol instances even when 

their GoTo View Link option was not enabled. 

https://www.datacad.com/products/DataCAD_Sub-01.html
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This is no longer the case. Layer On/Off Attributes are only added to a symbol instance when 

Symbol Layer Control is set to Per Instance. These attributes will also be added to existing 

symbol instances when you switch Symbol Layer Control from None or Per Definition to Per 

Instance. If you switch from Per Instance to either None or Per Definition, you will be asked 

"Would you like to retain Per Instance layer control attributes?" Answer Yes if you intend to 

return to Per Instance layer control at some point. Otherwise, answering No will delete the now 

unused Layer On/Off Attributes from each symbol instance in the drawing. 

Also, when Per Instance Layer Control is enabled, GoTo View Link Attributes will only be 

added to those instances that have their GoTo View Link option enabled. This option is 

available in the Insert Symbol menu, Symbol Tools context menu, and the newly expanded 

Symbol Layer Manager. 

Additionally, when a drawing is first loaded into this version and Symbol Layer Control is not 

set to Per Instance, DataCAD will delete the unused Layer On/Off attributes from each symbol 

instance in the drawing. This will slow down the loading of the drawing. However, it will only 

happen the first time the drawing is loaded and then saved. 

Symbol Layer Manager: GoTo View Link Options 

Several options have been added to the Symbol Layer Manager to give you greater control of 

the way On/Off Layers and GoTo View Links apply to symbol instances. 

Changing the On/Off Layers in the Symbol Layer Manager then selecting Apply or OK will set 

the On/Off Layers for the selected symbol instance. 

Apply To All Instances, can be checked prior to clicking the Apply or OK button to apply the 

changes to all instances of the selected symbol definition on the Active Layer. 

If Apply To All Instances is checked, the option, On These Layers becomes available so you can 

apply the changes to All Instances on the Active, On, or All layers. 

A GoTo Views section provides options for managing the GoTo View Links in symbol 

instances. 

When GTV Link is checked, DataCAD will associate the symbol's on/off layers and clipping 

boundary with a GoTo View whenever it is created or updated. 

A drop-down list of the drawing's GoTo Views appears below the GTV Link checkbox. 

Selecting one of the GoTo Views from this list will set the on/off layers in the Symbol Layer 

Manager. Selecting Update will update the on/off layers that are associated with the selected 

GoTo View. Selecting Update All GTVs will cause the symbol to display the same on/off layers 

for every GoTo View. 

For convenience, there is an option, As Selected, in the GoTo Views drop-down list. Selecting 

this option will set the on/off layers in the Symbol Layer Manager to the way they were when 

you first opened the Symbol Layer Manager. 
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Symbol Layer Control Notes: 

1. Binding an XREF to a Symbol will copy the XREF's GoTo View links to the new Symbol 

Instance. 

2. The following key has been added to the [Symbols] section of DCADWIN.ini: 

[Symbols] 

GTV Link=TRUE 

If that key is TRUE, the "GTV Link" toggle will always be ON when the Insert Symbol 

menu is shown. Conversely if the key is FALSE, the toggle will always be OFF. If the key 

is present but left blank, the state of the toggle will be remembered. 

3. A GTV Link dropdown has been added to the Entity Properties Editor for symbols. 

Note: This option is only shown if the current Symbol Layer Control is set to "Per Instance". 

4. When Per Instance layer control is enabled, a new GTV Link toggle is shown at F8 in the 

Insert Symbol menu and the Symbol Tools context menu. The GTV Link toggle in the 

insert symbol menu controls the state of a drawing variable that is used to set that 

property as symbols are inserted. The GTV Link property is per-instance therefore can 

be enabled/disabled on a per symbol entity basis. GTV Linking for Symbols works 

essentially as it does for XREFs. 

5. Changes have been made to allow you to add, delete, or rename layers in the Symbol 

Editor and have all its instances automatically update their local layer lists to reflect 

those changes. This, essentially, renders Symbol Tools, Layer Control..., Rebuild Layer 

List unnecessary when using Per Instance symbol layer control. 

6. Changes have been made so that Symbols using layer on/off settings that have been 

assigned with Symbol Layer Control set to Per Instance will not lose those settings when 

switching between None, Per Definition and back to Per Instance. 

7. When exporting to DWG and Symbol Layer Control is NOT set to "None", DataCAD 

will use the On/Off layer settings in the symbol definition. If you select "All Layers" for 

DWG export, all the layers in the symbol will be exported, but the On/Off status will 

reflect the current state of the symbol definition. If "On Layers" is selected, only those 

layers that are On will be exported. 

 

Symbol Browser: Recent / Favorite Folder Manager 

A new option, Manage, has been added to the Symbol Browser's Recent and Favorite Folders 

menus. Select this option to display a dialog you can use to manage your list of Recent and 

Favorite symbol folders. Click on a single item to highlight it. Click and Drag an item to move 

its position in the list (only one item can be moved at a time). [Ctrl] + Click or [Shift] + Click to 
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select multiple items. Press [Delete] to remove highlighted items from the list. Right-click to 

display a context menu with the following options. 

- Sorted 

- Delete Selected 

- Set Max Folders 

Select Sorted to Alpha-numerically sort the list. When Sorted is enabled, the ability to move 

items in the list is disabled. Delete Selected is only available when items are selected. Select Set 

Max Folders to set the maximum number of saved folder locations (1 - 100). 

Exclude Selection from Editing Routines 

A new option, Exclude, has been added to the 2D and 3D Edit Menus; Move, Copy, Rotate, 

Mirror, Stretch, Enlarge, and Erase. 

Note: Exclude is not available in Rotate, Quick, and Erase, Partial; or if Dynamic is toggled (On). 

The Exclude toggle appears at [F7] once you have begun the editing routine. For example, after 

you have defined the distance to stretch, toggle (On) Exclude, then click on entities you would 

like to exclude from Stretch. The entities you selected are highlighted. Click on a highlighted 

entity to remove it from the items to exclude. Right-click to return to the Stretch command. 

Perform the Stretch operation as many times as necessary. Toggle off Exclude to cancel and 

clear the Exclude selection. Exit Stretch; the Exclude Toggle and Selection will be reset. 

 

Enhancements 

Pak-N-Go Enhancements 

The following options have been added to the Destination section of the Extract Settings dialog 

for Pak-N-Go. 

- Pak-N-Go Folder 

- Pak-N-Go Name Sub-Folder 

- Recreate Folder Structure 

By default, the contents of a Pak-N-Go archive are extracted to the folder containing the PAK 

file. For convenience, the destination Pak-N-Go Sub-Folder has been added so the contents can 

be extracted to a sub-folder with the same name as the PAK file. Recreate Folder Structure 

extracts the contents of the archive to the original folders the individual files came from. 

A new option, Open External Files from Pak-N-Go Folder, has been added to the Pak-N-Go 

Settings dialog. This option is only available when the extract to destination is set to either Pak-

N-Go Folder, or Pak-N-Go Name Sub-Folder. Use this option to force DataCAD to use the 

contents of the archive as it was saved. Otherwise, DataCAD will try to read the external files 

from their original locations, which may be different from the archive. 
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Symbol and Smart Entity Counts 

A new Count option is available for Symbols and Smart Doors and Windows. [Ctrl] + Right-

click on any Symbol or Smart Door / Window instance and highlight Count in the Context 

Menu. Select Active Layer, On Layer, or All Layers to query the count for all instances of that 

item. The results are displayed on the Attention toolbar. 

For Symbols that have been loaded into the drawing, the Count option is also available in the 

Symbol Browser's Context Menu when browsing a folder or the current drawing. 

In the case of Smart Doors and Windows, instances of non-fixed width types of varying widths 

are tallied separately. So, the count will only include instances of the current type with the 

current width. 

A context menu has also been added to the item lists in the Smart Door and Window Managers. 

Right-click on any loaded Type to reveal the option, Count. Highlight Count and select either 

Active Layer, On Layer, or All Layers to display the number of occurrences of that Type. The 

results are displayed on the Attention Toolbar. 

Note: Varying widths of the same Type are counted together. 

Miscellaneous Enhancements 

1. Changed what is shown when selecting a renamed XREF for renaming in the Reference 

File Manager. 

2. Added a horizontal scrollbar (only when necessary) to the Styles list of the Style 

managers (Walls, Doors and Windows). Also, a hint is now displayed when the mouse 

is over a Style in the list. 

3. Changed Identify/Set All on an associative dimension to set the Show Dim Text drawing 

variable. 

4. New options have been added to the Clip Cube menu for incrementally adjusting either 

the x, y, or z coordinates of the Drawing Clip Cube. 

Ortho or Parallel Clip Cube: 

- Move X+ 

- Move X- 

- Move Y+ 

- Move Y- 

- Move Z+ 

- Move Z- 

- Move Distance (X, Y, or Z Increment) 

Note: These options only appear when Clip Cube is enabled. Use these options while viewing a 

clipped view to move the clip box 'through' your model. 
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5. Added the option, Convert 3D Lines to 2D Lines and Flatten, to the Drawing Audit 

dialog. 

6. [Ctrl] + Click'ing on a Symbol will now open the Symbol Layer Manager if Symbol Layer 

Control is set to Per Instance. 

7. XREF Clips and Symbol Clips will now be clipped by the Drawing Clip Cube. If an X-

Clip or S-Clip overlaps a Drawing Clip Cube, it will be merged with the Drawing Clip 

Cube. So, the portion of the X-Clip or S-Clip that lies within the Drawing Clip Cube will 

be displayed. 

X-Clips and S-Clips can be set to ignore Clip Cubes via a toggle in their context menu or 

within the X-Clip S-Clip menu. 

Note: Drawings saved in versions of DataCAD prior to 20.02.03 will automatically have their X-

Clips and S-Clips set to ignore Clip Cubes when opened in this version. 

8. Added a new radio group, Ignore CC, to the Reference File Manager. 

9. Added "Check Spelling" to the context menu for Text, PText, MText, Symbol Attribute 

Text and Symbols. 

10. Added the options, Half and Double to the Enlarge menu. 

11. Added new Board & Batten and Channel Lap siding materials in 25 standard fiber 

cement colors. 

12. Added a new Color Picker/Mixer to replace the previous one. 

13. DataCAD's color drop-down combo-box will now give access to all 255 colors. 

14. The key, 'Allow Trailing Spaces', has been added to the [Symbol Attributes] section of 

DCADWIN.ini. Setting this key to TRUE will prevent DataCAD from removing trailing 

spaces in Symbol Text Attribute values. 

 

Fixes 

1. Correction for Max key in DCADWIN.ini for Recent Files/Folders. 

2. Changed the loading of .DPS (plot settings) files to ignore blank "Last Plot Scale" keys. 

3. Added the key, ' Insertion Point Considered For Area/Fence', to the [Symbols] section of 

DCADWIN.ini.  

Setting this key to TRUE will allow symbols to be selected by their insertion point when 

using Area or Fence. 

4. Non-visible text attributes, within a Symbol, are no longer considered in Area or Fence 

selection. 
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5. Correction for the Extraordinary Values dialog in File Repair when the scale type is 

AS1100. 

6. A correction has been made to the Delete Empty Layer function in the Layer Manager. 

7. Symbol Text Attributes were ignored by the Flatten option during a Drawing Audit. 

This has been corrected. 

8. An error in the dialog enlargement factor assignment that would cause lines of text to 

overlap in dialogs has been corrected. 

9. An error in the range checking procedure used during a Drawing Audit that could cause 

an invalid Z value to display incorrectly has been corrected. 

10. The As Selected option in the Symbol Layer Manager has been moved from the GoTo 

View drop-down to the layer list popup menu. 

11. Logic errors in building the As Selected list in the Symbol Layer Manager have been 

corrected. 

12. DataCAD will now prevent any dialog that does not have a Maximize button from 

displaying in a maximized state. 

13. In the Drawing Repair dialog, corrected XREF and Symbol Insertion Z to Zero when the 

Defaults button is selected. 

14. A correction has been made to the Bind option for MSP Details that contain XREFs 

within a Drawing Clip Cube. 

15. Knockout borders will no longer be drawn around empty Symbol Attribute Text. 

16. Corrections have been made to the item list spacing in the Line Type and Hatch Pattern 

Managers. 

17. The Pak-N-Go archive routine was not including Nested XREFs. This has been 

corrected. 

18. The Extract Only option for Pak-N-Go is now available when no drawings are open. 

19. A correction has been made to the aspect ratio of the Line Type and Hatch Pattern 

Preview Window. 

20. A correction has been made to the Hyperlink Highlighting routine. 

21. A correction has been made to selection from the Clipboards menu when more than one 

page of Clipboards exists. 
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20.01.01 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. A ‘Distance X 2’ option has been added to the 2D and 3D Move, Copy, and Stretch 

menus. 

Note: The appearance and position of this option is affected by the state of the New 3D Menu 

key in the [General] section of DCADWIN.ini. 

Fixes 

1. An error in the Redefine function for XREFs that would cause the XREF to lose its layer 

on/off setting within its GoTo View Links has been corrected. 

2. The Edit Symbol Attribute dialog has been updated to address a problem where the 

Prompt column was not being displayed. 

3. A minor correction has been made to writing a Dimension Style file. 

20.01.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

DPI Awareness 

DataCAD's Program Interface and High-resolution Displays 

A multitude of issues related to the display of DataCAD's drawing and program interface on 

high-resolution devices, such as 4K monitors and tablets, have been addressed in this update. In 

all, more than 100 dialogs, including the Layer Manager and the XREF Manager, are affected by 

these changes. 

Starting with Windows Vista, Microsoft introduced DPI Virtualization to automatically upscale 

(i.e., bitmap stretch) applications like DataCAD so that their interfaces would appear the same 

size on higher resolution displays. Until the recent introduction of hi-dpi displays like 4K 
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monitors and tablets, stretching DataCAD's interface (dialogs and the drawing area) 125 - 150% 

was not detrimental. Even on a Surface Pro tablet running at 192 dpi, Windows did a fairly 

good job of upscaling DataCAD's menus and dialogs. 

However, the quality of the drawing area could degrade beyond what was acceptable. A 

display scaling of 200% or more would cause lines to look 'fat,' text to look 'fuzzy,' arcs to look 

'jagged,' and snapping points and markers to 'bloom.' 

In Windows 8.1, Microsoft introduced a way to disable display scaling on a per application 

basis. You could right-click on DCADWIN.exe (or the program shortcut), select Properties, go to 

the Compatibility tab and check Disable Display Scaling On High DPI Settings. This would 

prevent DataCAD from being scaled, and the draw form would be rendered at 1:1. 

Disabling Display Scaling would restore the drawing area so that lines, text, and arcs were 

sharp. However, DataCAD's menus and dialogs would also be rendered at 1:1, so the interface 

would become too small to read. The size of toolbar icons and the menu font can be adjusted in 

Program Preferences, so the main interface could be corrected, but many other dialogs would 

appear too small. 

The Windows 10 Creator's update introduced a major change to the way the operating system 

and applications implement DPI Scaling. In some cases, this would cause DataCAD to 'shrink' 

on high resolution displays. Even changing the display resolution would not correct this since 

the native resolution is always used. 

With this update to DataCAD, the drawing area will always be drawn at the highest resolution 

possible, or 1:1 with the display device. Toolbar icon sizes and menu font sizes can still be 

adjusted the same way in Program Preferences. For dialog boxes, a new Dialog Box Size slider 

bar has been added to the Interface tab. DataCAD will query the current display and 

automatically set a recommended enlargement. You can change this setting by adjusting the 

slider bar position. 

Since most of DataCAD's interface is affected by these changes, we expect there to be anomalies 

we have overlooked. Please report any interface elements you find to be the wrong size to 

help@datacad.com. 

3D Inclined Polygons & Slabs: Pitch / Angle / Grade 

New options for Pitch, Angle, and Grade have been added to the 3D Inclined Polygons and 

Slabs create and edit menus. 

To create an inclined polygon or slab using a pre-defined slope: 

- Go to 3D Entity, Polygons or Slabs, Inclines. 

- Select one of the inclined polygon or slab types to create: 

 1. 4 Edge Parallel (i.e., gable roof plane or ramp) 
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 2. 4 Edge Trapezoid (i.e. hip roof plane or tapered ramp) 

 3. 4 Edge General (i.e. gable to hip roof plane) 

 4. 3 Edge Bottom (i.e. hip roof plane) 

 5. 3 Edge Top (i.e. dormer roof plane) 

- Select one of the slope creation methods to use: 

 1. Base/Pitch (Create inclines from z-base to a height, specified by Pitch: Rise / Run) 

 2. Base/Angle (Create inclines from z-base to a height, specified by Angle) 

 3. Base/Grade (Create inclines from z-base to a height, specified by Grade) 

Note: 

For Pitch, any positive or negative Rise value is allowed. However, the Run value must be positive. For 

Angle and Grade, any positive or negative value is allowed. 

The maximum values allowed are: 

- Rise: +/- 685 units 

- Run: + 1000 units 

- Angle: +/- 89 degrees 

- Grade: +/- 5700 percent 

The minimum value must be non-zero. 

- Follow the prompts to enter the first edge of the polygon or slab. 

- Follow the prompts to enter the second edge or point of the polygon or slab. 

- Select New Pitch, Angle, or Grade to enter a new value for the slope of the polygon or slab. 

To change the slope an existing inclined polygon or slab: 

- Go to 3D Entity, Polygons or Slabs, Edit. 

- Select Pitch/Angle 

- Toggle one of the slope methods to use: 

 1. Rise/Run 

 2. Angle 

 3. Grade 

- Select New Pitch, Angle, or Grade to enter a new value for the slope of the polygon or slab. 

- Toggle on Move Top to update the z-coordinates of all but the lowest (i.e. Eave) vertices of the 

polygon or slab. Toggle on Move Bottom to update the z-coordinates of all but the highest (i.e. 

Ridge) vertices of the polygon or slab. The x and y coordinates of the polygon or slab vertices 

will not change. 

- Select inclined polygons or slabs by Entity, Group, Area, or Fence. 
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3D Inclined Polygons & Slabs: Entity Properties Editor 

The Entity Properties Editor has been updated to include the Slope parameters of 3D Inclined 

Polygons and Slabs. When you display the properties of a 3D Polygon or Slab that is not 

horizontal or vertical and has at least one edge parallel to the ground plane, its slope properties 

are shown. 

A drop-down list for the Slope Type can be set to one of the following: 

- Pitch 

When set to Pitch, the Rise and Run parameters can be changed. 

The maximum Rise value is +/- 685 units. The maximum Run value is 1000 units. 

- Angle 

When set to Angle, the angle, in decimal degrees, can be changed. 

The maximum angle is +/- 89 degrees. 

- Grade 

When set to Grade, the grade, in percent, can be changed. 

The maximum grade is +/- 5700%. 

When you change the slope parameters, DataCAD will update the z-coordinates of all but the 

lowest (i.e. Eave) vertices of the polygon or slab. Set Move Top to No to update the z-

coordinates of all but the highest (i.e. Ridge) vertices of the polygon or slab. The x and y 

coordinates of the polygon or slab are always maintained. 

Symbol Layer Manager 

When Symbol Layer Control is set to Per Instance, a new Symbol Layer Manager option is 

available in the Symbol Tools context menu. Select this option to display the Symbol Layer 

Manager for the currently selected symbol. 

Layers in the list can be toggled on/off by clicking on them. 

An Info Tip is displayed next to layers that have View and/or Scale-independent attributes. 

Note: 

The Symbol Layer Control 'Off' setting supersedes the View/Scale-dependent Symbol Layer 'On' setting. 

So, if a symbol's layer is set to 'Off' by Symbol Layer Control, the layer will not display, regardless of its 

view/scale-dependent setting. 

The View/Scale-dependent Symbol Layer 'Off' setting supersedes the Symbol Layer Control 'On' setting. 

So, if a symbol's layer is set to 'Off' by View/Scale-dependent Control, the layer will not display, regardless 

if its layer control setting. 

In other words, if a symbol's layer is turned off by either method, it will not display. 
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A new option, Open SLM (Symbol Layer Manager), has been added to the Insert Symbol menu 

when Symbol Layer Control is set to 'Per Instance.' When toggled on, the Symbol Layer 

Manager (SLM) will be opened when a symbol is inserted. 

Enhancements 

1. A new option, Real-time Updating, has been added to the Persistent Layer Manager. If 

un-checked, the Layer Manager will only update its layer list when the dialog has the 

Focus. 

2. Associative Dimensions and Smart Walls can be selected using the Entity method of 

Geometry, Divide. For Dimensions, the divisions are added along the dimension line. 

For Smart Walls, they are added along the Control Line. 

3. For renamed XREFs, the original path to the XREF is now appended to the new name, 

separated by characters, defined by line #6526 of DCADWIN.msg. 

4. New options have been added to the AEC File Repair dialog. 

Flatten 2D Entities within Symbols is now a sub-option of Flatten 2D Entities. 

XREF and Symbol Insertion to Zero is now a separate option. Previously, this would 

occur automatically if Flatten 2D Entities was checked. 

Covered Polylines are considered to be 3D entities and are no longer flattened along 

with 2D entities. Uncovered Polylines are considered to be 2D entities and will be 

flattened along with other 2D entities. 

5. The Entity Properties Editor has been updated to show all unavailable options for the 

selected entity in a disabled state. So, only available options, based on the current 

settings, are shown. For example, a Text entity has KnockOut Border and X/Y 

Enlargement options. However, they will only be enabled if KnockOut is set to Yes. This 

way, you do not need to Apply after setting KnockOut to Yes to see those additional 

options. Setting KnockOut it to Yes enables those options automatically. 

6. Symbol Layer Control on/off assignments are now retained when switching between 

None, Per Definition and Per Instance. 

7. As with GoTo Views, Multi-View Windows will now remember the current Tangents 

setting. 

 

Fixes 

1. DataCAD now checks to see if the restored position of a dialog falls within an inactive 

monitor. When this occurs, the dialog will be positioned at the center of the application 

window instead. 
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2. Corrections have been made to the selection by Area and Fence methods when selecting 

symbols. So, a symbol is selected only if the entire extents of the symbol is included in 

the area or fence selection boundary, not just the insertion point. To select a symbol by 

its insertion point only, enable crossing while selecting by area or fence. 

3. Trying to copy an entity by circular array, with z-increment enabled, and number of 

objects set to 1 would cause the drawing to close. This has been corrected. 

4. Various status messages have been added to the Save function in the File Purge dialog. 

5. Corrected a bug in Symbol Clips within XREF Clips with the Ignore Z property enabled. 

6. Fix to address: "Unexploded symbols will move and stretch by area inside of a CC. But, 

if the unexploded symbol contains Ptext, that doesn't seem to move or stretch when 

using the area method." 

7. An error that would cause DataCAD to become unresponsive when trying to create a 

Pak-N-Go archive of a drawing that contained XREFs with nesting enabled but were not 

displayed, has been corrected. 

8. The Layer Manager icons are now based on the font sized used in the layer list. 

9. The Persistent Layer Manager is now automatically updated after a DXF/DWG import 

has completed. 

10. The scaling of drawing markers such as Symbol and XREF insertion points is no longer 

automatic. By default, they are drawn at 100%. Their size can still be changed by setting 

the enlargement value (in percent) in the [Display] section of DCADWIN.ini. To change 

the enlargement of drawing markers, set Auto Adjust Marker Size Percentage to a value 

other than 100. 

11. An error that would prevent you from turning off Show Outline on a Polyline when 

Lock Aspect Ratio was off, has been corrected. 

12. The size of TrueType text was not transformed to the Object Viewer when lock size was 

enabled. This has been corrected. 

13. o2c / Shader light indicators now display when a light source is contained in a nested 

XREF. 

14. Helplines have been corrected to prevent property changes other than Color and Pen 

Style. 

15. Corrections have been made to the non-printing pen (pen 0) to prevent its assignment to 

the 'parent' entity color such as the insertion point of symbols and XREFs, and Smart 

Entity instances. 
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16. Corrections for text alignment to a Smart Wall 

17. An error that would prevent restoring (or undoing) a Smart Wall segment that had been 

deleted using the comma [,] key has been corrected. 

18. An error that would cause your drawing to close when erasing a Helpline has been 

corrected. 

19. An error that would prevent you from selecting Helplines using Area or Fence with 

Crossing enabled has been corrected. 

 

DCAL for Delphi Enhancements 

1. Header files for Delphi DX have been added. They are in the DCAL for Delphi\Header 

Files DX folder. 

2. A new sample macro, Edit_Group, has been added to demonstrate the use of the 

mode_group command. 

3. Sample macros are now included for Delphi DX in the DCAL for Delphi\Samples DX 

folder. 

4. All the sample macros have been compiled for DataCAD 20 and are available in the 

DCAL for Delphi\Compiled Macros folder. 

DCAL for Delphi Fixes 

1. An error in the declaration of the mode_group procedure would cause the drawing to 

close when this function was called. This has been corrected in uInterfaces.pas. 

2. A correction has been made to the get_loaded_lineType_definitions procedure. 

3. The mode_type record has been updated to include the from_select_all boolean. If true, 

the selection was performed using the [Ctrl] + [A], 'Select All' method. 

DataCAD Installer Fixes 

1. After uninstalling DataCAD, and when a previous version is also installed, you are 

prompted with the option to restore DataCAD's file associations with the previous 

version. This operation was failing to restore the file associations and has been corrected. 

2. In cases where the system's boot drive could not be detected, the installation drive was 

set to 'C' instead of 'C:\'. This has been corrected. 

3. An error in the Update Installer's Update Message and Label File routine for wide labels 

that would cause extra spaces to get added to the last new line of DCADWIN and 

DCADWIN3.msg has been corrected. 
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Fixes 

1. Changes have been made to DataCAD’s File Open routines to handle an error 

introduced by a recent Windows security update. The Microsoft Windows security 

update KB4051034 that was issued 12 December 2017 which applies to: Windows Server 

2008 R2 Service Pack 1, and Windows 7 Service Pack 1, causes a DataCAD file access 

error under certain conditions. Users running DataCAD on Windows 7, and accessing 

drawing files and symbol across a network, began experiencing unexpected file closings 

coincident with this security update. 

 

DataCAD 20 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 20, please click: 

What's New? from the Help pull-down menu in DataCAD. 
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DataCAD 19 

19.03.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

Layer Control in Symbols 

The following key is added to the [Symbols] section of DCADWIN.ini to set the default state of 

Layer Control in Symbols. 

[Symbols] 

Default Layer Control=0 

0, the default ('None' in the menu option), allows you to turn layers on and off within the 

Symbol Editor. However, all layers will be displayed in the symbol's instance. This has been the 

behavior since the Symbol Editor was added to DataCAD 12. 

1, ('Per Definition' in the menu option), allows you to turn layers on and off within the Symbol 

Editor. 

The on/off state of the layers is retained when you close and save the symbol. All instances of 

the symbol will display the same layers. 

2, ('Per Instance' in the menu option), enables a new menu option, 'Layers...', in the Symbol 

Tools sub-menu of the Symbol Context menu. Highlighting this option reveals the list of all 

layers, top-level and nested, contained in the symbol. A checkmark next to the layer name 

indicates the layer should be displayed. Any layer that is unchecked, will not be displayed. 

A new option, Symbol Layer Control... has been added to the Insert menu. There are three sub-

options. 

None (the default) 

Per Definition (layer on/off display is the same for all instances) 

Per Instance (layer on/off display can be unique for each instance) 

A new option, Layer Control..., has been added to the Symbol Tools sub-menu of the [Ctrl] + 

Right-click, Symbol Context menu. There are two sub-options. 

A listing of all layers, top-level and nested, contained in the symbol. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com


74 | DataCAD 19 

19.03.00 

Rebuild Layer List 

Selecting this option rebuilds the complete list of layers based on the current symbol definition 

and sets their displayed state to on. You should perform this operation after adding or deleting 

layers from a symbol definition. There are two sub-options. 

This Instance (rebuilds layer list for the selected symbol) 

All Instances (rebuilds the layer list for all instances of the selected symbol) 

Polyline Length Readout 

The length / perimeter and area of polylines is now displayed during editing. 

1. In addition to MCR, DMX (DCAL for Delphi and C++) macros are now remembered 

when they are the last macro used. 

2. Added the following new INI key to the [Smart Text] section of the INI file: 

[Smart Text] 

Smart Text Margin Obeys TextScale=TRUE 

 

Setting this to FALSE will cause PText/MText margins to always act as though TextScale 

is Off. 

3. Modified 2 Line Trim to allow the selection of coincident lines for the selection of the 

first line. That is, you select the 1st line and if it is the wrong one, right-click once and 

select again and it will pick the next line. This may be repeated until the correct line is 

selected. 

4. Modified Explode in the Symbol Tools context menu to obey the Keep Groups toggle in 

the Symbol Insert (Explode) menu. 

5. A new key, AS 1100 Exports As mm, has been added to the [DXF_DWG] section of 

DCADWIN.ini. 

Setting this key to TRUE, will cause DataCAD to export the AS 1100 Scale Type as 

millimeters. 

6. Two new keys, Nesting In XREFs and Nesting In Self-XREFs, have been added to the 

[XREFs] section of DCADWIN.ini. 

Note: The key, Allow Nesting has been deprecated. A new key, Display Nesting, has been 

added to store the Program Preference, Display Nested XREFs. These keys control the default 

state of the Nesting toggle in the Insert XREF menu. 

7. Mirror by Entity has been enhanced to allow the selection of Helplines. 
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8. A new option, Separator, has been added to Scale Type, AS 1100 menu toggle. This 

option allows you to choose either a space character, or a comma to delineate meters. 

9. A new toolbar code, 145, has been added for XClips. Equivalent to the menu selection 

sequence, Insert, Reference File Management, Clip Cubes. 

10. DataCAD will now save the Active layer upon a Symbol's creation. 

11. Pak-N-Go now includes symbols marked for 'Auto Reload.' 

12. The display size of DataCAD's markers used for the object snap indicator, insertion 

points, and 3D markers can now be customized by changing the value of a new key, 

Auto Adjust Marker Size Percentage, in the [Display] section of DCADWIN.ini. The 

initial value, in percent, is set automatically based on your display resolution. 

13. It is now possible to Object Snap to the Absolute Zero indicator. 

14. A new option, Bisect, has been added to the Mirror menu. 

15. The display grids can now be set to a custom color. 

16. A new toggle, Ignore CC (Clip Cubes), has been added to the symbol insert menu. 

17. A new option, By Center, has been added to the Move, Drag menu. 

18. For convenience, an 'Abs. Zero' option has been added to the Multi-scale Plotting, 

Layout menu. 

 

Fixes 

1. Changed the "One Line Trim" / "By Entity" checkbox on the "Misc." tab to a radio group 

with 3 options: 

 

Last Used 

By Entity 

2 Points 

2. Added error checking to address program lockup during mirror operation. 

3. Correction for "Loaded Indicator" not showing when using Object Snap to select a 

symbol from the browser. 

4. Correction for LockSize of entities with visible attributes. 

5. Correction to Undo command related to Line to Poly function. 
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6. Corrections for the relationship between Lock Angle in the Insert Symbol menu and the 

Clipboard Paste menu. 

7. A correction has been made to mirroring text. 

8. The Layer Name label in Identify has been corrected for wide menu configurations. 

9. An error that would cause Self-XREFs to become duplicated when launching the Sun 

Shader has been corrected. 

10. Corrections have been made to Area/Fence selection with Crossing enabled when in a 

parallel (elevation) view. 

11. Corrections have been made to Area/Fence selection of clipped XREFs and Symbols. 

This new methodology can be turned off with the following new key in the [XREFs] 

section of DCADWIN.ini: 

[XREFs] 

New Clipped Area Selection=FALSE 

The default is TRUE. 

12. Corrections have been made to Fence selection so that you can now toggle off crossing 

while drawing a counter-clockwise fence when auto-crossing is enabled. 

13. Corrections have been made to the DWG translator to handle orphaned XREFs and null 

strings in single-line text. 

14. The active mirror line was not displayed when the drawing Clip Cube was on. This has 

been corrected. 

15. Corrections have been made to the way DataCAD handles password protected 

drawings. 

 

DCAL for DOS Enhancements 

PROCEDURE Ent_Mirr(ent : In Out entity; pt1, pt2 : point; FixText : boolean); 

BUILTIN 675; 

 

PROCEDURE Ent_Explode_With_Matrix(ent : In Out entity; mat : modmat); BUILTIN 

676; 

 

PROCEDURE Explode_Symbol_Entity(Syment : In Out entity; Where : integer); 

BUILTIN 677; 

DCAL for DOS Fixes 

1. A correction has been made to the mode_group call. 
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19.01.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

Helplines (a.k.a. Construction Lines) 

A new option, [S4] Helplines, has been added to the Utility Menu. Helplines are infinite lines 

you can add to your drawing for reference only. You can offset them, snap to them, and trim to 

them, but they do not print. 

➔ To add helplines to your drawing; 

 Select Helplines from the Utility menu. 

 Click the first point of the helpline. 

 Click the second point of the helpline. 

DataCAD draws an infinite line between the two points. 

The following options are available in the Helplines menu: 

F1 Delete All 

Select Delete All to remove all the helplines from your drawing. 

F5 Color 

Select Color to choose a color for helplines. 

F6 Pen Style 

Select Pen Style to choose a pen style for helplines. 

F0 Show 

Toggle Show off to disable the display of helplines. 

S2 Draw First 

Toggle Draw First on to have helplines draw before (i.e., underneath) other geometry. 

S3 Draw Last 

Toggle Draw Last on to have helplines draw after (i.e., on top of) other geometry. 

The following Helpline-related extended codes have been added: 

https://www.datacad.com/products/DataCAD_Sub-01.html
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1111# : Helplines Show On 

1112# : Helplines Show Off 

1113# : Helplines Draw First 

1114# : Helplines Draw Last 

Z-Datum Reference 

A new option, [S5] Z-Datum, has been added to the Utility, Settings menu. You can enable this 

feature to set a Z offset to a relative zero height (a.k.a. Z-Datum Reference). For example, if the 

first floor of your building is at a real-world height of 212', you would set the Z-Datum value to 

212'. 

Subsequently, when you add a wall at Z-Base zero and Z-Height 8', DataCAD will 

automatically calculate the offset to position the wall at a real world Z-Base of 212' and a real 

world Z-Height of 220'. This makes it easier to model your project relative to the first floor, 

rather than having to calculate the offset yourself. 

Note: When this feature is enabled, the Coordinates/Hints Toolbar, Identify, and 3D Coordinate 

Identification indicate both the relative and world Z values. 

The following Z-Datum-related extended codes have been added: 

1117# : Z-Datum Reference On 

1118# : Z-Datum Reference Off 

1119# : Enter Z-Datum Reference point 

Drag-n-drop Layer Files 

In addition to the default action, replace current layer, you can now hold down the [Ctrl] key 

while dropping a layer to merge its contents with the current layer, or hold down the [Ctrl] + 

[Alt] keys while dropping a layer to create a new layer. 

1. A New Layer option has been added to the Layer, Import menu. 

2. Associative Dimension lines now support No. Divisions object snapping. 

3. The following extended codes have been added for Dimension Rounding: 

1115# : Dimension Rounding On 

1116# : Dimension Rounding Off 

4. [Ctrl] + [Enter] may now be used with DataCAD's input line. 

5. A new option, Create, has been added to the Identify, Set All menu. After you identify 

an entity and select Set All, you can then select Create which will take you to the 

identified entity's creation menu. 
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6. A new toggle option, Layer, has been added to the More... sub-menu of Change, Match. 

After you select Change, Match, toggle on Layer to apply the layer property of one 

entity to another. 

Note: The state of the Layer toggle when Change, Match, All is selected can be set by the key, 

Change Match All Includes Layer, in the [General] section of DCADWIN.ini. Set this key to TRUE 

if you want the entity's layer property to be included during Change, Match, All. The default value 

is FALSE. 

[General] 

Change Match All Includes Layer=FALSE 

7. The Reload option is now available in the Symbol Browser's context menu, for loaded 

symbols, when browsing by folder. 

8. Pressing and holding [Ctrl] + [Shift] and selecting the New Layer option in the Layer 

Manager will force the New Layer dialog to display at the center of the main display. 

9. MText can now be selected in Tangents. 

10. A new key, Entity Context Menu Obeys Layer Search, has been added to the [General] 

section of the DCADWIN.ini. If FALSE, the default, [Ctrl] + Right-clicking on an entity 

ignores the Layer Search toggle. If TRUE, the Layer Search toggle will apply to the 

Entity Context Menu. 

[General] 

Entity Context Menu Obeys Layer Search=FALSE 

  

Layout BETA 0.1.1.1 Enhancements 

1. Added support for Line Types and Line Weights. 

2. A checkbox option for 'Include Paper Space Entities' has been added to the DWG Import 

Entity Assignments Dialog. 

Note: This option is disabled when no paper space entities are detected. 

3. A new option, 'Paper Space,' has been added to the File drop-down menu. Selecting this 

option will launch Layout to display imported Paper Space sheets. 

Note: This option is disabled when no paper space entities are detected. 

4. A new option, 'Paper Space,' ('PaprSpac' for 8-character label) has been added to the 

Utility menu. Selecting this option will launch Layout to display imported Paper Space 

sheets. 

Note: This option is only displayed when paper space entities are detected. 
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5. The left and right mouse buttons can now be used to dynamically-pan the display in 

Layout. 

  

DCAL for DOS Enhancements 

PROCEDURE PlinVoidAdd(Parent, Void : In Out entity; DoDraw : boolean); 

BUILTIN 673; 

 

PROCEDURE PlinCovered(Plin : In Out entity; covered : boolean); BUILTIN 674; 

 

Enhancements to DCAL for C++ 

1. 'Hello World' example added to illustrate DataCAD's re-entrant state machine logic. 

2. 'Arrow' example updated for Visual Studio 2013. 

  

Fixes 

1. Entity validation now checks for zero-point Smart Entities. 

2. The View Layer function has been updated to display long layer names. 

3. A correction has been made to the function that calculates the extents of recalled GTVs. 

4. The .audit file can now be viewed while the Repaired drawing is still open. 

5. Filled polylines are no longer highlighted while their boundaries are being edited. 

6. A minor correction has been made to the Change, Text, Arrows, Color function to 

display the correct number of entities that were changed. 

7. A correction has been made to the Area selection box when in an elevation projection. 

8. Corrections have been made to Object Snapping for nested XREFs that have been 

mirrored and clipped. 

9. A correction has been made to address Symbol Browser "Loaded" indicators that were 

not displaying when they should. 

10. A correction has been made to address the width of MText boundaries that were 

importing at half of their original width. 

11. 3D Rotate was not being applied to the correct axis when a parallel clip cube was 

enabled. This has been corrected. 
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12. The Identify command has been changed to report the Area (one side) and Perimeter of 

flat (no height) Circles, and the Surface Area and Volume of Circles that have a non-zero 

height. 

13. A correction has been made to snapping to the center of Vertical Cylinders in Ortho 

(Plan) View. 

19.00.01 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. Two new options have been added to the GetSnap popup menu. 

Angle + Distance 

Gets the angle between two points, then adds (or subtracts negative value) the distance 

you specify. 

a. Click or snap to the first point. 

b. GetSnap to the relative point. 

c. Select Angle + Distance. 

d. Enter the distance beyond (or negative distance short of) the relative point. 

Midpoint 

Gets the midpoint between two points. 

a. Click or snap to the first point. 

b. GetSnap to the relative point. 

c. Select Midpoint. 

2. The maximum number of Fence points has been increased (from 36) to 256 in Stretch (2D 

and 3D). 
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DCAL for DOS Enhancements 

PROCEDURE do_Get_Active_SSet; BUILTIN 672; 

 

Fixes 

1. The Undo/Redo system would fail to resume after performing certain operations. So, the 

Undo/Redo shortcuts, [Ctrl] + Z, and [Ctrl] + Y would stop working. This has been 

corrected. 

2. An error that would cause the SketchUp export function to fail has been corrected. 

3. A correction has been made to the GetSnap routine so the '+ Distance' always returns the 

distance, (+ or -), relative to the direction of the point you are 'rubber banding' from. So, 

a negative distance will always be opposite the direction you are rubber banding 

toward. 

 

DataCAD 19 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 19, please click: 

What's New? from the Help pull-down menu in DataCAD. 

Fixes 

1. When the Toolbar Font was set to a size larger than 10 pts., the input field on the 

Message Toolbar would overlap the message text. This has been corrected. 

2. A correction has been made to the Get Snap, Get X or Y + Distance function while 

Tangents is active, and Direction Distance is the current input method. 

3. A crash that would occur when trying to display a perspective view of a model that 

included self-XREFs that contained Smart Entities has been corrected. 
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18.04.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Fixes 

1. A bug in the XREF extents procedure has been corrected. 

2. An error that would cause Get X + Distance and Get Y + Distance to return incorrect 

values while Tangents was active has been corrected. 

3. An error in the Drawing Repair routine related to deleting invalid entities in symbols 

has been corrected. Previously, choosing to delete invalid entities in symbols could 

corrupt the symbol definition if the first entity in the symbol was invalid, or if all the 

entities in the symbol were invalid. 

4. A bug which allowed the KnockOut property to be set on an XREF has been fixed. 

5. The checkbox for the Status Toolbar's Layer Search Button in the Customize Built-in 

Toolbars section of Program Preferences was not updating the corresponding key in 

DCADWIN.ini. This has been corrected. 

6. Changing from an imperial scale type (i.e., Architectural) to a metric scale type and then 

back to an imperial scale type can corrupt the rounding value used for dimensions when 

RoundIt is enabled. This has been corrected. 

7. The pull-down menu link to Toolbox, Configure now goes to the Macros Tab in Program 

Preferences instead of the Misc Tab. 

8. An error that would prevent you from being able to snap to the unclipped portion of an 

XREF, Self-XREF, or Symbol with 'Ignore Clip Cubes' enabled and partially contained 

within a Clip Cube has been corrected. 

9. The following DCADWIN.ini keys were not being read properly: 

[Undo] 

Disable During Import 
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[DXF_DWG] 

Adjust Text Sizing 

 

This has been corrected. 

10. The spacing of stacked fractions when using a TrueType Font has been corrected. 

 

DCAL for DOS Enhancements 

PROCEDURE PrintStr255(str : str255; Column, Row, Color, Curs : integer; 

Invert : boolean); BUILTIN 670; 

 

PROCEDURE GetSetLayerFilter(Filter : IN OUT str8; ReadOnly : boolean); 

BUILTIN 671; 

Fixes to DCAL 

A correction to the function Plot_Open10 for the NumCopies parameter. 

 

18.03.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

Update Installer Changes (ALL EDITIONS) 

1. The DataCAD updater will now determine if you have defined a custom path for your 

Message and Label files. After the custom path has been verified, the updater will make 

the necessary changes to the files in this location. If the custom path cannot be verified, 

the default path 'DataCAD 18\Support Files\Messages and Labels\' will be used 

instead. 

2. The DataCAD updater will now determine if you have customized the width of 

DataCAD's 'wide' menu button labels. If your existing DCADWIN.lbl and 

DCADWIN3.lbl files are configured with 'wide' labels that are greater than the default 

12 characters, new and changed lines will be formatted accordingly. 

https://www.datacad.com/products/DataCAD_Sub-01.html
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Program Preferences (ALL EDITIONS) 

Toolbars Tab 

A new Toolbars tab has been added to Program Preferences. Toolbar-related items which were 

previously on the Interface tab have been moved to the Toolbars tab. 

A new section, Customize Built-in Toolbars has been added. You can use the 'Select Toolbar to 

Customize' drop-down to choose the DataCAD toolbar you would like to modify. This applies 

to the Standard, Status, Types, Object Snap, Rendering, and Viewer toolbars. 

The Icon Toolbars section has been expanded to accommodate two additional user-definable 

toolbars. So, you can now have up to four user-definable toolbars displayed at once. 

A new Toolbar Settings section exposes the following options. 

Stretch When Docked 

Enabled by default, this option determines whether a docked toolbar will 'stretch' to fill the 

empty space that would otherwise occur between adjacent toolbars. 

Display Close Button 

Enabled by default, you can uncheck this option to hide the close button from docked toolbars. 

Lock Toolbars 

You can enable this option to lock the current arrangement of your docked toolbars. 

Disable Macro Hint Toolbar 

If you only want pause hints to appear at the message line, then you can check this option to 

prevent the hint toolbar from displaying. 

Note: A related enhancement to the behavior of the Macro Hint toolbar. The toolbar will no longer 

appear if the hint text is either '' (empty), or if it matches line 6288 of DCADWIN.MSG (NO COMMENT). 

Undocked Toolbars: Allow Resizing 

Check this option if you would like to resize undocked toolbars. 

Toolbar font 

The Toolbar Font section has been updated so you can now define the Font name, size, and style 

for text that appears on toolbars. This includes status bar drop-down lists, the SWOTHLUDFBK 

(Text), Coordinates / Hints, Message, and Attention toolbars. Formerly, the menu button font 

was applied to these toolbars. 

Interface Tab 

The following items have been added to Interface Tab 

File Dialog 

You can use the options in this section to customize DataCAD's File Dialog preview settings. 
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- Enable Preview on Close and Save to have DataCAD automatically create a bitmap preview of 

your drawing in its current state when you close and save the file. 

- Enable Preview on Forced Save if you want DataCAD to update the bitmap preview of your 

drawing in its current state each time you save your file. 

Note: The time to create the drawing preview will increase as the drawing becomes more complex. 

- Enable Show o2c Preview to see a 3D preview of files you select to open. 

Note: This option is available directly in the file dialog. 

However, if the 3D preview is problematic because of the complexity of the file(s), you can 

disable the option here instead. 

- Preview Image File Format 

Use this option to select the file format for the bitmap preview image which can be either BMP, 

JPG, TIF, TGA, PNG, or PCX. 

Plot Preview 

- Max. Bitmap Size (MB) sets the largest individual metafile size when generating the plot 

preview. 

- You can check Disable Spacebar to prevent this key from registering while the Plot Preview is 

being displayed. 

Symbol Browser 

- Max. Favorites sets the maximum number of favorites to display at once. 

- Check Sort Favorites to sort the list of favorites alpha-numerically. 

- Max. Recent sets the maximum number of recent folders to display at once. 

- Check Sort Recent to sort the list of recent folders alpha-numerically. 

- Max. Auto-divisions X sets the maximum number of horizontal divisions that are 

automatically created to display all the symbols in a given folder. 

- Max. Auto-divisions Y sets the maximum number of vertical divisions that are automatically 

created to display all the symbols in a given folder. 

- Check Resizable Folder Browser to allow resizing the Folder Browser dialog. 

Multi-view Windows 

- Increase or decrease the Scale Correction Percent value so Multi-view Window previews more 

accurately reflect the saved view. 
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Layer Manager List Font 

You can use this option to customize the font name and size used to display the list of layers. 

Note: Font style options such as bold and italic are not accessible since they are used by the Layer 

Manager to denote specific layer states. 

Symbol Attributes 

- Check First Row is Header if the first row in your CSV files that are linked to symbol attribute 

database lookups contains headings, not data. 

Menus Tab 

Scroll Forward / Backward 

- Check Hide Scroll Fwd / Back Buttons to remove the Scroll Back and Scroll Fwrd buttons from 

menus where they would otherwise appear. For example, in a drawing where there are more 

than 15 layers, a Scroll Fwrd button appears at [S7], while [S6] is reserved for Scroll Back. 

Hiding the Scroll Fwd / Back buttons frees up two positions in the menu list, as the scroll wheel 

and [PgUp]/[PgDn] keys can be used instead. 

A new option, Menu Button Height, has been added to the Menu Button Display Settings 

section. You can use this option to increase the height of the menu buttons in pixels. 

Drawing Tab 

Display Options 

- Check Extents Box During Pan/Zoom to display an extents box while you are panning or 

zooming instead of the line segments that make up the entities that are currently on screen. 

Hot Keys 

The 'Disable Hot Keys' section has been reworked for clarity. Disable Hot Keys has been 

renamed to Hot Keys since only the [Insert] and [w] keys can be completely disabled. By 

default, the Spacebar and numeric keys can be used to invoke distance input. Since the Spacebar 

cannot be disabled, this option has been renamed to '[0...9] Number Keys for Input'. When this 

option is unchecked, the number keys will not invoke distance input. 

The [ - ], [ , ], or [ . ] keys for input options can be checked so that these keys will invoke distance 

input instead of their default behaviors. 

XREFs 

- Check Dynamic Snapping to search for object snapping points within XREFs. 

- Check Refresh on Regen to automatically refresh displayed XREFs when the display is 

regenerated (i.e., when you press the [U] key). 

- When Update GoTo View Links is checked, XREFs that reside on locked layers may have their 

GTV Link updated. 
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- Check Automatically Convert to automatically convert DC5 files to AEC files when they are 

referenced in the drawing being opened. 

Mouse Panning and Zooming 

- Check Left & Right Mouse Buttons for Panning to enable panning while holding down the left 

and right mouse buttons. 

Miscellaneous Tab 

The checkboxes in the Print / Plot Options section have been replaced with groups of three 

radio buttons each. 

There are three possible states. 

1. Always, where all entities / attributes print, regardless of what is being displayed. 

2. Never, where none of the entities / attributes print, regardless of what is being displayed. 

3. As Displayed, where what is printed corresponds to what is being displayed (i.e., 

THLUDFBK). 

Line Feed Distance = Text Height 

The line feed distance for single line text and PText can now be based on the current text height 

rather than the current font definition. This applies to single line text entered through the Text 

menu, pasted from the clipboard, or inserted from a text file. 

When Single Line Text or PText are checked, a line spacing factor of 1.5 applied to a text height 

of 4 inches will always result in a line feed of 6 inches, regardless of the current font selected. 

Note: Line Feed = Text Height can be applied on a per PText entity basis. This setting is exposed in the 

PText Properties dialog and [Ctrl] + Right-click context menu for PText. 

Hatching 

Check Use Single Click to remove the Begin option and hatch entities as soon as you click on 

them. 

Program Preferences 

The following keys from DCADWIN.ini are now exposed in the Menus, (new) Toolbars, 

Interface, Drawing, and Miscellaneous tabs in Program Preferences. 
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Toolbars Tab 
[StatusArea] 

ButtonColors=TRUE 

ButtonDoorTypes=TRUE 

ButtonGotoViews=TRUE 

ButtonLayers=TRUE 

ButtonLineTypes=TRUE 

ButtonPlotterMenu=TRUE 

ButtonScales=TRUE 

ButtonSelSets=TRUE 

ButtonWallTypes=TRUE 

ButtonWindowTypes=TRUE 

DropDownColors=TRUE 

DropDownDoorTypes=TRUE 

DropDownGotoViews=TRUE 

DropDownInputModes=TRUE 

DropDownLayers=TRUE 

DropDownLineTypes=TRUE 

DropDownPlotScales=TRUE 

DropDownScales=TRUE 

DropDownSelSets=TRUE 

DropDownWallTypes=TRUE 

DropDownWidth=2 

DropDownWindowTypes=TRUE 

MaxColors=15 

MaxDoorTypes=15 

MaxGotoViews=15 

MaxLayers=15 

MaxLineTypes=15 

MaxScales=15 

MaxWallTypes=15 

MaxWindowTypes=15 

[Object Snap Toolbar] 

Layer Snap=TRUE 

End Point=TRUE 

Mid Point=TRUE 

Intersection=TRUE 

Center Point=TRUE 

Quadrant=TRUE 

Tangent=TRUE 

Number of Points=TRUE 

Perpendicular=TRUE 

Virtual=TRUE 

Search Hatch=TRUE 

Fast Symbol=TRUE 

Fast 3D=TRUE 

Selection Set=TRUE 

Miss Distance=TRUE 

Aperture On/Off=TRUE 

All Off=TRUE 
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[Rendering Toolbar] 

Edit Materials=TRUE 

Load Materials=TRUE 

Material By Color=TRUE 

Material By Layer=TRUE 

Object Viewer=TRUE 

Rendering Preferences=TRUE 

Sun Shader=TRUE 

Rendering Settings=TRUE 

[Viewer Toolbar] 

Refresh View=TRUE 

Object Viewer=TRUE 

Sun Shader=TRUE 

OpenGL Shader=TRUE 

Hidden Line Removal=TRUE 

Add GoTo View=TRUE 

Update GoTo View=TRUE 

New Clip Cube=TRUE 

Clip Cube On=TRUE 

Rotate +Y=TRUE 

Rotate -Y=TRUE 

Rotate +X=TRUE 

Rotate -X=TRUE 

Walk Forward=TRUE 

Walk Backward=TRUE 

Step Left=TRUE 

Step Right=TRUE 

Step Up=TRUE 

Step Down=TRUE 

Look Up=TRUE 

Look Down=TRUE 

Look Left=TRUE 

Look Right=TRUE 

[Toolbars] 

DockedCloseButton=TRUE 

FONTNAME=MS Sans Serif 

HideWhenInactive=TRUE 

Locked=0 

Point_size=10 

Stretched=TRUE 

Suppress Macro Hint Toolbar=FALSE 

Resizable=FALSE 

STYLE= 
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Interface Tab 
[File Dialog] 

Drawing Preview=TRUE 

Extension=PNG 

o2c Preview=TRUE 

Preview Forced Save=FALSE 

[Plot Preview] 

MaxBitmapMegaBytes=2 

No Spacebar=FALSE 

[SymbolBrowser] 

Max Favorites=10 

Max Recent=10 

MaxAutoDivisionsX=3 

MaxAutoDivisionsY=15 

Resizable Folder Browser=TRUE 

Sort Favorites=FALSE 

Sort Recent=FALSE 

 

[MultiView Windows] 

Scale Correction Percentage=100 

[Layer Manager] 

List Font Name=MS Sans Serif 

List Font Size=10 

[Symbol Attributes] 

Databases Have Header Row=FALSE 

 

Menus Tab 
[General] 

No Scroll Keys=FALSE 

[MenuBtn] 

BTN_HEIGHT=0 

Drawing Tab 
[Display List] 

UseBoxOnScroll=TRUE 

[XREFs] 

XREFs Auto-Refresh on Regen=FALSE 

Always Update GTV Links=FALSE 

Auto Convert=FALSE 

Dynamic Snapping=TRUE 

[General] 

Left+Right Mouse Button Panning=TRUE 

Misc. Tab 
[Single Line Text] 

Line Feed Distance Equals Text Height=FALSE 
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[Paragraph Text] 

Line Feed Distance Equals Text Height=FALSE 

[HatchPatterns] 

SingleClick=TRUE 

 

1. A new Object Snap toolbar has been added to DataCAD to provide persistent access to 

the current object snap settings. This toolbar may be turned on or off via the View, 

Toolbars pull-down menu. 

2. A new Icon-based SWOTHLUDFBK toolbar has been added to DataCAD. The size of the 

letter icons is determined by the Icon 

Size setting which is in the Icon Toolbars section of the Interface tab in Program 

Preferences. You can customize the icons displayed on this toolbar by changing the 

corresponding bitmaps in the Toolbars folder. 

Letter_S.png, Letter_W.png, Letter_O.png, Letter_T.png, Letter_H.png, Letter_L.png, 

Letter_U.png, Letter_D.png, Letter_F.png, Letter_B.png, and Letter_K.png. 

Note: Use External Toolbar Icons must be enabled if you want DataCAD to give preference to 

bitmaps located in the Toolbars folder. 

3. The current ClipCube Base/Height is now displayed when the drawing's ClipCube is 

enabled. 

 

Fixes 

1. A correction has been made to the partial erase command to address a crash that could 

occur when you tried to erase a portion of an arc that had been previously offset, and the 

result would create two new arcs. 

2. The font drop-down list located in the Font Dialog has been updated to work with the 

list item settings that were added to DataCAD 18.02.00. 

3. The Program Preferences dialog has been updated to track changes that require a 

program restart to take effect, then issue a single message after you select OK or Apply. 

Changes to the following settings will not take effect until you restart DataCAD. 

- Icon Size 

- Use External Toolbar Icons 

- Resizable Toolbars 

- Stretch Toolbars 

- Display Close Button on Toolbars 

- Lock Toolbars 
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- Toolbar Font 

- Undocked Toolbars Hide when DataCAD is inactive 

- Disable Macro Hint Toolbar 

- Center Dialog Boxes 

- List Item Height Adjustment 

- Symbol Browser Docked Width 

- Layer Manager List Font 

4. A correction has been made to the Reload Symbol function. 

5. The Symbol Browser was not updating properly when browsing an empty folder. This 

has been corrected. 

6. When performing a Save As on a Symbol, the name was always written using uppercase 

characters. The case will now match what you type. 

7. The Nested XREF Orphan warning would occur for each instance of the same orphan. 

This has been corrected so that only one warning will be issued per orphan, not per 

instance. 

8. The Nested XREF Orphan warning is now automatically disabled during batch plotting. 

Note: The Nested XREF Orphan warning can be disabled by setting the key, Warn On Nested 

Orphans, to FALSE in the [XREFS] section of DCADWIN.ini. 

9. The Identify command was not indicating enlargement values that were negative. This 

has been corrected. 

10. The Drawing Sessions path will now be updated correctly from either the Misc. or 

Pathnames tab. 

11. The bounding box width of MText and PText was not being exported to DXF/DWG 

correctly. This has been fixed. 

 

18.02.01 

Fixes 

1. An error that would cause the 2D Flatten routine to corrupt the height parameter of 3D 

Slabs has been corrected. 

2. An error in the update installer logic was causing the following keys in DCADWIN.ini 

to always get set to TRUE. This error would only occur if the update installer were run 

more than once. This has been corrected. 
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[MenuBtn] 

ShortLabels=FALSE 

SuppressLabels=FALSE 

[Screen Calibration] 

Calibrated=TRUE 

[Toolbars] 

HideWhenInactive=TRUE 

 

18.02.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

AEC File Repair 

A new 'Repair' option has been added to the 'idle' (no drawings open) File menu. When you 

open a file using this option, you will be presented with a dialog that includes the following 

options. 

Drawing Database Tests 

- Invalid Entities in Drawing 

- Invalid Entities in Symbols 

- Duplicate Polyline Vertices 

- Extraordinary Values 

Additional Options 

- Flatten 2D Entities 

- Toggle off SWOTHLUDFBK 

- Regen Screen on Load 

The default drawing database tests, Invalid Entities in Drawing and Invalid Entities in Symbols, 

compares specific entity variables to 'absolute zero' (defined as 1.0E-12). When these variables, 

such as the radius of a circle, are so tiny (between 0 and 0.000000000001 32nd of an inch), they 

can prevent you from editing them, or cause DataCAD to crash. These 'garbage' entities are 

identified and can be deleted from the drawing database by the repair option. 

The Duplicate Polyline Vertices option is self-explanatory and will automatically look for and 

remove duplicate polyline nodes. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com


DataCAD 18 | 95 

18.02.00 

The Extraordinary Values option will display a 'Z-Min/Max' dialog that will reveal Z values that 

are larger than 10,000,000 32nds of an inch (by default). So, if any of your entities contain Z 

values less than -26,041.67 feet or greater than 26,041.67 feet, they will be shown. You can edit 

the variables for each entity manually, or you can 'flatten' them one by one, or all at once. You 

can change the minimum and maximum values then 'Rescan' to see if any Z values fall outside 

of the range you specify. 

The Flatten 2D Entities option allows you to set all 2D entities' z-base/height values to zero. This 

includes 2D entities found in symbols. 

The Toggle off SWOTHLUDFBK option is useful when a corrupt line type or hatch pattern is 

prevention you from opening your drawing. Disabling the display of hatch patterns and line 

types may allow you to open the drawing so you can reload the offending definition. 

The Regen Screen on Load option can be toggled off if regenerating the display of your drawing 

is causing DataCAD to crash after it is loaded. 

A '.Audit' text file with the same name as your drawing is automatically created and contains a 

report of your drawing's history and what type of entities were deleted. 

Program Preferences Dialog (ALL EDITIONS) 

The Program Preferences dialog has been expanded and reorganized to provide easier access to 

DataCAD's menu, interface, drawing, and program settings. 

The Interface tab has been renamed to Menus. The options provided on this tab affect the 

display and behavior of DataCAD's menu buttons. A new Interface tab includes options for 

customizing toolbars and dialog boxes. A new Drawing tab includes options for customizing 

the drawing area and the behavior of the drawing cursor. Many of the options that were 

previously on the Miscellaneous tab have been moved to the Menus, Interface, or Drawing tab 

and several new options have been added. 

The following keys from DCADWIN.ini are now exposed in the Menus, Interface, Drawing, and 

Miscellaneous tabs in Program Preferences. 

Menus Tab 
[MenuBtn] 

SuppressLabels=False 

BTN_SPACING=1 

BTN_WIDTH=0 

[General] 

New 3D Menus=False 

MultiRemembersStatus=True 

 

Interface Tab 
[KeyFile] 

Use External Icons=False 
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[Toolbars] 

Point_size=10 

[StatusArea] 

DropDownWidth=0 

[Alias] 

Popup Lines=4 

Popup Width=300 

[Hatch/Linetype Preview] 

Size=100 

[Standard Toolbar] 

STD_NewFile=True 

STD_OpenFile=True 

STD_Save=True 

STD_Print=True 

STD_SpellCheck=True 

STD_ClipboardSelect=True 

STD_Cut=True 

STD_Copy=True 

STD_Paste=True 

STD_Redo=True 

STD_Undo=True 

STD_InsertXREF=True 

STD_InsertBMP=True 

STD_Hyperlink=True); 

STD_Order=True 

STD_Help=True 

Standard= 

[Dialogs] 

Item List Height Adjustment=0 

[General] 

CenterDialogBoxes=False 

[SymbolBrowser] 

DockWidth=0 

Drawing Tab 
[General] 

Insert Key Disabled=False 

MinusKeyTogglesOvershoot=True 

CommaKeyErasesLastEntity=True 

PeriodKeyRestoresLastEntity=True 

Disable Line Weight Hot Key=False 

Spacebar For Distance Input=False 

Reverse Scroll Wheel Zoom=False 

Automatic Crossing Selection=False 

Show Hatch During Drag=False 

[DEBUG] 

Draw Text Insertion Point=False 
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Miscellaneous Tab 
[General] 

Prevent Windows Screen Saver=False 

Prevent Windows Sleep=False 

No Timer Pause=False 

1LineTrim By Entity=True 

Copy Keeps Groups=False 

CapsLock=False 

AllCaps Linked=False 

[Printer] 

Print Associative Dimensions=True 

Print Bitmaps=True 

Print Fills=True 

Print Hatch=True 

Print Knockouts=True 

Print Line Types=True 

Print Line Weight=True 

Print Smart Wall Fill=True 

Print Smart Wall Hatch=True 

Print Text=True 

[General] 

SaveAs Uses Current Drawing Folder=False 

Shift For Implied Match=False 

Shift For Implied Deselect=False 

 

1. The enhanced entity validation now applies to drawing data imported into DataCAD. A 

new key, Validate Entities On Import, has been added to the [DXF_DWG] section of 

DCADWIN.ini to enable or disable validation during import. The default is TRUE. 

2. Added a 'To Clipboard' option to the Measures menu with the following options: 

Drawing Text: Copies the 'To Drawing' text to the clipboard. 

Value: Copies the measured value to the clipboard for use in the keyboard input field. 

3. The selection routine in the Offset command has been enhanced to cycle through 

coincident entities. If you select the wrong entity, you can now right-click, then click the 

same spot to choose the next available coincident entity. 

4. External symbol files can now be audited by enabling the following key in the [DEBUG] 

section of DCADWIN.ini. 

[DEBUG] 

Audit Symbol Files=TRUE 

The default value is FALSE. This key should only be set to TRUE temporarily when you 

audit your symbol libraries, then set back to FALSE when you are finished. Leaving this 
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key set to TRUE will increase the time it takes to display symbols in the Symbol 

Browser. 

Setting this key to TRUE will cause DataCAD to scan Symbols for invalid geometry 

while browsing folders in the Symbol Browser. If an invalid entity is encountered, the 

entity is deleted from the symbol definition, the .DSF file is updated and a '.Audit' file is 

created with the symbol's name in the same folder. The number of updated .DSF files is 

reported on DataCAD's error line. 

5. An option to disable the undo system during DXF/DWG file import has been added to 

the DXF/DWG tab of Program Preferences. Disabling the undo system during import 

can greatly reduce the time required to convert the file. The default value is TRUE. 

[Undo] 

Disable During Import=TRUE 

This applies to the importation of DXF/DWG, SKP and STL files. 

Fixes 

1. If necessary, you will now be prompted to provide an administrator password during 

the Check for Update process. Previously, the Check for Update function would fail to 

launch the update installer if you did not have adequate permissions. 

2. To prevent overlapping when display scaling is greater than 100%, the height of list 

items in dialogs such as the Layer Manger and XREF Manager will now be adjusted 

automatically when the current display resolution does not equal 96 dpi. The following 

section and key have been added to DCADWIN.ini so this adjustment can be disabled if 

necessary. 

[Dialogs] 

Adjust Item List Height=TRUE 

Item List Height Adjustment=0 

Item List Height Adjustment can be used in conjunction with 'Adjust Item List 

Height=TRUE' to add (or subtract) additional pixels to the height of the items in the List 

Boxes within DataCAD's various dialogs. 

3. Attempting to change the Layout % while you were in Quick Layout would cause the 

drawing to crash. This has been corrected. 

4. A correction has been made to the number of arcs entry field for ellipse approximation. 

5. A correction has been made to the length calculation of associative dimensions where 

the dimension points are not aligned. 

6. A correction has been made to the GetSnap function. 
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7. An error in the ellipse snapping routine that could cause DataCAD to crash has been 

corrected. 

8. When setting the active selection set from the Status Panel, the tooltip was not getting 

updated to show the current selection set number. This has been corrected. 

9. In some cases, the increment value of scale-dependent dimensions was not calculated 

properly. This has been corrected. 

10. The undo system is now suspended while a Section is being created. Previously, 

overflow errors could occur during the calculation of complex sections. 

11. The Search and Replace dialog now remembers its width and height. 

12. Corrections have been made to the Defaults button actions in Program Preferences. 

13. DataCAD will now check to see if a form's saved position is located on an inactive 

display before displaying the dialog. If the form's previous position is located on an 

inactive display, DataCAD will display the dialog centered over its own program 

window. 

14. A correction has been made to prevent the Create New Layer(s) dialog from popping up 

behind the Layer Manager dialog. 

15. Each of the following symbols contained one invalid entity which has been deleted. 

\Drawing\EQUIPNUM.dsf (Invalid Line) 

\Electrical\Receptacle\1SPECREC.dsf (Invalid Line) 

\Living Room\2D Furniture\BILF5-1.dsf (Invalid Line) 

\Living Room\2D Furniture\BILF5-2.dsf (Invalid Line) 

\Living Room\2D Furniture\BILF5-3.dsf (Invalid Line) 

\Living Room\2D Furniture\BILF5-4.dsf (Invalid Line) 

\Plumbing\Commercial\BIPC1-18.dsf (Invalid Line) 

\Plumbing\Handicapped\BIPH1-1.dsf (Invalid Arc) 

\Plumbing\Handicapped\BIPH2-11.dsf (Invalid Line) 

\Plumbing\Handicapped\BIPH3-1.dsf (Invalid Arc) 

\Plumbing\Handicapped\BIPH3-13.dsf (Invalid Line) 

\Plumbing\Sinks\16X14WH.dsf (Invalid Line) 

\Site\2D Cars\BSCP1-1.dsf (Invalid Arc) 

\Site\2D Cars\BSCP2-1.dsf (Invalid Arc) 

\Site\2D Park Equipment\BSBN2-1.dsf (Invalid Line) 

\Site\2D Park Equipment\BSBN2-3.dsf (Invalid Line) 

\Site\2D Trees - Plan\BTRE6-1.dsf (Invalid Line) 

\Site\2D Trucks\BSTE2-16.dsf (Invalid Line) 
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DCAL for DOS Enhancements 

1. Added long layer name support to setlyrname() and lyr_find() functions. 

SunShader 2.1.0.7 Enhancements 

1. Display Results On Screen is now a global option. 

SunShader 2.1.0.7 Fixes 

1. The Default Location settings in SunShaderNX.ini, read from geodata.ini, were not 

recognized. This has been corrected. 

[DEFAULT LOCATION] 

COUNTRY= 

CITY= 

2. Corrections have been made to the Reload Messages function. 

[TRANSLATION] 

EXPOSE INTERNATIONALIZATION TOOLS=TRUE 

 

18.01.01 

Important information about DataCAD 18 and Windows 10 'November 

Update' 

Coincident with the November update of Windows 10 (OS Build: 10586, Version 1511), 

DataCAD users began reporting unexpected drawing closures when performing certain menu 

actions. In particular, the drawing would close when using the [F1] key to select On/Off from 

the Layer menu. However, selecting On/Off with the mouse would not cause the error. In other 

parts of the program such as the GoTo View menu, adding a view, then pressing [Enter] would 

also cause the drawing to close. 

DataCAD 18.01.01 addresses these problems and we highly-encourage you to update DataCAD 

to the latest version if you are running it on Windows 10. 

Note: To determine what version of Windows 10 you are running, type 'about your pc' in the Windows 

Search field. Select 'About your PC' under 'Best match' where you will find the Edition, Version, and OS 

Build you are currently running. 

Fixes 

1. Get (X,Y) + (X,Y) Distance would return an incorrect location if the Grid Origin was not at 

0,0. This has been corrected. 

2. The Pak-N-Go feature new includes the background bitmap defined in the Rendering 

Preferences and saved o2c Views. 



DataCAD 18 | 101 

18.01.00 

3. DataCAD file associations were not working when DataCAD was already running. So 

double-clicking on an AEC file would not cause the file to open. This problem only occurs in 

DataCAD 18.01.00 and has been corrected. 

4. Navigating by using the arrow keys or the scroll wheel while in Quick Layout would cause 

the drawing to 'drift' off the lower left corner of the drawing window. This has been 

corrected. 

 

18.01.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

Ellipse Creation Methods 

Two creation methods, Radius and Diameter, have been added to the Curves, Ellipse menu. 

Radius allows you to define an ellipse by entering its center, and one end point for the first, then 

second axis. The first two points entered determine the angle of the ellipse. 

Diameter allow you to define an ellipse by entering both end points of the first axis, and one 

end point of the second axis. The first two points entered determine the angle of the ellipse. 

A new option, Approximate, has been added to the Ellipse menu. When toggled on, DataCAD 

allows you to specify how many arcs per quadrant will be used to approximate the edge of the 

ellipse. This can be useful for specifying two or three radii for the construction of an elliptical 

arch. 

1. A new Plot Scale dropdown and Print/Plot menu icon can be displayed on the Status Panel. 

These elements are off by default. To display them, set DropDownPlotScales and 

ButtonPlotterMenu to TRUE in the [StatusArea] section of DCADWIN.ini. 

[StatusArea] 

DropDownPlotScales=TRUE 

ButtonPlotterMenu=TRUE 

2. A new 'Flatten' option has been added to the Symbol Browser's context menu. You can use 

this option to set the z-base/height of 2D entities in a symbol to zero. 

3. The following extended character codes have been added: 

 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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1105# : Dimension Auto Style "No Points" On 

1106# : Dimension Auto Style "No Points" Off 

1107# : Dimension Auto Style "Points Only" On 

1108# : Dimension Auto Style "Points Only" Off 

4. An Apply button has been added to the Program Preferences Dialog. 

DCAL for DOS Enhancements 

FUNCTION DataCAD_Version : real; BUILTIN 669; 

Fixes 

Note: Changes have been made to this version of DataCAD to address unforeseen compatibility problems 

with Windows 10 (OS Build: 10586, Version 1511), also known as the November 2015 update. 

1. A correction has been made to the new DimTxtPnt calculation that would cause a crash 

when the dynamic snap indicator encountered a manually placed dimension text entity. 

2. A correction has been made to the display of Smart Arrow Heads that were not parallel to 

their construction plane. 

3. A correction has been made for when the Yes/No keys are mapped to S1 and S0. 

4. Layer names were not being formatted correctly to reflect their status in the Layer Manager. 

This has been corrected so that On layer names are Bold, Off layer names are Regular, the 

Active layer name is Bold and Underlined, Locked On layers are Bold, Strikethrough, and 

Red, Locked Off layers are Regular and Strikethrough. 

5. Using the [Ctrl] + Right-click context menu to relocate dimension text that had been placed 

manually, does not work after using Dimension, Change, Text Position. 

6. The 'Color Menu Goes Directly To Dialog' feature now works in the Mask menu. 

7. The 'New DimTxtPnt Calculation' key is no longer used. Changes have been made to the 

calculations for the start point of dimension text that has been placed manually on 

dimensions that have Lock Size enabled. Previously when changing Plot Scale, the 

dimension text would improperly shift in some cases. 

8. A correction has been made to Dimension, Change, Text Position when called from a 

keyboard macro. It was previously turning LockSize off. 

9. When using the ClipCube icon from the Viewer Toolbar to create or toggle a ClipCube 

on/off, DataCAD would display 0.0 0.0 0.0 on the command line. This has been corrected. 
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DataCAD 18 New Features and Enhancements 

DataCAD 18 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 18, please click: 

What's New? from the Help pull-down menu in DataCAD. 
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DataCAD 17 

17.04.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

Symbol Attribute Enhancements 

Resolving Broken Links to Databases 

Starting with this version of DataCAD, a prompt will appear when the database associated with 

a symbol text attribute cannot be found. Previously, DataCAD would always ignore the error 

and allow you to enter the value manually, rather than select it from the database. You can still 

choose to ignore the error, but now you have the option to search for the file yourself to repair 

the link. 

If you can redefine the path to the file, you will then have the option to make the change 

permanent. Otherwise, DataCAD will again look to the original path for the database the next 

time you open the drawing. 

DataCAD will automatically search the following locations to find the database link before 

prompting you to locate the file yourself. 

·         The original path. 

·         The currently configured Databases path. 

·         The current drawing file path. 

Note: The "Pak-N-Go" command will now include any symbol attribute database linked files. After un-

packing the file, if the database file is not in the original path, DataCAD will automatically look in the 

current drawing folder, like the way XREFs are resolved if not found. 

Edit Attribute Menu 

A new menu item, Edit Attribute, has been added to the context menu for Symbol Attribute 

Text within the Symbol Editor. When you [Ctrl] + Right-click on an attribute text entity, you can 

select this menu item to display the Edit Symbol Attribute dialog. You can use the fields and 

options in this dialog to redefine the properties of text attributes contained within a symbol’s 

definition. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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Note: While you can define many text attributes within a given symbol, DataCAD will only recognize one 

database per symbol. So, all the text attributes within the same symbol must be linked to fields in the 

same database. 

Edit Attributes Menu 

A new menu item, Edit Attributes, has been added to the context menu for symbols. When you 

[Ctrl] + Right-click on a symbol that contains attribute text entities, you can select this menu 

item to display the Edit/Customize Symbol Attribute dialog. 

Note: For more information about using attributes, see “Using Text Attributes for Symbols” in Chapter 13 

of the DataCAD Reference Manual. 

1. A new key, 'SaveAs Uses Current Drawing Folder', has been added to the [General] 

section of DCADWIN.ini. When set to TRUE, DataCAD will set the path to the current 

drawing folder when you use the Save As... or Save As Copy... commands. 

2. New extended character codes have been added to set the state of the Highlight setting 

for Classic Walls. 

1101# : Highlight On 

1102# : Highlight Off 

3. Upon opening a drawing, DataCAD will issue an explicit warning to indicate the 

occurrence of orphaned, nested XREFs. Previously, the warning applied to both 

orphaned XREFs and nested XREFs. 

4. Selecting a Smart Arrow using Identify, Set All now toggles Smart Arrow on in Text, 

Arrows. 

5. Selecting an Associative Dimension using Identify now displays its length on the 

Coordinates/Hints toolbar. 

Note: This only applies to Associative Dimensions that have Lock Scale enabled. 

6. New extended character codes have been added to set the state of Multiple in certain 

editing commands. 

1103# : Copy Multiple On 

1104# : Copy Multiple Off 

Note: The key, MultiRemembersStatus must be set to TRUE in the [General] section of 

DCADWIN.ini. 

DCAL for DOS Enhancements 

1. A new key, Allow Smart Entity Retrieval, has been added to the [Old DCAL] section of 

DCADWIN.ini. When set to TRUE, legacy DCAL can be used to update header fields 
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and perform basic editing functions such as move, copy, rotate, enlarge, etc. on Smart 

Entities. 

 

Fixes 

1. Undo now restores the state of XREF Nesting along with the XREF entity itself. 

2. Entity Hyperlinks assigned to a URL were not functioning. This has been corrected. 

3. Assigning an Entity Hyperlink to a file type other than AEC would cause the drawing to 

close unexpectedly. This has been corrected. 

4. Defining a printer settings file using the 'Settings Auto Load' key in the '[Printer]' section 

of DCADWIN.ini would cause new drawings to crash upon creation. This has been 

corrected. 

5. The position of dimension text, that was manually placed with the Lock Size property 

enabled, was not updated properly when the plot scale was changed. This has been 

corrected. 

Note: This fix will not correct existing dimensions. To correct an existing dimension, use 

Dimension, Linear, Change, Text, Position to re-position the text. 

6. A correction has been made to 'flipping' symbols with SymScale enabled that also 

contain associative dimensions. 

7. The Batch Plot function would truncate GoTo View names that contained periods. For 

example, a GoTo View named 'Front Elevation.A2' would produce a PDF file named 

'Front Elevation.PDF'. This has been corrected. 

8. The updated DXF/DWG DLLs that were included with DataCAD 17.03.00 would fail 

during import if the DWG file contained empty ACIS objects. This has been corrected. 

9. Object snapping would ignore smart entities contained in XREFs when the Drawing 

ClipCube was enabled. This has been corrected. 

10. DataCAD will now look for the current drawing's Pen Table (.DPF) in the current 

drawing's folder when it is not found in either the stored path or the Pen Tables path. 

11. Using the scroll wheel or pressing [PgUp]/[PgDn] after using the Enter key to add an 

angular dimension while the text is 'on the cursor', would cause the text to 'jump' near 

0,0. This has been corrected. 
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17.03.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. New options, Line Type by Layer and Line Spacing by Layer have been added to the 

Layer Manager dialog. When enabled, DataCAD will set the current line type and/or 

spacing on a per layer basis. You can specify the line type and/or spacing for a given 

layer within the Layer Manager, however, DataCAD will always remember the last 

active line type and spacing you used for a given layer. 

2. New options, Line Type and Line Spacing have been added to the Move and Copy To 

Layer menus. You can toggle these options on to set the line type and/or spacing of the 

entities you are moving or copying to a given layer. 

When Line Type and/or Spacing by Layer are off, the default, enabling these options will 

cause DataCAD to prompt you to select the line type and/or spacing you wish to use. 

When Line Type and/or Spacing by Layer or on, enabling these options will cause 

DataCAD to automatically use the line type and/or spacing currently associated with the 

layer. 

3. The XClip, New Cube cursor now disables the crosshairs while you are creating the 

bounding area box. 

4. Added "Print Alias List" to the "Select Alias" dialog box. 

5. A new key, "No Scroll Keys", has been added to the [General] section of DCADWIN.ini. 

Setting this key to TRUE, removes the Scroll Back and Scroll Fwrd buttons from menus 

where they would otherwise appear. For example, in a drawing where there are more 

than 15 layers, a Scroll Fwrd button appears at [S7], while [S6] is reserved for Scroll 

Back. Setting No Scroll Keys=TRUE frees up two positions in the menu list, as the scroll 

wheel and [PgUp]/[PgDn] keys can be used instead. 

6. The View Layer File function has been enhanced to allow 255 (increased from 80) 

character file / path names. 

7. The 'Fix Text' toggle has been added to the Clipboard Paste menu when you are pasting 

text. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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DCAL for DOS Enhancements 

PROCEDURE Clear_Keys; BUILTIN 663; 

Clears the function keys with a forced repaint. 

PROCEDURE Set_Active_SSet (SSet : integer); BUILTIN 664; 

 

PROCEDURE Unset_Active_SSet (SSet : integer); BUILTIN 665; 

 

PROCEDURE Ent_SetLockSize (LockSize : boolean; Ent : IN OUT entity); BUILTIN 

666; 

 

FUNCTION Ent_IsLockSize (Ent : IN OUT entity) : boolean; BUILTIN 667; 

 

PROCEDURE GetDimTxtPnt (Ent : IN OUT entity; dmTxtPt : IN OUT point); BUILTIN 

668; 

Fixes 

1. A correction has been made to the Layer Manager related to scrolling through the list of 

layers using the arrow keys. 2. A correction has been made to Get Y + Distance in the 

GetSnap menu. 

2. Redefined XREFs now inherit the Ignore Clip Cube setting from the original. 

3. A correction has been made to the display of XClip boundaries applied to mirrored 

XREFs. 

4. Under certain conditions, hatch applied to smart walls with 'match wall angle' enabled 

would 'leak' outside of the wall cavity. This has been corrected. 

5. The Area / Crossing selection box would not display during Clipboard Select while in a 

perspective view. This has been corrected. 

6. Undo now restores the state of XREF GoTo View links along with the XREF entity itself. 

 

17.02.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

https://www.datacad.com/products/DataCAD_Sub-01.html
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Enhancements 

1. The Get Snap popup menu includes new items that will appear when the nearest entity 

includes the corresponding snapping points. This makes it easier to snap to explicit 

points along an entity, even when they are not visible within the current view (i.e. off 

screen). 

2. The new items are... 

Get Snap 

This is the title and does not perform any function. 

X, Y + X, Y Distance 

Allows you to snap to a point that is offset in the x and/or y direction. 

Nearest 

Same as Nearest snapping. 

Radius Point 

Allows you to snap to the radius point of Arcs, Circles, and Ellipses. 

Center of Extents 

Allows you to snap to the center of an entity's extents. 

Centroid 

Allows you to snap to the centroid of polylines and polygons. 

Quadrant 

Same as Quadrant snapping. 

Perpendicular 

Same as Perpendicular snapping. 

 

Tangent 

Same as Tangent snapping. 

3. The following key has been added to the [DXF_DWG] section of DCADWIN.ini to 

enable (the default) or disable the conversion of XREFs during DWG export. When the 

value is FALSE, DataCAD will include XREF instances in the drawing being exported 

but will not convert externally referenced files. 

[DXF_DWG] 

Process XREFs=TRUE 

This option may be useful when only the parent file has changed, and externally 

referenced files do not need to be re-converted. 
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4. The following key has been added to the [General] section of DCADWIN.ini to 

determine whether the Lock Size setting of nested symbols should be recognized or 

ignored. 

[General] 

Allow Scale Dependent Nested Symbols=FALSE 

The default value is FALSE. If set to TRUE, DataCAD will recognize the Lock Size 

setting of nested symbols. 

5. The following key has been added to the [General] section of DCADWIN.ini so you can 

enable significant digits in DataCAD's distance edit fields shown in dialogs. 

[General] 

Use Significant Digits In Dialogs=FALSE 

The default value is FALSE. Setting this key to TRUE will cause the Distance edit fields 

in dialogs to adhere to the SigDigit setting in the ScaleType menu. 

6. The following key has been added to the [General] section of DCADWIN.ini so you can 

prevent the Windows Screen Saver from running while DataCAD is running. 

[General] 

Prevent Windows Screen Saver=FALSE 

The default value is FALSE. Setting this key to TRUE will disable the Windows Screen 

Saver when DataCAD is running. 

7. The following key has been added to the [General] section of DCADWIN.ini so you can 

prevent Windows from going to sleep or hibernating while DataCAD is running. 

[General] 

Prevent Windows Sleep=FALSE 

The default value is FALSE. Setting this key to TRUE will disable Windows sleep and 

hibernate modes while DataCAD is running. 

8. Added "Enable XClips" and "Enable SClips" toggles to their respective entity context 

menus. 

 

Fixes 

1. 2D entities, contained within nested XREFs that were mirrored, and were also contained 

within a Self-XREF, were not transformed properly when bound to symbols. This has 

been corrected. 
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2. Attempting to load a Wall Type containing material assignments for the caps or cavities 

when those materials were not already loaded in the drawing would cause DataCAD to 

crash with an Internal Diagnostic fault. This has been corrected. 

3. The Sun Shader entity filter now applies to entities contained within Symbols, Smart 

Entities, and XREFs. The following key has been added to the [Sun Shader] section of 

DCADWIN.ini to control this behavior. The default value is TRUE. 

[Sun Shader] 

Apply Filters To Embedded Entities=TRUE 

4. Groups are now maintained no matter how they are selected. For example: Previously, 

moving a group to another layer using the Group selection method would not retain the 

grouping. Now the grouping is maintained. 

5. Under certain circumstances, printing a drawing using a Pen Table with Bitmaps and 

Fills set to 'In Order' would cause MText and PText entities to be duplicated multiple 

times. This has been corrected. 

6. The SketchUp translator would crash during export when encountering zero-length 

lines. This has been corrected. 

7. The SketchUp translator was not binding and exporting XREFs as symbols. This has 

been corrected. 

8. The SketchUp translator was not converting the height of covered polylines that were 

rotated off the ortho plane. This has been corrected. 

9. SPBFills are no longer grouped together when they are created in succession. This is 

consistent with creating hatch entities. 

10. The Save As Copy command was changing the name of Self-XREFs in the current 

drawing to the name of the copied drawing. This has been corrected. 

11. Minor corrections have been made to the 'Filters' section of the Rendering Settings 

dialog's Sun Shader tab. 

 

Enhancements to DCAL (DataCAD Applications Language): 

The following routines have been added to DCAL Since 16.03.00, but were not previously 

documented in the revision history. 

DCAL for DOS Enhancements 

PROCEDURE SetPenStyle (PenStyleName : string); BUILTIN 659; 

 

PROCEDURE SetPenSpacing (PenSpacing : IN real); BUILTIN 660; 
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PROCEDURE Ent_SetPenStyle (PenStyleName : string; Ent : IN OUT entity); 

BUILTIN 661; 

 

PROCEDURE Ent_SetPenSpacing (PenSpacing : IN real; Ent : IN OUT entity); 

BUILTIN 662; 

 

17.01.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

SketchUp 2015 Compatibility (ALL EDITIONS) 

Added support for importing and exporting SketchUp files (*.SKP) in SketchUp 2015 format. 

1. The "Pak-N-Go" command will now include any symbol attribute database linked files. 

After un-packing the file, if the linked file is not in the original path, DataCAD will 

automatically look in the current drawing folder, like the way XREFs are resolved if not 

found. 

2. [Ctrl] + [L] is the default for opening and closing that Layer Manager (customizable in 

dcadwin.mnu). This change only applies to the persistent Layer Manager. 

3. Added the ability to hyperlink to a specific GoTo View in another drawing file. Selecting 

the hyperlink will open the drawing and recall the GoTo View to the screen. 

To create a hyperlink to another drawing that recalls a specific GoTo View: 

- Open the drawing which contains the object that will have the hyperlink assignment. 

- [Ctrl] + Right-click the entity, select "File" from the context menu, and then choose 

"Add." 

- In the "New File link" box, click the "File" button to define the linked file. Click "OK" 

when finished. 

- In the "New View" box, click the drop-down menu and then choose from the list of 

available GoTo Views in the linked file. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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- Click "OK" on the "New View" box to accept the GoTo View assignment or click 

"Cancel" to assign just the file, but no specific GoTo View. 

When you access the hyperlink, DataCAD will open the file and recall the assigned 

GoTo View. If you chose "Cancel" on the "New View" box, DataCAD will open the file to 

the last saved view in that file. 

4. Added a pathname description and location for "User Interface Files (.GUI)" on the 

"Pathnames" tab of Tools/Program Preferences. This enables you to store the user 

interface files "dcadwindialogs.gui," "dcadwintoolbars.gui," and "objectviewer.gui" in a 

path that is different from other support files. 

The key, PATH_GUI_FILES, has been added to the [Paths] section of DCADWIN.ini to 

store the location of GUI files. 

[Paths] 

PATH_GUI_FILES=Support Files\ 

5. Added support for using the color index number followed by the "$" character in 

keyboard macros, enabling you to select a specific color in a keyboard macro sequence 

while the new option to launch the Color Palette dialog from the Color menu is enabled. 

6. The ability to select coincident entities when executing the Erase, Partial command has 

been improved. In cases where there are two entities that occupy the same coordinates, 

choose Erase, Partial and then left-click to select the entity. If it is the wrong entity, right-

click once, and then left-click again in the same place to select the other entity. You may 

now proceed with defining the segment to remove. 

7. Added a new button to the 3D Hide menu labeled "New+Only On." This button appears 

after the command is complete. Clicking this button results in DataCAD setting the new 

layer which contains the hidden line removal result as "Active Only," and switches to 

the Plan view, enabling you to quickly access the hidden line removal result. 

8. Added a new key to the [General] section of DCADWIN.ini so you can now display the 

Color Palette dialog in commands that would normally display the "Color" menu. Add 

(if absent) or modify (if present) the following key: 

[General] 

Color Menu Goes Directly To Dialog=FALSE 

When set to FALSE (default), there is no change to program behavior when clicking the 

"Color" menu button. 

When set to TRUE, clicking "Color" (for example in the Change menu) will automatically 

display the Color Palette dialog. Previously, it would display the "Color" menu. 
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You can temporarily suppress the Color Palette dialog by pressing the [Ctrl] key while 

clicking the "Color" menu button. This causes DataCAD to display the "Color" menu, 

instead of the Color Palette dialog, for this one operation. 

9. The "Edit Fields" dialog is now displayed after choosing "Save As" from the right-click 

menu of a symbol displayed in the Symbol Browser, or from the [Ctrl] + Right-click, 

Symbol Tools context menu of a symbol in the drawing area. 

10. Added the option "Save As Copy" to the "File" pull-down menu. This command will 

save the changes of the current drawing session to a new file with a new name. It differs 

from the "Save As" command in that it will then return to working in the current 

drawing, as opposed to then opening the new version of the file. 

For example, you are working in Drawing1.aec. You choose File, Save As Copy, and 

then save out Drawing1_OptionA.aec. When the process is complete, DataCAD returns 

you to editing Drawing1.aec. If you had selected File, Save As to save out 

Drawing1_OptionA.aec, DataCAD would have returned to editing 

Drawing1_OptionA.aec after completing the command. 

11. Added a new key to the [General] section of DCADWIN.ini so the 3D editing menu 

buttons will match the positions of the 2D editing menu buttons (when possible). 3D 

Move, 3D Copy, 3D Mirror, and 3D Stretch are the only menus affected. Add (if absent) 

or modify (if present) the following key: 

[General] 

New 3D Menus=FALSE 

When FALSE (default), there are no changes to the 3D editing menus. 

When TRUE, the position of the menu buttons in the 3D Move, 3D Copy, 3D Mirror, and 

3D Stretch menus match (as closely as possible) to the positions of the menu buttons in 

the 2D Move, 2D Copy, 2D Mirror, and 2D Stretch menus. 

2D Move and New 3D Move  ('Old' 3D Move) 

F8 New Distance   (And Copy) 

F9 Invert    (Z Distance) 

S1 To New Layer   (Invert) 

S2 And Copy    ( ) 

2D Copy and New 3D Copy  ('Old' 3D Copy) 

F8 New Distance   (Z Distance) 

F9 Invert    (New Distance) 

S1 To New Layer   ( ) 

2D Mirror and New 3D Mirror ('Old" 3D Mirror) 

F8 New Line    (And Copy) 
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2D Stretch and New 3D Stretch ('Old' 3D Stretch) 

F3 Area    (Fence) 

F4 Fence    (Layer Search) 

F6 Layer Search   (New Distance) 

F8 New Distance   ( ) 

12. The following keys have been added to the [o2cViewer] section of DCADWIN.ini so you 

can customize the default "None" material settings. These settings determine the 

rendered appearance of entities that do not already have a material assigned to them. 

[o2cViewer] 

MatNone Color Diffuse= 

MatNone Color Reflect= 

MatNone Reflection Ambient=50 

MatNone Reflection Diffuse=40 

MatNone Reflection Specular=10 

MatNone Opacity=100 

MatNone Refraction=10 

MatNone Highlight Size=2 

MatNone Self-Illuminate=FALSE 

MatNone Render Backface=TRUE 

MatNone Has Texture=FALSE 

MatNone Texture Scale=1 

MatNone Texture Name= 

MatNone Smooth Edges=TRUE 

MatNone Texture Mask=FALSE 

MatNone Texture Colorize=FALSE 

MatNone Texture Reflection=FALSE 

13. The following keys have been added to the [o2cViewer] section of DCADWIN.ini so you 

can 'force' certain material settings to apply to all entities, regardless of their currently 

defined material definition. For example, if you want all surfaces in your model to 

appear glossy, you might set MatFixed Specular to 70 instead of the default value of 10. 

Or, if you want everything in your model to appear transparent, you might set MatFixed 

Opacity to 30 instead of the default value of 100. 

Note: These settings only apply at the time you launch your model in the Object Viewer and have 

no effect upon the material definitions that are stored in the drawing. 
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[o2cViewer] 

MatFixed ClrDiff_Red= 

MatFixed ClrDiff_Green= 

MatFixed ClrDiff_Blue= 

MatFixed ClrRefl_Red= 

MatFixed ClrRefl_Green= 

MatFixed ClrRefl_Blue= 

MatFixed Reflection Ambient= 

MatFixed Reflection Diffuse= 

MatFixed Reflection Specular= 

MatFixed Highlight Size= 

MatFixed Opacity= 

MatFixed Refraction= 

MatFixed Flags= 

14. The following key has been added to the [o2cViewer] section of DCADWIN.ini to 

prevent DataCAD from 'flipping' an entity's default rendered color when it is the same 

as the background color. Typically, this would apply to a white background. In this case, 

DataCAD will XOR the white lines in your drawing to black so they will not 'disappear.' 

This causes white entities to render black in the Object Viewer. Setting Material XOR 

Background to FALSE, will cause white entities to render white, instead of black, when 

you have a white background. 

[o2cViewer] 

Material XOR Background=TRUE 

 

Fixes 

1. Corrected a bug that caused improper grouping of entities while using the Move/To 

Layer command. 

2. Fixed a bug that would cause DataCAD to fail when selecting smart doors and/or 

windows by Area in Plan view if the door or window type had a symbol assigned for 

the 3D representation, and if that 3D symbol had its layers configured to be viewed in 

3D view projections only. 

3. Corrected an error that would cause a failure to export to SketchUp (*.skp) format if the 

drawing file contained a line with unequal Z-Base and Z-Height, and zero length. 

4. Lines with visible text attributes (added through DCAL) were being drawn to the screen 

in the wrong color. This has been fixed. 

5. If an XREF contained a symbol, and the XREF was not inserted at Absolute Zero, you 

were unable to snap to the symbol's insertion point. This has been corrected. 
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6. Changing the width of a fixed-width Smart Door now updates all instances of that door 

immediately after clicking "OK" on the Door Type Manager. Previously, changes were 

not shown until after closing, saving, and then reopening the drawing file. 

7. Corrected an error that could cause attribute text, in a symbol that contains visible 

attributes, to be in the wrong location in an AutoCAD DWG file created by export from 

DataCAD. 

8. A correction has been made to angle value handling in the Entity Properties Editor. 

9. A correction has been made to knockouts applied to rotated text. 

10. When creating an XClip boundary using the polyline method, the previous segment 

would disappear when subsequent points were picked. This has been corrected. 

11. A correction has been made to intersection snapping. 

12. The Stretch, AndCopy command was not drawing and undrawing the affected lines 

correctly. This has been fixed. 

 

Sun Shader 02.01.00.01 Enhancements 

 

1. The width of the Saved Views drop-down is now defined by the length of the longest 

name. 

2. When using File/Save Image, the path, image resolution, and image type are now stored 

with the application, and remembered across sessions. 

3. Added a new option to the Sun Shader tab of the View/Rendering/Settings dialog, 

labeled "Smart Symbol Export." When "Auto Extract 2D" is checked, layers inside of 

symbols that are assigned to display in 2D view projections (i.e. plan) are included in the 

Sun Shader. When un-checked, the 2D are not included. When "Auto Extract 3D" is 

checked, layers inside of symbols that are assigned to display in 3D view projections (i.e. 

isometric or elevation) are included in the Sun Shader. When un-checked, the 3D are not 

included. 

4. Added the ability to reload the Sun Shader interface text without having to restart 

DataCAD. This option is helpful when translating the program interface into other 

languages. 

Modify the following key in SunShaderNX.ini, located in the C:\DataCAD 17\Sun 

Shader\NX\Support Files\ folder: 
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[TRANSLATION] 

EXPOSE INTERNATIONALIZATION TOOLS=FALSE 

When set to TRUE, a new "[Debug] - Internationalization Tools" pull-down menu is 

shown at the top of the Sun Shader interface. Click it and then choose "Reload messages" 

to reload the interface text. 

 

DCAL for DOS Enhancements 

FUNCTION Contour_Search (cursor : IN point; Boundary : IN OUT pntarr) : 

integer; BUILTIN 657; 

 

FUNCTION Contour_Offset (cursor : IN point; Offset_Dis : IN real; color : IN 

integer; pln : IN OUT entity) : boolean; BUILTIN 658; 

 

DataCAD 17 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 17, please click: 

What's New? from the Help pull-down menu in DataCAD. 
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DataCAD 16 

16.04.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. Double-clicking on a DataCAD symbol file (*.dsf file extension) in Windows Explorer 

now opens the selected symbol in the Symbol Editor. 

Note: DataCAD must be already running, with a drawing file opened. 

2. Added Drag-n-drop support for opening a symbol in the Symbol Editor. With a drawing 

file opened, click, and drag the symbol file from Windows Explorer into the drawing 

area. Press and hold the [Ctrl] key and then release the mouse button. Release the [Ctrl] 

key when finished. This action will open the symbol in the Symbol Editor. 

 

Fixes 

1. If you have renamed any of the first fifteen colors in your color palette, picking Mask, 

Color, and then selecting the renamed color now results in DataCAD displaying the 

correct color name on the "Attention" toolbar. 

2. Fixed a bug that could cause DataCAD to stop responding after recalculating the 

drawing extents with display of associative dimensions turned off. 

3. Repaired the ability to use coordinate input, while in Direction/Distance mode, to place 

an associative dimension. 

4. Selecting the command to exit DataCAD, and then clicking "Cancel" would result in the 

license ID number being set to zero. This has been corrected. 

5. Scrolling the wheel on the mouse while DataCAD is drawing the information on a 

Multi-Layout sheet to the screen no longer results in DataCAD restoring the drawing 

area view after the process is complete. 

6. The Sun Shader initial view has been corrected. In some cases, the initial view would be 

incorrect until after you clicked on one of the preset views. 

https://www.datacad.com/products/DataCAD_Sub-01.html
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DCAL for DOS Enhancements 

PROCEDURE GetLicenseID (LiceseID : IN OUT string); BUILTIN 655; 

 

PROCEDURE SortLayersByName; BUILTIN 656; 

 

16.03.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. Added a new sub-menu labeled "Clean/Cap" to the Architect/Edit Walls menu (with 

Auto3D on). It provides the ability to change the status of Clean, Cap and Trim In/Out 

for smart wall nodes using Entity, Group, Area, Fence, Selection Set or Select All. 

Toggle "Cap" on to turn wall cap on or toggle it off to turn wall cap off. Toggle "Clean" 

on to enable automatic intersection cleaning or toggle it off to disable automatic 

intersection cleaning. The "Trim Out" and "Trim In" sub-options control whether wall 

lines are trimmed at the intersections of their interior or exterior lines. 

When you select walls to change by Entity, Group, Selection Set or Select All both nodes 

are changed for each selected wall. If you select by Area or Fence, only the wall nodes 

that are enclosed within the selection rectangle or polygon will be selected. 

2. Added a "Color=" readout to the "Attention" toolbar while in the 

Dimension/Linear/Arrow Style menu that shows the current value of the dimension 

arrow/tick mark color setting. 

3. Added a new key to the [XREFs] section of DCADWIN.ini: 

[XREFs] 

Always Update GTV Links=FALSE 

When absent or FALSE (default) nothing is changed; XREFs that reside on locked layers 

cannot have their GTV Link updated. When TRUE, XREFs that reside on locked layers 

may have their GTV Link updated. 

4. Added a new key to the [General] section of DCADWIN.ini: 

https://www.datacad.com/products/DataCAD_Sub-01.html
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[General] 

No Text Scale=FALSE 

When absent or FALSE (default), the Text Scale button is available in the Text and 

Dimension/Linear/Text Style menus. When TRUE, The Text Scale button is absent from 

both menus, and the function is disabled. 

5. Added a new key to the [General] section of DCADWIN.ini: 

[General] 

GTV Remembers Tangents=TRUE 

When absent or TRUE (default), GoTo Views store the status and angle of Tangents and 

the value of Tan Div from the Geometry/Tangents menu and recall them as GoTo Views 

are restored (added in 16.00.00). Setting this key to FALSE will omit all Tangents related 

settings from the parameters stored and recalled by GoTo Views. 

6. Added support for using "2 Points" in the Geometry/Tangents menu while in a parallel 

3D view. 

7. Previously, if a drawing contained more than 10 GoTo Views, and you accessed the 

second page of the list, chose Move View, picked a view to move, and then picked the 

view to move it in front of, DataCAD would revert to the first page of views when 

finished. Now, DataCAD remains on the page you were on when you began the process 

of moving the view. 

8. Added the ability to define a specific color for the pocket of smart pocket doors. In the 

Door Type Manager, load a pocket door and then go to the "Swing" tab. Un-check 

"Match Door Color," and then use the "Color" drop-down field to define the color of the 

door pocket. Previously, the pocket matched the jamb color, as defined on the "Jambs" 

tab. 

 

Fixes 

1. Corrected an erroneous "This layer is locked" message, that would sometimes appear on 

the "Attention" toolbar after pressing the [u] key on the keyboard to update display list, 

when the layer was not actually locked. 

2. Fixed an error that could cause MText in a DXF or DWG file exported from DataCAD to 

display with incorrect line wrap parameters in AutoCAD. 

3. When "Dimensions" is toggled off in the Utility/Display menu, and associative 

dimensions are suppressed from display, you can no longer select them using Area 

selection. Previously, if the dimensions fell within the selection rectangle, they would be 

selected even though they were not displayed. 



124 | DataCAD 16 

16.03.00 

4. Using the Move/To Front or Move/To Back command no longer groups the selected 

entities with other entities drawn after or before them. Previously, Move/To Front would 

group the selected entities with entities drawn after them, and Move/To Back would 

group them with entities drawn before them. 

Note: If the selected entities were previously part of a group, that group association will be lost 

after using Move/To Front or Move/To Back. 

5. Using "Add Current Folder to Favorites" in the folder icon drop-down menu at the top 

of the Symbol Browser, with "Sort Favorites=TRUE" in the [SymbolBrowser] section of 

DCADWIN.ini, no longer results in DataCAD overwriting the previously selected 

favorite folder name. New folders are now appended to the list. 

6. Repaired an issue that could cause the KnockOut border on associative dimension text 

to be displayed, even if it is turned off, if the drawing area background is set to white. 

7. Corrected an error that could prevent successful export to DWG format if the file 

contained polylines which have duplicate vertices. 

8. The "Layer Search" button would be added at the [F6] menu position in the 

Measures/Area Perim menu, with Cont Search on, after clicking inside of a boundary. As 

a result, it would overwrite the "To Drawing" button. To prevent this, the Layer Search 

button has been moved to the [F5] menu position, in this menu only. 

9. Using the [Ctrl] + Right-click/Relocate option on an associative dimension which had 

"Lock Size" enabled would cause the dimension to be placed incorrectly. This has been 

fixed. 

10. Fixed a crash that could occur while exporting a file which contains smart pocket doors 

to DWG format. 

11. Repaired the ability to select 64ths, 128ths, or 256ths in the Change/Dimensions/Lock 

Scale menu when Inch/Frac is on. 

12. If Dynamic Snapping Hint and/or Indicator were enabled, and all settings were toggled 

off in the Utility/Object Snap menu, the message "No Object Snap settings currently in 

effect" was permanently displayed on the "Attention" toolbar, overwriting other 

messages. This has been corrected. 

 

DCAL for DOS Enhancements 

PROCEDURE ExportAutoCADFile (acadfname: string; vernum, lyrmodenum: aSInt); 

BUILTIN 652; 

Where: 
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acadfname is the fully qualified name of the DWG file to create. 

vernum is the DWG version to create (18=AC2004, 21=AC2007, etc.). 

lyrmodenum should be passed as either Lyr_On or Lyr_All. 

FUNCTION LoadLinetype (name : string) : integer; BUILTIN 653; 

 

PROCEDURE do_ChangePlotScale (NewScale : integer); BUILTIN 654; 

 

16.02.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. A new option labeled "Edit Contents" has been added to the [Ctrl] + Right-click context 

menu for single-line text, MText, and PText. Picking this option executes the 

Change/Text/Contents command for the selected text entity. 

2. Added the ability to mask by Hatch Pattern when selecting entities to modify. In the 

selection menu, choose "Mask" and then toggle [F6] Pattern on. Select the pattern to 

mask, right-click, and then select the objects to modify by Entity, Group, Area, Fence, or 

press [Ctrl] + [a] for Select All. 

3. There is a new key in the [General] section of DCADWIN.ini: 

[General] 

Close Symbol Editor Windows First=FALSE 

When absent or set to TRUE, if a drawing file and a Symbol Editor window are open 

and the drawing is the active window, selecting File/Close All/Yes to All will result in 

DataCAD automatically switching to the Symbol Editor window to close it first. When 

set to FALSE, the windows will close in the current order, which may result in the "Save 

As" dialog being displayed for the Symbol Editor window, because the drawing from 

which the symbol originated has already been closed. 

4. Added support for the "Lock Size" property on nested-level symbols, independent of the 

status of this setting on the top-level symbol in which the nested symbols are inserted. 

To enable this feature, add (if absent) or modify (if present) the following key in the 

[General] section of DCADWIN.ini: 

[General] 

Allow Scale Dependent Nested Symbols=TRUE 

https://www.datacad.com/products/DataCAD_Sub-01.html
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When FALSE or absent, DataCAD continues to function as it did previously; Lock Size is 

not supported on nested level symbols. 

5. Added a "Purge Unused" button to the "Edit Materials" dialog. This button will purge 

the definitions of materials assigned to the following: Empty layers; Colors, when the 

drawing is set to render "By Layer"; Colors which have not been used to draw any 

entities in the drawing; Symbols loaded in the drawing file header, but not used in the 

drawing. 

6. Added the ability to remove individual material definitions while simultaneously 

removing the assignment of the selected material from any entities, layers, or colors to 

which it was previously assigned. After opening the "Edit Materials" dialog from the 

View/Rendering pull-down menu, highlight the name of the material you wish to 

unassign and purge from the file, and then click the "Unload" button. DataCAD will 

remove all assignments of this material and purge it from the drawing. 

7. Added a "Reload" button to the "Edit Materials" dialog. Clicking this button reloads the 

currently selected material definition from the hard drive. It is only available when the 

material definition has already been loaded. 

 

Fixes 

1. Repaired the ability to use Undo after performing a 1-Line Trim by Entity. 

2. DataCAD adds associative dimension prefix and/or suffix text when you press [Ctrl] + 

[Enter] on the text entry dialog after using the Entity Properties Editor to change the 

value. Previously, the change was not applied. 

3. Using a custom keyboard macro to refresh all XREFs could sometimes result in a 

program freeze. This has been corrected. 

4. When [Alt] + [r] is configured to refresh all XREFs and the command is executed, the 

correct message is now displayed on the "Attention" toolbar. 

5. Using the DCADWIN.ini keys "Sort Favorites=TRUE" and/or "Sort Recent=TRUE" in the 

[SymbolBrowser] section no longer result in duplicates of the favorite and recent folders. 

6. Clicking the "Context" button (which appears on the "Context" toolbar when you are in a 

menu which has no context toolbar assigned) to configure the context toolbar, and then 

clicking "OK" or "Cancel" to dismiss it, no longer disables the ability to use keyboard 

shortcuts. 

7. Corrected an error which could cause DataCAD to crash when selecting "Undo" after 

choosing a GoTo View. 
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8. Fixed an error which could cause XClip boundaries to change inadvertently after using 

the Print/Plot menu. 

9. Corrected an issue that could cause DataCAD to fail to draw Smart Walls after recalling 

a saved GoTo View. 

10. Repaired the ability to object snap to symbols in the Symbol Browser, enabling you to 

pick them by points other than the defined insertion point, when "Inference Snapping" is 

enabled on the "Interface" tab under Tools/Program Preferences. Previously, DataCAD 

would pick the symbol by the insertion point the first time, and only snap to the selected 

point the second time. 

 

16.01.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

Enhancements 

1. Added a new option labeled "Inference Snapping," located in the "Dynamic Snapping" 

section of the "Interface" tab under Tools/Program Preferences. Either the dynamic 

snapping "Hint" or "Indicator" must be enabled to use this feature. 

When this option is enabled, you can use the left mouse button to object snap to an 

entity that is within the current object snap miss distance. If no entity is found within the 

miss distance, then DataCAD will simply begin drawing a line. 

Pressing the [Shift] key on the keyboard while simultaneously clicking the left mouse 

button will temporarily disable inference snapping for that click only. DataCAD will 

interpret this as a standard left-click. 

The middle mouse button will summon the "Get Snap" popup menu. Previously, you 

would execute Get Snap by pressing [Shift] + [Middle-click]. In addition, you can use the 

middle mouse button to Object Snap while holding down the [Shift] key to disable 

Inference Snapping. 

[Shift] + [Right-click] will be registered as a double-click to summon the Properties 

Editor, Reference File Manager and/or the Symbol Editor, depending upon your 

"Double-Click" settings on the "Misc" tab under Tools/Program Preferences. 

https://www.datacad.com/products/DataCAD_Sub-01.html
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2. Added "Dist / 2" and "Dist * 2" options to Geometry/Offset. 

3. Added a "Z Offset" option to the Geometry/Offset menu. 

4. The "Entity Properties Editor" for symbols and XREFs, accessed via the [Ctrl] + Right-

click context menu, now displays the "Line Spacing Factor." This value is the line 

spacing factor/enlargement. It is also shown in the [Ctrl] + Right-click/Identify context 

menu, and in the list of information returned by the Identify command. 

5. When using "Dynamic" in the Geometry/Offset menu to offset a line, DataCAD now 

displays a rubber-band line to indicate the direction of the offset. This can be helpful, as 

it shows the direction of the cursor when using Direction/Distance input mode and then 

offsetting by a specific distance using keyboard coordinate input. 

6. When "Keep Layer Manager Open" is checked on the Layer Manager, it will now remain 

on-screen throughout an editing session, even if all drawings are closed. 

7. Added "Factor" to the Change/Text menu. This option enables you to change the line 

spacing factor (the vertical space between individual lines of text) inside of PText and 

MText entities. Single-line text is not supported. 

8. Added an option to "Open this symbol's folder in Windows Explorer," under the [Ctrl] + 

Right-click/Symbol Tools context menu for symbols in the drawing area, and the [Right-

click] context menu for symbols in the Symbol Browser. Selecting this option will open 

the folder in which the symbol is saved using Windows Explorer. 

9. New extended character codes (V= in toolbar button, A= 10XX# in toolbar sequence, or 

10XX# in keyboard macro): 

1096# : PText/MText Boundary On 

1097# : PText/MText Boundary Off 

1098# : Purge Unused Symbols 

1099# : Reload All Symbols 

10. XREFs on locked layers can now be refreshed (but not reloaded). 

11. Added a button labeled "Reassociate" to the "Architect" menu (when "Auto 3D" is 

enabled). Use this command to re-associate Smart Doors and Smart Windows with 

Smart Walls. Click "Reassociate," choose the Smart Wall, and then pick the Smart Door 

or Window to associate with it. 

12. Added support for Underline and Overline properties on Symbol Attribute Text. The 

Underline and Overline are variable length and match the length of the value text 

entered. DataCAD can object snap to the underline and overline as well. 
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13. When "Draw Text Insertion Point=TRUE" in the [Debug] section of DCADWIN.ini, 

DataCAD will display the text insertion point on the screen but will not print it. 

14. There are two new keys in the configuration settings file that can automatically 

alphabetize the "Recent Folders" and "Favorite Folders" lists in the Folder drop-down 

menu on the Symbol Browser. 

Add (if absent) or modify (if present) the following keys to the [SymbolBrowser] section 

DCADWIN.ini: 

[SymbolBrowser] 

Sort Recent=FALSE 

Sort Favorites=FALSE 

Set either key to TRUE to have the list sorted alphanumerically. 

 

Fixes 

1. Using the "Bind to symbol" command on a self-XREF in a drawing that contained other 

XREFs would result in the XREFs becoming orphans. This has been fixed. 

2. Fixed an issue that would cause DataCAD to set text height to zero when selecting a text 

style which had "Text Scale" on. 

3. When you insert a symbol with Explode toggled on, and an enlargement factor set to 

anything other than 1, DataCAD now assigns the correct line spacing factor to the 

entities. Previously, the line factor setting was double the value it should be. 

4. The Entity Properties Editor for 3D quadric entities (spheres, cones, tori, cylinders, and 

3D arcs) now shows the correct rotation and enlargement values when the object is 

created in a view other than plan. 

5. Selecting "Undo" immediately after creating a PText or MText entity no longer requires a 

screen regeneration to remove the entity from the display. 

6. Right-clicking to return to the PText or MText menu after entering the Alignment sub-

menu now correctly updates the menu title. Previously, it failed to update and kept the 

title "Alignment." 

7. Splines within XREFs or self-XREFs that had a Pen Style assigned failed to display 

correctly. This has been fixed. 

8. When using [Shift] + [_] to enter a negative overshoot value, DataCAD no longer 

converts it to a positive value. 
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9. Renaming a layer that has a long name, in a file that contains a self-XREF, to a layer that 

has a short name no longer results in DataCAD turning off the layer in the self-XREF. 

10. The "Show Fill" setting in the "Smart Wall Hatch/Fill" section of the Reference File 

Manager no longer affects Smart Walls that are native to the drawing. 

11. Choosing "Scale Type" from the "Area Perim" sub-menu of the Utility/Measures menu 

while "Cont Search" or "Rectangle" was toggled on would result in DataCAD displaying 

the "Voids" menu instead. This has been corrected. 

12. Corrected a bug that would cause DataCAD to change the name displayed in the "GoTo 

View" drop-down menu in the Layer Manager if you used implied match to turn off a 

layer from the Layers/OnOff menu while "Keep Layer Manager Open" is checked. 

13. If you insert a symbol with "Symbol Scale" enabled and "Explode" toggled on, DataCAD 

now assigns the correct Line Factor to the entities. 

14. Checking only the "Auto Extract 2D" option in the "Smart Entity Export" section of the 

DXF/DWG tab under Tools/Program Preferences, and then exporting a file to DWG 

using "On Layers" would result in DataCAD failing to include the extracted 2D door and 

window information. This has been corrected. 

15. Font name is now assigned correctly when switching between saved text styles. 

16. Repaired a bug related to renaming the active layer using the Layer Manager. 

17. Partial ellipses inside of symbols were placed in the wrong position if the symbol was 

inserted using "Dynamic Flip" with "Explode" toggled on. This has been fixed. 

18. Fixed a bug that could cause the Sun Shader to fail to include Smart Walls that are inside 

of an XREF. 

19. Corrected a cursor ghost that would occur after using the custom [Ctrl] + [f] keyboard 

shortcut to refresh all XREFs. 

20. The Symbol Browser no longer automatically scrolls back to the top after right-clicking 

on a symbol, choosing "Save As," and then saving out a copy to the hard drive. This 

would occur when browsing symbols in the current drawing, if the number of divisions 

were set to show fewer than all symbols in the drawing, and then the scroll bar was used 

to display more symbols. 

21. If "Keep Layer Manager Open" is checked, the Layer Manager no longer updates on-the-

fly while running a toolbox macro. 

22. Restored the "DIN Standard" button to the Dimension/Linear/Dim Style menu. 
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23. The status of the "Include lights from XREFs" setting on the "o2c" tab of the 

View/Rendering/Settings dialog was not being saved properly. In addition, turning on 

"Include Ground Plane" inadvertently affected the status of "Include lights from XREFs." 

The status was also being transferred between open drawings. All three issues have 

been corrected. 

24. Using the scroll wheel on the mouse to zoom in or out after right-clicking to complete a 

tangent arc section of a Smart Arrow no longer reverts to tangent arc mode. 

25. Repaired a bug which could cause a crash when switching from a 3D view to a Plan 

view in a drawing that contained XREFs which included Smart Walls. 

26. Restored the ability to zoom out using the scroll wheel on the mouse after drawing a 

Smart Arrow while "Text Scale" is toggled on in the "Text" menu and "Changes plot scale 

if TxtScale is on" is checked in the "PgUp/PgDn in Text Menu" setting is checked on the 

"Misc" tab of Program Preferences. 

27. When an associative dimension was created with KnockOut on, and Arrow Style set to 

Filled Arrow or Filled Dot, the dimension text would fail to KnockOut the dimension 

line if the text was placed manually. This has been corrected. 

 

16.00.01 

Fixes 

1. Corrected a bug that caused objects to render incorrectly in the Sun Shader when "Material by 

Color" was selected in the View/Rendering pull-down menu. 

2. Corrected an issue that could cause witness line 2 of some associative dimensions to be 

unintentionally drawn at an angle. 

3. The X, Y, and Z Enlargement fields in the Properties dialog were not being updated properly. 

This has been corrected. 

 

DataCAD 16 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 16, please click: 

What's New? from the Help pull-down menu in DataCAD. 

New Features 

AutoCAD R2013 – R2017 Compatibility (ALL EDITIONS) 

DataCAD 16 adds support for importing and exporting AutoCAD R2013 through R2017 files in 

DXF and DWG format. This enables you to collaborate and share files with associates who use 

the latest versions of AutoCAD. 



132 | DataCAD 16 

DataCAD 16 New Features and Enhancements 

 



DataCAD 15 | 133 

 

DataCAD 15 

15.04.01 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

1. Support for negative distances has been added to the Overshoot property, enabling lines 

to fall short of their actual endpoints. 

2. Added the ability to change the "At Head" or "At Tail" placement property for Smart 

Arrows via the Entity Properties Editor.  This enables you to swap the head and tail of a 

Smart Arrow after it has been drawn. 

3. Add the following key to the [Plot Preview] section of DCADWIN.ini to disable the 

Spacebar while the Plot Preview window is displayed: 

[Plot Preview] 

No Spacebar=TRUE 

When FALSE or absent, pressing the Spacebar while the Plot Preview window is 

displayed will result in DataCAD selecting the current active button, which is the "Plot" 

button. 

4. Added a "Fit" sub-option to the "Copy" menu when "Array" is toggled on. 

To use this feature: 

Choose "Copy" and then select a start point and end point that define the overall 

distance of the array.  Toggle "Array" on and then define the number of copies for the 

array.  Toggle "Fit" on, and then select the entity to copy.  DataCAD creates an array and 

fits the number of copies you defined within the two points. 

5. Pressing the [Enter] key on the keyboard after making a change in the Entity Properties 

Editor now results in DataCAD applying the change immediately.  Previously, you 

would need to press the [Tab] key first to change the focus to a different field or click the 

[OK] button. 

6. Added a new button labeled "Extents" to the "Add View" and "Update View" sub-menus 

of the "GoTo View" menu.  Toggling this option on when adding or updating a GoTo 

https://www.datacad.com/products/DataCAD_Sub-01.html
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View will result in DataCAD automatically recalculating the extents of the view any 

time the view is recalled. 

7. If you convert a polygon to a polyline, edit it, and then explode it back to polygons, faces 

that have four or more sides will no longer be triangulated. 

8. Added two new extended character codes for use when exporting DWG files (V= in 

toolbar button, A= 10XX# in toolbar sequence, or 10XX# in keyboard macro): 

3017# : DWG Export, All Layers 

3018# : DWG Export, On Layers 

9. The polyline created by executing the "Line to Poly" command in the 

Curves/Polyline/Edit menu is now highlighted in dashed, gray lines until you right-click 

to exit the command. 

10. Added two new extended character codes which set the state of the "Draw Marks" 

toggle which displays (or suppresses display of) polyline vertices (V= in toolbar button, 

A= 10XX# in toolbar sequence, or 10XX# in keyboard macro): 

1094# : 3D Settings/DrawMarks On 

1095# : 3D Settings/DrawMarks Off 

11. Creating a Fence selection by clicking points in a counter-clockwise order results in 

DataCAD automatically enabling "Crossing."  Selecting the points in a clockwise order 

leaves "Crossing" off.  The order and position of the first three selected points 

determines whether it is clockwise or counter-clockwise. 

This feature requires the following key be enabled in DCADWIN.ini 

[General] 

Automatic Crossing Selection=TRUE 

 

Fixes 

1. Corrected an issue that could cause associative dimensions in an XREF to display the 

dimension value on the wrong side of the dimension line. 

2. Repaired the 3D representation of Smart Door jambs, which were being drawn as 

polygons with no thickness. 

3. Fixed a bug that would prevent the "Relocate" option in the [Ctrl] + Right-click context 

menu for associative dimensions from relocating a horizontal dimension if "Vertical" 

were toggled on, or a vertical dimension if "Horizontal" were toggled on in the 

Dimension/Linear menu. 
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4. When inserting a symbol with "Explode" toggled on if you define a "Line Factor" other 

than 1 DataCAD will now apply the correct factor to the spacing of line types within the 

symbol. 

5. Corrected an issue that would cause DataCAD to fail to move the XClip boundary on a 

Multi-Layout sheet if the XREF that had the XClip assigned had been moved in the 

drawing area.  This issue would only occur if "GTV Link" was off for the XREF, and the 

detail was placed without using the "GoTo View" sub-menu of the "Multi-Layout" menu. 

6. Tangents mode (from the Utility/Geometry menu) is temporarily suspended when you 

enter the "Print/Plot" menu and then select "Layout" from the "Multi-Layout" menu.  

This enables you to use the "Snap To Divs" option to place the detail at a division 

intersection.  Tangents mode resumes automatically when you exit the command. 

7. If an associative dimension is drawn such that the two witness lines are on opposite 

sides of the dimension line, the "Offset" and "Overlap" for the witness lines are now also 

drawn on opposite sides.  Previously, they were drawn in the same direction, resulting 

in an incorrect display on one side. 

8. Filled arrows (both Smart Arrows and classic) now drawn with the Filled Dot arrow 

style are now displayed during dynamic dragging commands, such as Move/Drag or 

Copy/Drag. 

9. Double-clicking the toolbar button to launch the Object Viewer no longer results in a 

crash after dismissing the Object Viewer window. 

 

New features in Sun Shader 2.0.4.1 (Since 2.0.3.3): 

1. Implemented "Entity Type" and "Entity Size" filters that can omit information from the 

model to improve display speed.  These options are in the "Rendering Settings" dialog, 

accessed via the button on the "Rendering" toolbar. 

2. Restored support for alpha channel in transparent bitmaps. 

Note: transparent bitmaps cannot be supported while shadows are being cast. 

3. Added the ability to render selected information in the Sun Shader. To use this feature, 

choose "Clipboard Select" from the "Edit" pull-down menu (or press [Ctrl] + [e]), and 

then highlight some information. Click the "Launch Sun Shader" toolbar button. Only 

the selected information is rendered in the Sun Shader. 

4. Added the ability to render individual symbols in the Sun Shader. To use this feature, 

position your cursor over a 3D symbol in the Symbol Browser. Right-click your mouse, 

and then select "Sun Shader." DataCAD launches the Sun Shader with just the one 

selected symbol displayed. 



136 | DataCAD 15 

15.04.01 

5. Added the ability to define a custom time window for shadow study. Previously, Sun 

Shader was limited to the Sunrise to Sunset window. 

6. The smallest time interval for "Frequency" on the "Date and Time" tab of Shadow Study 

Settings is now 5 minutes. The 6-hour interval has been removed. 

7. The font size of the Shadow Study result text can now be customized. 

8. Pressing [Alt] + [x] locks rotation about the X-axis. Pressing [Alt] + [z] locks rotation 

about the Z-axis. 

9. Two new DCADWIN.ini keys: 

[Sun Shader] 

Force Solid Background=TRUE 

When FALSE (or absent) the Sun Shader background uses a gradient. When TRUE, the 

background uses a solid color. 

[Sun Shader] 

Force Ground Plane display for Shadow Study=FALSE 

When TRUE (or absent) the Sun Shader includes a ground plane when Shadow Study 

mode is activated. When FALSE, no ground plane is used. 

 

Fixes in Sun Shader 2.0.4.1 (Since 2.0.3.3): 

1. The Sun Shader now looks for bitmap textures in the same folder as the drawing when 

the texture cannot be found in the specified path or the Materials folder. 

2. Saved views in the Sun Shader failed to get deleted from the database and would 

reappear after closing and reopening the Sun Shader. 

3. Saved view projections could be displayed incorrectly if the size of the Sun Shader 

application window was different from the time the view was saved. 

4. Fixed a view jump that would occur while in "Perspective" viewing mode. The jump 

would occur the first time you clicked on the +/- Field of View button. 

5. Sun Shader now remembers the maximized state of the application when closed and 

then reopened if "Remember last view" is enabled. 

6. The Sun Shader will now remember the position of the toolbars between sessions. 

7. Sun Shader now launches with the correct view clipping plane, and with all view 

parameters initialized. 
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Fixes 

1. Corrected an error that would turn off all the layers in an XREF when placing a detail on 

a Multi-Layout sheet using a GoTo View. 

2. Corrected the "Layer" drop-down in the Entity Properties Editor to display long layer 

names when clicked. 

3. Changed the "Layer" column in the Layer Manager for improved display of long layer 

names. Double-clicking the column header divider automatically resizes the column to 

the length of the longest name. 

 

15.03.01 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

1. Added a new key to the [General] section of DCADWIN.ini 

[General] 

Disable Line Weight Hot Key=FALSE 

When TRUE, the [w] key on the keyboard is disabled. Pressing this key increases the 

value of the current line weight by 1. 

2. Added the "Dynamic Snapping" setting (On or Off), found in the [Ctrl] + [Right-

click]/XREF Tools context menu for XREFs, to the Reference File Manager. 

3. Added a button labeled "Previous," which selects the previously selected set of entities, 

to the "Mask" menu of each selection menu. For example, you may select "Move," define 

a distance, and then choose a set of entities to move. To perform another editing 

operation on the same entities, pick the editing command, choose "Mask", and then pick 

"Previous." 

4. Options to display "Prefix," "Dimension," and "Suffix," have been added to the "Dim 

Style" sub-menu of the Dimensions/Linear menu.  Their status and custom data is 

included with the collection of information saved in the dimension style file (*.dimstyle). 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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The prefix text will be added in front of the dimension text.  Similarly, suffix text will be 

added after the dimension text.  When "Dimension" (on by default) is toggled off, 

DataCAD will draw all the dimension components, but the dimension text will be 

absent. 

Options to change the "Prefix String" and "Suffix String" are available in the Entity 

Properties Editor for associative dimensions, along with access to the stats of the 

"Dimension Text" setting.  [Ctrl] + Right-click on an associative dimension and then 

choose “AssocDim Properties” to access the Properties Editor. 

5. Added a key to the DCADWIN.ini configuration settings file that can keep the drawing 

timer running even if DataCAD is not the active application. 

[General] 

No Timer Pause=FALSE 

Setting this to TRUE will keep DataCAD from pausing its drawing timers when it is not 

the active application. 

6. The "Nesting," "GTV Link," "Dyn. Snap," and "Smart Wall Hatch/Fill" sections of the 

Reference File Manager are grayed out until you select an XREF to modify. This works 

like the way the "Highlighting" section works. 

7. The way symbols are selected when using "Fence" with "Crossing" enabled has been 

adjusted. Previously, the symbol would only be selected if the insertion point was 

within the Fence boundary, even with "Crossing" turned on. Now, the symbol will be 

selected if the Fence boundary crosses any part of the symbol, like the way 

Area/Crossing selection works. 

There is a new DCADWIN.ini key that can restore the command to its previous state: 

[General] 

New Crossing Fence=FALSE 

When TRUE or absent, DataCAD uses the new Fence/Crossing selection method on 

symbols. When FALSE, DataCAD uses the previous Fence/Crossing selection method on 

symbols. 

8. The on/off state of the "Multiple" toggle in the "Move/Drag" or "Copy/Drag" menu has 

been separated from the "Multiple" toggle in the "Save Symbol" menu. 

9. When replacing or redefining a symbol, the name of the symbol is now displayed on the 

"Message" toolbar at the bottom of the program interface. 

10. There is a new "Auto Reload" option in the [Ctrl] + Right-click/Symbol Tools context 

menu for symbols. When checked, DataCAD will automatically reload the symbol 

definition for the symbol instance each time you open the drawing. This setting is 
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assigned and remembered on a per-symbol (but not per-instance) basis. If a symbol 

marked for Auto Reload is not found in the original location, DataCAD will display an 

error message when you open the drawing to notify you. 

11. Menus which have [Scroll Fwd] and [Scroll Back] buttons, such as the Hatch/Patterns, 

Line Type, or Layers/OnOff menus, now support the ability to use the scroll wheel on 

your mouse to scroll forward and backward. Your cursor must be positioned over the 

menu for DataCAD to execute this function. 

12. Two new fields for "X Radius" and "Y Radius" have been added to the Entity Properties 

Editor for ellipses. [Ctrl] + Right-click on an ellipse and then choose "Ellipse Properties" 

to access these fields. 

13. The "Stretch" command now supports the ability to select the quadrant points of ellipses. 

14. Added drop-down menus for "Horizontal Alignment" and "Vertical Alignment" to the 

Entity Properties Editor for text entities. In the Horizontal Alignment section, you may 

select from the options "Left," "Center," and "Right." In the Vertical Alignment section, 

you may select from the options "Bottom," "Middle," and "Top." 

15. Added support for "Nearest" object snapping while inserting a symbol in a non-plan 

view with "Current View" toggled on. 

16. Added the following new INI keys to the [Printer] section of the DCADWIN.ini file: 

Print Text=DEFAULT 

Print Hatch=DEFAULT 

Print Line Weight=DEFAULT 

Print Line Types=DEFAULT 

Print Associative Dimensions=DEFAULT 

Print Fills= DEFAULT 

Print Bitmaps=DEFAULT 

Print KnockOuts=DEFAULT 

Print Smart Wall Hatch=DEFAULT 

Print Smart Wall Fill=DEFAULT 

Set any of the above to TRUE to force them to print, even if the attribute setting in the 

Utility/Display menu is turned off. If set to DEFAULT or missing, the drawing's display 

toggles T, H, L, U, D, F, B, and K in SWOTHLUDFBK will be used to determine whether 

or not the attribute is included in the printed output. 

17. The ability to access the "Primary Divisions" and "Secondary Divisions" on a 3D Mesh 

entity has been added to the Entity Properties Editor. 

18. When working in the Door Type Manager, making changes to a door type, and then 

clicking the "Apply" button now updates the display of all instances of the door 

immediately. Previously, you would need to close the Door Type Manager to see the 
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drawing update. This change also affects the Window Type Manager and Wall Type 

Manager. 

19. Added "Save As" to the context menu that appears when you right-click on a symbol in 

the Symbol Browser. This enables you to save a copy of the symbol to a different folder, 

or with a different name. 

20. Added "Show Edge" and "Hide Edge" options to the 3D Polygons/Edit menu, enabling 

you to select individual polygon edges to show or hide. 

21. Added "X Rotation," "Y Rotation," and "Z Rotation" fields to the Entity Properties Editor 

for Polylines. Use these fields to check or adjust the X, Y and Z rotation angles of the 

selected polyline entity. 

Note: When all these values are not zero, you must use the 'Get Construction Plane' menu before 

you can edit the Polyline. Otherwise, the error message "You must be in this Polyline's 

construction plane to perform this function." will be displayed when you try to use the Polyline 

editing tools. 

22. The "Viewer" toolbar buttons have changed. Rotate +/- Y has been removed. Rotate +/- Z 

previously rotated relative to the screen, but now rotates using "world" Z. The default 

rotation angle, previously 30°, has been changed to 5°. This is now consistent with the 

same toolbars in the Object Viewer and the Sun Shader. 

23. Access to the "Horizontal Alignment" and "Vertical Alignment" settings are now 

available via drop-down menus in the Text/Font dialog. 

24. The appearance of the 3D cursor has been updated to display the X, Y, and Z axes in red, 

blue, and green, respectively. These colors remain independent of the current color. 

 

Fixes 

1. Entities that were grouped prior to executing the Change/More/KnockOut command 

remain grouped. Entities that were un-grouped prior to executing this command remain 

un-grouped. 

2. Corrected an error in the display order of individual lines of text inside of PText entities 

that are inside of symbols used to define the 2D representation of Smart Windows. 

3. Corrected an issue that could cause MText and PText entities to display an extra space 

after character number 255. 

4. Repaired the "Show Hatch" and "Show Fill" check boxes in the "Smart Wall Hatch/Fill" 

section of the Reference File Manager. 
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5. Entities that were deselected prior to executing an editing command that involved 

choosing multiple entities (for example Move/Drag/Multiple) are no longer included in 

the new "Previous" selection set. 

6. Fixed a bug that could enable Smart walls to be selected by Area even if both end points 

were not contained within the Area box. 

7. Corrected an error during export to DWG format that could place MText entities in the 

wrong location in the resultant file. 

8. Blocks or slabs of zero thickness are now represented in the Sun Shader as two polygons 

with opposite-facing normals to retain the correct rendering results. This applies to the 

geometry generated in Smart Doors and Smart Windows as well. 

9. When the "Render as wireframe" performance option in the Sun Shader was un-checked, 

using the Pan/Zoom/Rotate widget to zoom in or out would result in the Sun Shader 

rendering the model in wireframe. This has been corrected. 

10. Corrected a difference in the nominal base line spacing factor between symbols 

(previously 1/32") and XREFs (1'-0"). Both now use 1'-0" as the base value. This change 

was needed for symbols inside of XREFs to maintain the correct line spacing when the 

XREF used an enlargement factor other than 1. 

11. Choosing "Ins Point" and then picking an insertion point after going to the "Multi-

Layout" menu, picking "GoTo View," and then selecting a view to place as a detail, could 

result in DataCAD displaying the wrong information attached to the cursor as you 

placed the detail on the sheet. This has been fixed. 

12. Selecting "Save As" from the "File" menu, and then clicking the "Save as type" drop-

down and picking each available type, one after another without saving the file, no 

longer results in DataCAD adding each version identification number to the file name. 

Only the type that is selected when you click "Save" is added. 

13. Using the Entity Properties Editor to change the font assigned to associative dimension 

text failed. This has been corrected. 

14. If you had created an associative dimension with "Lock Size" enabled, clicking the drop-

down for "KnockOut," selecting "Yes," then clicking on "Apply" no longer changes the 

size of the dimension text and tick marks changes. 

15. Using the [Ctrl] + Right-click, XREF Tools, Hide command, and then the [Ctrl] + Right-

click, XREF Tools, Unhide command on an XREF that has a custom name assigned in the 

Reference File Manager now retains the custom name. Previously, it would revert to the 

standard XREF name (path plus file name) after executing the Unhide command. 
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16. If you were using the "Current View" toggle to insert a symbol while in a non-plan view, 

the button would disappear when you switched to a plan view, and you would be 

forced to switch back to the previous view projection to turn it off. This has been fixed, 

and the "Current View" toggle remains available regardless of the current view 

projection. 

17. When using the 3D Cursor and X, Y, Z Coordinate input to draw chained 3D Lines, the 

Z value remained relative to the first point entered, when it should have updated to be 

relative to the last point entered. This has been corrected. 

18. Corrected the button label tooltip for "Lock Size" in the "Ins Symbol" menu. 

19. The 3D Cursor in the 3D Stretch command continues to display the 3D Cursor after 

selecting the first point of the distance to stretch. Previously, it would revert to the 

standard crosshair cursor after selecting the first point. 

20. Added support for 1/64, 1/128 and 1/256 base units for Dimension Rounding. 

21. For better usability, the default values in the 3D Views/Walk Through menu have been 

changed. The default "Walk Dist" has changed from 10' to 3'. The default "Turn Angle" 

has changed from 30° to 5°. The default "Step Dist" has changed from 5' to 1'. The default 

"Look Angle" has changed from 10° to 5°. 

22. Using the "Vert Surf" option in the 3D Entity/Mesh Surface menu to create a vertical 

mesh surface now results in control points that are distributed with equal spacing from 

Z-Base to Z-Height. Previously, they were set to Z-Base, Z-User 1, Z-User 2, and Z-

Height, respectively. 

23. When adding text to the drawing via the Coordinate Identification or 

Measures/AreaPerim command and using the "Font" dialog to define an alignment other 

than the default Left/Bottom, the correct text alignment is now used. 

24. Corrected an error storing the screen coordinates that define the position of the "Browse" 

dialog, which would sometimes result in the dialog being opened off-screen. 

25. When editing the boundary of an XClip on a self-XREF, DataCAD no longer displays a 

"ghost" of the boundary you are editing. 

26. Fixed an error that could cause KnockOuts to fail to display properly if the 

DCADWIN.ini key New Smart Object Generation= in the [General] section was set to 

TRUE. 

27. DataCAD failed to make the second point relative to the first point when creating a 3D 

entity using the 3D Cursor and coordinate input. This has been repaired. 
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28. In a new drawing, the "Self-XREF" option in the "Insert" pull-down menu is now grayed 

out until after you save the file. 

29. Manually placing associative dimension text that had KnockOut enabled would fail to 

knockout the dimension line. This has been fixed. 

30. Using the Symbol Browser to browse symbols in the drawing, in a drawing that 

contained more than 30 symbols, and then scrolling down and selecting a symbol from 

the bottom of the grid would cause DataCAD to jump back to the top after selecting the 

symbol to insert. This has been corrected. 

 

Fixes in DataCAD LT 

1. Right-clicking on a DataCAD drawing file (*.aec file extension) in Windows Explorer 

and then choosing "Open with DataCAD 15" would fail if DataCAD LT 15 was already 

running. This has been fixed. 

New features in Sun Shader 2.0.3.3 (Since 2.0.2.11): 

1. Added the ability to render selected information in the Sun Shader. To use this feature, 

choose "Clipboard Select" from the "Edit" pull-down menu (or press [Ctrl] + [e]), and 

then highlight some information. Click the "Launch Sun Shader" toolbar button. Only 

the selected information is rendered in the Sun Shader. 

2. Added the ability to render individual symbols in the Sun Shader. To use this feature, 

position your cursor over a 3D symbol in the Symbol Browser. Right-click your mouse 

and then select "Sun Shader." DataCAD launches the Sun Shader with just the one 

selected symbol displayed. 

Fixes in Sun Shader 2.0.3.3 (Since 2.0.2.11): 

1. The Sun Shader now looks for bitmap textures in the same folder as the drawing when 

the texture cannot be found in the specified path or the Materials folder. 

 

15.02.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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New Features 

1. Added a "Dynamic" option to the 2D and 3D Stretch commands. 2D lines, 3D lines, 

Smart walls and (open) polylines are supported. After selecting "Dynamic," click near 

the end point of the line, wall, or polyline you wish to stretch. You may then reposition 

it dynamically using the rubber-band method. 

2. Enhanced the Add Vertex and Move Vertex commands in the Polyline/Edit, 3D 

Polygon/Edit and 3D Slab/Edit menus. DataCAD will highlight the selected polyline, 

polygon, or slab with a dashed gray line type. If multiple edges or nodes are found 

within the miss distance, you may right-click and then select again to cycle through the 

coincident entities. 

3. When using the "Point" selection method in the "Stretch" command and then using the 

left mouse button to click on a point, DataCAD will select all points that are within one 

pixel of the cursor position. This has been enhanced such that if no point is found within 

one pixel, DataCAD will now choose the closest available end point. 

4. Access to the "Underline" and "Overline" properties for single-line text entities has been 

added to the Text/Font dialog. Checking either (or both) turns this property on for 

subsequent text. 

5. There are new extended character codes that can be used to define the status of these 

settings. 

1089# : Underline On 

1090# : Underline Off 

1091# : Overline On 

1092# : Overline Off 

6. The "Batch Plot" dialog now shows the current path when "Plot to File" is checked. 

7. Added support for Associative Dimensions to the Geometry/Tangents function. When 

you select an Associative Dimension, DataCAD rotates the cursor to match the angle of 

the dimension line. 

 

Fixes 

1. Fixed an issue that could cause Smart walls to be left out of existing Multi-Layout 

details. 

2. Using the Change/More/KnockOut command no longer groups the selected entities. 

3. Corrected an error that would omit Self-XREFs from Sun Shader 2.0. 
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4. Fixed a problem in the "Save As" command in DataCAD 15 Professional that would omit 

the .AEC file extension from drawing files unless it was explicitly included in the file 

name field. 

5. The "Message" toolbar now displays the correct message when clicking the second point 

of an XClip boundary. 

6. Fixed an issue that could cause DataCAD to display incorrect XClip extents when 

opening a file that contains an XREF with an XClip. 

 

New features in Sun Shader 2.0.2.11 (Since 2.0.2.2): 

1. Added the ability to define a custom time window for shadow study. Previously, Sun 

Shader was limited to the Sunrise to Sunset window. 

2. The smallest time interval for "Frequency" on the "Date and Time" tab of Shadow Study 

Settings is now 5 minutes. The 6-hour interval has been removed. 

3. The font size of the Shadow Study result text can now be customized. 

4. Pressing [Alt] + [x] locks rotation about the X-axis. Pressing [Alt] + [z] locks rotation 

about the Z-axis. 

5. Two new DCADWIN.ini keys: 

[Sun Shader] 

Force Solid Background=TRUE 

When FALSE (or absent) the Sun Shader background uses a gradient. When TRUE, the 

background uses a solid color. 

[Sun Shader] 

Force Ground Plane display for Shadow Study=FALSE 

When TRUE (or absent) the Sun Shader includes a ground plane when Shadow Study 

mode is activated. When FALSE, no ground plane is used. 

 

Fixes in Sun Shader 2.0.2.11 (Since 2.0.2.2): 

1. Saved views in the Sun Shader failed to get deleted from the database and would 

reappear after closing and reopening the Sun Shader. 

2. Saved view projections could be displayed incorrectly if the size of the Sun Shader 

application window was different from the time the view was saved. 
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3. Fixed a view jump that would occur while in "Perspective" viewing mode. The jump 

would occur the first time you clicked on the +/- Field of View button. 

4. Sun Shader now remembers the maximized state of the application when closed and 

then reopened if "Remember last view" is enabled. 

 

15.01.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

1. Added the ability to disable XClips and SClips for the entire drawing. [Ctrl] + Right-click 

in a blank section of the drawing area to access the Drawing Context Menu. Un-check 

"XClips On" and/or "SClips On" to disable display of XClips or SClips. DataCAD will 

display XREFs and Symbols as if no XClips or SClips are assigned. The individual 

clipping boundaries are retained. 

2. Added support for Drag-N-Drop of the following filetypes: 

AEC/DC5 

These files may be dropped onto the DataCAD start screen or an open drawing to open 

them in new windows. Holding the [Ctrl] key when dropping the file will import it into 

the active drawing. Holding the [Alt] key when dropping the file will insert it as an 

XREF in the active drawing. 

DXF/DWG 

These files may be dropped onto the DataCAD start screen or an open drawing to open 

them in new windows. 

Holding the [Ctrl] key when dropping the file will import it into the active drawing. 

SKP 

These files may be dropped onto an open drawing to insert them as a Symbol. Holding 

the [Alt] key when dropping the file will insert it as an XREF in the active drawing. 

TXT 

These files may be dropped onto an open drawing to insert them as a PText. The drop 

point is used the first point of the PText boundary. If you hold the [Ctrl] and [Alt] keys 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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when dropping the file, DataCAD will prompt you to select the first point of the PText 

boundary. 

Bitmaps (BMP, JPG, JPEG, GIF, TIF, TGA, PNG, PCX, PCD) 

These files may be dropped onto an open drawing. DataCAD will use the drop point as 

the first point of the boundary rectangle. If you hold the [Ctrl] and [Alt] keys when 

dropping the file, DataCAD will prompt you for the first point of the boundary. 

XLS 

These files may be dropped onto an open drawing to insert them as an XREF. 

o2c 

These files may be dropped onto an open drawing to insert them as a Symbol. 

ACO 

These files may be dropped onto an open drawing to insert them as a Symbol. 

3DS 

These files may be dropped onto an open drawing to insert them as a Symbol. 

STL 

These files may be dropped onto an open drawing to insert them as a Symbol. 

DSF/SM3 

These files may be dropped onto an open drawing to insert them as a Symbol. 

Metafiles (EMF/WMF) 

These files may be dropped onto an open drawing. 

3. When selecting "Save As" from the "File" menu, the "File Name" field is automatically 

populated with the name of the current drawing file. (ALL EDITIONS) 

4. When exporting to DXF or DWG using "On Layers," only those symbols which are 

instanced on the exported layers are included in the file header. This change was made 

to reduce the size of the resultant DXF or DWG file. (ALL EDITIONS) 

5. Added a new option labeled "Loaded Indicators" to the "Options" pull-down menu at 

the top of the Symbol Browser. When enabled, a small check mark is displayed in the 

upper right corner of cells on the Symbol Browser displaying symbols that have been 

loaded in the header of the current drawing. 

6. The Measure/InclAngle and Measure/ExclAngle now support Smart walls. Previously, 

only 2D lines were supported. 

7. GoTo View parameters now include the status and angle of "Tangents" in the 

"Geometry" menu, and the number of Tangent Divisions. 
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8. The status of the "Preview" check-box on the File/Open dialog has been separated from 

the "Preview" check-box on other dialogs, such as Insert/SketchUp or Insert/o2c. Un-

checking "Preview" on the File/Open dialog turns off the creation of the drawing file 

preview images, which are saved in the same folder as the drawing file and display a 

preview when you select a file. You may now turn this off while leaving the preview of 

other files types on. 

9. The "Intersection" command in the "Geometry" menu now supports Smart walls. 

Previously, only 2D lines were supported. 

10. Added a new key to DCADWIN.ini that disable the display of hatch during any 

dynamic drag operation. The key is: 

[General] 

Show Hatch During Drag=FALSE 

When FALSE (default) or absent, display of hatch is suppressed while performing a 

dynamic operation, such as Move/Drag, Copy/Drag or when inserting a symbol. When 

TRUE, all hatch is displayed during dynamic operations. 

11. Enhanced speed of display (up to 2x times faster) when switching between GoTo Views 

or regenerating the screen. There is an INI key to disable this new feature: 

[General] 

New Smart Object Generation=FALSE 

When absent or TRUE, DataCAD uses the new faster method of screen regeneration. 

When FALSE, the older method is used. (ALL EDITIONS) 

12. Optimized file saving process for improved speed. (ALL EDITIONS) 

13. Updated the sample macros in the DCAL for Delphi\Samples folder (Complete or 

Custom installation only) for compatibility with DataCAD 15. Also added a 

corresponding 'Compiled Macros' folder that contains a compiled DMX file for each 

sample macro. (ALL EDITIONS) 

14. Add the following entry to the [General] section of DCADWIN.ini to specify DataCAD's 

busy animated cursor. Windows cursors, .CUR, and animated cursors, .ANI, are in 

C:\Windows\Cursors\ by default. 

[General] 

Busy Cursor=GoldenMean 

15. You can add the following entries to the [o2cViewer] section of DCADWIN.ini to 

customize the rotation of the model and/or the texture about the o2c world Z-axis. 

Set Model_Z_Angle to 180 to orient the model consistent with o2c's coordinate system. 
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Set Texture_Z_Angle to 90 to orient bitmap textures on horizontal surfaces to match the 

orientation of the source image that is read from the hard drive. 

Note: The texture angle should be added to the model angle, so they rotate 'together'. 

The default values; no rotation. Range: 0 - 360. 

[o2cViewer] 

Model_Z_Angle=0 

Texture_Z_Angle=0 

Recommended values for 'correct' orientation. 

[o2cViewer] 

Model_Z_Angle=180 

Texture_Z_Angle=270 

16. You can add the following entry to the [o2cViewer] section of DCADWIN.ini to load the 

current DataCAD perspective view when launching the Object Viewer. 

Note: 'Remember Last View' must be set to FALSE, otherwise the last o2c view will be restored 

instead. 

[o2cViewer] 

LoadDataCADView=True 

17. Repaired the ability to use the "Sunlight On/Off," "Ambient 1 On/Off," "Ambient 2 

On/Off," "Ambient 3 On/Off," and "Lamps On/Off" buttons on the "Lights" toolbar in the 

Object Viewer for Windows Vista/7/8. 

 

Fixes 

1. Creating a text entity that has "Lock Size" enabled, and then using the Entity Properties 

Editor to change the status of either "Underline," "Overline" or "KnockOut" would result 

in the text changing its size. This has been fixed. 

2. Corrected an error that could cause the center line of three-line classic walls to extend off 

into space when "Outside" and "Clean" are toggled on in the "Architect" menu. 

3. Updated the *.u$r file to report the correct version number. 

4. If the text in an associative dimension string was too big to fit within the dimension 

lines, and you right-clicked to let DataCAD place it automatically, using 

Change/Dimension/TextPos would place the text in the wrong location the first time you 

tried to reposition it. This would occur only when "Text Scale" and "Lock Size" were on 

in the Dimension/Linear/Text Style menu and has been corrected. 
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5. Adding a new layer to the middle of a list of layers and then setting it to be the active 

layer could sometimes result in DataCAD failing to set the selected layer active. This has 

been fixed. 

6. Corrected a crash that could occur after selecting a line to match for Geometry/Tangents, 

and then beginning a new line and pressing the [O] key on the keyboard to toggle 

Orthomode on. 

7. Corrected a bug that could occur when using the [v] keyboard interrupt to access the 

GoTo View menu to update the parameters of a saved GoTo View that includes an XREF 

with GTV Link enabled without first exiting the Edit XClip command. 

 

DataCAD 15 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 15, please click: 

What's New? from the Help pull-down menu in DataCAD. 

Sun Shader 2.0 (ALL EDITIONS) 

DataCAD 15 includes an enhanced Sun Shader built around an all-new rendering engine 

optimized for speed, enabling you to review complex models with ease. An updated user-

interface makes navigation easier and you can now save GoTo Views for later recall.  Rendering 

quality has also been improved by adding support for transparency and smoothing. 

Incorporating shadow maps into your DataCAD drawings is now automated with a new 

'Superimpose Saved Image' feature. 

1. Superimpose saved images that match the position and scale of your drawing. 

2. Support for transparent materials has been added. 

3. Added a Layer Manager with access to the layers that were on when the Shader was 

opened. 

4. Added a "GoTo Views" toolbar, which can save, recall, update and delete Views. 

5. Added a "Zoom" toolbar with options for Zoom/Extents and Zoom/Window. 

Note: The Zoom/Window button is a toggle. Click on the button a second time after defining the 

zoom window to exit Zoom/Window mode. 

6. When using the scroll wheel to zoom in or out, the view of the model is now centered at 

the cursor location. 

7. Display of shadow study results (Instance, Altitude and Azimuth) is synchronized with 

the current instance of the animation frame. 
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8. Added an Edge Properties drop-down toolbar button which contains options for 

defining the properties of edges in your model. 

9. SunShader now has support for smoothing in material properties. 

10. Added a "Rotate" toolbar. 

11. Added a Pan/Zoom/Rotate widget. 

12. Added a "Review" toolbar to display polygon face, edge, and vertex normals. 
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DataCAD 14 

14.03.02 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

1. Added "Smart Arrows" to the list of entities supported by selection mask. (ALL EDITIONS) 

2. Added the following extended character codes: 

1079# : Hatch On 

1080# : Hatch Off 

1081# : Fill On 

1082# : Fill Off 

1083# : Bitmaps On 

1084# : Bitmaps Off 

3015# : Launch Sun Shader 

3. Added an option to flatten all entities to Z-Base/Z-Height=0 while exporting to DXF or 

DWG format. 

4. Added support for retaining GoTo Views and the GTV Link when redefining an XREF. 

 

Fixes 

1. Corrected an issue that could cause an incorrect drawing extents if XREFs with XClips 

were present in the drawing. 

2. Using the scroll wheel on the mouse or the [PgUp]/[PgDn] keys on the keyboard to 

zoom in or our while in PText entry mode would cause the "Boundary" toggle on the 

menu bar to become switched on. This would only occur if Show PText/MText 

Boundary On Entry/Resize= was set to TRUE in the [General] section of DCADWIN.ini. 

This has been fixed. 

3. Fixed a problem exporting a file to DWG if the drawing contained hatching with Lock 

Size enabled. Hatching now exports at the correct scale. If Lock Size is enabled, the scale 

of the hatch is relative to the plot scale at the time of the export. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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4. Toggling "Multiple" on while in Save Symbol mode, and then selecting the same entity 

twice with Shift For Implied Deselect=TRUE in the [General] section of DCADWIN.ini, 

would result in an error stating "Unable to load symbol into drawing database." This has 

been corrected. 

5. If No LockSize=TRUE in the [General] section of DCADWIN.ini, creating a Smart arrow 

with Text Scale on and a custom symbol for the arrow head would result in DataCAD 

failing to apply the enlargement factor to draw the arrow head at the correct size for the 

current plot scale. This has been fixed. 

6. Corrected an erroneous perpendicular object snap on curves. 

7. Corrected an access violation error that could occur when printing some Smart doors 

that contain 2D symbols. 

8. If you created a drawing and set your M/PText angle to 90 degrees, and then closed the 

file and started a new one without exiting the application, DataCAD would use the 

previously defined 90 degree angle instead of the default of zero. This has been fixed. 

9. When using the Symbol Browser to browse symbols in the drawing, DataCAD now 

stores the values of the settings for divisions in the drawing. This prevents it from 

reverting to the default 3x15 after selecting a symbol to insert. 

10. You are no longer permitted to set the value zero for "No.Divisions" in the "Object Snap" 

menu. 

11. You are no longer permitted to set the value zero for "KnockOut X Enlargement" and 

"KnockOut Y Enlargement" in the Entity Properties Editor of entities that support 

KnockOuts. 

 

14.03.01 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 

available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

1. Added "Relocate" to the [Ctrl] + Right-click context menu for associative dimensions. 

Selecting this option puts DataCAD into dimension placement mode, so that you may 

reposition the dimension line using the existing dimension points. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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2. To maintain consistency with previous versions, the default status of the "Ignores Clip 

Cube" setting when inserting XREFs has been changed to off (unchecked). If the XREF 

does not have an XClip, it will obey the drawing-level Clip Cube by default. 

3. Added a key to DCADWIN.ini to facilitate turning off the temporary boundary box that 

appears around MText and PText when placing or resizing the entity. 

[General] 

Show PText/MText Boundary On Entry/Resize=FALSE 

When TRUE (or absent), a temporary boundary box is displayed around MText and 

PText entities when creating or resizing them. When FALSE, the temporary boundary 

box is not shown. 

4. Added a key to DCADWIN.ini which disables the Lock Size feature on text and 

dimensions. (ALL EDITIONS) 

[General] 

No LockSize=TRUE 

When FALSE (or absent), Lock Size is available in the Text and Dimension/Text Style 

menus (with Text Scale enabled). When TRUE, the Lock Size button is no longer present 

in the Text or Dimension/Text Style menus. If a drawing contains text that has Lock Size 

turned on, DataCAD will continue to change the size of the text in the drawing area 

when you change the plot scale. Use the Change/More/Lock Size/Off menu command, or 

the "Lock Size" setting in the Entity Properties Editor, to turn Lock Size off if you wish to 

change this property for existing entities. 

 

Fixes 

1. Associative dimension text was being displayed with KnockOut on even if it was off. 

When using a non-black background, the KnockOut was drawn in a different color. This 

has been fixed. 

2. Corrected an issue that could cause associative dimensions inside of symbols to display 

their text in the wrong position. 

3. If a drawing contained a Clip Cube and an XREF outside that Clip Cube, DataCAD 

(Professional Edition) would calculate the drawing extents incorrectly. This has been 

fixed. 

 

14.03.00 

DataCAD Subscription 

Unless noted otherwise with the indicator (ALL EDITIONS), new features and enhancements are only 
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available in DataCAD Subscription. 

 

Other editions include bug fixes only. For information about the benefits of upgrading to DataCAD 

Subscription, please visit About DataCAD Subscription or contact DATACAD Customer Service via phone 

at +1 (860) 217-0490 or via e-mail at info@datacad.com. 

New Features 

1. Add the following key to the [General] section of DCADWIN.ini to disable all hard-

coded keyboard interrupts (single-letter key presses): 

[General] 

Shortcut Keys Invoke Alias=TRUE 

When FALSE (or absent), single-letter keyboard interrupts continue to function as they 

always have. For example, pressing [a] sends DataCAD to the "Architect" menu. 

When TRUE, DataCAD directly accesses the Command Line Alias function and executes 

the selected command. This mode of command entry more closely mimics that of 

AutoCAD and enables you to customize the keyboard commands. For example, you 

could set the [a] key to take you to the "Arrow" menu instead of the "Architect" menu. 

Multi-character aliases are also supported, for example "ZE" for "Zoom/Extents." 

For more information on creating a command line alias, see "Using the Command Line 

Alias" in Chapter 2 of the "DataCAD 14 Reference Manual." 

2. Add the following key to the [General] section of DCADWIN.ini to disable direct 

distance input: 

[General] 

Spacebar For Distance Input=TRUE 

When FALSE (or absent), the [Spacebar] is not necessary to invoke coordinate input 

mode. (ALL EDITIONS) 

3. The "Bisect" function in the Geometry\Tangents menu now supports the ability to select 

Smart walls. Previously, only 2D lines were supported. 

4. The "Justify" command in the "Text" menu now supports the ability to select 2D Lines, 

3D Lines and Walls as the line of justification, using the "Entity" option in that menu. 

After selecting a justification line, and then exiting and returning to the menu, a "Prev 

Line" option is now available, enabling you to use the previously selected justification 

line. 

5. The "1-Line Trim" command in the "Cleanup" menu supports the ability to select 

individual wall lines of Smart walls. Previously, this function was limited to selecting 

the control line. 

https://www.datacad.com/products/DataCAD_Sub-01.html
mailto:info@datacad.com
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6. DataCAD supports the ability to select Circles in the "Line To Poly" function of the 

Polyline\Edit menu. 

7. Added a "3-Sided Only" option to the 3D Explode/To Polygons command. When 

activated, exploding an object will result in a collection of 3-sided polygons. This can be 

useful when exporting a model to a rendering application. 

8. A temporary boundary box is displayed when creating or resizing MText and PText 

entities. (ALL EDITIONS) 

 

Fixes 

1. DataCAD now correctly calculates the drawing extents when there is an XREF outside 

the drawing-level Clip Cube and the XREF has "Ignore Clip Cube" un-checked. 

Note: the "Ignore Clip Cube" setting for XREFs is a Subscription Edition feature. 

2. DataCAD's keyboard interrupts would cease to function after selecting View\Toolbars, 

picking "Configure Context Toolbar," and then clicking "OK" to dismiss both dialogs. 

This has been corrected. 

3. The status of the "KnockOut" toggle is no longer global. The toggles in the "Text" and 

Dimension\Text Style" menus control KnockOuts to Text, Smart Arrows and 

Dimensions. The toggle in the "Curves menu controls KnockOuts on curved entities 

(arcs, circles, polylines). The toggles in the 3D Polygons and 3D Slabs menu are tied 

together and control KnockOuts on 3D Polygons and 3D Slabs. 

4. There are new extended character codes associated with these changes: 

1071# : KnockOut for Curves On 

1072# : KnockOut for Curves Off 

1073# : KnockOut Border for Curves On 

1074# : KnockOut Border for Curves Off 

1075# : KnockOut for Polygons and Slabs On 

1076# : KnockOut for Polygons and Slabs Off 

1077# : KnockOut Border for Polygons and Slabs On 

1078# : KnockOut Border for Polygons and Slabs Off 

5. If a rotated XREF contained a horizontal associative dimension with KnockOut enabled, 

the dimension text would be drawn in the wrong orientation. This has been fixed. 

6. Restored the display of the Clip Cube boundary after selecting "New Cube" and clicking 

two points to define the rectangle. 
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7. DataCAD now correctly stores the status of the "Ignores Clip Cube" setting on self-

XREFs that have their own XClips. 

Note: the "Ignore Clip Cube" setting for XREFs is a Subscription Edition feature. 

8. DataCAD now correctly stores the status of the "Ignores Clip Cube" setting on symbols 

that have S-Clips. 

9. Fixed an issue that would fail to set "GTV Link" to "On" when opening files from older 

versions in DataCAD 14 Subscription Edition. 

10. Using keyboard shortcuts to switch between GoTo Views and the Print/Plot menu could 

result in DataCAD failing to restore the correct XREF layers to the view. This has been 

corrected. 

11. Using the Entity Properties Editor to turn Line 1 or Line 2 off after creating an 

associative dimension with Lock Size enabled would result in the size of the dimension 

text changing. This has been fixed. 

12. Creating an associative dimension with Lock Size enabled, and then using the Entity 

Properties Editor to turn Lock Size off, would result in the dimension text changing size. 

This has been corrected. 

 

14.02.01 

Fixes 

1. Unchecking "Show Fill" in the "Smart Wall Hatch/Fill" section of the Reference File 

Manager could sometimes cause DataCAD to fail to print solid fill in Smart Walls in the 

host drawing in addition to the XREF. This has been corrected. 

2. Fixed a crash that could occur while exporting (to DXF or DWG) a drawing that 

included XREFs which contained KnockOut entities. 

 

14.02.00 

New Features 

1. Walls that are drawn on different layers now support the ability to have their 

intersections cleaned using the "T Intersect," "L Intersect," and "X Intersect" commands in 

the Cleanup menu. Layer Search must be toggled on for these to work. 

2. The option to ignore the drawing-level Clip Cube has been added to the [Ctrl] + Right-

click context menu for XREF entities. It is remembered on a per-XREF basis and is on by 

default. If you un-check this option, the XREF will obey the drawing-level Clip Cube; 
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when the Clip Cube is enabled, any portion of the XREF which is outside the boundary 

will be suppressed from the view. 

3. If the "GTV Link" in the Reference File Manager is set to "On," the status of the "Ignore 

Clip Cube" setting is remembered with the host-level GoTo Views in the drawing. 

4. The GTV Link feature now supports per-XREF highlighting in addition to the per-XREF-

layer highlighting that was previously supported. 

5. Area, Perimeter and Volume have been added to the list of information returned on the 

Coordinates/Hints toolbar when you "Identify" a bitmap. 

6. When you pick "Import" (and then either Replace or Merge) in the "Layers" menu to 

import a layer, the "Load from which file" dialog appears. The default name in the "File 

name" field is the same name as the layer, which is currently active in the drawing, and 

was previously limited to eight characters. This limitation has been lifted, and the 

function now supports long layer names. 

7. When an XREF is inserted with an enlargement factor, that same enlargement factor is 

now applied to the overshoot value for any objects in the XREF that have overshoot 

assigned by entity. 

8. The [Ctrl] + Right-click context menu has been enhanced to display new options when 

executed while the cursor is positioned over a blank space in the drawing area. 

a. Selecting "Paste" will paste the contents of the Windows Clipboard. 

b. Selecting "Paste Special" will open the "Paste Special" dialog enabling you to select 

from the available formats (if applicable) to paste the contents of the Clipboard. 

c. Selecting "Paste As Symbol" will enable you to paste the current contents of the 

Clipboard as a symbol in the drawing, provided the Clipboard contains DataCAD 

information. 

d. Choosing "Clipboard Select" invokes the Clipboard Selection mode so that you can 

choose information to Copy to the Clipboard. 

e. Selecting "Save all drawing symbols to a folder" enables you to save all symbols 

currently instanced in the drawing to a selected folder on your hard drive. 

Note: DataCAD will not save nested-level symbols or symbols which are no longer instanced. 

9. A "Prev. Line" option has been added to the Cleanup/1 Line Trim menu. It enables you 

to define a previously selected line as the trim-to line for the command. After choosing 

"Prev. Line," you then pick the outside of the line, and then proceed with choosing lines 

to trim. 
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10. An "Entity" toggle has been added to the "Mirror" menu which enables you to select a 

2D Line, 3D Line or Wall to act as the line of reflection. The status of this setting is 

remembered on a per-drawing basis. 

 

Fixes 

1. Zero thickness slabs are no longer allowed. Any routine which previously created a 

zero-thickness slab will now create a polygon instead. 

2. Corrected a DWG import issue that could result in an internal diagnostic fault error 

during import. 

3. Fixed a problem that could potentially draw entities in the wrong color when switching 

between GoTo Views with Multi-View Windows also opened. 

4. Selecting a saved Text Style that changes the status of the "Text Scale" toggle in the 

"Text" menu no longer causes DataCAD to close unexpectedly. 

5. Using the Entity Properties Editor to change which layer a symbol is inserted upon 

could sometimes change the rotation angle of the symbol. This has been fixed. 

6. Fixed an issue which caused incorrect drawing extents calculations when associative 

dimensions with text that does not fit between the witness lines was added and 

automatically placed in a rotated orientation by DataCAD. 

7. Repaired the ability to edit polylines that have been rotated off the ground plane while a 

Clip Cube is enabled. 

8. Turning off the display of hatching no longer turns off the display of associative 

dimensions that were created by the "Overall" command after completing a set of string 

line dimensions. 

 

14.01.02 

Fixes 

1. The "Status Panel" toolbar now updates the name of the current layer when you use the 

Layer Manager (with "Keep Layer Manager Open" checked) to change which layer is 

active. 

2. Using Change/More/Lock Size/Off on Smart Arrows correctly converts the arrowhead 

size to the real-world value. 

3. Using Mirror/AndCopy on a symbol that contains an associative dimension with a 

KnockOut applied now draw the dimension in the correct location. 
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4. Using the Entity Properties Editor to change the size of text now calculates the correct 

value. Note that the current status of the "Text Scale" toggle in the "Text" menu is no 

longer shown. If you wish to have DataCAD calculate the value based upon the current 

plot scale, you can check "Text Scale" in the "Font" dialog when you open it. 

5. Using the scroll wheel on your mouse to set the plot scale for a Multi-Layout detail no 

longer results in ghost images being left on the screen. 

6. Virtual, perpendicular object snap points are no longer being displayed when the 

"Virtual" option is turned off in the Object Snap menu. 

7. Repaired a display anomaly which occurs when turning a layer off for the first time 

during a drawing session, when the Symbol Browser is displayed, and the Dynamic 

Snapping hint and indicator are both turned off. 

8. Fixed the "Update" command in the "GoTo View" menu with respect to saving layer 

status, XClip status and boundary, and XREF layer highlight settings when "Remember 

Layer Status for GoTo Views" is checked in the Insert/Reference File Management pull-

down (Standard Edition) or "GTV Link" is set to "On" in the Reference File Manager 

(Subscription Edition). 

9. If the center line of a 3-line Smart wall were drawn in a color assigned to Pen 0 (non-

printing) in the Pen Table, and the wall cavities had solid fill assigned, the center line 

would print. This has been corrected. 

10. In some instances, DataCAD 14 would appear to hang when opening a file that was last 

saved in DataCAD 12 or prior, if the drawing contained a symbol with hatching inside it 

that was drawn at a dense scale, and the symbol was then inserted into the drawing 

enlarged. This has been fixed. 

11. Repaired the functionality of the 3D Change/Flip Normals command. Previously, this 

command only worked when accessed through the 3D Polygons/Edit/Flip Normal 

menu. 

12. If Symbol Scale and Lock Size were both on, and you tried to insert a symbol by 

snapping to a point other than the defined insertion point, DataCAD would place the 

symbol by the insertion point instead of by the selected point. This has been fixed. 

 

14.01.01 

Fixes 

1. The Layer Manager no longer creates duplicate layer names. Previously, you could 

create a new drawing and add a new layer named Layer002. If you made it active and 
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deleted Layer001, the created another new layer, it would also be named Layer002. It is 

now named Layer002(1). 

2. The "Layer Search" button was absent from the "3D Section" menu. This button now 

appears after defining the cut line but before beginning the process of cutting the 

section. 

3. If you changed the color of a layer while working in the Symbol Editor, DataCAD would 

fail to save the change. This has been corrected. 

4. Turning "Text Scale" on in the "Text" menu, and then opening the "Font" dialog and 

changing the size would result in DataCAD setting the wrong size after clicking OK to 

dismiss the "Font" dialog. This has been fixed. 

5. Slabs with more than 36 points are no longer exploded to polygons when you exit a 

drawing file. 

6. Using Copy/ToLayer with the "Layer Color" toggle enabled now changes the color of 

PText and MText entities. Previously, PText and PText entities would retain their 

original color. 

7. Perpendicular object snapping is no longer incorrectly identifying Virtual snap points 

when "Virtual" is toggled off. 

8. Selecting "Sheet" from the Print/Plot menu, and then returning to the main Print/Plot 

menu, selecting "Scale", and choosing a new scale would result in DataCAD changing 

the current text size setting if Text Scale were enabled. This has been fixed. 

9. Using Identify/SetAll on a text entity that had Lock Size off would turn Lock Size on for 

Smart Arrows. This has been corrected. 

10. A correction has been made to set active layer when the persistent layer manager is 

being used. 

 

14.01.00 

New Features 

1. The Layer Manager has new layer status indicators. If the layer name is drawn in black 

text, the layer is turned on. If the layer name is underlined, it is the current active layer. 

If the layer name is gray, the layer is turned off. If the layer name is red with a 

strikethrough, the layer is on and locked. If the layer name is gray and strikethrough, the 

layer is off and locked. 
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2. The toggle "Remember Layer Settings for GoTo Views" has been removed from the 

"Reference File Management..." menu in the "Insert" pull-down. The new option "GTV 

Link" has been added to the Insert XREF menu, the RFM, the XREF Properties dialog 

and the [Ctrl]+Right-click context menu for XREFs. This setting is remembered on a per-

XREF basis. 

Note: Even if this option is Off, the GTV links are still remembered for the XREF. However, the 

XREF's layers will not be toggled on and off in response to changing GTVs unless this option is 

subsequently toggled on. 

3. Added a "Current Color" option for Smart Arrows which will draw the arrow heads 

using the current layer color. 

4. Added a "Current Weight" option for Smart Arrows which will draw the arrow heads 

using the current line weight. 

5. Smart Arrow styles "Closed" and "Dot" may now be a KnockOut. 

6. If 1stOrtho is toggled On in Smart Arrows, Ortho Snapping is Off for subsequent legs of 

the leader. 

7. The new toggle named "WYSIWYG" has been added to the Plotter menu. This toggle is 

only available when "Pen Sort" is Off. When enabled, print order is the same as screen 

display order, resulting in "What You See Is What You Get." 

8. The following extended character codes have been added: 

1066# : Pen Sort On 

1067# : Pen Sort Off 

1068# : WYSIWYG On 

1069# : WYSIWYG Off 

9. The "1st Ortho" toggle in the Smart Arrows menu has been enhanced. When on, only the 

first segment of the Smart Arrow leader will be orthogonal, regardless of whether 

"Ortho Mode" is on or off in the "Tools" pull-down menu. Previously, if Ortho Mode 

were checked all segments of the leader would be drawn orthogonal; to draw only the 

first segment orthogonal, you had to turn 1st Ortho on and turn Ortho Mode off. 

 

Fixes 

1. The length of witness lines, and related position of dimension lines, for associative 

dimensions that have "Lock Size" enabled display has been updated for improved 

display when you change the current plot scale. 
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Note: This correction applies to new dimensions only. Dimensions in existing drawing files will 

need to be erased and redrawn to take advantage of this change. 

2. Corrected an inability to object snap to 2D lines inside of multiple instances of the same 

symbol that had been inserted and then rotated such that the lines intersected. 

3. Repaired a crash that would occur if you closed the Layer Manager while the layer name 

field was active, and then reopened the Layer Manager. 

4. When "RoundIt" is on in the DimStyle menu, and you change the current Scale Type, the 

rounded values of associative dimensions are more accurate. 

5. Manually placed associative dimension text that has Lock Size enabled now scales 

properly when you change the current plot scale. 

6. Fixed a crash that would occur when pressing [Ctrl] + [z] after opening the Layer 

Manager with "Keep Layer Manager open" checked. 

7. Pull-down and context menus which had sub-menus containing "Yes/No" or "On/Off" 

options have been removed. In their place, the setting name will have a check mark next 

to it for "Yes" or "On," and no check mark next to it for "No" or "Off." 

8. An issue that would inadvertently change the size of the boundary when converting an 

AutoCAD "Wipeout" to a DataCAD "KnockOut" while importing a DWG file has been 

corrected. 

9. MText and PText entities that have both Lock Size" and "KnockOut" enabled are now 

scaled correctly when exported to DXF or DWG format. 

10. Increased the amount of space available on the Coordinates/Hints toolbar to display 

information when using the Identify command. Previously, the information could get 

cut off. 

11. If "Text Scale" was on in the Text menu, and you changed the current plot scale while 

placing a detail on a multi-layout sheet, when you returned to the text menu the value 

for "Size" had changed. This affected the Text Style and Dim Style settings for associative 

dimensions as well. This has been corrected. 

12. Fixed an error changing the size of PText and MText entities that have Lock Size 

enabled. 

13. Using File/Save As in the Symbol Editor would prevent you from closing the Symbol 

Editor and choosing "Yes" to save the changes to the new symbol in the current drawing. 

This has been corrected. 
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14. Exploding a symbol which had "Lock Text Angle" on would place text that was inside 

the symbol in the wrong location. This has been fixed. 

15. Corrected issues related to object snapping to entities within XREFs. 

16. Setting "Increment" to zero when drawing string line associative dimensions would 

prevent the "Overall" option from appearing on the menu. This has been corrected. 

17. Exporting a file that contains associative dimensions with Lock Size enabled to 

DXF/DWG format now correctly scales the dimension text size and offset, tick 

marks/arrows, offset, overlap, and overrun. 

18. Saving a file that contains associative dimensions with Lock Size enabled to DataCAD 

X3, DataCAD 12 or DataCAD 11 format now correctly scales the dimension text size and 

offset, tick marks/arrows, offset, overlap, and overrun. 

19. If Lock Size was on in the Dimension/Linear/Text Style menu, and you used 

Identify/SetAll on an associative dimension that had Lock Size turned off, DataCAD 

failed to turn Lock Size off. This has been corrected. 

20. If a Smart Door with Unit Type "Garage" used a symbol for the 3D representation, the 

center point drawn in 2D plan view was incorrectly offset by 1 inch. This has been 

corrected. 

21. Repaired the ability to use [Ctrl] + [a] on the input line for Select All. This issue only 

affected Windows XP workstations. 22) Inserting a symbol that contains hatching with 

Lock Size enabled would result in the wrong scale for the hatching. This has been 

corrected. 

 

14.00.07 

Fixes 

1. If a drawing contained an XREF with an XClip, and had the drawing-level Clip Cube 

enabled, you were unable to object snap to entities in the XREF. This has been corrected. 

2. Restored the display of the dot in the "Dot" arrow style for classic arrows. 

3. The check mark indicator for KnockOut on the top-level of the [Ctrl] + Right-click 

context menu was not being displayed if "Border" was enabled. This has been fixed. 

4. A hatch boundary that was set to "No Outline" failed to function as a KnockOut. This 

has been corrected. 

5. Attempting to load a Smart Wall Type file that has the "Read-only" attribute checked 

would cause the drawing to crash. This has been fixed. 
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6. Attempting to save a Smart Wall, Door or Window Type file that has the "Read-only" 

attribute checked would cause the drawing to crash. DataCAD will now display the 

"Save As" dialog instead. 

7. Smart Arrows that used the "Dot" arrow style were being drawn at twice the defined 

size. This has been corrected. 

8. If a Smart Arrow used a symbol that contained a solid fill in the arrowhead, the solid fill 

failed to print. This has been fixed. 

9. Corrected an issue related to Symbol Scale not updating correctly when changing the 

plot scale. 

10. Adjusted the end cap display for Smart Walls that have solid fill, so that the cap on the 

strike side of a door is drawn on top of the fill. 

 

14.00.06 

Enhancements 

1. The "Fills" button in the Utility\Display menu, and the [F] button on the 

SWOTHLUDFBK toolbar no longer affects KnockOuts. Instead, you must use the [K] 

button on the SWOTHLUDFBK toolbar or the "KnockOut Display" option in the 

View\KnockOuts pull-down menu. 

2. The Symbol Browser no longer displays symbols in the current folder if DataCAD is 

open, but no drawings are open. 

3. The "Zoom Level" for the PText and MText editors is now remembered as a program-

level setting. 

 

Fixes 

1. Removed the "KnockOut" option from the [Ctrl] + Right-click context menu and the 

Entity Properties Editor for Smart Arrows, as this feature is not yet supported. 

2. Repaired a crash that would occur if you changed the enlargement factor of a KnockOut 

using the Entity Properties Editor, performed an Undo, and then erased the entity. 

3. The "Reset Timers" button in the Drawing Information dialog no longer resets to a 

negative value. 

4. Using the [/] key or the Zoom Window button on the Navigation Pad while in a nested-

level menu no longer requires an extra right-click to exit the menu. 
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5. The "Rotate" command now correctly rotates the XClip boundary of nested XREFs. 

6. Hatching in Smart Wall cavities is now drawn using the Solid line type instead of the 

line type assigned to the wall line. 

7. Exploding multiple symbols by Area would also explode any nested symbols within 

them. This has been corrected. 

8. Smart pocket doors now obey the Compatibility Mode toggle in the View\KnockOuts 

pull-down menu. 

9. Removed the "KnockOut" option from the [Ctrl] + Right-click context menu and the 

Entity Properties Editor for bitmaps and solid fills, as this feature is not supported. 

10. Fixed a crash that would occur after using the Entity Properties Editor to turn KnockOut 

on for an MText entity, and then choosing Undo. 

 

14.00.05 

Enhancements 

1. Added new drawing-level settings for the default X and Y Enlargement factor for 

KnockOuts on Text, PText, MText, Symbol Attribute Text and Associative Dimensions. 

The values for Associative Dimensions are separate from the values for the other text-

based entities. The menu buttons to access these settings are in the various entity 

creation menus, after toggling KnockOut on. 

2. Once an entity has been added to the drawing, the value of the X and Y Enlargement for 

the KnockOut is remembered (and can be changed) on a per-entity basis. 

a. To set these variables before adding the objects to the drawing, turn on KnockOut in 

the Text, PText, MText, Symbol Attribute Text or Dimension\Linear\Text Style 

menu. Click the "X Enlargement" and/or "Y Enlargement" button to set the value. 

Entities drawn after this point in time will use the values defined. 

b. To change the values of these variables on entities already in the drawing, use the 

Change\More\KnockOut menu, the [Ctrl] + Right-click context menu, or open the 

Entity Properties Editor for the object you wish to change. 

3. Added a check mark status indicator to [Ctrl] + Right-click context menus for items that 

have an On/Off status. 
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Fixes 

1. Using the "Partial" command in the Print\Plot menu no longer gets DataCAD stuck in 

dynamic pan mode. 

2. Solid Fill in Smart Walls now obeys the Print First/Print Last/In Order option in the Pen 

Table. 

3. Corrected an error in the value of Smart Wall hatch angle when saving a Wall Type file. 

4. DataCAD now draws the "Overrun" on associative dimensions correctly when "Lock 

Size" is enabled. 

5. DataCAD now draws non-associative dimensions using the correct color and weight for 

tick marks and/or arrows. 

6. Fixed an error reporting the Area measurement when the Scale Type was set to 

InchFrac. 

7. If a drawing was set to render by layer, no material was assigned to the layer, and the 

current color was set to something other than the default, when you exported to 

SketchUp, DataCAD would assign the wrong rendered color. This has been corrected. 

 

14.00.04 

Enhancements 

1. Smart Wall hatching and fill in XREFs now supports highlighting. 

2. Added the ability to selectively show or suppress hatching and solid fill in Smart walls 

in XREFs. This setting is remembered on a per-XREF basis. It is found in three places: 

a. In the Insert\XREF menu, the "Wall Hatch" and "Wall Fill" menu buttons control 

whether hatching and solid fill inside of an XREF is shown. 

b. In the Reference File Manager, the "Show Hatch" and "Show Fill" checkboxes in the 

"Smart Wall Hatch/Fill" section control whether hatching and solid fill inside of an 

XREF is shown. 

c. In the [Ctrl] + Right-click context menu, the XREF Tools\Smart Wall Hatch/Fill 

setting defines whether hatching and solid fill inside of an XREF is shown. 

3. In the Reference File Manager, the "Inherit current Smart Wall Hatch/Fill setting" 

controls whether nested XREFs use the highlight settings of their host. This option is 

also in the Insert\Reference File Management drop-down menu and is remembered in 

the top-level drawing. 
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4. When a Check Plot printer is selected in the PrintPlot\Setup dialog, the Quick Layout 

box is displayed in dashed red lines. Similarly, the Multi-Layout page extents and detail 

borders are also displayed in dashed red lines. When the primary printer is selected, 

they are shown in white. 

5. Added an "All Caps" check box to the PText and MText entry dialogs. 

 

Fixes 

1. The text box for dimension text is now shown when using Change\Dimensions\Text 

Pos on an associative dimension that has Lock Size enabled. 

2. Corrected an issue related to exporting models with XREFs to SketchUp. 

3. Objects drawn in a color assigned to Pen 0 (non-printing) that are inside an XREF or 

Symbol would be printed when Pen Sort was turned off. This has been fixed. 

4. The dimension text in an associative dimension that has KnockOut enabled no longer 

obscures the dimension line. 

 

14.00.03 

Enhancements 

1. The layout of the Layer Manager has been adjusted to provide a smaller minimum 

width. 

2. Added "KnockOut= Yes/No" to the list of information returned on the Coordinates/Hints 

toolbar when Identifying an entity that supports KnockOuts. 

3. Added a DCADWIN.ini key to disable dynamic panning via left + right mouse buttons. 

[General] Left+Right Mouse Button Panning=FALSE 

4. Added the ability to suppress Smart Wall Hatch and Fill within XREFs. Toggles have 

been added to the Property dialog as well as the [Ctrl]+Right-click context menu under 

"XREF Tools". These are on a per-XREF basis. 

 

Fixes 

1. Exporting to DWG format with "XREFs" set on "Bind to Symbols" no longer clears the 

Undo buffer. 

2. Fixed a crash that would occur after deleting the edge of a polyline SClip (symbol 

clipping boundary) or XClip (XREF clipping boundary). 
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3. Opening and dismissing the Entity Properties Editor for a Smart Wall segment that 

contains a solid fill no longer clears the display of the fill. 

4. Updated the version references in the Windows Extended File Information tooltip. 

5. Creating a Smart Arrow with a dot arrowhead and whose leader is an arc drawn 

counter-clockwise now draws the arc correctly. 

6. Opening the Object Viewer via a keyboard shortcut added to the dcadwin.mnu file no 

longer causes DataCAD to crash. 

7. The following commands are no longer supported when editing a polyline SClip 

(symbol clip) or XClip (XREF clip) boundary: Del Edge, Push Pull, Close, Poly to Line, 

Line to Poly, and Toggle Cover. 

8. Using the "Wall Line X" setting for "Fill Color" in the "Settings" section of "Fill 

Properties" on the "2D Cavity Settings" tab of the Wall Type Manager now matches the 

correct wall line. 

9. Moving MText and PText entities that have KnockOut on, and Border displayed no 

longer causes the border to temporarily disappear. 

10. The KnockOut (and Border) no longer require a screen refresh if you add MText or 

PText entities to the drawing with KnockOut (and Border) turned on. 

11. Repaired a problem loading DataCAD 12 dimension style files that had Text Scale 

enabled. 

 

14.00.02 

Enhancements 

1. After clicking "Apply" in the Reference File Manager, the "Layer Control" and "GoTo 

View" lists retain their scroll position. 

2. Added a toggle for KnockOuts in the Architect menu (while Auto 3D is on). When on, 

node numbers also have KnockOuts. 

3. Added a "Sizeable" check box to the Entity Properties Editor dialog. When checked, you 

can click and drag the dialog by a corner to resize it. 

 

Fixes 

1. Corrected the display of smart walls that contain windows with overlapping jambs in 

the Object Viewer. 
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2. Associative hatching is no longer duplicated in the hidden line removal result in 3D 

views that also contain symbols. 

3. If a smart arrow consists only of a curved segment and arrowhead, the leader uses the 

color defined for the arrowhead instead of the current color. This has been corrected. 

4. After inserting a symbol that has a text attribute, holding the right mouse button would 

enable dynamic panning. This has been fixed. 

5. Using the Entity Properties Editor to turn Lock Size on for an MText entity resulted in 

changing the text size without changing the plot scale. 

6. Corrected the double printing of 2D curves. 

7. If a polyline were drawn in a color that was set to Pen 0 (non-printing) in the Pen Table, 

it would be printed anyway. This has been corrected. 

8. Setup now recognizes customization of lines 1776 and 1777 in dcadwin.msg. 

9. Text insertion points no longer print on PText entities. 

10. Opening the Entity Properties Editor for a symbol that had Lock Size enabled would 

change the size of the symbol. This has been fixed. 

11. Clicking and holding the right mouse button no longer invokes dynamic panning after 

using the Change/Text/Contents function on PText entities. 

12. Turning dimension witness lines off via the Change menu no longer turns off display of 

tick marks. 

13. Fixed a problem exporting to SketchUp format. 

 

DataCAD 14 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 14, please click: 

What's New? from the Help pull-down menu in DataCAD. 

New Features 

1. A new "KnockOut" attribute can be applied to text, MText, PText, associative 

dimensions, 2D arcs and circles, ellipses, polylines, 3D polygons and slabs. The 

KnockOut masks entities behind it with a "transparent" solid fill. 

2. Hatching and SPB fills can now be applied to smart wall cavities. 



172 | DataCAD 14 

DataCAD 14 New Features and Enhancements 

3. Associative dimensions now support the "Lock Size" feature that automatically re-sizes 

them when you change your plot scale. The result is that the dimensions are always the 

same size on the printed page, even if you change the plot scale. 

4. Symbols now support the "Lock Size" feature that automatically re-sizes them when you 

change your plot scale. The result is that the symbols are always the same size on the 

printed page, even if you change the plot scale. 

5. Hatching now supports the "Lock Size" feature that automatically re-sizes it when you 

change your plot scale. The result is that the hatching always the same scale on the 

printed page, even if you change the plot scale. 

6. The ability to save the status of XREF layers with a GoTo View in the host drawing has 

been enhanced to include the highlight settings on the layers in the XREF. 

7. The ability to save the status of XREF layers with a GoTo View in the host drawing has 

been enhanced to include XClip boundaries. 

8. The maximum number of vertices on 3D slabs and polygons has been increased from 36 

to 256. 

9. The maximum number of primary and secondary divisions on cylinders, cones, spheres, 

tori, and revolved surfaces has been increased from 36 to 128. 

10. XREF and symbol clipping boundaries may now be edited without having to re-draw 

the boundary. The standard polyline editing commands are used. 

11. The Pen Sort button in the Print/Plot menu controls whether the Pen Assignment order 

(when on) or the layer order (when off) is used to determine the order in which objects 

are drawn on the printed page. 

12. The File/Export/SketchUp command now supports saving to SketchUp 7 and SketchUp 

8 formats. 

Enhancements 

1. Manual X-, L- and T-Intersection routines have been updated. After selecting the walls 

to clean, you will now select the "master" wall. The other wall will butt up against the 

master wall. 

2. New DCADWIN.ini keys: 

[General] 

LayerColorRemembersStatus=TRUE 

When FALSE, the Layer Color toggle in the Move/To Layer command will always 

default to off. 
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[Hardlock] 

Look For Network Hardlock=FALSE 

When TRUE, DataCAD will search the local network for a hardlock if one is not found 

on the local parallel or USB port. When FALSE, DataCAD only searches the local parallel 

and USB ports. 

3. Click and hold both the left and right mouse buttons at the same time to enable dynamic 

panning of the drawing area. 

 

Fixes 

1. Changing the page size in the Plotter/Setup dialog now immediately changes the grid 

which represents the page. 

2. True Type Font text inside XREFs appears in the correct location in the Sun Shader. 

3. The elevation value for the ground plane in the Sun Shader is now absolute. Previously 

it was relative to the model. 

4. If the Sun Shader is configured to display the compass, it is now shown on the ground 

plane regardless of the elevation value. 

5. Changing the North angle in the Sun Shader no longer results in an incorrect calculation 

of the model extents while in perspective viewing mode. 

6. Repaired a delay that occurred when turning layers on an off in the Layer Manager 

while "Keep Layer Manager open" is checked. 

7. Repaired the "Font Search" option when masking text and selecting a PText entity. 

8. The status of Orthomode is now recognized when inserting a Smart door or window. 

This enables you to use Direction/Distance input when placing a variable-width 

opening. 

9. The Sun Shader now uses the correct North angle when "Use DataCAD's North" is 

checked. 

10. If you exported a file to DWG format, the file contained an XREF on a locked layer, and 

the translator was set to bind the XREFs to symbols, after the export was complete the 

symbol would remain on the layer. This has been corrected. See 

http://forum.datacad.com/viewtopic.php?f=41&t=11815 for a more detailed description. 

11. Undoing the process of exploding MText no longer displays the text in the wrong font. 

http://forum.datacad.com/viewtopic.php?f=41&t=11815
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12. Using the Change/To Style command in the Dimensions menu no longer applies a fixed 

increment to the changed dimensions. 

13. Corrected an issue related to material opacity when exporting a file to SketchUp format. 

14. The "Purge" button in the Line Type Manager no longer purges line types that are only 

used in symbols. 

15. The "Purge" button in the Hatch Pattern Manager no longer purges hatch patterns that 

are only used in symbols. 

16. Corrected an error that could result in invalid data in the "Background" field of the 

Rendering Settings dialog. 

17. Repaired the ability to export to DWF format. 

18. Lines that have an endpoint which is coincident with a polygonal clip boundary will 

now be clipped properly. 

19. Loading a Layer Set into a drawing that contains named MSP Sheets no longer 

overwrites the names of the sheets. 
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DataCAD X3 

13.06.03 

Fixes 

1. Enabled "DataCAD X3 Lab" Educational License type. 

 

13.06.02 

Fixes 

1. An error that would cause the softlock edition of DataCAD to require the presence 

hlvdd.dll has been corrected. 

 

13.06.01 

Fixes 

1. If you installed the update to 13.06.00 from any previous version of DataCAD 13, the 

"Check for update" feature would not work for future updates. This has been corrected. 

2. A mathematical error that could cause the Hidden Line Removal process to sometimes 

fail has been fixed. 

 

13.06.00 

Enhancements 

New Softlock Option 

DataCAD is now available with a software-based license management option in lieu of the 

hardware-based USB license key. For more information, please contact Sales and Customer 

Service at (860) 217-0490 or info@datacad.com. 

Fixes 

1. Smart Objects are now shown in the correct location in the Object Viewer when the 

drawing contains a Clip Cube and the current view projection is Isometric. 

2. MText and PText entities inside a symbol no longer disappear when a Clip Cube that 

encloses them is enabled. 

3. Corrected a problem that would cause filled dots on non-associative dimensions to 

disappear after a screen refresh. 

4. Fixed a delay that could occur when turning layers on and off in the Layer Manager. 

mailto:info@datacad.com


176 | DataCAD X3 

13.05.01 

5. The Text Mask/Font Search option now works on PText entities. 

6. Drawing variable-width Smart doors and windows now adheres to the current state of 

the Orthomode setting, enabling you to use Direction/Distance. 

 

13.05.01 

New Features and Enhancements 

AutoCAD R2010 – R2012 Compatibility 

DataCAD 13.05.01 adds support for importing and exporting AutoCAD R2010 through R2012 

files in DXF and DWG format. This enables you to collaborate and share files with associates 

who use the latest versions of AutoCAD. 

1. Optimized Multi-View Windows to improve speed when [Ctrl] + [Tab]bing between 

drawings. 

2. Added options to "Obey Clip Cube" or "Ignore Clip Cube" under "Clipping" in the [Ctrl] 

+ Right-click context menu for associative dimensions. 

3. Added options to "Obey Clip Cube" or "Ignore Clip Cube" under "Clipping" in the [Ctrl] 

+ Right-click context menu for symbols. 

4. You may now object snap to the intersection of entities in a symbol and that symbol's S-

Clip boundary. 

5. If you enable "Changes plot scale if TxtScale is on," located in the "PgUp/PgDn in Text 

Menu" section of the "Misc" tab of Program Preferences, and Text Scale is also on in the 

Insert/Stamp menu, you may now use the [PgUp] and [PgDn] keys on the keyboard to 

change the current plot scale while inserting stamp. 

6. Added a new "Extents" button to the Multi-Layout/Layout menu. When in Layout 

mode, you may turn this button off to see the drawing information while placing the 

detail, rather than seeing just the extents box. 

 

Fixes 

1. Corrected an error that could cause DataCAD to crash while exporting a file to DWG, 

with the XREF options "Bind to Symbols" and "Self-XREFs Only" enabled. 

2. Fixed an incorrect "This layer is locked" message on the "Attention" toolbar while 

exporting files that contain filled Smart arrows to DWG. 

3. When exporting a file that contains Smart arrows to DWG format, the arrows would end 

up on the layer "0." They now remain on their original layer. 
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4. When you are working in the Symbol Editor, if the Symbol Browser is currently 

browsing the folder which contains the symbol you are editing, you may no longer 

right-click on that symbol in the Symbol Browser. This prevents you from inadvertently 

inserting of a self-referencing symbol. 

5. Exporting a file that contains orphaned XREFs to DWG format would cause the drawing 

to close with no error message. This has been corrected. 

6. Additional modifications to the Sun Shader to prevent "Internal Diagnostic Fault" errors. 

7. Corrected a crash that would occur when adding Smart doors or windows, or when 

exiting the Print/Plot menu if "Node Markers" was turned off in the "Architect" menu 

(with Auto 3D enabled). 

8. Fixed a problem which would cause a delay when exiting the Print/Plot menu. 

9. You may no longer select an undefined custom color for the drawing area background 

color. 

10. Hatching that has "Lock Scale" off, and that is inside a symbol, would change its scale if 

you enlarged the symbol. This has been corrected. 

 

13.03.02 

New Features and Enhancements 

SketchUp 8 Compatibility 

Added support for SketchUp version 8 files. 

1. There is a new Plot Scale stamp (@PLOTSCALE) which allows for multiple variations. 

The following are examples of entries added to the [Stamp] section on the INI file: 

PLOTSCALE_1MenuText=Plot Scale 1 

PLOTSCALE_1=Scale: @PLOTSCALE = 1'-0" 

PLOTSCALE_2MenuText=Plot Scale 2 

PLOTSCALE_2=This is the current plot scale: @PLOTSCALE 

2. The Insert/Stamp function now supports Text Scale and Lock Size. 

3. [Ctrl] + Right-click/XREF Tools context menu for XREFs has option to disable dynamic 

snapping on a per-XREF basis. 

4. If you change the name of a layer in a file which contains a self-XREF, the name of the 

layer in the self-XREF changes immediately and retains the On/Off status. 

5. Added support for Change/Text/Alignment on MText and PText entities. 
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6. Added the ability to turn the display of node markers for Smart walls, doors, and 

windows on and off via the "Node Markers" button in the Architect menu (when Auto 

3D is on). 

7. Added an "Explode" button to the PText and MText menus to explode paragraph text 

and multi-line text entities to single line text entities using the standard selection menu. 

8. Expanded the "Performance" section of the "Options" dialog in the Sun Shader. The 

"Rendering method during Pan/Zoom/Rotate" may now be set to "Render as wireframe," 

"Render with entity colors" or "Render with materials." The value for this setting is 

remembered on a per-drawing basis. 

 

Fixes 

1. MText entities which contain words of different sizes now export to DWG correctly. 

2. Added "SketchUp Files (*.skp)" to the supported file types in the "Redefine" command 

for XREFs. 

3. If the Object Viewer were set to use a bitmap for the background, selecting 

"Background" from the right-click context menu would open the wrong dialog. This has 

been fixed. 

4. Repaired the ability to turn "Dynamic Flip" on in the Insert/Symbol menu when 

"Explode" is on and "Lock Angle" had previously been turned on. 

5. Loading a Smart door which uses a symbol for either the door or the knob after loading 

a Smart wall which has a material that uses a texture assigned to one or more of the wall 

lines would result in DataCAD displaying the wrong material to the door or knob. This 

has been corrected. 

6. Pasting a symbol from the Clipboard with Max Lines set to 1 would result in an 

incorrect extents box. This has been fixed. 

7. You may no longer use the [Ctrl] + Right-click/XREF Tools/Bind/On Layers or To 

Symbol menu option on an XREF which has no layers displayed. Doing so previously 

created an invalid symbol. 

8. Under some circumstances, exporting a file to DWG format with "Bind to Symbols" and 

"Self-XREFs Only" checked in the XREFs section off the File/Export/DWG dialog would 

result in left-over symbols of the self-XREFs in the drawing. This has been corrected. 

9. The text box which appears when using Change/Dimensions/Text Pos now correctly 

represents the size of the text being moved. Previously, it did not obey the current "Sig 

Digits" setting from the Scale Type menu. 
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10. The Save As/DataCAD 12 command no longer removes PText entities from the drawing. 

11. Repaired the "Text Search" option in the Mask/Text Mask command. 

12. An error that would prevent the Sun Shader from running if certain Microsoft DLLs 

were not found has been corrected. This update installs the Microsoft Visual C++ 2005 

Service Pack 1 Redistributable Package ATL Security Update. 

13. When pasting a Smart arrow from the Clipboard with an enlargement factor other than 

1, the arrowhead was not scaled properly. This has been fixed. 

 

13.02.00 

Enhancements 

1. The Sun Shader now supports perspective viewing. Click the toolbar button labeled 

'Perspective Projection,' or choose 'Perspective' in the 'View' pull-down menu to enable 

this viewing mode. 

2. Related to support for perspective viewing, the Sun Shader has toolbar buttons to 

increase and decrease the field of view. 

3. The Sun Shader has a new 'Fixed distance' toggle in the 'View' pull-down menu. It 

performs the same function as in the Object Viewer; when off (default), increasing or 

decreasing the field of view will result in a change to the distance between the eye and 

focal points. When on, the distance between the eye and focal points remains fixed, 

causing the increase/decrease field of view buttons to operate more like a zoom lens on a 

camera. 

4. There are two new extended character codes: 

(V= in toolbar button, or 10XX# in keyboard macro) 

1054# : Smart Arrows ON 

1055# : Smart Arrows OFF 

5. When working with a *.shx font in the MText editor, the Bold and Italic icons are now 

enabled. 

 

Fixes 

1. You are now able to toggle 'Orthomode' on and off via the [o] key on the keyboard while 

drawing a curved leader. 

2. Lines drawn immediately after text are no longer grouped with the text. 
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3. The 'Message Toolbar' now displays the correct message while in the 'Push/Pull' sub-

menu of the Curves/Polyline/Edit menu. 

4. Using the scroll wheel on your mouse to zoom in or out while in Quick Layout mode 

would cause DataCAD to close the drawing after placing the layout box and clicking 

Print/Plot. This has been corrected. 

5. When 'Auto 3D' is off, pressing [Shift] + [\] while in the 'Architect' menu will now 

update the status of the 'Cap' menu button accordingly. 

6. The ability to select an existing polyline as an XClip boundary has been restored. 

7. The 'Bind to Symbols' option in the 'XREFs' section of the File/Export/DWG dialog now 

places information on the original layers instead of layer 0. When you import the DWG 

back into DataCAD (or open it in AutoCAD), the original layers inside the XREF (which 

is now a symbol) are accessible. 

8. Editing Multi-Layer symbols using the Symbol Editor would result in duplicate layers, 

each containing a single entity. This has been corrected. 

9. Multi-line, center-justified paragraph text created in DataCAD 12 now displays correctly 

in DataCAD X3. 

10. MText which contained italicized True Type Font text followed by SHX text would fail 

to wrap correctly. This has been corrected. 

11. Corrected a problem related to displaying the correct extents of symbols which contain 

nested symbols in the Symbol Browser. 

12. Repaired the ability to set Max Lines to 1 to view an extents box when inserting a 

symbol which contains nested symbols. 

13. Geographic locations in the time zone of UTC -6 will now display the correct time zone 

information in the Sun Shader. 

14. If an XREF contained associative dimensions whose text was drawn in a True Type Font, 

the dimension text would fail to display. This has been fixed. 

 

13.01.00 

Enhancements 

1. The status of the "Do Float" toggle in the Settings/Scale Type menu has been separated 

from the "Do Float" setting in the Measure/AreaPerim/Scale Type menu. 

2. Added the ability to object snap to Smart Arrow leaders. 
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3. Added "Total Leader Length" to the list of information returned by the Identify 

command when you select a Smart Arrow. It is displayed on the Coordinates/Hints 

toolbar. 

4. Added support for "Show/Hide," in the Curves/Polyline menu, on Smart Arrow 

segments. 

5. DataCAD will now prompt you with a default name when you select "Paste As Symbol" 

from the "Edit" pull-down menu. 

6. Increased the width of the "Location" drop-down In the Sun Shader's "Options" dialog so 

that it adjusts automatically to display the longest name. 

7. The name of a Multi-Layout Detail that is linked to a GoTo View is now displayed in 

green on the menu button. In addition, the text on the Coordinates/Hints toolbar will 

indicate that the detail is linked to a GoTo View when you mouse over the menu button 

with the detail name. 

8. Added the new "Del Entities" button to the Redefine Symbol menu. 

9. The "Animation Speed" for the Sun Shader may be customized by entering a value (in 

milliseconds) into the “Delay between frames” field.  This controls the delay between 

frames when you click the “Play” icon on the Shadow Study toolbar. 

10. A new option has been added to define the North angle.  You can either use DataCAD's 

North direction, or you can define a custom North angle.  A visual compass may also be 

displayed on the ground plane.  These settings are available on the "Shadows" tab of the 

Sun Shader "Options" dialog. 

 

Fixes 

1. The Sun Shader supports material assignments in XREFs. 

2. The Sun Shader places XREFs at the correct coordinates and uses the correct material 

assignments on Smart entities. 

3. The Sun Shader stores the correct location between sessions. 

4. If the Symbol Browser is set to browse symbols in the drawing, it now updates when 

you use the Insert/Symbol command to insert new symbols. 

5. When "Text Scale" is on in the "Text" menu, "Changes plot scale..." is checked in the 

"PgUp/PgDn" section of the Misc tab of Program Preferences, and you go into the 

Arrows menu, the [PgUp] and [PgDn] keys on the keyboard now change the current 

plot scale. 
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6. DataCAD recognized erroneous object snap points near enlarged symbols which 

contained circles. 

7. Corrected a conflict with material assignment by layer inside a symbol when the same 

layer name exists in the host drawing. 

8. Corrected a display issue which occurred when previewing a Smart wall type that did 

not have any materials assigned immediately after loading one that did. 

9. DataCAD now saves the correct version identification number in the drawing file header 

when saving backward to DataCAD 12 format. 

10. Fixed an error that would occur when attempting to save a file which contains a Smart 

arrow with a curved segment back to DataCAD 12 or earlier format. 

11. When pasting a text entity from the Clipboard, the status of the "Fix Text" toggle was 

being ignored. 

12. DataCAD failed to recognize the "Ignore Clip Cube" setting on SymAtr entities. 

13. The extended character code for Set Texture Origin now works correctly. 

14. The [OK] and [Cancel] buttons now display correctly on the “Search and Replace” 

dialog when Windows is set to use “Large Fonts.” 

15. Pressing [Enter] on the keyboard while the “Search and Replace” dialog is displayed is 

the equivalent of clicking [OK]. 

16. Fixed an error moving some instances of circles, arcs, and solid fills by area. 

17. Fixed an error removing classic doors and windows from walls. 

18. Corrected a problem with the “Edit/Customize Symbol Attributes” dialog. 

19. Batch Plotting GoTo Views in a drawing that contains XREFs, and that is set to 

remember the XREF layer settings in GoTo Views no longer results in the XREF layers 

being turned off at the end of the process. 

20. Using Undo after erasing a Smart arrow would result in the arrow being restored with 

no arrowhead.  This has been fixed. 

21. The Stretch/AndCopy function would duplicate information that was not included in 

the Area selection box.  This has been corrected. 
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DataCAD X3 New Features and Enhancements 
For details on the new features and enhancements to DataCAD X3, please click: 

What's New? from the Help pull-down menu in DataCAD. 

 

New Features 

Sun Shader 

A new, OpenGL-based Sun Shadow rendering window provides you with sun angle and 

shadow data based on date, time, and location.  A three-dimensional representation of the path 

of the sun across the sky from sunrise to sunset can also be displayed around your model for 

illustrative purposes.  You can save individual views out to various image formats or combine 

them into a time-lapse animation. 

Persistent Layer Manager 

The Layer Manager may now remain open while working in your drawing.  This is particularly 

helpful if you have more than one monitor connected to your computer.  Open the Layer 

Manager in your drawing and place a check in the box next to "Keep Layer Manager Open" to 

enable this feature.  You must restart DataCAD before the setting will take effect.  This is a 

global setting that affects the program operation in all drawings. 

Smart Arrows 

DataCAD supports the ability to add curved leaders on arrows.  It will also automatically adjust 

the orientation of the leader line to match the angle of the arrowhead if you stretch one end.  

You can now specify a symbol to be used as an arrowhead.  Arrows can be drawn by selecting 

either the head or tail end first.  New arrowhead options are available in the 

Change/Text/Arrows menu and in the Entity Properties Editor. 

1. DataCAD now supports the ability to rename Multi-View Windows.  If a GoTo View is 

read into a MVW, it automatically uses the same name. 

2. Added "Favorites" and "Recent Folders" to the folder icon pull-down menu on the 

Symbol Browser. 

3. Layers within symbols may now be assigned 2D and 3D view dependency.  Open your 

symbol using the Symbol Editor, and then launch the Layer Manager to access this 

feature. 

4. Layers within symbols may now be assigned minimum and maximum scale 

dependency, for both view scales and print scales.  Open your symbol using the Symbol 

Editor, and then launch the Layer Manager to access this feature. 

5. Text size may now be defined at a fixed, real--world size, independent of print scale.  

Text which has this property will change its relative size as you change your print scale, 



184 | DataCAD X3 

DataCAD X3 New Features and Enhancements 

resulting in printed text that is always the same size.  Symbol Text Attributes and 

Arrows are also supported. 

6. There are new extended character codes that can turn Lock Size on and off in the Text 

menu (V= in toolbar button, or 10XX# in keyboard macro): 

1048# : Lock Size ON 

1049# : Lock Size OFF 

7. The Lock Angle option in the "Ins Symbol" menu will keep text inside a symbol locked 

to the angle at which it was created, regardless of the rotation angle of the symbol. 

8. Added a "Flip Normal" option to the 3D Polygons/Edit menu.  This option reverses the 

direction of the polygon normal. 

9. A new "Normal Up" option in the 3D Polygon/Horizontal and Rectangle menus controls 

the direction of the polygon normal.  When "Normal Up" is on, the polygon normal faces 

out of the screen, regardless of the order in which you select the points that define the 

polygon. 

10. The On/Off status of layers inside an XREF may now be linked to GoTo Views in the 

host drawing. 

11. Added a "Hide" option to the [Ctrl] + Right-click/XREF Tools context menu.  This 

operation performs a hidden line removal on the current projection of the XREF and 

saves the result as a symbol.  "Unhide" and "Update hide" options are available on the 

[Ctrl] + Right-click menu of the resultant symbol. 

12. The On/Off status of layers in Multi-Layout Details may now be linked to the GoTo 

Views that were used to create them.  If you use the "Update" command in the GoTo 

View menu to update the view definition, any Multi-Layout Detail that is linked to the 

GoTo View will update as well. 

13. Added "Hide GTV" button to the 3D Hide menu.  This operation performs a hidden line 

removal on the selected GoTo Views and adds the results as symbols in the drawing.  

An "Update Hide" option is available in the [Ctrl] + Right-click/Symbol Tools menu of 

the resultant symbol. 

14. Polylines may now be rotated off the ground plane using the 3D Rotate command.  

Hatching and solid fill are supported. 

15. The 3D Object Viewer interface has had several new toolbars added to improve ease of 

navigation.  In addition, the 3D Object Viewer now supports saved views, like GoTo 

Views in DataCAD. 
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Enhancements 

1. The File/Save As dialog has been updated to include DataCAD 12 and DataCAD 11 AEC 

file formats in the "Save As Type" drop-down field. 

2. The Change/Match/More menu can now match a Smart entity's Type. 

3. Added "Creation Method" to the Entity Properties Editor for Smart doors and windows.  

Valid settings are "By Sides" and "By Center." 

4. Added support for SketchUp version 7 files. 

5. The Measure\PntToPnt and Measure\Line commands now return Length, Run, Rise 

and Angle measurements, all of which can be added To Drawing. 

6. Added the ability to select Smart walls for "Line" and "Line Angle" measurements. 

7. New toolbar codes to set the On/Off status of dimension witness lines: 

(V= in toolbar, or 10XX# in keyboard macro) 

1044# : Suppress witness line 1 = TRUE 

1045# : Suppress witness line 1 = FALSE 

1046# : Suppress witness line 2 = TRUE 

1047# : Suppress witness line 2 = FALSE 

8. DataCAD no longer exits "Entity" mode in the Dimension/Linear menu until you right-

click or choose "Exit." 

9. Added support for Smart walls, doors, and windows to "AutoDim" mode in the 

Dimension/Linear menu. 

10. Added a key to DCADWIN.ini to omit the leading zero from associative dimensions of 

less than one meter. 

[General] 

Meters Show Leading Zero=TRUE 

Set this to FALSE to remove the leading zero.  For example, a dimension of 0.65m would 

become .65m instead. (01249) 

11. Updated "Move drawing to origin" mechanism for importing DWG files. 

12. A "View Dependency" toggle has been added to the View pull-down menu to 

enable/disable display of view dependent layers within symbols. 

13. View Dependency toolbar codes (V= in toolbar, or 10XX# in keyboard macro): 
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1042# : View Dependency ON 

1043# : View Dependency OFF 

14. Options for Obey/Ignore Clip Cube, Fix Text and Text Scale have been added to Symbol 

Text Attribute (SymAtr) entities. 

15. Added "Scale" and "Rotation" options in the Entity Properties Editor for symbols, XREFs 

and quadrics. 

16. A new “GoTo View Hyperlink” field has been added to the Entity Properties Editor.  If a 

GoTo View is hyperlinked to the selected entity, it will display here.  You may also use 

the drop-down list to choose a GoTo View from the drawing to link to the selected 

entity. 

17. Added "By Points" option to "CalDist" in the "Enlarge" menu.  When this option is 

toggled on, you click two points to define the known distance, then click two more 

points to define the new distance. 

18. When "Symbol Scale" is on in the "Ins Symbol" menu, a new trap door to the "Plot Scale" 

menu has been added. 

19. Enabled "Nearest" object snapping for 3D entities. 

20. Added "By Center" option to the "Ins Symbol" menu which enables you to insert 

symbols by the center of their extents, excluding the insertion point. 

21. Added "Paste as Symbol" to the "Edit" pull-down menu for pasting information from the 

Windows Clipboard. 

22. The "Clipboard Select" command has a new "By Center" option that is available when 

"Ins Point" is toggled on.  It will automatically calculate the center of the extents of the 

selected entities when you copy the information to the Clipboard.  If you later use the 

Edit/Paste As Symbol function, the symbol insertion point will be set to the center of the 

extents of the entities, rather than absolute zero. 

23. There is a new "DelEnts" option to the Save Symbol menu.  When turned off, the entities 

that you select to be saved into a symbol are no longer deleted from the current 

drawing. 

24. A "Save As" option has been added to the Symbol Tools context menu.  You can [Ctrl] + 

Right-click on a symbol in the drawing, mouse over "Symbol Tools" and then select 

"Save As" to save a copy of the symbol to a folder on the hard drive. 

25. Added the ability to Load, Edit and Save the "Decimals" file, Dcadwin.dec, via the 

Utility/Settings/EditDefs menu. 



DataCAD X3 | 187 

DataCAD X3 New Features and Enhancements 

26. The View/Rendering/Texture Origin pull-down menu has new options that enable you 

to “Show” and “Clear” the texture origin of entities in your drawing. 

27. There is also a new extended character code for Set Texture Origin (V= in toolbar button, 

or 10XX# in keyboard macro): 

1052# : Set Texture Origin  

28. There is a new “Layer Color” toggle in the Move/To Layer and Copy/To Layer menus.  

This option appears after you select the destination layer.  When enabled, the selected 

entities will inherit the color currently assigned to the destination layer. 

29. Béziers and B-spline curves may now have up to 20 control points.  The previous limit 

was 8.  They also support unique Z-Base and Z-Height settings. 

  

Fixes 

1. Corrected an error which would temporarily add a duplicate Text Style to the list each 

time you updated the current style's settings. 

2. The symbol browser failed to observe the "View Isometric" setting for a symbol folder if 

the current drawing was set to display symbols in the drawing when you created a new 

file.  This has been corrected. 

3. A bug in the Bind Material function, found in the InsSymbol menu as a sub-option of 

Explode, and in the Save Symbol function, made it impossible to assign rendering 

materials by color, and have the assignments affect entities inside symbols if the symbol 

originally had material assignments by layer.  This has been fixed. 

4. The state of the active button in the Curves/Polyline/Edit menu is no longer carried over 

from one drawing to the next when you open multiple files without exiting DataCAD. 

5. The "Do Hatch" option that appears in the Line Type/Overshoots menu when "Globally" 

is enabled now works correctly. 

6. If both "Cutout" and "In Wall" were turned off in the Classic Architect/Windows menu, 

the "One Layer" and "Any Layer" search options did not display in the Smart Windows 

menu.  This has been corrected. 

7. Change/Text/All Caps failed to operate on PText entities.  This has been fixed. 

8. The "Save Image" function now recognizes symbols contained within a Clip Cube in 3D 

views. 
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9. Corrected an error importing a DataCAD drawing which contains symbols that would 

fail to include all symbols in the file. 

10. Deleting vertices from the end of an open polyline that consisted exclusively of bulges 

would result in anomalous display of the object in the Object Viewer.  This has been 

fixed. 

11. If you scaled an MText entity using the Enlarge command, and then exported it to DWG 

format, the word wrap would occur at the original boundary instead of the scaled one.  

This has been corrected. 

12. If an MText entity contained words with different colors assigned, exporting to DWG 

would result in the wrong colors being applied to the individual words.  This has been 

fixed. 

13. The Measure/AreaPerim/ContSearch function now correctly displays the Area and 

Perimeter values on the Message Toolbar.  Previously, it failed to do so if the selected 

figure contained a bulge. 

14. If an MText entity contains a Stamp keyword (such as @PLTDATELONG), DataCAD 

now uses the value rather than the keyword when determining the word extents. 

15. When "Assoc" is off in the Dimension menu, the first dimension is no longer duplicated 

by the Auto-Dim function. 

16. The following items are now grayed out in the File menu when in the Symbol Editor, 

because they are not supported: 

--Save 

--Save as DataCAD 11 AEC... 

--Save All 

--Pak-N-Go 

--Purge... 

17. The File/Save As operation in the Symbol Editor now remembers the path where the last 

symbol was saved. 

18. The Change/Match/More command inadvertently changed Z-Base and Z-Height even 

when they were not selected.  This has been corrected. 

19. When using the Measure/AreaPerimeter command and adding the Area text to the 

drawing using a DataCAD *.shx font, the superscripted "²" was not displayed.  This has 

been corrected. 



DataCAD X3 | 189 

DataCAD X3 New Features and Enhancements 

20. A crash related to deleting a polyline vertex and then undoing the operation has been 

corrected. 

21. The X and Y coordinates on the Coordinates/Hints toolbar now reset to zero 

immediately after clicking the mouse to begin a new line. 

22. If both "By Center" and "Rename" were enabled when inserting a Self-XREF, using 

"Absolute Zero" would place the reference at absolute zero instead of by absolute zero.  

This has been corrected. 

23. Corrected the position off the control point when using the "Resize" command on an 

MText entity that was aligned by Center/Bottom, Center/Middle or Center/Top. 

24. MText entities that had been mirrored about the X axis would not be sized properly.  

This has been corrected. 

25. Changed the "Purge unused symbols" command to no longer remove nested-level 

symbols that were being used as 3D Smart doors and windows. 

26. Adjusted the naming convention for layers created by the Extract 2D/3D command.  The 

manual and the automatic commands both name new layers as "LayerName_2d" and 

"LayerName_3d." 

27. The On/Off status of "Fix Text" is now carried over from an XREF to a Symbol when 

using the "Bind to symbol" option in the XREFs [Ctrl] + Right-click context menu. 

28. Repaired the ability to set the StackFrac option via the Change/Dimensions/Lock 

Scale/Inch Frac menu. 

29. Updated the "Pak-N-Go" feature to include external files that were linked via the 

Hyperlink feature.  Also added the ability to search the current drawing path to resolve 

orphaned files. 

30. If you used the Text Search function of the Mask operation during a drawing session, 

and then began a new session without exiting DataCAD, Text Search would be left on 

from the prior session.  This has been corrected. 

31. The "Clear Mask" command failed to reset the status of the "Text Search" toggle.  This 

has been corrected. 

32. Added *.XLS files to the "Files of type" drop-down menu of the "Redefine XREFs" dialog. 

33. Using the Purge/Save As AEC command on a file that contains a Self-XREF will now 

rename the reference to match the new name of the host file. 

34. Refined Contour Search function in the Hatch/Boundary menu. 
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35. When creating a revolved surface while in an elevation or isometric view, the outline of 

the profile was not drawn to the screen.  This has been corrected. 

36. Added support for Smart walls to "Auto Hatch/Fill" in the Options dialog under the 3D 

Section menu. 

37. The "Save Image As..." dialog which appears after pasting an image from the Clipboard 

will now remember the last path used to save the image file. 

38. Fixed a printing issue which would occur after changing the formatting of text in an 

MText entity. 

39. The first and last points of a 2-point arc must be different. 

40. A zero-length line is no longer left behind if you use Erase/Partial and then snap to one 

of the end points of an existing line when defining the segment to remove. 

41. The "Distance/2" function in the "Stretch" menu failed to operate if the current selection 

mode was set to "Fence."  This has been corrected. 

42. Removed the "Rotate" button which would display in the 2D Polygons/Rectangle menu 

when the cursor was not rotated to match the angle of a line in the drawing. 

43. The "Save Image" function failed to recognize Smart entities in 3D views if a Clip Cube 

was enabled.  This has been corrected. 

44. Updated the "Rename" function in the "GoTo View" menu to only allow numbers and 

letters. 

45. Corrected an error that would cause some DXF and DWG files to fail to import correctly 

if "Move drawing to origin" was checked on the "DWG Import Assignments" dialog. 
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Fixes 

1. If "Background" was on in the Section/Options dialog, hidden background lines were 

always drawn in the section result.  They are now only drawn if "Background" is on and 

if "Draw Hidden" is also on in the Hide/Options menu. 

 

12.08.03 

Fixes 

1. Enabled support for covered polylines in the "Auto Hatch" option of the "3D Section" 

command. 

2. You are now able to pick Smart Walls in the Dimension/Linear/Entity command. 

3. The Dimension/Linear/AutoDim function will recognize the control lines of Smart Walls. 

4. The Dimension/Linear/AutoDim function failed if it only passed through 2 lines.  This 

has been corrected. 

5. Corrected an error calculating the angle of rotation using Match/InclAngle or 

Match/ExclAngle. 

6. Entering coordinates while using the "Gradians" angle type did not work properly.  This 

has been corrected. 

7. Repaired the functionality of the "Layer Toggle" command, which did not work 

correctly if you selected a Multi-Layout detail by clicking on it. 

8. The "Lock Origin," "Lock Angle" and "Lock Scale" settings in the Entity Property Editor 

for associative hatch were not working properly.  This has been corrected. 

9. The "Swing Angle" for Smart Bi-Fold and Double Bi-Fold doors was setting the percent 

open rather than the angle.  This has been corrected. 

10. Corrected the "InclAngle" and "ExclAngle" commands in the "Measures" menu. 

11. Added hourglass cursor to indicate that the program is working during the "Update" 

command in the "3D Section" menu. 

12. Restored the ability to use [Ctrl] + [Left/Right Arrow] to switch between the last two 

active GoTo Views. 
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13. Using coordinate input to draw Smart walls while working in Relative Cartesian or 

Relative Polar would allow the creation of zero length walls.  This has been corrected. 

14. Corrected an error that would occur when inserting a SketchUp file if the option 

"Symbol Scale by Template=TRUE" was enabled in the configuration settings file. 

15. Improved display of Excel files in the Insert/Excel command.  Font size and the position 

of the text within the cells are now calculated more accurately. 

16. The 3D Section tool now recognizes the status of "Draw Hidden" in the Hide/Options 

menu when the Section/Options setting "Background" is enabled.  Hidden lines are be 

drawn using the "Hidden Color," "Hidden Style" and "Hidden Spac." settings in the 

Hide/Options menu, while background lines are be drawn using either "Original Colors" 

or a specified color, as defined in the Section/Options dialog. 

17. If the first and last vertices of a closed polyline occupy the same coordinates, the 

duplicate point is discarded. 

 

12.08.02 

Fixes 

1. Attributes of nested symbols are no longer duplicated when the Symbol Editor is used to 

modify a symbol. 

 

12.08.01 

Fixes 

1. Importing a DWG file that contained a block (symbol) which had MText within it would 

result in an internal diagnostic fault error. This has been corrected. 

2. Size and Aspect are no longer set to zero when entering the Text menu with Dynamic 

turned off. 

3. Corrected the display of text that was entered with Dynamic off, and with Alignment set 

to Fit. 

4. The "Fix Text" property was not properly applied to text within symbols if Explode were 

enabled when the symbol was inserted. This has been corrected. 

5. Using the Clipboard to Copy and Paste an associative dimension with text that had been 

relocated would result in the pasted dimension text being placed at the original 

coordinates. This has been corrected. 
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6. Fixed a failure to recognize hyperlinks to GoTo Views if the drawing file contained a 

Multi-Layout detail with the same name as the linked GoTo View. 

 

12.08.00 

New Features 

1. The new DataCAD® TrueType® Font is included with this update. It is installed into 

your C:\Windows\Fonts\ folder, and may be used in DataCAD 12, and other Windows 

applications. 

2. You may now apply the following 2D editing operations to smart walls: 

Fillet and Chamfer (the first wall selected determines the Type) 

Erase, Partial 

Free Trim 

Geometry, Tangents 

Geometry, Offset 

3. You may now use the following 2D menus to create smart walls: 

Curves 

Polygons 

4. The following smart wall-related improvements have been made: 

Wall, Door, and Window Types are now listed alphabetically after they are loaded. 

Smart walls may now be selected when creating Angular dimensions. 

5. MText and PText entities may now be saved in symbols. 

6. Added export to SketchUp (SKP) format. Select File, Export, SketchUp. 

The following DCADWIN.ini keys can be updated to set default Shadow options for 

SketchUp file export. The Keys (with default values) are: 
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[SketchUp] 

City=Avon (CT) 

Country=USA 

Latitude=41.8065 

Longitude=-72.8418 

TZOffset=-5 

;Time Zone Offset from Greenwich Mean Time. Make sure to set this 

correctly as Shadow time uses this offset. 

ShadowTimeMonth=6 

ShadowTimeDate=21 

ShadowTimeHour=12 

;ShadowTimeHour uses a 24-hour clock. For example, 2PM is 14. 

ShadowTimeMin=0 

DaylightSavings=false 

DisplayShadows=true 

EdgesCastShadows=false 

Hide Edges=false 

7. The ability to fillet Arcs to Arcs and Lines to Arcs has been improved. 

8. You may now use unit indicators to specify values you input via the command-line 

calculator. Previously, you were limited to using decimal values based on the current 

Scale Type. You can mix unit types and they must appear within square brackets. 

For Example: 

[1' 2-3/4"] = 1 foot 2 and 3/4 inches 

[1.25'] = 1.25 feet 

[1.25"] = 1.25 inches 

[1-1/4"] = 1 and 1/4 inches 

[1.25m] = 1.25 meters 

[1.25cm] = 1.25 centimeters 

[1.25mm] = 1.25 millimeters 

The following is an example of a mixed unit calculation: 

=([8' 10-3/16"] / 13) + [12cm] 

The result (based on a scale type of Architectural) is 1 foot 0 and 29/32 inches. 

Previously, you would have to enter the following equation to achieve the same 

calculation: 

= (8 + (10/12) + (3/16/12)) / 13 + (12 * 0.032808399) 

9. Pak-N-Go provides the ability to take your current drawing and pack it up into a single 

file that includes all its XREFs, Bitmaps, SHX Fonts, Pen Tables, Materials and Textures. 
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The reverse operation allows extracting the archive either to a single directory or it will 

recreate the original folder structure. 

DCADWIN.ini entries (accessible through interface as well): 

[PakNGo] 

Backup Bitmaps=TRUE 

Backup Fonts=TRUE 

Backup Materials=TRUE 

Backup Pen Tables=TRUE 

Backup XREFs=TRUE 

Recreate Folder Structure=FALSE   Menu structure: 

    File 

     - Pak-N-Go 

      - Create... 

        (Use this option to archive the current drawing and related files into a single file.) 

      - Extract> 

         - Extract Contents 

           (Use this option to extract the contents of a Pak-N-Go archive into a directory you 

specify.) 

         - Open... 

           (Use this option to extract the contents of a Pak-N-Go archive and open the parent 

drawing.) 

         - Settings... 

           (Access options for extracting Pak-N-Go archives.) 

             Make Copies of Existing Files: 

           _ XREFs 

           (Make copies of existing externally-referenced files.) 

           _ Bitmaps and Textures 

           (Make copies of existing externally-referenced bitmaps and bitmap textures.) 

           _ SHX Fonts 

           (Make copies of existing SHX fonts.) 

           _ Pen Tables 

           (Make copies of existing pen tables.) 

           _ Materials 

           (Make copies of existing material files.) 

             Destination: 

           _ Recreate Folder Structure 

           (Check this option to automatically recreate the original file/folder structure.) 

           (Leave this option unchecked to specify a single directory for the extracted files.) 

15. Make Legible Option: 
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You can add the following entries to the [PaletteFile] section of DCADWIN.ini to 

automatically adjust the contrast of DataCAD's display and printed output. 

[PaletteFile] 

Display RGB Push=FALSE 

If TRUE, DataCAD will automatically adjust the current palette colors based on the 

Percentage and Threshold values, and relative to the drawing background color. 

Display RGB Push Percentage=33 

Amount in percent to "push" the palette color toward either black or white. 

Display RGB Push Threshold=64 

Based on a range of 0 - 255, the threshold at which DataCAD will automatically adjust a 

palette color. Technically, this represents the difference in brightness between the 

foreground (palette) and background color. Lower values allow a greater range of colors 

and less contrast. Higher values allow a lesser range of colors and more contrast. 

Plotter RGB Push=FALSE 

If TRUE, DataCAD will automatically adjust the current palette colors based on the 

Percentage and Threshold values, and relative to white (the paper color). 

Plotter RGB Push Percentage=33 

Amount in percent to "push" the palette color toward either black or white. 

Plotter RGB Push Threshold=64 

Based on a range of 0 - 255, the threshold at which DataCAD will automatically adjust a 

palette color. Technically, this represents the difference in brightness between the 

foreground (palette) and background color. Lower values allow a greater range of colors 

and less contrast. Higher values allow a lesser range of colors and more contrast. 

16. Added a new "Anti-aliasing" option to the Settings dialog in the 3D Shader menu. 

17. A new option named "Other Side" has been added to the 1 Line Trim command. This 

option 'flips' the outside to the other side of the trim-to line. 

18. An updated DXF\DWG Color Map dialog now displays the name and RGB value of 

selected colors. 

19. Added two new keys in the [General] section of the DCADWIN.ini file: 

[General] 

No Command Line in Layer Menus= 

When the key is absent or set to FALSE (default), the sub-menus of the Layers menu (OnOff, 

SetActive, ActiveOnly, Lock, Rename, Erase, Delete, Export, ViewLayer) work the same way 
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that they always have, except that if you hold the [Ctrl] key on the keyboard when entering 

them, the command line is disabled. 

When set to TRUE, the command line is always disabled in these menus, unless you hold 

the [Ctrl] key when entering them. 

[General] 

Scroll Keys in Layer Menus= 

Note: No Command Line in Layer Menus= must be set to TRUE for this key to work. 

When TRUE, the [PgUp] and [PgDn] keys on the keyboard will scroll through the list of 

layers. [Shift] + [PgUp]/[PgDn] may be used to Zoom. 

When FALSE, the [PgUp] and [PgDn] keys on the keyboard will Zoom. 

20. Added a new section to the DCADWIN.ini file: 

[MultiView Windows] 

Scale Correction Percentage=100 

Using 100 as a baseline value, the number can be adjusted to customize display of Multi-

View Windows. For instance, if the image in your MVW's is too small, try using a number 

greater than 100 (like 110 or 120) in the above entry. If the MVW image is too large, use a 

smaller number (like 90 or 80). 

21. Added the options "Ignore" and "Bind to Symbols" for XREFs on the SketchUp export 

dialog. 

22. Added "Auto Extract 2D" and "Auto Extract 3D" options to the DXF\DWG tab of 

Tools\Program Preferences. When checked, the 2D and/or 3D information contained 

within Smart entities is automatically extracted to corresponding 2D and 3D layers 

during export to AutoCAD (DXF or DWG), SketchUp (SKP), or DataCAD 11 (AEC) 

format. 

23. A new option named "Bind XREFs to Symbols" has been added to the "Enter Filename to 

Export" dialog for exporting to DXF\DWG. When enabled, DataCAD will automatically 

convert all XREFs to symbols in the exported DWG/DXF file without affecting the 

original drawing. 

24. Binding XREFs to Symbols has a sub-option that can limit the operation to "Self-XREFs 

Only" when exporting to DXF\DWG. Other XREFs are exported as XREFs and should 

be included with the host DWG file when sent to an AutoCAD user. 

25. Added a new "Convert to XREF" option to the [Ctrl] + Right-click\Symbol Tools context 

menu to convert symbols to XREFs. When selected, you are prompted to select a folder 

in which to save the drawing, and for a name. 
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26. Added the ability to convert a Symbol that was originally a Self-XREF back to a Self-

XREF after import. 

Note: DataCAD drawings may contain Self-XREFs. A drawing must exist on the hard drive to be able 

to reference itself. During export to DWG, if you convert a Self-XREF to a symbol, DataCAD adds an 

attribute to the symbol which it can later use during import to identify that symbol as having once 

been a Self-XREF.   When importing a DWG file, DataCAD will scan the database to determine whether 

the file contains any Symbols that were once Self-XREFs. What it does next depends upon what it 

finds.   If the drawing into which you are importing the DWG has already been saved, and DataCAD 

finds a Symbol that it recognizes as having once been a Self-XREF, that Symbol will automatically be 

converted back to a Self-XREF during import.   If you are importing the DWG into a new file that has 

not yet been saved, and DataCAD finds a Symbol that it recognizes as having once been a Self-XREF, 

you will be asked if you would like to save the file.   If you choose [Yes], DataCAD will prompt you to 

save the file. The import process will continue, and the symbols will be converted back to Self-XREFs 

automatically.   If you choose [No], the import process will continue, and the symbols will be imported 

as Symbols. Subsequently saving the drawing will enable the option to convert the Symbols back to 

Self-XREFs via the [Ctrl] + Right-Click, Symbol Tools context menu. 

27. When you launch the Symbol Editor the browse type (Folder, Template or Drawing) in 

the Symbol Browser is not changed. If the browse type was set to "Drawing" and the 

symbol does not contain any nested Symbols, the Symbol Browser will be blank. If you 

switch to another drawing, and that drawing contains no symbols, the Symbol Browser 

view would change to "Folder." 

28. The Symbol Browser has a new option in the Browse (Folder, Template, and Drawing) 

pull-down menu named "Remember in Drawing." 

When checked, the Symbol Browser will remember the Browse Type (Folder, Template or 

Drawing), the folder or template file (when the type is either Folder or Template), the View 

Isometric, and the Auto Divisions settings in the drawing. 

Note: If the saved folder or template file does not exist, the Symbol Browser will default to the last 

one used as specified in the [SymbolBrowser] section of the INI file: 

SymbolFolder=C:\DataCAD 12\Symbols\Drawing\ 

TemplateFile=C:\DataCAD 12\Templates\Test.tpl 

29. Enabled a new key in the [SymbolBrowser] section of DCADWIN.ini. 

[SymbolBrowser] 

Symbol Scale by Folder=FALSE 

When set to TRUE, a new "Symbol Scale" option, which corresponds with the Symbol Scale 

button on the Ins Symbol menu, will be visible in the Options pull-down menu of the 

Symbol Browser. This option is only enabled when browsing by Folder. 

30. Enabled a new key in the [TemplateWindow] section of DCADWIN.ini. 
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[TemplateWindow] 

Symbol Scale by Template=FALSE 

When TRUE, a "Template.ini" file will be created in the same folder as the template file 

(*.tpl) which enables remembering the Symbol Scale status on a per-template basis. 

 

Miscellaneous Enhancements 

1. Added Text Scale, Plot Scale, All Caps, and Arrows buttons to the MText and PText 

menus. 

2. If Fix Text is on, MText and PText entities retain their line order when rotated more than 

90°. 

3. In the PText or MText dialog, [Ctrl] + [Enter] = [OK] and [Esc] = [Cancel]. 

4. In all other dialogs, [Enter] and Middle Mouse Button = [OK], [Esc] and Right Mouse 

Button = [Cancel]. 

5. The [Enter] key dismisses the Edit Fields dialog after typing the Item Name when saving 

a symbol. 

6. Added Geometry\Tangents support for Polyline entities. 

7. Added "Mask" to the Stretch selection menu. 

8. Added PText, MText, Smart Walls, Doors and Windows to the list of options in the 

Mask\Entity menu. 

9. Added "Material" to the 3D Change menu. 

10. Added "Line 1 On/Off" and "Line 2 On/Off" to the Entity Properties Editor for 

associative dimensions. 

11. Added "Outline On/Off," "Scale," "Angle," "Lock Origin," "Lock Angle," and "Lock Scale" 

to the Entity Properties Editor for polylines with associative hatching. 

12. Added "Outline On\Off" to the Entity Properties Editor for Polylines with solid fills. 

13. The Identify command includes the material assignment in the list of information 

returned. 

14. XREF names are now case sensitive. 

15. Added tooltips for the Mask menu to display the currently selected Entity, Color, Line 

Type and Weight. 
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16. Corrected field of view angles for list of camera Focal Lengths in the 3D Views, Set 

Perspective menu. 35mm has been replaced with 18mm. 

17. The Batch Plot dialogs may be resized horizontally. 

18. Added a "Purge" button to the Wall Type, Door Type and Windows Type Managers, 

and to the Hatch Pattern and Line Type Managers that enables you to purge unused 

types from the file. 

19. Creating a new material in the Material Assignments dialog will automatically launch 

the Edit Materials dialog. 

20. Enhanced the 2D Change\Spacing command to work on symbol instances. Previously, 

only the 3D Change command worked. This command uses a base unit of 1/32", so to 

change the spacing to 1, use Change\Spacing\..1/32. 

21. Added the following new key to the [General] section of the INI file: 

[General] 

Symbol Attribute AllCaps=FALSE 

Adding this key will set the default value of the AllCaps checkbox in the Symbol 

Attribute editor. 

22. When translating files to and from DXF or DWG format, the file CHR2SHX.dat may be 

placed in the DataCAD 12\Fonts\ folder and used to scale the size of text. 

23. When closing the Symbol Editor and choosing [Yes] to save changes you made to a 

symbol, layers within the symbol that had been turned off were discarded. This has been 

changed to turn off layers back on so that you do not lose information. To delete a layer 

from within a symbol, you must now explicitly choose the Delete Layer option in the 

Layer Manager (or in the Layers menu) while in the Symbol Editor. 

 

Fixes 

1. When creating stepped Smart walls with the condition that the length of the jog in the 

wall is equal to the width of the wall, DataCAD now correctly creates the intersection. 

2. Points in DWG files were incorrectly imported as 2D lines with a zero length. This has 

been corrected. 

3. Choosing Geometry\Tangents on an entity while in an Isometric view would result in 

an internal diagnostic fault error. This has been corrected. 

4. After performing a 1-Line Trim by Entity, the trim-to line is now re-drawn in its original 

color. 
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5. Corrected the improper location of manually placed associative dimension text for an 

aligned dimension that had been drawn on an angle, and then mirrored about the X or Y 

axis. 

6. Fixed a problem that caused the Geometry\Tangents menu to incorrectly use the Snap 

Angle setting from the Grids menu instead of from the TanDivs menu. 

7. The Reports function of the Blocker macro failed to calculate the correct Area Total and 

% of Total if you created three or more rooms. This has been corrected. 

8. Fixed a crash that would occur when using SetPersp if the HitherClip plane passed 

through a Solid, Pattern or Bitmap Fill. 

9. The "Save As DataCAD 11 AEC" command was saving copies of MText entities to the 

same coordinates as the original entity. This has been corrected. 

10. Fixed a bug related to Undoing and Redoing the accessing of GoTo Views. 

11. Fixed an erroneous Dynamic Snap indication that occurred when hovering the cursor 

near points on a Self-XREF that was on a layer which was turned off. 

12. Automatic crossing selection was not working properly if the cursor had been rotated to 

match a line that had an angle of 180° or greater. This has been corrected. 

13. Fixed the failure of the Undo system to properly undo hatching if a keyboard macro 

interrupted the process. 

14. Fixed a crash related to exploding certain symbols that contained attributes. 

15. If you launch the Symbol Editor and save changes to the symbol out to the hard drive 

without first loading the symbol into the active drawing, the symbol field information 

would be lost. This has been corrected. 

Note: Right clicking a symbol in the Symbol Browser and choosing Edit Symbol now loads that 

symbol into the header of the current drawing. 

16. Restored proper display of the text box that is attached to the cursor during the 

Change\TextPos command for associative dimensions. The text box was not displayed 

if the chosen associative dimension had a different scale type than the current Lock Scale 

selection. 

17. Restored the display of the initial Current Plot Scale to the Coordinates\Hints toolbar 

while performing a Multi-Layout\Layout. 

18. The door swing for a Smart garage door was displayed even if "Include Swing" was un-

checked on the Swing tab. This has been corrected. 



202 | DataCAD 12 

12.07.01 

19. DataCAD will no longer create the SymbolBrowserInfo.ini file if you browse a folder 

that does not contain any symbols. 

20. Inclusion of Stops on Smart Doors at the Header and Jamb are tied to the inclusion of the 

Header or Jamb. If Include Header is off, but Include Stops is on, the Stops are only 

drawn on the Jambs, not on the Header. 

21. The DXF\DWG Translator now supports import of AutoCAD control codes found 

within MText entities. 

22. Corrected a problem with the Purge routine related to modified default smart entity 

types. 

23. Corrected the display of the Symbol Reports dialog when Windows is set to use Large 

Fonts (120 DPI). 

24. Fixed a crash that would occur after choosing File\Print twice then right clicking twice. 

25. Fixed a crash that would occur when using [Ctrl] + [Tab] to switch between two 

drawings that were currently displaying Multi-Layout sheets. 

26. Creating Text or Associative Dimensions, then inserting a symbol without exiting the 

Text or Dimension\Linear menu first would result in the Text or Dimension being 

grouped with the symbol. This has been corrected. 

27. If a drawing contained a Clip Cube with IgnoreZ enabled, and some of the entities 

within the Clip Cube fell outside the Z-Min and Z-Max that would be used if IgnoreZ 

were off, when placing a Multi-Layout detail on a sheet, the incorrect extents would be 

used. This has been corrected. 

28. Fixed a bug related to rotating associative dimension text. 

29. If "Dynamic" was off in the "Text" menu, and "Alignment" was set to "Fit," text would be 

drawn from the starting point to Absolute Zero. This has been corrected.   

 

12.07.01 

Fixes 

1. An error that would cause previously moved entities to be included in the current copy 

selection has been corrected. 

2. In some cases, an error that would cause DataCAD to crash when you used [Shift] + 

Double-click to open an XREF has been corrected. 
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3. An error that would cause drawing material assignments to be incorrect after reloading 

materials via either the Edit Materials or Assign Materials dialogs has been corrected. 

4. An error that would cause DataCAD to crash when you reopened the Material 

Assignment (Color) dialog after loading a DMF file using the Replace option has been 

corrected. 

5. DataCAD was calculating the extents of the area selection box incorrectly if the cursor 

was rotated.  This has been corrected. 

6. The purge materials function was not updating unexploded symbols.  This has been 

corrected. 

7. If the INI key "Do Not Rotate Dimension Text" was set to FALSE, and the value for 

"Offset" in the Dimension\Linear\Text Style menu was greater than the value for 

"Overlap" in the Dimension, Linear, DimStyle menu, DataCAD would incorrectly place 

the dimension text automatically.  This has been corrected. 

 

12.07.00 

New Features 

Changes to Rendering Settings and Options 

Overview 

The interface for rendering activities such as loading materials, editing materials, and assigning 

materials has been modularized for ease-of-use and consistency.  The Rendering Settings dialog 

is now the Edit Materials dialog and only contains options for loading and editing drawing 

materials.  A new Settings dialog contains rendering options such as Background Color/Image 

and Include lights from XREFs which are now remembered on a per-drawing basis. A new 

Material Assignment dialog allows you to map either drawing colors to drawing materials or 

drawing layers to drawing materials depending on which method you are using.  These 

rendering-related tasks are now accessible via a new View, Rendering pull-down sub-menu and 

the [Ctrl] + Right-click context-menu.  In addition, new extended codes and a DCADWIN.ini 

key have been added. 

Summary 

- New Edit Materials dialog 

- New Material Assignment dialog 

- New Rendering Settings dialog 

- New Rendering Toolbar 

- Material by Color now uses embedded materials (not DMF) 



204 | DataCAD 12 

12.07.00 

Note: If you currently render by color, DataCAD will automatically import (embed) any material you have 

customized from the corresponding DMF file upon opening your drawing in version 12.07.00. 

- A new option, Save DMF, allows you to save your color to material assignments for use in 

other drawings. 

- A new option, Load DMF (Merge), allows you to import color to materials assignments from 

other drawings without overwriting existing assignments and materials. 

- A new option, Load DMF (Replace), allows you to import color to materials assignments from 

other drawings overwriting any existing assignments and materials. 

- Rendering by Color or by Layer are now remembered on a per-drawing basis. 

- A new option, Purge, has been added to the Edit Materials dialog so you can remove 

unassigned materials from your drawing. 

- Material list drop-down menus, wherever they appear, are now sorted alphanumerically. 

- DataCAD now remembers the last material you edited on a per-session basis for each open 

drawing. 

- In the Entity Properties dialog, "Render by Color", has been replaced with "Show Materials" so 

you can optionally disable the display of materials in the preview window. 

- The load material file preview has been updated to show the corresponding PNG thumbnail if 

found, or automatically display the corresponding bitmap texture or diffuse color if the material 

does not use a texture. 

- The following extended codes have been added for various rendering menus and settings 

    1023# : Assign Material 

    1029# : Edit Materials 

    1030# : o2c Rendering Settings 

    1031# : Material by Color 

    1032# : Material by Layer 

    1036# : Show Load Material dialog 

- The following options have been added to the [Ctrl] + Right-click context menu 

    Material by Entity 

        Edit material assignment for highlighted entity 

    Material by Entity Layer 

        Edit material assignment for highlighted entity's corresponding layer 

    Material by Entity Color 

        Edit material assignment for entity's corresponding color 
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- A new option, Updates Drawing Materials, has been included in the Symbol Editor section of 

the o2c Rendering Settings dialog.  If this option is checked, DataCAD will automatically 

update drawing materials based on changes you made while editing a symbol. 

  

Miscellaneous Enhancements 

1. An hourglass (Windows animated 'Busy' pointer) now appears while DataCAD is 

performing a task that suspends user input.  You can configure DataCAD to use a 

custom busy cursor by adding the following entry to the [General] section of 

DCADWIN.ini. 

[General] 

Busy Cursor= 

If blank, DataCAD will use hourglass.  Otherwise, DataCAD will use the name you 

specify. 

Note: Animated cursors reside in the Windows\Cursors folder. 

2. You can now redefine a symbol by selecting an XREF. 

3. The Reference File Manager context menu now displays the corresponding layer name 

for the XREF that is currently highlighted. 

4. You can suppress perpendicular snapping to text by adding the following entry to the 

[General] section of DCADWIN.ini. 

[General] 

Perpendicular Snap to Text=TRUE 

5. The GoTo View pull-down menu has been updated to highlight last selected view. 

6. The Line Type pull-down menu has been updated to highlight the current line type. 

7. The XREF Manager has been updated to automatically highlight the last selected GoTo 

View. 

8. You can now use the shortcut [Ctrl] + [A] 'Select All'. This option is intended to be used 

while in selection mode, for example after defining a distance to move.  It will apply the 

current editing operation to all entities that are currently displayed.  Entities on layers 

that are locked or off will not be affected. The following entry in the [General] section of 

DCADWIN.ini determines the letter that needs to follow [Ctrl] to invoke Select All. 

[General] 

Select All Character=A 

9. You can now select PText for Implied Match for angle input. 



206 | DataCAD 12 

12.07.00 

10. You can now select Associative Dimensions for Implied match for angle input. 

11. You can now select PText for Implied match in Tangents. 

12. DXF/DWG Import/Export now supports Unicode Diameter, Degrees and Plus/Minus 

symbols. 

13. The following lines in DCADWIN.MSG determine which extended characters are to be 

used for Diameter, Degrees, and Plus/Minus symbols in SHX, TTF, and DWG text. 

1317|140ª Character number for the diameter symbol in SHX or DWG 

1318|145ª Character number for the degrees symbol in SHX or DWG 

3459|176ª Character number for the degrees symbol in TTF fonts 

5135|216ª Character number for the diameter symbol in TTF fonts 

5136|146ª Character number for the Plus/Minus symbol 

5137|146ª Character number for the Plus/Minus symbol in TTF fonts 

14. The following extended codes have been added to determine the current control line for 

smart walls. 

1033# : Smart Wall side -2 (Outside) 

1034# : Smart Wall side -1 (Center) 

1035# : Smart Wall side 0 (Inside) 

15. You can now save HLR and Save Image results directly to the Clipboard. 

Note: If you paste the image from the Clipboard with Original Layers enabled, the entities will be 

pasted to a layer named "0". 

16. Architect, Edit Walls, Poly to Wall has been updated so you can define the inside of the 

wall prior to converting a polyline to a wall. 

17. As documented in the "Creating Keyboard Shortcuts for Pull-down Menu Options" 

section of the DataCAD Reference Manual Appendix, you can now use single letters or 

numbers to invoke any pull-down menu option.  Previously, this would interfere with 

text input. 

18. The Enlargement factor for XREFs and Symbols is now displayed in the Identify section 

of the [Ctrl]+Right-click context menu. 

19. A new option, Keep Groups, has been added to the Paste and Explode menus so you can 

retain original entity groupings.  You can determine the default behavior of these 

toggles by adding the following entries to the [General] and [Clipboard] sections of 

DCADWIN.ini 
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[General] 

Explode Keeps Groups=FALSE 

[Clipboard] 

Paste Keeps Groups=TRUE 

Controls the default status of the Keep Groups toggle. 

If TRUE, Keep Groups will automatically reset to on. 

If FALSE, Keep Groups will automatically reset to off. 

If blank, the Keep Groups toggle will retain its last status. 

20. Two new options, Prev/2 and Prev*2 have been added to the 2D Move, Copy, and 

Stretch menus so you can either halve or double the previous distance. 

 

Fixes 

1. An error that would prevent walls from "stepping" less than half their width has been 

corrected. 

2. The display of text size has been restored to the Identify command when Text Scale is 

enabled. 

3. An error that would cause a file to close at the end of the DXF/DWG import process has 

been corrected. 

4. An error that would cause a mismatch between the width of a wall opening and the 

width of a smart door defined using a symbol has been corrected. 

5. An error that would cause the contents of an exploded MText entity to end up on the 

active layer, rather than its original layer has been corrected. 

6. An error related to changing the contents of string line text via the Text Properties dialog 

has been corrected. 

7. An error related to creating zero length smart doors and windows with fixed width 

disabled has been corrected. 

8. The outline color of TrueType text was exported to DWF format in the current cursor 

color rather than its actual color.  This has been corrected. 

9. Error related to Text Scale has been corrected. 

10. An error that would cause MText to move after format RTF has been corrected. 

11. A boundary was displayed around non-associative hatch.  This has been corrected. 
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12. An error that would cause Change, Text, Font, Size to result in real world height when 

Text Scale was enabled has been corrected. 

13. Using Bind\To Symbol on an XREF that contained a nested self-XREF would crash.  

This has been corrected. 

Note: If an XREF contains a nested self-XREF which has an XClip, binding it to a symbol will 

remove the XClip from the self-XREF since a symbol cannot contain a nested symbol that has an 

SClip. 

14. It was no longer possible to toggle Create New off after drawing a rectangular polyline 

void.  This has been corrected. 

15. Fixed Ratio would not apply correctly to inserting bitmaps with a resolution greater 

than 65K pixels along either edge.  This has been corrected. 

16. An error that would cause the undo function to stop working after pressing a keyboard 

interrupt while in the Hatching\Boundary menu has been corrected. 

17. The area selection box lines were not displayed as dashed when using automatic 

crossing with a rotated cursor.  This has been corrected. 

18. It was not possible to snap to the entities within a 'Clipped' XREF when the 'Clipped' 

XREF was located outside of the drawing clip cube.  This has been corrected. 

19. The Symbol Text Attribute database link did not recognize the list separator character 

defined by Windows Regional Options.  This has been corrected. 

20. The text boundary would not appear when repositioning dimension text.  This has been 

corrected. 

21. PText and MText were not handled properly by Change, Text, Contents.  This has been 

corrected. 

22. Text, Justify now applies to PText and MText. 

23. Smart Wall node numbers are no longer exported to DWG. 

24. Deleting the contents of PText or MText entities now disables the OK button so it is not 

possible to create an “empty” text box. 

25. Overhead door types that used a symbol for a door would show the door offset by the 

width of the jamb in a 3D view and wider by the width of the jamb in plan view.  This 

has been corrected. 
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26. If you attempt to turn off the only layer via the Layer Manager, the OK button will no 

longer turn grey as this is not a valid action. 

27. Assigning an SPB Fill to a vertical polygon would cause a crash.  This has been 

corrected. 

28. Using Curves, Polyline, Edit, Fillet, then selecting a polyline edge would cause a crash.  

This has been corrected. 

29. An error related to snapping within an XClip with Ignore Z enabled has been corrected. 

30. An error that would cause lightweight polyline widths to vary depending on the unit 

type when exporting to DXF/DWG has been corrected. 

31. An error related to displaying the layers list when using [Page Down] to scroll-forward 

has been corrected. 

32. An error that would cause a drawing to close unexpectedly when plotting a Quick 

Layout that contained a polyline based XClip has been corrected. 

33. An error that would cause entities within a clipped MSP detail to be hidden though 

Ignore Z was enabled has been corrected. 

34. It is possible to interrupt the copy process by pressing a key such as [Delete] or [Arrow]. 

35. The Entity Properties dialog now reports the Z-Base for 3D Markers correctly. 

36. The Partial Erase pull-down menu would display the Erase menu.  It now displays the 

Erase, Partial menu. 

37. Scale to Pen mappings now apply to Quick Layout. 

38. A correction has been made to the extents calculation of self-XREFs. 

39. A correction has been made so the ReadBitmaps key in the [Layer Manager] section of 

the DCADWIN.ini file is remembered. 

40. The Save Symbol and Redefine Symbol functions no longer allows you to select entities 

on locked layers for inclusion in the new/updated symbol. 

41. Keep Groups would not apply when using Copy, Array or Copy Circular Array by Area 

or Group.  This has been corrected. 

42. DataCAD was not placing the 2D symbol representation for a smart window at the 

correct elevation.  This has been corrected. 
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43. A highlighted entity you had selected to identify would remain on the screen and 

editable if you selected a GoTo View that did not include the entity's layer instead of 

exiting the Identify menu first.  This has been corrected. 

 

12.06.00 

New Features 

AutoCAD R2007 – R2009 Compatibility 

DataCAD 12.06.00 adds support for importing and exporting AutoCAD R2007 through R2009 

files in DXF and DWG format. This enables you to collaborate and share files with associates 

who use the latest versions of AutoCAD. 

1. The Add and Move Vertex functions have been updated to maintain the current pitch of 

3D polygons and slabs, regardless of the current parallel view. 

2. "Alignment" has been added to the identify command. 

3. Identify, Set All on PText entity now sets the corresponding angle. 

 

New BETA Features 

The Command-line Calculator now supports unit specifiers.  Unit specifiers can be mixed and 

must appear within square brackets. 

For Example: 

[1' 2-3/4"] = 1 foot 2 and 3/4 inches (Architectural) 

[1.2.3.4] = 1 foot 2 and 3/4 inches (Architectural) 

[1.25'] = 1 and 1/4 feet (Decimal Feet) 

[1.25"] = 1 and 1/4 inches (Decimal Inches) 

[1-1/4"] = 1 and 1/4 inches (Fractional Inches) 

[1.1m] = 1.1 meters 

[1.1cm] = 1.1 centimeters 

[1.1mm] = 1.1 millimeters 

The following is an example of a mixed unit calculation: 

=([8' 10-3/16"] / 13) + [12cm] 

The result (based on a scale type of Architectural) is 1 foot 0 and 29/32 inches. 

You can enable the enhanced command-line calculator by adding the following entry to 

the [BETA] section of DCADWIN.ini. 
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[BETA] 

New Calculator=TRUE 

 

BETA Feature Enhancements 

1. Pak-N-Go now extracts to the folder where the archive resides. 

2. The following entries in the [SketchUp] section of DCADWIN.ini can be modified to suit 

your own preferences. 

[SketchUp] 

City=Avon (CT) 

Country=USA 

Latitude=41.8065 

Longitude=-72.8418 

TZOffset=-5 

; Time zone offset in hours. 

ShadowTimeMonth=6 

ShadowTimeDate=21 

ShadowTimeHour=12 

ShadowTimeMin=0 

DaylightSavings=FALSE 

; If TRUE, the position of the sun will be adjusted to reflect 

daylight savings. 

DisplayShadows=TRUE 

; If TRUE, SketchUp will cast shadows. 

Hide Edges=FALSE 

; If TRUE, SketchUp will hide polygon edges. 

EdgesCastShadows=FALSE 

; If TRUE, SketchUp will cast shadows from the edges of polygons. 

LaunchOnExport=FALSE 

; If TRUE, DataCAD will automatically launch SketchUp after 

export. 

3. The creation of components and groups has been optimized for SketchUp export. 

 

Fixes 

1. An error that would prevent symbols within XREFs from being added to the drawing 

correctly when binding an XREF has been corrected. 

2. Minor corrections to address cursor ghosting. 

3. Classic wall did not inherit the current Pen Style setting. This has been corrected. 

4. Minor correction to Edit Symbol Text Attributes dialog. 
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5. Quick Layout would crash if your drawing contained XREFs with Shader Lights and 

Show Lights was on. This has been corrected. 

6. It was not possible to delete or move the last vertex of an open polyline. This has been 

corrected. 

7. Minor correction to display of shader light indicator in XREFs. 

8. Under certain circumstances, the dynamic display of the opening would fail to appear 

when adding an opening to a smart wall. This has been corrected. 

9. An error related to selection highlighting in Measures, Area/Perimeter has been 

corrected. 

10. With RoundIt on, DataCAD would correctly return the real value of the distance when 

using Measures, Point to Point.  However, the rounded value would be placed after you 

selected To Drawing. This has been corrected. 

11. The [End] and [Delete] keys would fail to interrupt the Contour Search process. This has 

been corrected. 

12. DataCAD would change the Z-Base and Z-Height value of a polyline to match the 

current Z-Base and Z-Height setting after you used either Polyline, Edit, Chamfer or 

Fillet. This has been corrected. 

13. An error that would cause partial tori to exhibit invalid snapping points has been 

corrected. 

14. An error that would cause DataCAD to create corresponding U$R files in the \Windows 

directory while editing a symbol has been corrected. 

15. An error that would cause DataCAD to crash after undoing and then redoing a hatch 

using the boundary method has been corrected. 

16. The Layer Manager dialog would not display correctly when using Large Fonts. This 

has been corrected. 

17. An error that would cause DataCAD to exit the 2 or 3pt arc polyline creation method 

while panning or zooming has been corrected. 

18. An error that would prevent multiple block attributes with the same name from 

importing correctly into a DataCAD drawing has been corrected. 

19. The secondary division setting did not always apply to tori correctly. This has been 

corrected. 
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BETA Feature Fixes 

1. An error that would cause some of the contents of a Pak-N-Go archive to expand into 

the \DataCAD program folder when Recreate Folder Structure was enabled has been 

corrected. 

2. DataCAD models now export to SketchUp at the correct real-world scale. 

3. DataCAD textures now export to SketchUp at the correct scale. 

4. DataCAD models now cast shadows in SketchUp. 

 

12.05.00 

New Features 

1. A new shortcut, [Shift] + Double-click, has been added to open XREFs directly. 

2. PText is now recognized by the Change, Text, Match command. 

3. New extended character codes have been added for SPB-Fill settings. 

1027# :  Sets the current Solid Pattern Fill active 

1028# :  Sets Bitmap Fill active if the currently specified file exists 

4. A new option, Show X and Y has been added to the Grids menu.  If toggled on, the 

drawing cursor will display an X and a Y indicating the orientation of the positive X and 

Y axis. 

5. A new option, Show Zero, has been added to the Grids menu.  If toggled on, the 

drawing cursor will display an arrow indicating the direction of zero degrees. 

Note: The Show Zero indicator only displays if the grid has been rotated, Tangents is enabled, or 

the Zero Angle has been redefined. 

6. The Polyline, Void menu has been enhanced to allow the creation of "new" voids in 

addition to selecting existing polylines. 

7. The Polyline, Edit routine has been enhanced to support voids. 

8. It is now possible to display either icons only or icons with text in the Layer Manager. 

Note:  To access this option, right-click below the icon menu.  You can also double-click below 

the icon menu to change its position from left to right or vice versa. 
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9. A new key, Do Not Rotate Dimension Text, has been added to the [General] section of 

DCADWIN.ini.  If TRUE, DataCAD will automatically place dimensions that do not fit 

above the witness lines rather than rotate them to fit. 

10. The Contour Properties dialog now includes Divisions and Stiffness. 

11. The 2D and 3D Curves Properties dialogs now include Start Angle and End Angle. 

12. In the Status Panel, locked layers now show as bold, italic, and red. 

13. Smart Walls can now be selected for Angle, Match (and implied match). 

14. Added pitch, slope, and grade to Identify and [Ctrl] + Right-click, Identify context menu 

(lines, 3D lines, polygons, slabs, and blocks). 

15. The o2c Viewer now remembers its last view and lights on/off settings on a per-drawing 

basis when the following key in DCADWIN.ini is set to TRUE (the default is FALSE). 

[o2cViewer] 

Remember Last View=TRUE 

16. If Shader, Show Lights is enabled, lights from XREFs will also display in the drawing. 

17. Undo now functions while you place symbols and allows you to undo each instance one 

at a time instead of all at once. 

18. When the cursor is rotated via Grid Angle or Tangents, Quadrant snapping is rotated 

accordingly. 

19. The Select option in Measures, Area/Perimeter is now a toggle. 

 

New BETA Features 

You can enable the following features for testing purposes by setting the corresponding 

DCADWIN.ini key to TRUE in the [BETA] section. 

SketchUp Compatibility 

Added export to SketchUp (SKP) format.  Select File, Export, SketchUp. 

[BETA] 

SketchUp Export=TRUE   

Pak-N-Go 

Pak-N-Go provides the ability to take your current drawing and pack it up into a single file that 

includes all its XREFs, Bitmaps, SHX Fonts, Pen Tables, Materials, and Textures. 

[BETA] 

Pak-N-Go=TRUE 
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File > Pak-N-Go > Create 

Use this option to archive the current drawing and related files into a single file. 

File > Pak-N-Go > Extract > Extract Contents 

Use this option to extract the contents of a Pak-N-Go archive into a directory you specify. 

File > Pak-N-Go > Extract > Open... 

Use this option to extract the contents of a Pak-N-Go archive and open the parent drawing. 

File > Pak-N-Go > Extract > Settings… 

Access options for extracting Pak-N-Go archives. 

Make Copies of Existing Files: 

 XREFs 

Make copies of externally-referenced files. 

 Bitmaps and Textures 

Make copies of externally-referenced bitmaps and bitmap textures. 

 SHX Fonts 

Make copies of external SHX fonts. 

 Pen Tables 

Make copies of external pen tables. 

 Materials 

Make copies of external material files. 

Destination: 

 Recreate Folder Structure 

Check this option to automatically recreate the original file/folder structure. Leave this 

option unchecked to specify a single directory for the extracted files. 

 

Fixes 

1. The display of 'x' for locked layers in the Status Panel has been enhanced to XOR more 

legibly when the inverse color is like the background color.  For example, the inverse 

color of Light Grey is Light Grey, so the 'x' would not appear if your locked layer color 

were Light Grey. 

2. The conversion of HELV_LT.CHR to HELV_LT.SHX would fail.  This has been 

corrected. 
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3. In some cases when copying smart walls, doors, and windows "up" or "down" in an 

elevation view to create additional stories, some of the openings were not created. This 

has been corrected. 

4. More Contour Search tweaks. 

5. Due to an error, DWG export would hang if your file contained ellipses.  This has been 

corrected. 

6. Corrections have been made to improve the handling of Hebrew text. 

7. A nested symbol with the same name as the parent symbol would crash when edited.  

This has been corrected. 

8. Symbol attributes that would import correctly via DWG in 12.03.00 would not in 

12.04.01.  This has been corrected. 

9. It was not possible to move PText that had been previously copied but moving the 

original would moves both.  This has been corrected. 

10. Identifying hatches or solid fills would cause the Scale Type to reset to Architectural.  

This has been corrected. 

11. The identified angle of text was incorrect after it has been rotated with Fix Text off, then 

exploded.  This has been corrected. 

12. The identified angle of text was incorrect after it was placed as a symbol, then exploded.  

This has been corrected. 

13. In some cases, zooming with the mouse wheel in a drawing that contained circular 

XREFs would cause the drawing to close unexpectedly.  This has been corrected. 

14. The scaling factor for a symbol was not updated properly after changing the plot scale 

via the Plotter menu.  This has been corrected. 

15. The interior lines of classic 3- and 4-line walls always had a z-height of 0.  This has been 

corrected. 

16. A specific DWF file creation that worked in DataCAD 11 did not work in DataCAD 12.  

This has been corrected. 

17. PText would rotate in the wrong location after it had been copied.  This has been 

corrected. 

18. DataCAD's internal handling of Windows printer names has been updated to support 

similarly named printers correctly. 
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19. Identify, Set All on Paragraph Text no longer affects the Stringline Text alignment 

setting. 

20. If you copied an entity a specific distance and to a layer at the same time, the distance 

value would change.  This has been corrected. 

21. The message prompts for entering Smart Doors and Windows with Cut Wall off have 

been corrected. 

22. Improvements have been made to copy/paste from Word and Excel to DataCAD. 

23. If you edit a symbol from within a drawing with a clip cube, the clip cube will be 

disabled while you edit the symbol. 

24. Editing a covered polyline using either the chamfer or fillet options would remove the 

cover.  This has been corrected. 

25. Non-associative hatching with the Dots pattern at a scale of 200 would not print.  This 

has been corrected. 

26. The following actions no longer cause all open drawings to be closed without being 

saved. 

a. Open another drawing while in the Plotter menu then go to the Plotter menu in the 

drawing you just opened. 

b. Select close All from the File pull-down menu, then answer No to save the current 

drawing. 

27. An MSP Detail custom insertion point would not "stick" after rotating and placing detail.  

This has been corrected. 

28. The Swing Type, 'Line' was not working for Smart Doors.  This has been corrected. 

29. When you render materials by color, DataCAD now updates the name of the Rendering 

Settings (DMF) file stored in your drawing immediately after loading a DMF file or 

saving the currently loaded DMF file to a new name.  In addition, the maximum length 

of the fully qualified DMF file name has been increased from 80 to 255 characters. 

30. In some cases, ellipses would fail to move by area.  This has been corrected. 

31. The display of text insertion points would cause DataCAD to crash when stretching an 

associative dimension.  This has been corrected. 

32. Identifying PText did not report correct weight.  This has been corrected. 



218 | DataCAD 12 

12.04.00 

33. External icons now load faster (only applies when Use External Icons=TRUE). 

 

12.04.01 

Fixes 

1. In rare circumstances, object snapping or dynamic snapping to the intersection of a line 

and an arc would cause the active drawing to close unexpectedly.  This has been 

corrected. 

2. Due to an error in the prior version, Identify, Set All did not work correctly with PText.  

This has been corrected. 

3. The contour search function has been adjusted for improved reliability. 

4. Due to an error, it was not possible to resize PText or MText after it had been moved.  

This has been corrected. 

5. Due to an error, the position of PText was not correct after it was moved then later 

inserted as an XREF with an enlargement factor other than 1.  This has been corrected. 

6. XREF Layer highlight settings were not restored after you performed an erase then 

undo.  This has been corrected. 

7. Under some circumstances, the search aperture would display larger than normal when 

you [Alt] + [Tab]'ed between drawings. 

 

12.04.00 

New Features 

1. You can now midpoint snap to the edges of cones, truncated cones, spheres, and tori. 

2. A new toggle, Dynamic Flip, has been added to the Insert Symbol menu.  When this 

option is enabled, you can use the [Ctrl] key to flip the symbol vertically and/or the 

[Shift] key to flip the symbol horizontally ( instead of using an enlargement factor of -1 ). 

3. Within the Layer Manager the [Tab] key now moves to and highlights the next layer 

name field and  [Shift] + [Tab] moves to and highlights the previous layer name field. 

4. The following hot keys can be used to add layers within the Layer Manager: 

[Ins] adds 1 layer before the currently highlighted layer or the first layer if none are 

highlighted. 

[+] adds 1 layer after the currently highlighted layer or the last layer if none are 

highlighted. 
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[Shift] + [INS] prompts for the number of layers to add then adds them before the 

currently highlighted layer or thee first layer if none are highlighted. 

[Shift] + [+] prompts for the number of layers to add then adds them after the currently 

highlighted layer or the last layer if none are highlighted. 

5. You can now bind ( i.e., convert ) XREFs to Symbols.  Only the On layers will be 

included in the symbol definition.  XClips are automatically converted to SClips. 

6. Two new options, All and Selected have been added to the Free Trim, Begin menu.  

When All is active, you can select any line to trim between highlighted lines.  When 

Selected is active, you can only select highlighted lines. 

7. A new key has been added to the [General] section of DCADWIN.ini so you can 

customize the behavior of Implied Match. 

[General] 

Shift For Implied Match=FALSE 

If TRUE, the [Shift] key must be used to invoke implied match. 

8. A new key has been added to the [Toolbars] section of DCADWIN.ini so you can 

suppress the Macro Hint Toolbar. 

[Toolbars] 

Suppress Macro Hint Toolbar=FALSE 

If TRUE, the Macro Hint Toolbar will not display when a keyboard macro has been 

invoked. 

9. The Macro hint toolbar can now be docked and undocked. 

10. Two new options, Add 90 1st and Add 90 Center have been added to the Mirror menu 

so you can rotate the mirror line about either the first point you picked or the midpoint 

between the first and second points you picked. 

11. You can now undo chained entities one at a time instead of all at once. 

12. You can now undo layer on / off operations one layer at a time. 

13. For convenience, a new option Halve Distance has been added to Move, Copy, and 

Stretch menus. 

14. The Identify command now displays the height between z-base and z-height. 

15. When you create a new wall, door, or window type DataCAD now automatically sets it 

active as well. 
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16. A new option, Fix Text, has been added to the [Ctrl] + Right-click context menu so you 

can "normalize" text ( i.e., make readable from the bottom or right of the page ). 

17. A new key has been added to the [DEBUG] section of DCADWIN.ini so you can 

optionally display insertion points for text. 

[DEBUG] 

Draw Text Insertion Point=FALSE 

If TRUE, non-printing markers will appear at text insertion points. 

18. The status of Fix Text now appears on the [Ctrl] + Right-click Context, Identify sub-

menu ( only applies to text, symbols, and XREFs ). 

19. A Fix Text option has been added to the Change, More... sub-menu. 

20. An extended character code, 1026#, has been added so you can clear the command stack 

via a keyboard macro. 

21. The PText edit window now uses the Drawing Area font you specify on the Interface tab 

of Program Preferences.  This font is also used in the Tools, Info ( Drawing Information ) 

dialog. 

22. A new key has been added to the [General] section of DCADWIN.ini so you can 

customize the behavior of Implied Deselect. 

[General] 

Shift For Implied Deselect=FALSE 

If TRUE, the [Shift] key must be used to deselect entities you've already selected. 

If FALSE, the [Shift] key can be used to disable Implied Deselect ( i.e., always select ). 

 

Fixes 

1. Corrections have been made to address multi-scale plotting detail highlight ghosting 

after deleting a detail. 

2. A correction has been made so you can now delete a multi-scale plotting detail by 

picking it from the multi-layout window. 

3. The Symbol Scale setting was not updated after you restored a GoTo View ( requires 

Plot Scale to be saved with GoTo View ). 

4. An error that would prevent the dynamic snap indicator from displaying while rubber 

banding smart walls has been corrected. 
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5. In some cases, the global overshoot setting was not applied to entities within XREFs.  

This has been corrected. 

6. Further adjustments have been made to improve the reliability of contour search. 

7. Smart wall node indicators are no longer included in symbols. 

8. Like two-line trim, one line trim now turns clean on at wall node. 

9. In some cases, highlighted entities were not displayed using a dashed pen style.  This 

has been corrected. 

10. In some cases, the 3D rotate command would not apply the current x, y, or z angle 

relative to the current orientation of the entity being rotated.  This has been corrected. 

11. Due to an oversight, the current pen style was applied to SM3-based symbols when they 

were inserted into the drawing.  This has been corrected. 

12. When adding nodes to smart walls, the new node will be projected to the nearest smart 

wall within the search aperture only when Clean is on. 

13. An error that would prevent symbols within smart entities from displaying within 

XREFs has been corrected. 

14. An error that would cause text to be selected incorrectly when using the Spellchecker on 

MText has been corrected. 

15. Smart entities were not included in drawing file previews.  This has been corrected. 

16. Smart walls were not cleaning when saved as symbols.  This has been corrected. 

17. Changes have been made to improve the handling of same-named symbol text 

attributes. 

18. The number of voids has been restored to the Identify, Polyline results display. 

19. Due to an oversight, the current pen style was applied to associative dimension text.  

This has been corrected. 

20. A correction has been made to 3DS export. 

21. The options No Sill, No Sash, and No Glass on the 2D Options tab of the Window Type 

Manager have been changed to Include Sill, Include Sash, and Include Glass, 

respectively. 
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22. An error that would cause mirrored or rotated MText to move in the opposite direction 

has been corrected. 

23. Multi-view Window tooltips were not sized properly.  This has been corrected. 

24. The angle property of MText and PText was not updated properly after rotation.  This 

has been corrected.  Existing MText and PText entities will be updated automatically. 

25. The extents of reversed text was not calculated properly which could prevent you from 

selecting it.  This has been corrected. 

26. In some cases, text entities with Fix Text enabled would not transfer via DWG properly.  

This has been corrected. 

Note: Text within symbols or XREFs that have their Fix Text property enabled will not transfer via 

DWG.  In other words, DWG does not support a Fix Text property on blocks or XREFs. 

27.  In some cases, drawing files that contained solid fills would close unexpectedly if you 

tried to pan, zoom, or scroll during a redraw.  This has been corrected. 

 

12.03.00 

New Features 

1. Edit Symbol is now accessible via the Symbol Browser context menu. 

2. The previous view type is now remembered in all but the o2c Insert dialog. 

3. A new option, Add 90, has been added to the 2D Mirror menu so you can rotate the 

current line of reflection by 90 degrees. 

4. The default Multi-view Window caption prefix as defined in DCADWIN.MSG line 4346 

has been increased from 7 to 79 characters. 

5. The Paste command now displays DataCAD’s private Clipboard(s) if the Windows 

Clipboard is empty. 

 

Fixes 

1. An error in 3D polygon area calculation has been corrected. 

2. An error related to XREFs with long pathnames has been corrected. 

3. Text entities that contained empty strings were automatically deleted which prevented 

the Scrive macro from functioning properly.  This has been corrected. 



DataCAD 12 | 223 

12.03.00 

4. The line feed factor was not being applied correctly to TrueType Fonts with a non-zero 

angle.  This has been corrected. 

5. An error that would cause DataCAD to crash when you saved a wall, door, or window 

type to a new path has been corrected. 

6. Undo now restores a polylines edge visibility. 

7. A Layer Search toggle has been added to the Curves, Polyline, Show / Hide menu. 

8. An error that would cause hatch pattern dots to draw at the drawing origin has been 

corrected. 

9. An error that would cause dots in Dotted and Dot-Dash line types to appear offset from 

the line has been corrected. 

10. An error that would prevent hyperlink hints from displaying in certain views has been 

corrected. 

11. TrueType font names were not transferred from DataCAD 10 drawings to DataCAD 12.  

This has been corrected. 

12. The texture origin assignment was not correct for non-ortho polygons.  This has been 

corrected. 

13. The 2D and 3D glass representation for window types did not reflect the offset value for 

non-centered panes.  This has been corrected. 

14. If NoGridInSelect=TRUE, Grid Snap will be inactive whenever the input line is active. 

15. In some cases, File I/O dialogs will not appear correctly when Old File Dialogs=FALSE 

in the [General] section of DCADWIN.ini.  You can set this value to TRUE to restore 

DataCAD’s File I/O dialogs to pre-12.02.00 status. 

16. The “Layer not found” message was not appearing when you typed a non-existent name 

in the Layer Menu input prompt.  This has been corrected. 

17. In some cases, ellipses were unmovable.  This has been corrected. 

18. In some cases, hatch would not move by area.  This has been corrected. 

19. BMP icons were not automatically converted to PNG format unless Use External 

Icons=TRUE.  This would prevent custom toolbar icons from displaying.  This has been 

corrected. 
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20. An INI setting, New FreeTrim=FALSE, has been added to the [General] section of 

DCADWIN.ini.  If TRUE, FreeTrim will only act on entities that are highlighted.  

Otherwise, DataCAD will trim any line segment you select between highlighted entities. 

21. Control points no longer appear “ballooned” in the Symbol Browser. 

22. In some cases, materials would not appear correctly in the wall, door, and window type 

manager previews.  This has been corrected. 

23. If toolbars are locked, double-clicking on a blank portion of an undocked menu no 

longer re-docks the menu. 

24. Window openings were not drawn when the window header was coincident with the 

top of a wall.  This has been corrected. 

25. In some cases, while in isometric view, object snapping to symbols in the Symbol 

Browser would not return the correct point.  This has been corrected. 

26. An error that would cause DataCAD’s menu window to “flicker” when undocked has 

been corrected. 

27. An error that would prevent the oblique view icon in the Object Viewer toolbar from 

displaying has been corrected. 

   

12.02.00 

New Features 

1. A new option, View Isometric, has been added to the Symbol Browser Options pull-

down menu. When selected, symbols being displayed from the current folder will 

appear in isometric view. Otherwise, symbols will appear in plan view. This setting is 

remembered on a per folder basis so 2D and 3D symbols can display accordingly. 

Note: 3D object snapping applies to symbols displayed in isometric view so you can set your 

insertion point based on this method. 

2. The 3D Cursor option has been added to the 3D Stretch menu so you can now use x, y, 

and z coordinates to define your stretch distance. 

3. The maximum Multi-scale Plotting Sheet name length has been increased from 8 to 80. 

4. A new option, Add 90, has been added to the 2D Move, Copy, and Rotate menus so you 

can change the current direction by 90 degrees while retaining the current distance. 

5. All Caps has been added as an option to the Edit Symbol Attribute dialog. 
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6. Options have been added to the 3D Coordinate Identification menu to allow you to 

insert the results into your drawing. 

Note: This option is only available via the [?] keyboard interrupt. 

7. In addition to smart walls, doors, windows, and cutouts may now be selected via 

Tangents. 

8. Voids and Edit have been added to the SPB-Fill, Boundary menu. 

9. Performing a Save As via the wall, door, and window managers will automatically load 

the new style and set it as active. 

10. A new key, "Suppress Witness Line 1", has been added to the [General] section of 

DCADWIN.ini. If FALSE, associative string line dimensions will include the first witness 

line. The default value is TRUE. 

11. A new section [Standard Toolbar] has been added to DCADWIN.ini. If any of the 

following keys are set to FALSE, the corresponding icon will not appear on the Standard 

Toolbar. 

STD_NewFile=, STD_OpenFile=, STD_Save=, STD_Print=, 

STD_SpellCheck=, STD_ClipboardSelect=, STD_Cut=, STD_Copy=, 

STD_Paste=, STD_Undo=, STD_Redo=, STD_InsertXREF=, 

STD_InsertBmp=, STD_HyperLink=, STD_Order=, or STD_Help=. 

12. The DataCAD File Open dialog now remembers its size and view type ( not including 

Tiles or Thumbnails ) in Windows 2000 and XP ( Vista provides this feature 

automatically ). 

Note: Detail view takes longer to display than List view. 

13. DataCAD now supports 32-bit PNG format icons ( 24-bit color + 8-bit opacity ) versus 

the previous 24-bit BMP format. 

 

Fixes 

1. Fixed width doors, windows, and cutouts must now be fully enclosed within the 

selection boundary to move them. 

2. The Closed option has been removed from the Torus properties dialog since this feature 

is not currently supported on Tori. 

3. An error that would cause the base of two smart walls to move to zero during an X, L, or 

T-intersection cleanup has been corrected. 
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4. In some cases, smart walls would extend to infinity. Adjustments have been made to 

prevent this from occurring. 

5. Ellipse center points were always drawn at 0,0. This has been corrected. 

6. A problem with drawing smart doors or windows with Cut Wall turned off has been 

corrected. 

7. An error that would cause the Plane Snap function to display the resulting view upside 

down has been corrected. 

8. The previous path for saving bitmaps was not remembered. This has been corrected. 

9. The rubber band line has been restored in the Move, Drag routine. 

10. Errors that would cause text to display improperly ( or not at all ) have been corrected. 

11. The DCADWIN.ini setting Old Line Weights=TRUE was not working where a line 

weight of 2, 3, 4, etc. would display as 3, 5, 7, pixels and so on.  This has been corrected. 

12. An issue related to Windows Vista that would cause a two-pixel wide line to display 

only one pixel wide has been corrected. 

13. An error that would cause dashed circles within symbols and XREFs to display as solid 

has been corrected. 

14. Text boxes and object snapping were incorrect for text entities with an alignment other 

than bottom, left. This has been corrected. 

15. An error that would cause grouping to be lost via Copy, Paste has been corrected. 

16. Z Offset is no longer available when placing symbol with the 3D cursor. 

17. In some cases, the lighting buttons in the Object Viewer were not working. This has been 

corrected. 

18. It is no longer possible to create zero length smart entities. 

19. The Layer option has been removed from the Symbol Entities Properties dialog. 

20. FreeTrim would apply to lines that were not part of the current selection. This has been 

corrected. 

21. An error that would cause the reference angle for Direction/Distance input to be 

incorrect when placing a symbol has been corrected. 
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22. An error that would allow solid fills to appear outside of the ClipCube has been 

corrected. 

 

12.01.00 

New Features 

1. 3DS ( 3D Studio ) has been added to the File, Export menu. 

2. The following improvements have been made to Object Snapping within non-ortho 

views: 

• You can now snap to the intersection of 3D lines and polygon edges using the 3D 

cursor. 

• You can now snap to the intersection of 3D lines and polygon edges using the 2D 

cursor. 

• You can now select any line in a non-ortho view for Tangents. 

3. The following extended character codes have been added: 

    1024# : Auto3D (Smart Walls) On 

    1025# : Auto3D (Smart Walls) Off 

4. The following INI settings have been added to the [Printer] section of DCADWIN.ini: 

[Printer] 

Settings Auto Load=MySettings.dps 

Automatically load a specific Printer Settings File where MySettings.dps is the name of a 

previously saved Printer Settings File.  The name may be fully qualified or just the 

filename.  If you do not specify a path, the path defined by 

PATH_PLOTTERSETTINGSPATH will be used. 

Clear Settings=FALSE 

If TRUE, the current printer settings will be removed from your drawing when you 

open it. 

5. You can now select entities for Boolean operations using Entity, Group, Area, or Fence 

and Mask. 

6. An Explode option has been added to the MText and PText context menus for 

conversion to string line text. 

7. A Resize option has been added to the MText and PText context menus. 
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8. The context menu in the Layer Manager has been expanded to include options that were 

previously accessible via the toolbar only. 

9. Hatch and fills are now applied immediately at the time you select or create the 

boundary. 

10. The Orphan Manager dialog can now be resized. 

11. A new option, Show / Hide has been added to the Polyline menu so you can toggle the 

edge visibility of polyline boundary segments. 

12. TIN modeler processing can now be interrupted using the [Delete] key. 

If TIN model creation will take more than five minutes, DataCAD will display a dialog 

with the estimated time required. 

 

Fixes 

1. During keyboard input, [Spacebar] [Spacebar] 1 [Spacebar] 2 was interpreted as 1'-2".  It 

is now interpreted as 1/2" as it was in prior versions. 

2. Non-associative, string line dimensions included duplicate witness lines between 

dimensions.  This has been corrected. 

3. An error that would cause text characters to step in the z-direction has been corrected. 

4. A problem related to ellipses that contained invalid matrix data has been corrected. 

5. Errors related to printer settings have been corrected. 

6. The Z-Offset options in the Insert Symbol menu were not working.  This has been 

corrected. 

7. An error related to angle normalization when using tangents has been corrected. 

8. Refinements have been made to the contour search function so that it will work more 

reliably. 

9. Nested symbols were not being read from DWG files.  This has been corrected. 

10. Errors related to creating PDF files have been fixed. 

11. Invisible text attributes were not exported via DWG.  This has been corrected. 

12. In some cases, invalid characters were added to text attribute values during export to 

DWG.  This has been corrected. 
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13. The prompt string for text attributes was replaced with the prompt default value during 

export to DWG.  This has been corrected. 

14. An error in AECExtension.dll that would cause Windows Explorer to crash when 

deleting multiple drawing files has been corrected. 

15. Symbol Scale has been removed from the Paste menu. 

16. Symbol scale was not adjusting line spacing accordingly. This has been corrected. 

17. Autosave is now disabled during keyboard input. 

18. XREF lights were not being recognized by the Object Viewer.  This has been corrected. 

19. The display of bold TrueType Fonts has been corrected. 

 

12.00.00 

DataCAD 12 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 12, please click: 

What's New? from the Help pull-down menu in DataCAD. 

New Feature Highlights 

Smart Entities 

DataCAD 12 provides new smart wall, door, and window entities that contain routines and 

parameters that define their behavior and interaction with other smart entities.  When you draw 

two walls in a prior version of DataCAD, they do not know anything about each other until you 

explicitly tell the program to clean them together.  In DataCAD 12, walls of the same type 

automatically clean to each other without you having to perform additional cleanup routines. 

The same automation applies to doors and windows as well.  When you add a door or window 

to a wall, the wall automatically cuts itself to accommodate the opening.  Further, when you 

move, copy, or delete a door or window, the wall automatically heals itself.  These "smarts" 

eliminate most of the cleanup steps you had to perform in prior versions. 

A smart entity also knows what it is supposed to look like when viewed in plan or perspective.  

In plan, a door looks just like the 2D doors you are familiar with.  However, when you switch to 

a 3D view, the door is automatically modeled complete with a jamb, casing, and trim.  When 

you display your model in the object viewer, it is complete with rendered materials. 

SketchUp File Import 

DataCAD 12 adds direct support for SketchUp files. Now you can easily add models you have 

created in SketchUp to your DataCAD projects. You can open, insert, or externally reference 

SketchUp files. DataCAD 12 will automatically extract materials and bitmap textures from the 
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SketchUp file and embed them into your DataCAD drawing. You can also convert SketchUp 

files to o2c format for raytraced visualization. 

Excel Spreadsheet Import 

You can insert Excel spreadsheets into your drawings. 

Object Snapping Enhancements 

DataCAD 12's object snapping mechanism has been completely re-written to provide faster 

response times in larger drawings and to eliminate previous limitations. It is now possible to 

snap between and within symbols and XREFs (including nests). You can also snap to polyline 

bulge centers and XClip boundaries. A new dynamic snap indicator displays available object 

snap locations in real-time. 

3D Boolean Operations 

Add, Subtract, and Union operations. 

3D Edit Planes 

Recall construction planes on a per-entity basis. 

Double-precision Display List 

DataCAD 12 includes a new option to enable a double-precision display when you need to 

work on projects that cover a large real-world area.  This setting is applied on a per-drawing 

basis. 

Multi-line Text (a.k.a. MText) 

A new multi-line text (with support for TTF and SHX fonts) entity provides wrap-around text 

boundaries and the ability to uniquely format text within the same paragraph such as font, size, 

bold, italic, underline, overline, color, alignment, and line feed factor. Multi-line text is based on 

RTF (Rich Text Formatting) and is round-trip compatible with AutoCAD's MText. 

SHX Font Support 

DataCAD 12 provides native support for AutoCAD SHX fonts. 

Font Dialog Enhancements 

An enhanced Font Dialog allows you to save and load text styles. You can also access options 

such as All Caps, Plot Scale, and Line Factor options that were previously available in the main 

Text menu only. 

Entity Properties Editor 

It is now possible to access the properties of any entity simply by [Ctrl] + Right-clicking on the 

object. From here you can change settings and apply them immediately. A real-time 3D preview 

window allows you to see changes to three-dimensional entities. 
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o2c Rendering Enhancements 

In addition to rendering by color or by layer, you can also assign material definitions on a per 

entity basis. Material definitions are now embedded in your drawing in a central location. So, 

you can easily assign the same Brick material to multiple entities. 

New Symbol Tools 

A new addition to the context-sensitive Symbol Tools menu allow you to edit unexploded 

symbols on the fly. The changes you make can be saved to the current drawing only and/or to 

the hard disk, or to a new symbol definition. Symbols can now be clipped using rectangular or 

irregular shaped polyline boundaries. 

Ready2Render Symbols 

New 3D symbols added to DataCAD 12 include pre-assigned materials and textures, so they are 

ready to render as soon as you add them to your model. In addition, we have updated many of 

the existing 3D symbols, so they are "ready-to-render" as well. 

New Seamless Textures and Backgrounds 

DataCAD 12 includes more than 200 new seamless textures and dozens of background photos 

to add realism to your renderings. 

New Hatch Patterns 

More than 50 new hatch patterns have been added for interior and exterior materials. 

Dimension Enhancements 

You can now assign a unique scale type to any dimension allowing you to maintain multiple 

dimensioning formats within the same drawing. 

Fence Clip 

XREFs and Symbols can now be clipped using irregular shaped polyline boundaries. 

Pen Styles / Pen Widths 

Based on the Windows line type format, you can now apply scale-independent patterns to your 

DataCAD line types. These patterns are compatible with the Windows Metafile format and 

convert directly to Adobe PDF format. Now you can apply property lines to curves. 

New Toolbars 

Notate Toolbar 

Types Toolbar 

Plotting Enhancements 

Your current plotter and Quick Layout settings can now be saved to a file and loaded into other 

drawings.  You can also assign unique pen tables to specific scales.  So large-scale drawings and 

details can have thicker pens and small-scale drawings can have thinner pens.  Unique pen 

tables can also be assigned to specific multi-scale plotting details. 
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Multi-scale Plotting Enhancements 

• You can now save your multi-scale plotting layouts to DWG format so your consultants 

can access them directly using AutoCAD. 

• A new context menu provides quick access to MSP Detail operations. 

• MSP Details can be selected directly from the layout window versus only from the 

menu. 

• MSP Detail extents are highlighted when you hover your cursor over them.  A tooltip 

displays the detail name. 

• MSP Detail Make Current now sets the current Plot Scale to what the detail was saved 

at. 

• MSP Detail names may now contain up to 80 characters. 

Multiple Private Clipbooks w/ Preview 

DataCAD 12 stores up to 10 private Clipbooks that contain the most recent data you copied 

from your drawing to the Windows Clipboard.  Whenever you Paste, you can re-select any of 

your Clipbooks.  A preview of each Clipbook's contents is shown when you highlight the item 

in the menu. 

Reference File Manager Enhancements 

XREF Highlight settings can now be assigned on a per-XREF and/or XREF Layer basis.  The 

Reference File Manager dialog has been updated to allow drag-n-drop between the Loaded, 

Refresh, Reload, Bind, and Delete lists.  You can also assign custom names to XREFs.  The 

Inherit Current Highlight Setting option for Nested XREFs is now remembered on a per 

drawing versus global basis. 

Display Symbol Contents While Dragging 

The contents of symbols can now be displayed dynamically during placement and rotation. 

AEC File Import 

    Select Layers, GoTo Views, MSP Sheets, Multi-view Windows 

    Layer Import: New, Append, Overwrite 

    Drawing Settings: Update 

Long GoTo View Names 

GoTo View names may now contain up to 80 characters. 

Long MSP Detail Names 

Multi-scale Plotting Detail names may now contain up to 80 characters. 
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Access / Update GoTo Views via Layer Manager 

A GoTo View list pull-down menu has been added to the Layer Manager for quick access to 

layer on/off settings. 

Access Material Definitions via Layer Manager 

Materials can now be set on a per layer basis via the Layer Manager. 

XREF Highlighting Per Layer 

XREF Highlighting can now be set per XREF Layer basis. 

XREF Manager Drag-n-drop 

Items from the Reference Files list can be moved to either the Refresh, Reload, Bind, or Delete 

lists using a drag-n-drop method. 

Hyperlink Hints/Tooltips 

Hyperlink paths are now displayed when you hover the cursor over an entity that contains a 

hyperlink. 

Search Associative Hatch 

The Search Hatch setting in the Object Snap menu now applies to Associative Hatch. 

Implied Unselect 

Consistent with Windows standards, clicking on an entity after it has been selected will remove 

it from the current selection set. 

Trap Door to Dimension Change 

A trap door to Dimension, Change has been added to the Change menu. 

Smooth Curve Dragging 

Curves now display smoothly rather than segmented when you create them. 

Multiple Associative Dimension Scale Types. 

Independent from the global Scale Type setting, individual associative dimensions can display a 

unique unit type. 

Polyline Bulge Centers 

The radius point for polyline bulges is now displayed when Display, Curve Centers is enabled. 

Symbol Scale 

Just like Text Scale for notes and dimensions, you can now define symbols at their plotted size 

and enlarge them accordingly for a given drawing scale. 

Rotate Menu Enhancements 

Quick Rotate 

Rotate entities about the point you click as you select them without having to define a center of 

rotation each time. 
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Absolute Rotate 

Rotate entities to an absolute angle about their center as you select them. 

Rotate by Center 

Rotate entities about their centers as you select them (Also works with Dynamic Rotation). 

Insert Symbol Current View (Dynamic) 

Insert symbols based on their world orientation relative to the current view. 

Angle Snap Divisions Increased To 720 

The Angle Snap setting may now be set as small as 30 minutes, or 720 divisions of a circle.  

Previously, the smallest angle allowed was 10 degrees, or 36 divisions of a circle. 

MSP Detail Make Current Also Sets Plot Scale 

MSP Detail Make Current now sets the current Plot Scale to what the detail was saved at. 

Inherit Nested XREF Highlight On A Per Drawing Basis 

The Inherit Current Highlight Setting option for Nested XREFs is now remembered on a per 

drawing versus global basis. 

Select by Fill 

It is now possible to select filled entities from within their closed boundary in addition to their 

edges. 

24x24 Interface Icons 

DataCAD 12 includes a set of 24x24 pixel interface icons for use on high-resolution displays. 

New Toolbars 

The Notate toolbar has been re-introduced to DataCAD 12 and takes advantage of new symbol 

options. 

Change Text 

Added Angle and Alignment to the Change, Text, menu. 

Paste Enhancements 

The Paste menu has been expanded to include Dynamic Rotate, Line Factor, Bind Materials, 

Symbol Scale, Max Lines, and Clipbooks. 

MSP Detail Highlighting and Context Menu 

MSP Details are now highlighted when you hover your cursor over them. 

[General] 

Detail Highlight=TRUE 

[Ctrl] + Right-clicking on any detail will open a context menu with the following options. 

    Rename 

    Update 

    Make Current 
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    Rotate 

    Pen Table 

XREF Alias 

It is now possible to assign a custom name to XREFs. 

 

Miscellaneous Enhancements 

1. Voids and Edit options have been added to the Boundary menu in Hatch. 

2. The maximum number of points for a selection fence has been increased from 36 to 100. 

3. A Draw Leader option has been added to the Dimension, Change, Text Position menu. 

4. Included and Excluded options have been added to the, Angle, Match menu. 

5. The All Black toggle in the Pen Table dialog is no longer a drawing variable, it is now 

stored as part of the Pen Table. 

6. Layer menus now remember the last page you were on. 

7. An option Clip Cube Obey / Ignore has been added to the context menu for text entities. 

8. It is now possible to open multiple files with the same name at the same time. 

9. Hyperlinks to Internet URLs that are embedded within top-level symbol entities are 

now accessible via [Ctrl] + Right-click. 

10. New extended character code 1022# added for 3D Views, Isometric. 

11. More button added to Change menu for new DataCAD 12-specific attributes including 

Pen Style, Pen Style Spacing, and Material. 

12. Fix Text (including attribute text and dimension text) now applies to rotate and mirror 

operations. 

13. XClips and new SClips can now be rotated via the Rotate menu. 

14. New Object Snap method "Offset" and corresponding extended character codes 1018# : 

Turns Offset On, 1019# : Turns Offset Off, and 1020: Prompts for new Offset distance. 

15. SHX is now the native format for "stroke" fonts (Existing CHR's are automatically 

converted). 

16. Tools, Extract 2D/3D pull-down menu added for conversion of Smart Entities. 
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17. Double-click Property Editor, Edit XREF, and Edit Symbol or [Ctrl] + Double-click. 

18. TTF equivalents of standard DataCAD fonts are now included. 

19. All program paths have been added to Program Preferences. 

20. Inherit Current Highlight Settings added to [Ctrl] + Right-click context menu. 

21. All Caps Linked option between Text and Change Text menus.  [General] AllCaps 

Linked=TRUE. 

22. Stretch now applies to 3D Cylinders. 

23. Added Rotate option in MSP layout menu. 

24. Right-clicking on an XREF entry in the Reference File Manager now reveals a context 

menu with the following options. 

Select All 

Unselect All 

Invert Selection 

Repath 

Redefine 

Rename 

Minimize Names 

Copy Highlight Settings 

Paste Highlight Settings 

Nesting On 

Nesting Off 

25. INI Entries 

[General] 

Detail Highlight=TRUE 

If TRUE, a bounding box will be displayed when you hover your cursor over an MSP 

detail. 

Automatic Crossing Selection=FALSE 

If TRUE, area selection from right to left will imply crossing. 
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Dynamic Snap=true 

Dynamic Snap Delay=50 

ABNT=TRUE 

Double Click For Properties=TRUE 

Double Click For RFM=TRUE 

Double Click For Symbol Editor=FALSE 

Auto Extract 2D=TRUE 

Auto Extract 3D=FALSE 

SHX Conversion= 

[PATHS] 

PATH_XREFBASEPATH=Drawings\ 

PATH_WALLTYPES=Support Files\Wall Types\ 

PATH_DOORTYPES=Support Files\Door Types\ 

PATH_SMARTDOORSYMBOLPATH=Symbols\ 

PATH_WINDOWTYPES=Support Files\Window Types\ 

PATH_SMARTWINDOWSYMBOLPATH=Symbols\ 

PATH_TYPESBASEPATH=Support Files\ 

PATH_TXTSTYLES=Support Files\Text Styles\ 

PATH_O2CMATERIALBASEPATH=Materials\ 

PATH_O2CTEXTUREBASEPATH=Textures\ 

PATH_SKETCHUP=SketchUp\ 

PATH_EXCELFILES=Excel\ 

PATH_SYMBOLBASEPATH=Symbols\ 

PATH_CLIPBOARDFILES=Clipbooks\ 

PATH_PLOTTERSETTINGSPATH=Support Files\Plotter Settings\ 

PATH_SPELLCHECK=Support Files\Dictionaries\ 

[StatusArea] 

ButtonColors=TRUE 

If TRUE, Color Palette icon will be shown. 

DropDownColors=TRUE 

If TRUE, Colors drop-down list will be shown. 

ButtonLineTypes=TRUE 

If TRUE, Line Type menu icon will be shown. 

DropDownLineTypes=TRUE 

If TRUE, Line Type drop-down list will be shown. 

ButtonLayers=TRUE 

If TRUE, Layer Manager icon will be shown. 

DropDownLayers=TRUE 

If TRUE, Layers drop-down list will be shown. 

ButtonScales=TRUE 
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If TRUE, Layer Search icon will be shown. 

DropDownScales=TRUE 

If TRUE, Display Scale drop-down list will be shown. 

ButtonGotoViews=TRUE 

If TRUE, GoTo View menu icon will be shown. 

DropDownGotoViews=TRUE 

If TRUE, GoTo View drop-down list will be shown. 

ButtonSelSets=TRUE 

If TRUE, Selection Sets menu icon will be shown. 

DropDownSelSets=TRUE 

If TRUE, Selection Sets drop-down list will be shown. 

DropDownInputModes=TRUE 

If TRUE, Input Mode drop-down list will be shown. 

ButtonWallTypes=TRUE 

If TRUE, Wall Type Manager icon will be shown. 

DropDownWallTypes=TRUE 

If TRUE, Wall Type drop-down list will be shown. 

MaxWallTypes= 

Number of lines displayed in the Wall Types drop-down list. 

ButtonDoorTypes=TRUE 

If TRUE, Door Type Manager icon will be shown. 

DropDownDoorTypes=TRUE 

If TRUE, Door Types drop-down list will be shown. 

MaxDoorTypes= 

Number of lines displayed in the Door Types drop-down list. 

ButtonWindowTypes=TRUE 

If TRUE, Window Type Manager icon will be shown. 

DropDownWindowTypes=TRUE 
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If TRUE,  Window Types drop-down list will be shown. 

MaxWindowTypes= 

Number of lines displayed in the Window Types drop-down list. 

[Purge] 

Materials(Automatic)=FALSE 

If TRUE, unused material definitions will automatically be removed upon exit, and  

save. 

Styles(Automatic)=FALSE 

If TRUE, unused wall, door, and window type definitions will automatically be removed 

upon exit, and save. 

Materials(Manual)=FALSE 

Styles(Manual)=FALSE 

[External Types] 

Walls=TRUE 

If TRUE, external Wall Type definitions will be displayed in manager. 

Doors=TRUE 

 If TRUE, external Door Type definitions will be displayed in manager. 

Windows=TRUE 

If TRUE, external Window Type definitions will be displayed in manager. 

[SketchUp] 

FrontOverBack=TRUE 

If TRUE, material definition for "positive" side of polygon will be imported. 

ExtractTextures=TRUE 

If TRUE, bitmap textures will be extracted from model. 

OverwriteTextures=FALSE 

If TRUE, existing bitmap textures will be overwritten. 

ExtractedTexturePath=Textures\ 

Path to save extracted bitmap textures. 

[Clipboard] 

FileName= 
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File Name prefix for private clip book files. 

If blank, prefix will be Computer Logon Username or if Username is blank then Machine 

Name. 

MaxClips=10 

Minimum of 1, no maximum 

PenWidthFactor=10 

Line weight to pen width conversion factor 

[XREFs] 

Dynamic Snapping=TRUE 

[File Dialog] 

Preview Forced Save=FALSE 

If TRUE (and Preview=TRUE, the drawing preview bitmap will be updated after each 

forced file save. 

Otherwise, the drawing preview bitmap will only be updated when you exit and save 

your changes. 

[o2cViewer] 

Use Entity Material=TRUE 

ExtractTextures=TRUE 

If TRUE, bitmap textures will be extracted from model. 

OverwriteTextures=FALSE 

If TRUE, existing bitmap textures will be overwritten. 

ExtractedTexturePath=Textures\ 

Path to save extracted bitmap textures 

 

Fixes 

1. Angle Normalization fix. 

2. Entering either [<] or [*] in the Select Line Type input would cause an error.  This has 

been corrected. 

3. In some cases, using the scroll wheel between Print and Print Preview would cause an 

error.  This has been corrected. 

4. The Object Snap routine no longer recognizes points on entities that lie outside the 

clipping boundary. 
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5. Symbol Attribute Text enlargements were not transferred via DXF/DWG.  This has been 

corrected. 

6. In some cases, Symbol Attribute Text default values would revert to the attribute name 

after saving and re-opening the file.  This has been corrected. 

7. In some cases, the LOG file would not be deleted after opening a DXF/DWG file.  This 

has been corrected. 

8. The display of XClip boundaries was not updated automatically when you changed 

display scales.  This has been corrected. 

9. It is no longer possible to delete a locked layer via the Layer Manger unless you unlock 

the layer first. 
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Fixes 

1. The text line feed would advance based on the slant angle.  This has been corrected. 

2. All GoTo Views would inherit the current layer on/off settings when opening a DC5 file.  

This has been corrected. 

3. Under some circumstances XClips with Ignore Z enabled would drop text.  This has 

been corrected. 

4. DWG files containing associative hatch entities with no boundary definition would 

cause DataCAD to crash during import.  This has been corrected. 

 

New Features 

Implied Match 

The Match option is now automatically implied when DataCAD prompts you to select a layer, 

color, or angle. So you can simply click on an entity that resides on the layer you want, click on 

an entity that is the color you want, or click on an entity that has been drawn at the angle you 

want, without having to select the Match option first. 

Note: When DataCAD prompts you for an angle you can click on a 2D line, 3D line, text entity, symbol, or 

XREF to match its angle. You can also select a 2D arc to set the angle to match the tangent nearest the 

point you click on the arc. 

Infinity Clip 

A new option, Ignore Z, has been added to the Clip Cube and XClip menus.  Enabling this 

option creates a Clip Cube with an infinite top and bottom. The status of this toggle is stored 

with GoTo Views and MSP details. 

New extended key codes have been added that allow you to explicitly set the status of the 

Ignore Z toggle. 

1014# : Ignore Z On 

1015# : Ignore Z Off 

Note: XClips with Ignore Z enabled will export to DXF/DWG. 

Log File 

DataCAD now maintains a log file in the \Temporary Files folder for each drawing you open. 

DataCAD deletes the log file along with other temporary files when you exit your drawing 

normally. If you experience a crash and subsequently open and recover your drawing, the 
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corresponding log file is moved to the \RECOVER_ARCHIVE folder. You can submit the log 

file to Technical Support for further analysis. 

Symbol Tools Menu 

A context-sensitive menu is now available when you [Ctrl] + Right-click on a symbol. 

Symbol Tools 

    Open in Symbol Browser 

    Send to Object Viewer 

    Reload 

    Replace 

    Redefine 

    Reset Insertion Z 

        To Zero 

        To Z-Base 

        To Z-Height 

    Explode 

        To Current Layer 

        To Insertion Layer 

        To Original Layers 

    Reports 

    Edit Fields 

    Edit Attributes 

Exploding Symbols 

The symbol explode command now provides you with three options. 

    Current Layer  (Explode symbol’s entities to current layer) 

    Insertion Layer  (Explode symbol’s entities to symbol’s insertion layer) 

    Original Layers  (Explode symbol’s entities to their original layers) 

Note: These options are remembered independently from the explode options available when you insert 

a symbol. 

Change Symbol’s Insertion Z 

You can now change the Z-Height of a symbol’s insertion point via the Change, Z-Base menu. 

Reload All versus Reload On 

The Reload All (Symbols) option now reloads all symbol definitions regardless of their 

corresponding layer on/off status. A new option Reload On Layers Only, only reloads symbol 

definitions that reside on layers that are on. 

Fix Text Within Symbols 

Text and Symbol Text Attributes contained within Symbols now adhere to the Mirror, Fix Text 

toggle. 
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Keep Groups 

A new toggle, Keep Groups, has been added to the Copy and Move, And Copy menus. If 

toggled on, the entities which have been copied or moved will retain their original grouping. 

Note: A new entry, Copy Keeps Groups=, has been added to the [General] section of DCADWIN.ini to 

control the default status of the Keep Groups toggle. 

If set to TRUE, Keep Groups will automatically reset to on. 

If set to FALSE, Keep Groups will automatically reset to off. 

If left blank, the Keep Groups toggle will retain its last status. 

Sticky One Line Trim by Entity 

A new entry, 1LineTrim By Entity=, has been added to the [General] section of DCADWIN.ini 

to control the behavior of the Entity toggle in 1LnTrim. 

If set to TRUE, Entity is automatically reset to on. 

If set to FALSE, Entity is automatically reset to off. 

If left blank, the Entity toggle will retain its last status. 

Note: New extended key codes have been added that allow you to explicitly set the status of the Entity 

toggle. 

1016# : One Line Trim by Entity On 

1017# : One Line Trim by Entity Off 

Sticky Contour Search 

The Contour Search option is now "sticky" in all menus where it appears. 

XREF Enhancements 

A new popup menu is available when you right-click on the list of XREFs in the Reference File 

Manager and provides the following options: 

Select All 

Unselect All 

A new option, Multiple, has been added to the Insert, XREF menu. Enabling this option allows 

you to insert multiple copies of the same XREF like inserting a symbol. 

Inserting an XREF or pasting Clipboard data using the By Center option has been changed as 

follows: 

a. Insertion point is based on X and Y extents only. Original Z extents are retained. 

b. A new Z-Offset menu is now available like inserting a symbol. 
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A new option, XREFs Auto-Refresh on Regen=, has been added to the [XREFs] section of 

DCADWIN.ini.  If TRUE, all XREFs will automatically Refresh when you regenerate the display 

list by pressing the [u] key. 

You can now suppress the loading of XREFs by holding the [Ctrl] key down when you select 

Open. 

An XREF you select in the Reference File Manager will now remain highlighted after you 

"Apply" your changes. 

Unlimited o2c Lights via XREFs 

A new option, Use Lights from XREFs has been added to the Rendering Settings dialog. When 

checked, o2c objects will contain lights from the current and referenced drawing files. 

o2c Ground Plane 

A new option Show Ground Plane has been added to the Rendering Settings dialog. When 

checked, o2c objects will automatically contain a ground plane. 

Dimension Bump/No Bump 

A new option DinStdNoBump=, has been added to the [General] section of DCADWIN.ini to 

control the behavior of dimension text that does not fit between the witness lines. 

If set to TRUE, dimension text is not “bumped”. 

If set to FALSE, dimension text that does not fit between the witness lines will be “bumped” to 

the opposite side of the dimension line when the DIN Standard Dimension Style is enabled. 

Hebrew Text Support 

DataCAD now supports Hebrew (right to left) TrueType fonts. 

1 New Layer 

A new menu option, 1 New Layer, has been added to the Layer menu so you can add one new 

layer, name it, and make it active in one step. 

Hatch Lock 

You can now lock associative hatch origin, angle, and scale independently. These options are 

also accessible via Identify, Set All. 

 

Miscellaneous Enhancements 

1. The first field of the Edit/Customize Symbol Attribute dialog box is now highlighted 

when the dialog is shown. You no longer need to select the first field to change it, you 

can just begin typing. 

2. MSP detail menu labels now display the corresponding detail’s scale in the tooltip. 
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3. The complete layer name is now reported in the attention line for functions within the 

layer menu. 

4. Tooltips for the Active Layer and Current Color dropdowns in the status panel now 

show the full name. 

5. The selected entities to be changed when using Match in the Change menu are now 

highlighted and their count is reported. 

6. Further refinements to the Surface Area and Volume calculations in the Identify menu. 

Specifically, all linear (line length, radius, perimeter, etc.) measurements are reported 

using the current drawing Scale Type. Only areas, volumes and surface areas are now 

reported using the Scale Type specified in the Area/Perim menu. Also, corrections to the 

Surface Area and Volume calculations for Slabs have been made. 

7. A new option, 2 Points, has been added to the Tangents menu. Selecting this option 

allows you to enter 2 points to indicate the angle to rotate the cursor. 

8. Many selection issues have been addressed. These include (but are not limited to) 

functions that require you to select a certain entity type (i.e. a polyline) but were not 

masking out disallowed entity types making it difficult to select the proper entity. 

9. New options have been added to the [SymbolBrowser] section of DCADWIN.ini to set 

the maximum number of divisions the Symbol Browser will automatically create when 

you browse a folder for symbols.  Previously, there was no practical limit for the number 

of symbols the Symbol Browser would automatically try to display. 

MaxAutoDivisionsX=3 

; Default is 3.  Valid range is from 1 to 25. 

MaxAutoDivisionsY=15 

; Default is 15.  Valid range is from 1 to 25. 

10. Text Alignment options are now available when you insert a Stamp. 

11. The [Page Up] and [Page Down] keys now scroll through the Mask, Entity options. 

12. The Draw Leader option has been added to the Dimension, Linear, Change, Text 

Position menu. 

13. The Identify command has been enhanced so you can cycle through coincident entities 

by clicking the mouse repeatedly. 

14. An exclusive Layer Search toggle has been added to the Identify command.  The default 

state of the toggle is always On. 

15. You can now write a macro to select a custom color (16 to 255). 
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Examples: 

[Change to Color 38] 

Hint=Change color to 38 

A=^;^S7^S7^S8^38$^S0 

 

[Change to Color Yellow] 

Hint=Change color to Yellow 

A=^;^S7^S7^S8^yellow$^S0 

Note: If the color you specify is not found then the color will remain unchanged. 

16. The destination layer is now displayed in the message bar when you use the Copy To 

Layer or Move To Layer option. 

 

11.08.00 

Fixes 

1. A Self-XREF would not update properly if you first erased it then restored it with the 

Undo command.  This has been corrected. 

2. A screen regeneration was required after repathing an orphaned XREF for it to appear in 

the drawing. This has been corrected. 

3. Rotated dimensions should now mirror properly. 

4. The surface area calculation for Slabs containing voids has been corrected. 

5. The Perimeter and Area readout in the Edit function of the Polyline menu when Info is 

toggled on has been corrected. 

6. An error in the Z coordinate of associative hatch has been corrected. 

7. An error in the Symbol Browser display has been corrected. 

8. An error that would cause o2c textures to "fracture" has been corrected. 

9. An error related to Change/Match selection highlighting has been corrected. 

10. An error related to WeldLine has been corrected. 

11. An error related to the Dots dimension arrow style has been corrected. 

12. An error related to the Draw Leader dimensioning option and stacked fractions has been 

corrected. 

13. An error related to selection of a highlighted entity after zooming has been corrected. 



DataCAD 11 | 249 

11.07.00 

14. An error related to dimension rounding has been corrected. 

15. An error related to MSP detail ghosting has been corrected. 

16. The initial column width settings in the Layer Manager have been adjusted. 

17. An error related to ClipCubes and XClips improperly clipping fills has been corrected. 

18. The Identify menu now displays a tooltip for layer and color. 

19. The All Caps toggle is no longer visible in the Change, Text menu unless Contents has 

been selected.  Further, the All Caps toggle in the Change, Text menu inherits the status 

of the All Caps toggle in the Text menu. 

20. An error that would cause an XREF on an "off" layer to appear after turning nesting off 

via the Reference File Manager has been corrected. 

21. An error related to XREF extents recalculation has been corrected. 

22. Any changes you make in the printer setup dialog will now be immediately reflected in 

the current Quick Layout or Multi-layout view.  You no longer must exit and re-enter 

the Print/Plot menu to update the layout view. 

23. If a template were displayed and you recalled a GoTo View using a hyperlink, the GoTo 

View would draw on top of the template.  This has been corrected. 

24. An error related to the Full Circle preset option in the Sphere menu has been corrected. 

 

11.07.00 

New Features 

1. A marker (similar to a symbol insertion point) is now drawn at the insertion point of an 

XREF, only if it contains no visible entities (for example, if all of the layers within the 

XREF are off, or the layers that are on contain no entities). 

Note: You can [Ctrl] + Right-click on XREF markers to Identify them or access the Reference File 

Manager. 

2. A new Re-path option has been added to the Reference File Manager so you can change 

the source path for multiple XREFs at once. 

3. New options to control the precision of the Architectural scale type have been added to 

the Scale Type menu.  If Architectural scale is selected, you may choose from the 

following precisions: 
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32nds 

64ths 

128ths 

256ths 

4. A new option, "Merge layers on export to layer '0'," has been added to the DXF/DWG 

preferences tab and export dialog that allows you to put all of your drawings symbol 

layers onto layer '0' to avoid creating ghost layers. 

5. The Identify command now reports perimeter, surface area, and volume (where 

applicable) for polylines, polygons, slabs, spheres, cones, truncated cones, and tori. 

Note: You must set the unit and precision for Identify takeoffs via the Utility, Measures, Area/Per., 

Scale Type menu, not the Utility, Settings, Scale Type menu which is for drawing, editing, and 

dimensioning. 

6. New check boxes for controlling the behavior of View-dependent Editing operations 

have been added to the Misc. tab of Program Preferences.  If checked, DataCAD will 

invoke 2D editing commands when you are in an Ortho view, or 3D editing commands 

when you are in a parallel (non-Ortho) view.  This behavior applies to left-hand menus, 

pull-down menus, and keyboard shortcuts (not keyboard macros). 

Note: If you want your keyboard macros to behave in concert with the view-dependent editing 

setting, you must prefix your key sequences with an exclamation mark ("!") as shown in the 

following example. 

A keyboard macro for 2D Stretch might be: 

S^;^F5^ 

This sequence forces you to the 2D Stretch menu, regardless of your current view 

projection.  By changing the macro sequence to... 

S^!^;^F5^ 

...you will invoke either the 2D or 3D stretch command based on your current view 

projection. 

 

Fixes 

1. An error in the Section, 3D Knife function would cause DataCAD to crash when you 

placed the resulting geometry on the active layer. This has been corrected. 

2. In some cases, material definitions with an un-initialized texture scale would cause 

DataCAD to crash when you launched the Object Viewer. This has been corrected. 
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3. In some cases, an error related to polylines would cause DataCAD to crash when you 

used the third-party HtchPref macro. This has been corrected. 

4. You can add a new entry to the [o2cViewer] section of DCADWIN.ini if you are unable 

to create an o2c object from a model that contains many polygons per material. 

MaxPolygonsPerMaterial=16380 

; Default is 16380. Set to a lower value if you are unable to create an o2c object from a 

model that contains many polygons per material. 

5. Bitmap textures marked "in-use" by the Object Viewer would prevent you from editing 

them in a paint program while DataCAD was running. This has been corrected. 

6. In the Reference File Manager, the Layer list was not being cleared once an XREF had 

been selected for Reload/Refresh/Bind/Delete/Redefine. This has been corrected. 

7. Multiple selection has been restored to the Layer list in the Reference File Manager. 

8. Errant object snapping within XREFs and Symbols when intersection snapping is 

enabled has been corrected. 

 

11.06.00 

New Features 

AutoCAD R2004 – R2006 Compatibility 

DataCAD 11.06.00 adds support for importing and exporting AutoCAD R2004 through R2006 

files in DXF and DWG format. This enables you to collaborate and share files with associates 

who use the latest versions of AutoCAD. 

1. Symbol Text Attributes Using Databases 

You can now add values to symbol text attributes by selecting them from a Tab 

Delimited database. 

Overview: 

When you create a Symbol Text Attribute, you will notice a new section "Database 

Linkage" for defining a database source to select values from. 

No Link 

Just like it sounds. This is the default setting. 

Lookup Field 

Specify a field within database records to choose a value from. 
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Field Filled by Lookup 

Field value set by previous symbol attribute. 

Database Name: 

Choose Tab Delimited Text File (*.txt) for database source. 

Note:  Only Tab Delimited databases with a TXT extension are currently supported.  Most 

database and spreadsheet programs will save to a tab-delimited format. 

You will also find a new menu item, Refresh Fields From Database(s), located on the 

Symbol Browser Options menu which allows you to update the values contained in 

symbol text attributes you've inserted into the drawing to reflect the latest changes in 

your database(s). 

Notes on Databases: 

There are many ways to create a database. A database is... 

"A collection of data arranged for ease and speed of search and retrieval". 

You could create a spreadsheet (Client List.xls) where column A contains "First Name" 

and column B contains "Last Name". Each column represents a "Field" in the database. 

Each row represents a "Record" in the database. 

When you create a Symbol Text Attribute, you can use the Lookup Field option to tell 

DataCAD to display a drop-down list of First Names from your Client database. Then 

you can select the name when you insert a symbol that contains this text attribute. 

Since a symbol can contain an unlimited number of symbol text attributes, you could 

create the following six attributes... 

First Last 

Street 

City State Zip 

...and save them as a symbol. 

Using the Field Filled by Lookup option, you can tell DataCAD to automatically 

populate the values of Last, Street, City, State, and Zip based on the First name you 

select. 

If you update the addresses in your client list database, you can then use the Refresh 

Fields from Database(s) option to update the values that appear in your drawing. 

3. You can now use the Reference File Manager and the Orphans dialog to redefine multiple 

XREFs at once. 
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4. You can now launch the current highlight selection directly into the Object Viewer. 

5. Added link to new DataCAD Forum to Help pull-down menu. 

 

Fixes 

1. During DXF/DWG import/export, the degree symbol [°], typically [Alt] + 0127 in CHR 

fonts or [Alt] + 0176 in TTF fonts, is mapped accordingly.  So, if you map an SHX font to 

a TTF font, all the [Alt] + 0127 characters will be mapped to [Alt] + 0176. 

2. Using the Measures, Takeoffs menu on multiple polylines would only return the area 

and perimeter values for the first polyline.  This has been corrected. 

3. Crashing in HLR routine caused by covered polylines with equal z-base/z-height values 

has been corrected. 

4. Non-resizable folder browser dialog fixed. 

5. Cut/Fill calculation routine error corrected. 

6. Problem with line type and hatch pattern definitions coming from older versions of 

DataCAD has been corrected. 

 

11.05.02 

Fixes 

1. An error that would cause the drawing window to refresh unnecessarily (once for each 

polyline entity) when exiting the Curves, Polyline, Edit menu has been corrected. 

 

11.05.01 

New Features 

1. DataCAD XClips are now exported via DWG. 

Notes: 

"Automatically Export Reference Files" must be enabled. 

A new version of DXFDWG.DLL is installed with this update. 

2. You can add the following entry to the [Toolbars] section of DCADWIN.ini to prevent 

toolbars from "stretching" when they are locked. This is useful if you like to dock the 

menu window toward the bottom of the application window. 
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[Toolbars] 

Stretched=1 

Default is 1. Set to 0 to disable toolbar "stretching". 

3. A new ground plane option has been added to the Object Viewer. You can add the 

following entries to the [o2cViewer] section of DCADWIN.ini to control the ground 

plane's settings. 

[o2cViewer] 

GroundPlane=FALSE 

Default is FALSE. Set to TRUE to enable automatic ground plane creation. 

GroundPlaneEnlargeFactor=1.5 

Default is a square with sides that are 1.5 times the greatest model x, y, or z extents. 

GroundPlaneAtBase=TRUE 

Default is TRUE. If TRUE, ground plane is created at the base of the model's extents. If 

FALSE, ground plane is created at specific height. 

GroundPlaneAtHeight=0 

Default is 0. Elevation of ground plane in world units (1 unit = 1/32"). 

GroundPlaneMaterialFile=Materials\default.ini 

Specify the material file for the ground plane rendering settings. 

4. You can add the following entry to the [General] section of DCADWIN.ini so DataCAD 

will always display the Windows arrow cursor instead of the crosshair cursor. This 

option is useful for creating online demos such as Viewlets when you do not want the 

cursor to change between the arrow and the crosshair. 

[General] 

ShowWinArrowCursor=FALSE 

Default is FALSE. Set to TRUE to force display of Windows arrow cursor. 

5. A new toolbar code, L=170, has been added for Edit Symbol Attribute. 

 

Fixes 

1. A serious error that could cause drawing data corruption has been corrected. The error 

would typically corrupt embedded line type assignments. 

2. The following sequence would cause DataCAD to close without prompting you to save 

changes. 
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a. Use [Alt] + [q] shortcut to "Quit" 

b. Select Cancel 

c. Use [Alt] + [q] shortcut to "Quit" 

d. Right-click the mouse 

This has been corrected. 

3. An error related to the Batch Plot, To File, Browse dialog has been corrected. 

4. An error related to the display of superscripted values on the Information Toolbar has 

been corrected. 

5. The Mask, Entity menu labels now read from DCADWIN.LBL versus DCADWIN.MSG. 

6. All line types would import from DXF/DWG as Solid. This has been corrected. 

7. Dimension, Change, Text Position did not show the full extents of stacked fractions 

when repositioning dimension text. This has been corrected. 

8. It was not possible to set a reference point during Dimension, Change, Text Position as 

in previous versions. This capability has been restored. 

9. The scroll wheel now zooms in Quick Layout and changes the plot scale in Multi-

Layout. 

10. Dimension, Change, Text Style, Text Size now defaults to the current Text Size setting 

versus the default text size of 6". 

11. Display related fixes have been made to prevent "pixel dust" from occurring during 

drawing and editing operations. 

12. Hatch related fixes have been made to prevent associative hatch pattern bleeds and 

drop-outs. 

13. Creating a section with Permanent Arrows enabled would cause DataCAD to crash. This 

has been corrected. 

14. An error in the display of polylines during editing operations has been corrected. 

15. An error that would prevent FrameIt from building multiple boundaries simultaneously 

has been corrected. 

16. An error in the display of multi-weight text has been corrected. 
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17. An error that would prevent the AEC_Model macro from cutting a wall on a layer other 

than the active layer when layer search was enabled has been corrected. 

18. Shader lights would fail to render in the object viewer.  This has been corrected. 

 

11.05.00 

New Features 

1. Display Enhancements -- DataCAD's graphic pipeline has been enhanced for improved 

performance.  The time required for Panning, Zooming, Dynamic Panning, and Scroll 

Wheel Zooming has been significantly reduced.  In addition, the Perspective Walk 

Through, Pan View setting is recognized when you use either the scroll wheel or the 

dynamic panning method to walk forward or backward or step up, down, left, or right 

respectively.  A new menu item, Scroll Dist., has been added to the Perspective, Walk 

Through, Options menu to set the walk and step distance when you use the mouse to 

navigate in a perspective view. 

The following DCADWIN.ini entries have been added to fine-tune DataCAD's display 

settings so you can take advantage of faster graphics hardware. 

[Display] 

Enhanced Bitmap=FALSE 

Default value is FALSE. If FALSE, DataCAD will take less time to resample bitmaps 

before they are displayed (lower quality). If TRUE, DataCAD will take more time to 

resample bitmaps before they are displayed (higher quality). 

Max Vectors=10000 

Default value is 10000. Sets the number of vectors to display at once after recalculating 

the display (i.e., Regen). 

Max Entities=1000 

Default value is 1000. Sets the number of entities to draw before checking for an 

interrupt such as Panning or Dynamic Panning. If you have a fast display adapter, you 

can increase this value to reduce flicker when you use Dynamic Panning (entities filled 

with either hatch patterns or bitmaps are excluded). 

[Display List] 

Min Arc Vectors=24 

Default value is 24 segments. Sets the minimum number of vectors to draw for arcs, 

circles, and ellipses (symbols and XREFs excluded). The higher the value, the smoother 

arcs will display without requiring a regen. 

UseBoxOnScroll=TRUE 
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Default value is TRUE. If TRUE, DataCAD will display extents boxes for text and other 

complex entities when you use Dynamic Panning. If FALSE, DataCAD will not 

substitute extents boxes for text and other complex entities when you use Dynamic 

Panning. 

[Printer] 

Enhanced Bitmap=TRUE 

Default value is TRUE. If TRUE, DataCAD will take longer to resample bitmaps before 

they are printed (higher quality). If FALSE, DataCAD will take less time to resample 

bitmaps before they are printed (lower quality). 

[Bitmaps] 

MinSize=0.001 

MaxSize=100 

Specify the minimum and maximum size in megabytes of bitmaps to store in memory. 

Increase the minimum size and decrease the maximum size if the amount of RAM you 

have available is limited (i.e. 256MB or less) and if your drawings contain either a lot of 

and/or large bitmaps. 

2. Command Line Calculator Tokens -- You can use the following tokens with the 

Command Line Calculator. 

Operation Example Calculated Value 

Z-Base: 

=ZBASE+1 

Current Z-Base + 1 

 

Z-Height: 

=ZHITE+1 

Current Z-Height + 1 

Last X: 

=LASTX+1 

X coordinate of last point selected relative to absolute zero. 

Last Y: 

=LASTY+1 

Y coordinate of last point selected relative to absolute zero. 

 

Last Z: 

=LASTZ+1 

Z coordinate of last point selected relative to absolute zero. 
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Truncate: 

=TRUNC(123.456) 

123 

Fraction: 

=FRAC(123.456) 

0.456 

Logarithm: 

=LOG(1000) 

3 (Base 10) 

The following tokens are not covered in the Reference Manual. 

Raised to the power of: 

=10^2 

100 

Exponential: 

=EXP(1) 

2.718281828 

Absolute Value: 

=ABS(-123.456) 

123.456 

PI: 

=PI 

3.14159265359 

3. The orientation of the rubber band box for area selection now matches the angle of the 

cursor/grid.  A "Rotate" toggle has been added to the Area selection menu so you can 

align the rubber band box to either the drawing window or the cursor/grid angle. 

4. New toolbar codes have been added to control the Jamb In toggle for Door Swings. 

[JambIn On] 

V=1012 

[JambIn Off] 

V=1013 

5. An entry has been added to DCADWIN.ini to restore area and volume indicators 

generated by the Measures menu to pre-version 11 format. 
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[General] 

Superscripted Areas and Volumes=FALSE 

6. A new toggle, Locked, has been added to the Hatch Type menu so you can assign 

associative hatch patterns that are relative to their boundaries versus the drawing. 

7. New ASCII character codes have been added so you can set the state of the Locked hatch 

toggle via a keyboard macro, toolbar icon, or alias. 

[Alt] + 0252 [ü] : Turn Hatch Type Locked On 

[Alt] + 0253 [ý] : Turn Hatch Type Locked Off 

8. A new option, Hatch Origin, has been added to the Display menu. When toggled on, 

DataCAD will display the origin of associative hatch entities. Independently from the 

Hatch Origin display setting, DataCAD will show the origin of associative hatch entities 

when they are highlighted. 

9. A Self-XREF option has been added to the Insert menu for your convenience. 

10. A new built-in function number, L=179, has been added so you can insert a Self-XREF 

via a toolbar icon. 

11. A new toggle, Open RFM, has been added to the Insert, XREF menu so that DataCAD 

will automatically launch the Reference File Manager after you insert an XREF. 

12. It is now possible to change the radius of an arc using the Stretch command. 

13. The Symbol Browser folder browser dialog is now resizable on Windows NT/2000/XP.   

Note: This feature is not available on Windows 95/98/ME.  You can disable this feature by adding 

the following entry to the [SymbolBrowser] section of DCADWIN.ini. 

[SymbolBrowser] 

Resizable Folder Browser=FALSE 

Default value is TRUE. 

14. A new option, Lock Toolbars, has been added to the View pull-down menu. If checked, 

all docked toolbars will be locked into their current position. Floating toolbars will 

remain undocked. 

15. The following section can be added to DCADWIN.ini if you would like to customize 

which regions (i.e., Top, Bottom, Left, and Right) of the program interface will become 

fixed when Lock Toolbars is enabled. 

[Toolbars] 

Locked=0 
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Default value is 0. If set to a value of 1, all regions will lock/unlock. Top=2, Bottom=4, 

Left=8, 16=Right. If you only want the Top, Bottom, and Left regions to lock/unlock, set 

Locked to a value of 2+4+8 or 14. 

16. It is now possible to generate reports based on symbol text attribute data.  To generate a 

report based on symbol text attributes stored in your drawing, use the Extract Attributes 

option from the Symbol Browser Options menu. 

17. DCAL for Delphi-based add-ons (.DMX files) are now supported. 

18. File compression can be disabled by adding the following entry to the [General] section 

of DCADWIN.ini.  This option may be useful if you are sharing drawing files with 

someone who is using DataCAD LT 11. 

[GENERAL] 

Compressed Drawing Files=FALSE 

Default value is TRUE. If FALSE, DataCAD will not compress drawings when you save 

them. 

19. Added a scroll bar to the "Macros in Menu" list on the Macros tab of Program 

Preferences which allows you to see the entire path and name of macros in the list. 

 

Fixes 

1. The Backup option has been corrected to restore the last reference point when you create 

a Horizontal 3D Polygon. 

2. The order of the entities that comprise non-associative dimensions was changed in 

DataCAD 10.  The order has been restored to match DataCAD 9 and prior versions so 

that when you press the comma key, you will remove witness line 2 first. 

3. In some cases, performing an undo after saving a symbol text attribute would cause the 

drawing to close unexpectedly.  This has been corrected. 

4. In some cases, repeatedly exploding a symbol and performing an undo immediately 

afterward would cause the drawing to close unexpectedly.  This has been corrected. 

5. In some cases, repeatedly adding and clearing entries from the Batch Plotting list would 

cause DataCAD to crash.  This has been corrected. 

6. DataCAD will not allow you to save your drawing to a path where the available disk 

space is less than the drawing swap file. Previously, if you attempted to save a file to a 

location such as a floppy disk with insufficient space, the drawing would close without 

issuing any error and your changes would be lost. 
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7. An error related to creating a selection fence with more than 36 points such that some of 

the points cross over each other has been corrected. 

8. An error related to hatch patterns with names greater than eight characters has been 

corrected. 

9. An error related to Layer Sets that would result in an internal diagnostic fault error has 

been corrected. 

10. An error related to exporting partial ellipses to DWG format has been corrected. 

11. An error related to Self-XREFs with Nesting enabled has been corrected. 

12. Setting the Layout % to a value of zero would cause the drawing to close.  This has been 

corrected. 

13. Attempting to display a symbol in the Object Viewer from the Symbol Browser without 

the o2cPlayer.ocx control present would cause DataCAD to crash.  This has been 

corrected. 

14. A symbol assigned to "Draw Permanent Arrows" in the Section, Options menu was not 

remembered.  This has been corrected. 

15. An error that would cause an "Outermost" hatch to change to a "Normal" hatch when 

converted from DWG to AEC format has been corrected. 

16. An error that would cause dimension component colors to round-trip from DataCAD to 

DWG to DataCAD incorrectly, has been corrected. 

17. Text contained in an XREF that was enlarged, then bound would display the correct size 

but identify the original size.  This has been corrected. 

18. An error that would cause the origin of hatch contained within a symbol from a DWG 

file to shift when exploded has been corrected. 

19. An error that would prevent the AEC Model macro form from displaying has been 

corrected. 

20. The On Layers and All Layers menu options for exporting DXF, DWG, and DWF files 

have been separated so you can create a unique keyboard shortcut for each file type. 

21. An error that would cause the Quick Layout function to display the effective plotting 

area incorrectly when accessed using the [Ctrl] + [P] shortcut has been corrected. 

22. An error that would prevent DataCAD from saving a file to a folder with a name 

containing more than one period in Windows 98 has been corrected. 
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23. Plotting from the Preview window after plotting To File would cause DataCAD to plot 

To File rather than the printer you selected.  This has been corrected. 

24. An error that would cause a symbol to disappear when you tried to explode it on a 

locked layer has been corrected. 

25. An error that would cause duplicate drawing attributes to occur when loading a layer 

set has been corrected. 

26. When using the Layer Manager to rearrange layers in front of Layer 01, DataCAD would 

not save the new layer information to the auto-recovery file until a forced save was 

performed.  As a result, the layers that were moved in front of Layer 01 would be lost if 

the auto-recovery file were opened prior to a forced save. 

27. It is now possible to use the [+] character in a GoTo View name. 

28. The Line Type manager failed to recognize the [/] character when specifying line 

spacing.  For example, [..1/2] for half-inch spacing. This has been corrected. 

29. Information Pasted into a drawing from the Clipboard was not appended to the active 

Selection Set when the Append option was enabled in the SelSets menu. This has been 

corrected. 

30. Wall Style files (*.FWA) saved by the Frame-It macro would not load in DataCAD 11. 

This has been corrected. 

31. The inability to enter a blank string in the Password menu would prevent you from 

removing password protection from your files. This has been corrected. 

32. Clicking the Copy (or Cut) button after selecting information to Copy to the Clipboard 

would inadvertently toggle the InsertPnt button on. This has been corrected. 

33. In files that contained two copies of the same XREF with different layer settings, you 

were unable to bind On Layers only in the second XREF after binding All Layers in the 

first XREF.  This has been corrected. 

34. Creating an isometric view in a drawing would cause the Layer Sets function to add a 

view named LYRUTIL each time it was used.  This has been corrected. 

35. Exploding a symbol that contained an ellipse would cause the drawing to close 

unexpectedly.  This has been corrected. 

36. Under some circumstances, it would not be possible to select a polyline edge for editing 

when it was coincident with a line.  This has been corrected. 



DataCAD 11 | 263 

11.01.02 

37. Under some circumstances, it would not be possible to select an associative hatch 

boundary edge while hatching when it was coincident with a line.  This has been 

corrected. 

38. Various display anomalies have been addressed. 

 

11.01.02 

New Features 

1. In addition to using the scroll wheel to zoom in and out ([Ctrl] + Scroll Wheel by 

default), you can now use [Ctrl] + [Alt] + Left-click to pan the current view. 

2. You can add the following entry to the [General] section of DCADWIN.ini to reverse the 

zoom direction when using the scroll wheel. 

[General] 

Reverse Scroll Wheel Zoom=TRUE 

Fixes 

1. An error that would cause DataCAD to crash at the time you snapped to a polyline node 

when defining the first point of an axis for a revolved surface has been corrected. 

2. The Defaults option on the Interface tab of Program Preferences now restores the toolbar 

icon size to 16 after you restart DataCAD. 

3. An error that would cause the Wall Style Save As command to update both the current 

and new wall style has been corrected. 

4. The Item Name for a symbol would not appear in a symbol report if you used the undo 

command after saving the symbol.  This has been corrected. 

5. The GetSnap context menu now appears on the correct display when using dual 

monitors. 

6. An error that would cause angular dimension filled arrow heads to distort when 

bounded by a ClipCube has been corrected. 

7. The Fix Text option has been updated to work with the new text alignment options 

when you mirror text. 

8. The Offset value was ignored when loading dimension styles.  This has been corrected. 

9. The GoTo View list in the Reference File Manager was also displaying MSP details.  This 

has been corrected. 

10. The prompt, "Select entity to match color," has been restored to Change, Color, Match. 
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11. An error that would cause an MSP view to be recalled versus the corresponding GoTo 

View when using the [Shift] + 1, 2, 3... hotkeys has been corrected. 

12. An error that would cause the text size value to change after recalling a GoTo View 

when Text Scale was enabled has been corrected. 

13. Hatch Pattern Files (.PAT) and Line Type Definition Files (.LIN) that contained a blank 

line feed at the end of the file would not convert to the new .DHP or .LTF format 

properly.  This has been corrected. 

14. Hebrew and other right-to-left fonts may not display properly when you import them 

via DXF/DWG.  You can add the following entry to the [DXF_DWG] section of 

DCADWIN.ini so that DataCAD will ignore the backward flag applied to text. 

[DXF_DWG] 

BackwardTextFlag=FALSE 

15. TrueType Fonts, Fills, and Bitmaps did not display in the plot preview when running 

DataCAD on Windows 98.  As a result, it was not possible to save the plot preview 

image to PDF format.  This has been corrected. 

 

11.01.01 

New Features 

1. It is now possible to select XREFs using the Mask function. 

2. It is now possible to exclude hatch pattern entities from the Global Overshoot setting.  

To do this, set the Do Hatch toggle in the Overshoot Menu. 

3. It is now possible to set the default input mode by adding the following entry to the 

[General] section of DCADWIN.ini. 

[General] 

Default Input Mode=0 

0=Relative Polar 

1=Absolute Polar 

2=Relative Cartesian 

3=Absolute Cartesian 

4=Direction/Distance 

4. It is now possible to disable the [Insert] hot key so that you do not inadvertently change 

the current input mode by adding the following entry to the [General] section of 

DCADWIN.ini. 
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[General] 

Insert Key Disabled=TRUE 

5. The Rounding feature has been added to the Engineering, Decimal Feet, and 

Inch/Fraction scale types. 

6. It is now possible to adjust how closely the extents of your drawing fit to the edge of the 

drawing window by setting the Percent value in the Zoom menu. 

Note: This feature is only available when Free Zoom is enabled. 

7. The display of line weights has been enhanced so that there is a 1:1 correspondence 

between the line weight setting and the number of rows of pixels used.  Previously, a 

line weight of two would be represented by three rows of pixels and a line weight of 

three would be represented by five rows of pixels and so on. 

Note: This change effects the display of entities only, printed output remains the same.  The 

previous method can be restored by adding the following entry to the [General] section of 

DCADWIN.ini. 

[General] 

Old Line Weights=TRUE 

 

Fixes 

1. DataCAD would crash if you tried to identify an associative hatch entity on a locked 

layer that was created in a prior version.  This problem has been corrected. 

2. If the Scale Type were set to either Meters, Centimeters, or Millimeters, DataCAD would 

return the error "Points file units cannot be that small" when you tried to import 

surveyor data to create a TIN surface.  This problem has been corrected. 

3. An error that would cause the Layer Manager to no longer display an existing layer 

name after you tried to create a new layer with the same name has been corrected. 

4. Wall styles that used either dotted, dashed, or dot-dash line types would create walls 

with solid line types instead.  This problem has been corrected. 

5. Access to Add-On help is now working correctly. 

6. Multi-scale Plotting sheet extents would not fit correctly on newer displays with a 

resolution of 1440x900.  A new Layout % option has been added to the Multi-layout, 

Layout Settings menu so you can work with wider displays. 

7. The active layer was overwritten by the first layer in a layer set you imported.  This 

problem has been corrected. 
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8. Under some circumstances, MSP details would not import correctly from a layer set.  

This problem has been corrected. 

9. The message, "Automatic file save complete" now reads "Auto-recover file created."  You 

must save the changes you have made when you close a drawing file.  Auto-recover files 

are only used in the event you exit DataCAD abnormally. 

10. You cannot measure the perimeter or area of an open polyline. 

11. Under some circumstances, the previous stretch distance was not remembered correctly.  

This problem has been corrected. 

12. Some AEC files would fail to open - giving a "File decompression error -3" or "File 

decompression error -5."  This problem has been corrected. 

13. TrueType fonts and fills on extremely large paper sizes would be clipped or not be 

displayed at all.  This problem has been corrected. 

14. TrueType fonts and fills on extremely large paper sizes would be clipped and/or display 

in the wrong location if 'Rotate at device' was enabled.  This problem has been corrected. 

15. Fixed a problem where points imported from a DWG file would display as small dots 

instead of the standard small square DataCAD markers. 

16. Fixed a problem where files with associative hatch on locked layers created prior to 

version 11.01.00 would crash during file purge and close/save. 

17. 'Aligned' or 'Fit' text stored in a symbol that was then inserted exploded, changed aspect 

when it was then moved.  This problem has been corrected. 

18. Fixed a problem where Identify/Set All did not distinguish between symbol attribute 

text and regular text for text alignment and justification parameters, causing current 

values to become invalid. 

19. Fixed a problem where some drawing files saved in 11.01.00, then opened and saved in 

11.00.03 or earlier versions, then re-opened in 11.01.00 would crash. 

20. Loading DC5 files from certain prior versions of DataCAD caused exceptionally long 

load times.  This problem has been corrected. 

21. A change was made to correct disappearing text when printing clipped, rotated details, 

and with the media rotated at device option enabled. 

22. A problem has been corrected where arc based CHR text (such as HLV_TP) inserted 

with 'Mirrored' alignment would cause DataCAD to hang. 
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23. Fixed a problem where you could edit polylines on locked layers (which would not be 

allowed) and you would receive an Internal Diagnostic Fault 3 error from 77 when 

attempting to delete a vertex. 

24. It would only be possible to create rectangular polyline boundaries in either the 3D 

Knife or Revolved Surface menus if rectangle were the method set in the curves, polyline 

menu.  This has been corrected. 

25. The DXF/DWG translator now imports splines by converting them to either polylines (if 

the control points are co-planar and parallel to the ortho plane) or 3D lines. You can 

restore the previous method where DataCAD converts spline entities to a point for 

round-tripping by adding the following entry to the [DEBUG] section of DCADWIN.ini. 

[DEBUG] 

DWGSplineAsPoint=FALSE 

Default value is FALSE. TRUE restores previous conversion method. 

26. Corrections have been made to the DXF/DWG translator for improved conversion of 

hatch and MText entities. 

 

11.01.00 

New Features 

Classic-style Menu Window 

Classic Menu Window, Navigation Pad, Projection Pad, and Status Panel are available.  To 

enable these classic-style elements, go to View, Toolbars.  If you would also like to have the 

classic look of raised buttons, go to the Interface tab in Program Preferences and check Classic 

Buttons. 

Bitmap Orphans Manager 

A new bitmap orphans manager allows you to redefine paths for bitmaps you have already 

inserted into your drawing. 

Nested XREF (External Reference) Display Toggle 

A new option allows you to disable the display of nested external references at the time you 

insert an XREF.  You can also toggle the display of nested external references on a per XREF 

basis via the Reference File Manager or the context-sensitive pop-up menu.  The display of 

nested references can be disabled globally with the Display Nested XREFs option in the Nested 

XREFs section of the Misc. tab of Program Preferences. 
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Duplicate XREFs Use Same Memory Space 

Multiple XREFs of the same file now use a single memory space.  Used in combination with the 

Display Nested XREFs toggle, you can significantly reduce the amount of memory required to 

open your drawings that contain XREFs. 

Self-referencing XREFs Use Same Memory Space 

Multiple self-referencing XREFs now use the same memory space so DataCAD no longer 

creates a new swap file every time you reference a drawing into itself. 

Plot Scale Saved with GoTo Views 

A new option, Save with GoTo Views, has been added to the Current Plot Scale section of the 

Misc. tab of Program Preferences.  This lets you save the current plot scale with a GoTo View 

when you create it. 

Global Line Overshoots 

You can now set the line overshoot value globally so that it applies to all entities equally.  The 

global line overshoot is scale-independent and is defined as a real-world, plotted distance. You 

can access the Overshoots menu from the Line Type menu. 

Note: Overshoot must be toggled on in the Display menu to view/plot line overshoots. 

Contour Search Supports Line/Arc and Arc/Arc 

The contour search routine has been updated to handle line/arc and arc/arc conditions that were 

not supported previously. 

2-Line Trim Supports Line/Arc and Arc/Arc 

The two-line trim command has been updated to handle line/arc and arc/arc conditions that 

were not supported previously. 

Embedded Line Types 

Line Types (up to 255) are now stored in your drawing file.  Now, you do not have to worry 

about providing custom line type definitions to your colleagues when you give them copies of 

your drawings.  DataCAD 11.01.00 automatically converts your line type definitions from 

DCADWIN.LIN to individual .DLT files stored in \DataCAD\Support Files\Line Types. 

Line Type Creator 

Now, anything you draw can be converted into a new line type.  The line type creator allows 

you to select entities in your drawing (up to 65,536) to define one segment of a custom line type.  

You can begin using your new line type immediately. 

Line Type Manager 

A line type manager has been added to the Line Type menu. Select Line Manage from the Line 

Type menu to access a dialog for loading or re-loading external line type definitions into your 

drawing. You can also set the End Correction and Default Spacing for embedded line type 

definitions. 
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Note: The Factor option has been removed from the Line Type menu. The default spacing (or last spacing 

value entered on a per line type basis) is always used. 

The [q] and [Q] keyboard interrupts now recognize the default line type spacing setting in the 

line type definition. Now, the default line spacing for a given line type will automatically be set 

when you change the current line type using the [q] or [Q] keyboard interrupts. Previously, the 

default line type spacing was only set when you selected the current line type from the menu. 

Embedded Hatch Patterns (Optimized) 

Embedded hatch patterns have been optimized to require less memory. For example, in one test 

file that included four StoneCAD patterns applied to a lot of entities, the drawing file size was 

reduced from 17MB to 10MB.  DataCAD 11.01.00 automatically converts your hatch pattern 

definitions from DCADWIN.PAT to individual .DHP files stored in \DataCAD\Support 

Files\Hatch Patterns. 

Hatch Pattern Manager 

A hatch pattern manager has been added to the Hatching menu. Select Manage from the 

Hatching menu to access a dialog for loading or re-loading external hatch pattern definitions 

into your drawing. You can also set the angle and scaling for embedded hatch pattern 

definitions. 

Note:  By default, you cannot load a line type named “Solid,” “Dotted,” “Dashed,” or “Dot-Dash” into your 

drawing. These names are reserved for the internal hard-coded line type definitions. Lines 135 – 138 

determine the reserved names for these line types. 

Notes: Line Type and Hatch Pattern Managers 

The top section of each dialog displays the definitions that are currently (or will be) loaded into 

the active drawing. This section is used to modify parameters. Clicking OK or Apply will load 

newly selected definitions and/or apply changes you have made. Once your changes have been 

applied, you can use the Save or Save As options to save your internal definitions to the hard 

drive. You can use the Reload option to overwrite an internal definition with an external one. 

The lower section of each dialog displays external definitions that you may load into the active 

drawing. You cannot make changes to external definitions in this section. You must first apply 

changes to internal definitions, then use the Save or Save As options to externalize your new 

settings. 

You can manually convert DataCAD line types (.LIN) to the new (.DLT) format or DataCAD 

hatch patterns (.PAT) to the new (.DHP) format.  Use the Convert... option from the Line Type 

and Hatch Pattern managers. 

Launch External Application from Toolbar 

A new toolbar code has been added for launching external applications.  You can now use the 

new "P" code to launch an external program (such as WordPad) from a DataCAD toolbar icon. 
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To launch an external program from a DataCAD toolbar, use the following syntax. 

[Launch_WordPad] 

Hint=Launch WordPad 

Icon=WordPad_Icon 

P=c:\program files\windows nt\accessories\wordpad.exe 

If the external program supports command line parameters, you can include them as well.  The 

following example launches WordPad and automatically opens my_document.txt. 

[Open_My_Document] 

Hint=Launch WordPad and open My_Document.txt 

Icon=My_Document_Icon 

P=c:\program files\windows nt\accessories\wordpad.exe 

c:\my_documents\my_document.txt 

Screen Calibration 

Using the Screen Calibration dialog, accessible from the Interface Settings tab of Program 

Preferences, you can measure the test pattern in either decimal inches or millimeters to adjust 

both the screen scaling and aspect ratio. 

Browse Symbols from Toolbar 

There is a new Toolbar Code for Symbol Browser You can now use the new "B" code to load a 

folder or template into the symbol browser via an icon. 

Use the following syntax in your toolbar (.DTB) file. 

To open a folder... 

[Browse_Folder] 

Hint=Browse for drawing notation symbols. 

Icon=Drawing_Symbols_Icon 

B=c:\program files\datacad\symbols\drawing\ 

or 

[Browse_Folder] 

Hint=Browse for drawing notation symbols. 

Icon=Drawing_Symbols_Icon 

B=symbols\drawing\ 

To open a template... 

[Open_Template] 

Hint=Open drawing notation template. 

Icon=Drawing_Template_Icon 

B=c:\program files\datacad\templates\drawing.tpl 

or 

[Open_Template] 

Hint=Open drawing notation template. 

Icon=Drawing_Template_Icon 

B=templates\drawing.tpl 
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Note: The .tpl extension is required to open a template.  Otherwise, DataCAD assumes you are browsing a 

folder. 

Enhanced Context-sensitive Menu 

An Identify section has been added to the context-sensitive ([Ctrl] + Right-click) menu for quick 

access to Identify Set and Set All options.  XREF-related options have been grouped together in 

an XREF Tools fly-out menu that provides quick access to the following options. 

Other Enhancements 

1. The SPB-Fills Settings dialog now shows the current layer color when the Fill Color is set 

to Entity instead of displaying the last fill color used. 

2. A Clear option has been added to the Multi-View Window context-sensitive menu. 

3. If you would like to adjust the number of colors to scroll through using the [k] and [K] 

key interrupts, add the following entry to the [PaletteFile] section of DCADWIN.ini. 

[PaletteFile] 

MaxColorsInKey=15 

15 is the default. You can use any number from 1 to 255. 

4. The Auto-recover Save interval is now set on a global basis instead of a per drawing 

basis.  Go to the Misc. tab of Program Preferences to change the default value of 15 

minutes. 

5. If you would like to adjust the number of items to display in the status panel drop-down 

lists (Colors, Line Types, Layers, Scales, and GoTo Views), add the following entry to the 

[StatusArea] section of DCADWIN.ini. 

[StatusArea] 

MaxColors=15 

MaxLineTypes=15 

MaxLayers=15 

MaxScales=15 

MaxGotoViews=15 

6. All the drawing indicators (Reference Point, Object Snap Point, and Absolute Zero) may 

be selectively enabled via the Drawing Indicators section of the Misc. tab of Program 

Preferences. 

7. DataCAD's built-in Dashed line type definition has been updated so that each segment 

begins and ends with a solid line. 

8. You can add the following entry to the [PaletteFile] section of DCADWIN.ini so that 

DataCAD will always read your external RGB Color Palette files instead of the 

embedded one. 
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[PaletteFile] 

Store In Drawing=FALSE 

9. The current offset distance is now displayed on the attention toolbar when you perform 

a perpendicular offset. 

10. You can now reset the drawing timer to zero from the Directory menu. 

11. DataCAD now remembers the last DXF/DWG export format you selected instead of the 

default R14 DWG. 

12. We added an Internal Menu Function Number (L=170) for Edit Symbol Attribute. 

13. The layer name input field for saving hidden line removal images now supports long 

layer names. 

14. DataCAD symbol paths now round-trip to/from DXF/DWG.  Previously, due to an 

AutoCAD limitation, DataCAD would only export the symbol name to DXF/DWG 

format, not the fully qualified path. (i.e., my_symbol.dsf instead of 

c:\program_files\datacad\symbols\my_symbols\my_symbol.dsf). 

Note: Symbols (a.k.a. Blocks) that are redefined or created in the DXF/DWG file will not include 

the fully qualified symbol path. 

15. The Purge Drawing dialog has been updated. The pull-down menus have been 

corrected; now, you can select empty layers and unused symbols, line types, and hatch 

patterns to be automatically purged from the drawing database. 

16. New ASCII character codes. 

[Alt] + 0250 [ú] : Turn Offset Perpendicular On 

[Alt] + 0251 ]û] : Turn Offset Perpendicular Off 

17. All DataCAD's dialog boxes will now remember their size and position (if applicable). 

This includes support for multiple-monitor, extended desktops. 

If you wish to have all your dialog boxes pop up in the center of your screen, you can 

add the following entry to the [General] section of DCADWIN.ini. 

[General] 

CenterDialogBoxes=TRUE 

The default value is FALSE. 

18. The Begin option has been removed from the hatch pattern menu.  Hatch patterns and 

fills are now applied immediately to entities at the time you select them.  You can restore 

the Begin option by adding the following entry to the [HatchPatterns] section of 

DCADWIN.ini 
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[HatchPatterns] 

SingleClick=FALSE 

 

Fixes 

1. Selecting the close document icon while DataCAD was still in the process of opening the 

file would cause an illegal operation.  This problem has been corrected. 

2. If you receive an error message when using a KIP plotter driver, please add the 

following entry to the [Printer] section of DCADWIN.ini. 

[Printer] 

Strong Printer Checks=FALSE 

3. Associative hatch boundaries with less than three vertices would cause DataCAD to 

crash when accessing Quick Layout via the Print/Plot menu.  This problem has been 

corrected. 

4. Users without administrative privileges who launched the Object Viewer while using 

bitmap textures that required administrator privileges would cause DataCAD to crash.  

This problem has been corrected. 

5. Selecting Edit Fields via the context-sensitive menu within the Symbol Browser would 

cause DataCAD to not respond in some circumstances.  This problem has been 

corrected. 

6. Creating a fence area selection with more than 36 points would result in an internal 

diagnostic fault in some circumstances.  This problem has been corrected. 

7. Opening a DC5 file from read-only media would cause an exception error in 

imagelib.dll.  This problem has been corrected. 

8. When the last entity added to the current layer was an orphaned XREF, using the [,] or 

[.] keys would cause the drawing to close.  This problem has been corrected. 

9. Using the Match function from within the Layers menu would cause an internal 

diagnostic fault.  This problem has been corrected. 

10. Redefining an orphaned XREF would cause DataCAD to crash.  This problem has been 

corrected. 

11. Moving a drawing that contained self-referencing XREFs to a directory other than the 

one it was created in would cause DataCAD to crash when re-opening the file.  This 

problem has been corrected. 
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12. Trying to open a drawing that was in-use, and then selecting Cancel when prompted by 

DataCAD to open a copy would prevent you from being able to save the current 

drawing.  This problem has been corrected. 

13. Under some circumstances, DataCAD would crash if you tried to insert a self-

referencing XREF into a drawing opened via a mapped network drive using a non-

mapped (a.k.a. "browsed") network drive.  This problem has been corrected. 

14. Under some circumstances, DataCAD would crash when you tried to select a hatch 

pattern from the menu window. 

15. Some third-party fonts would cause DataCAD to crash when selected in the Font dialog.  

This problem has been corrected. 

16. Under some circumstances, copying a polyline would cause DataCAD to crash.  This 

problem has been corrected. 

17. Under some circumstances, entering a door swing using the Sliding door style with 

center point off would cause a floating-point error.  This problem has been corrected. 

18. Under some circumstances, DataCAD 11 would not recognize the layer search setting 

for inserting door swings from prior version files.  This problem has been corrected. 

19. DataCAD would crash when switching back to the previously opened document if you 

tried to open an unsupported file type.  This problem has been corrected. 

20. Ghosting that would occur when you deleted a dimension with filled arrow heads has 

been corrected. 

21. Under some circumstances, R2000 DWG files created by DataCAD would cause 

AutoCAD to issue a warning: "The last command created proxy entities...Missing 

Application: WipeOut..." upon File, Open.  This problem has been corrected. 

22. The surface area calculation of non-orthogonal 3D polygons was incorrect.  This 

problem has been corrected. 

23. Under some circumstances, DataCAD would not return you to the drawing if you 

selected Cancel from the Save As dialog.  This problem has been corrected. 

24. Opening a DXF/DWG file directly with a default drawing specified would cause 

DataCAD to draw the contents of the default drawing twice.  You would then have to 

refresh the display to see the contents of the DXF/DWG file.  This problem has been 

corrected. 

25. Under some circumstances, dimension arrow heads were exported to DXF/DWG format 

at the wrong size.  This problem has been corrected. 
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26. The pan view down icon is now disabled when the Layers, On/Off menu is active. 

27. Errors in menu hints have been corrected. 

28. DataCAD would not add/subtract the areas of multiple polylines when the first polyline 

selected included a void.  This problem has been corrected. 

29. Hard-coded labels have been externalized for translation purposes. 

30. When using a scale type set to millimeter, dimension text values larger than 999mm no 

longer display a comma to separate 1,000's. 

31. DataCAD would duplicate entities on the current layer when you tried to copy them to a 

locked layer.  This problem has been corrected. 

32. The To Drawing option would enter angle values in degrees, minutes, and seconds 

when the Angle Type was set to decimal degrees.  This problem has been corrected. 

33. The "Fit" alignment method did not apply to symbol attribute text properly.  This 

problem has been corrected. 

34. Self-referencing XREFs would not un-highlight after selecting them with the [Ctrl] + 

Right-click shortcut.  This problem has been corrected. 

35. DataCAD would create an inordinate number of temporary files when you inserted 

multiple self-referencing XREFs.  This problem has been corrected. 

36. The display of text you entered was not updated immediately when using an alignment 

method other than left, bottom.  This problem has been corrected. 

37. Inserting multiple copies of a symbol exploded to its original layers would cause the 

entities to belong to the same group.  This problem has been corrected. 

38. The line weights of entities contained within an XREF would increase proportionally to 

the XREFs enlargement factor.  This problem has been corrected. 

39. Errors related to using Hebrew CHR-based text have been corrected. 

40. The Layer Sets function would create invalid layers corresponding to the off layers when 

saving just the on layers.  This problem has been corrected. 

41. Covered polylines with bulges would not render or explode to polygons correctly.  This 

problem has been corrected. 

42. Under some circumstances, it was not possible to set the XREF highlight line type 

spacing to match the referenced file.  This problem has been corrected. 
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43. The characters used to indicate area and volume by the To Drawing function are 

determined by lines 4495, 4496, 4497, and 4498 in the DCADWIN.MSG file. 

44. The Direction/Distance input mode would not work if the Coordinates/Hints toolbar 

were turned off.  This problem has been corrected. 

45. It is now possible to undo Move In Front, Behind, To Front, To Back and Swap 

operations. 

46. It would take two undo levels to undo a rectangular polyline.  This problem has been 

corrected. 

47. Filled arrow heads on text arrows would not export to DXF/DWG format.  This problem 

has been corrected. 

48. The warning "This file contains orphaned XREFs" would not be displayed if a reference 

file were renamed or moved via Windows Explorer. 

49. It was not possible to set a texture scaling value to less than 1000 when the Scale Type 

was set to Millimeters.  This problem has been corrected. 

50. Loading a pen table directly from a network file server to either a Windows NT, 2000, or 

XP workstation would take an inordinate amount of time.  This problem has been 

corrected. 

51. The Small Text setting did not apply to text contained within an unexploded symbol.  

This problem has been corrected. 

52. In some cases, the [Ctrl] + [e] keyboard shortcut for clipboard select would not work 

after dismissing a dialog box.  This problem has been corrected. 

53. The DCADWIN.ini setting NoGridInSelect=FALSE would not re-enable the snap grid 

during selection and editing operations.  This problem has been corrected. 

54. DCAL macros were unable to call the polygons menu.  This problem has been corrected. 

55. The Small Text setting did not apply to symbol attribute text contained within an 

unexploded symbol.  This problem has been corrected. 

56. It was possible to use the [Ctrl] + [Tab] keyboard shortcut to change the active document 

window when a dialog box was active.  This problem has been corrected. 

57. Clicking in the symbol browser before you complete the current operation will now 

interrupt the current operation. 
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58. The Object Viewer's background color was not remembered.  This problem has been 

corrected. 

59. Under some circumstances, non-associative hatch patterns were drawn incorrectly.  This 

problem has been corrected. 

60. The command line calculator did not adhere to the Windows regional setting for the 

decimal separator.  This problem has been corrected. 

61. Metric values with more than four digits to the right of the decimal separator are no 

longer rounded to three digits when entered in an input field. 

62. Surveyor data with decimal values of 13 or more significant digits would get rounded to 

a maximum of 12 significant digits when imported into DataCAD.  The maximum 

number of significant digits supported by DataCAD is now 14. 

63. Hatch, Pattern, and Bitmap fill settings are now remembered on a per drawing basis. 

64. DXF/DWG files would not open via the Windows Open With... command.  This problem 

has been corrected. 

65. The Symbol Browser now refreshes automatically when you change the drawing area 

background color. 

66. Spaces used in layer names within the first eight characters are no longer automatically 

converted to an underscore. 

67. The two-line trim command would appear to work on entities stored on a locked layer 

until you refreshed the display.  This problem has been corrected. 

68. Drawing a 3-point circle with a near-infinite radius would cause a significant pause.  

This problem has been corrected. 

69. The drawing extents of associative dimensions were not calculated properly under some 

circumstances.  This problem has been corrected. 

70. The 'Update' option in the Sectioning tool was unable to find the original section cutline 

after a file save, and an illegible error message would be displayed. This problem has 

been corrected. 

71. Fixed a problem where selecting a multi-scale plot sheet would cause an invalid 

floating-point operation. This would occur when the sheet contained polylines with a 

bulge as the first vertex. 

72. An error has been corrected in the file purge routine that would cause entities belonging 

to a selection set to lose their association with the selection set. 
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73. The Millimeter scale type has been corrected to not display a comma in linear dimension 

values greater than 1000. 

74. If the last entity added to the current layer was an XREF, pressing the [,] or [.] key would 

cause the drawing to close. This problem has been corrected. 

75. It was not possible to disable the Drop Mesh Drop Edge option.  This problem has been 

corrected. 

76. An exploded symbol's text would not retain its original alignment position.  This 

problem has been corrected. 

77. The object snapping point indicator did not reflect the correct point when using the 3D 

cursor.  This problem has been corrected. 

78. Under some circumstances, solid fills would "leak" out of boundaries that contained 

concave bulges.  This problem has been corrected. 

79. Performing an Undo after saving a symbol with a symbol text attribute would cause 

DataCAD to crash.  This problem has been corrected. 

80. Under some circumstances, the drawing extents would not calculate properly if a clip 

cube were active.  This problem has been corrected. 

81. An error related to the Polyline to Polygon feature of 3D Power Tools has been 

corrected. 

82. The display of Templates is now fully supported by the Symbol Browser. 

83. If you experience "jumping" toolbars because the font on the Context Toolbar's neutral 

state label is too large, you can add the following entry to the [Toolbars] section of 

DCADWIN.ini. 

[Toolbars] 

Point_size=10 

This key sets the point size of the text used for the Context Toolbar's neutral state label, 

Status Bar pull-down menus, and SWOTHLUDFB text independently from your 

Windows pull-down menus. 

84. The Cut Wall routine would cause DataCAD to crash when the [Enter] key was used to 

select the sides of the opening.  This problem has been corrected. 

85. Trying to install or update DataCAD while it was running would cause a fatal error.  

The installation program now determines if DataCAD is running and prompts you to 

close DataCAD before continuing. 
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86. Hatch patterns will now apply to 3D Blocks when you generate a section. 

87. Setting a perspective view would sometimes cause an access violation in drawings that 

were created prior to version 11. 

 

11.00.03 

New Features 

1. Z-Offset sub-options for inserting symbols are now toggles. So, it is now possible, for 

example, to insert a symbol at the current Z-Base without having to reset the Z-Offset 

value. 

2. It is no longer necessary to reselect Perpendicular Distance when setting a new distance 

value for a perpendicular offset. 

3. A new XREF-related option, XClip, has been added to the [Ctrl] + Right-click context 

menu. 

4. A Delete Empty option has been added to the Layer Manager. 

 

Fixes 

1. An error that would cause a drawing to close unexpectedly when plotting associative 

hatch to a DesignJet plotter has been corrected. 

2. A scenario that would cause DataCAD to create an inordinate number of temporary files 

when opening a file containing XREFs via a network path has been corrected. 

3. An error that would cause a drawing to close unexpectedly when changing the position 

of dimension text has been corrected. 

4. An error that would cause a drawing to close unexpectedly when inserting an XREF of a 

file with an empty active only layer has been corrected. 

5. Polylines with voids did not fill properly. This problem has been corrected. 

6. The file hyperlink for an XREF was not updated when its path was redefined. This 

problem has been corrected. 

7. The DCADWIN.ini setting FixFilledCurves=TRUE was not recognized. This problem has 

been corrected. 

8. The extents of a drawing with an XREF containing an empty on layer were not 

calculated correctly. This problem has been corrected. 
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9. The Layer Filter toggle was inadvertently enabled when opening a DC5 file that did not 

have the Layer Filter enabled. This problem has been corrected. 

10. The insertion points of symbols, the center points of arcs and circles, and the control 

points of 3D entities were not rotated with the corresponding drawing entities when 

displaying a rotated plot. This problem has been corrected. 

11. The snap grid was not automatically disabled when editing polyline voids. This problem 

has been corrected. 

12. Stringline dimensions drawn consecutively can now be selected as a "Group". 

13. The Attention bar now displays the name of either the current Printer or Fit To Printer, 

whichever is active. 

14. Incorrect results or fatal errors would occur during view manipulation in DCAL macros. 

This problem has been corrected. 

15. The 'Update' option in the Sectioning tool was unable to find the original section cutline 

after a file save, and an illegible error message would be displayed. This problem has 

been corrected. 

16. Fixed a problem where some DCAL macros that create polygons and/or slabs (such as 

3DTools' triangulation tool) would create polygons/slabs with all sides marked invisible. 

17. Fixed a problem where selecting a multi-scale plot sheet would cause an invalid 

floating-point operation. This would occur when the sheet contained polylines with a 

bulge as the first vertex. 

18. Fixed a DCAL problem where the lyr_seton procedure for turning layers on/off did not 

work. 

19. An error that would cause DataCAD to check for network messages an inordinate 

number of times resulting in a performance slowdown has been corrected. 

20. "Cutting" data from the drawing to the clipboard when using an insertion point did not 

work.  This problem has been corrected. 

21. The logic for selecting menu buttons has been optimized to eliminate delays when 

clicking options in rapid succession. 

 

11.00.02 

DataCAD 11 New Features and Enhancements 
For details on the new features and enhancements to DataCAD 11, please click: 
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What's New? from the Help pull-down menu in DataCAD. 

New Feature Highlights 

Double-precision Database 

DataCAD 11 uses double-precision floating point math to calculate and store values in the 

drawing database. Prior versions of DataCAD had an effective accuracy of ~7 decimal places. 

DataCAD 11 has an effective accuracy of ~14 decimal places. That means DataCAD 11 is now as 

accurate as AutoCAD® and you can work on much larger projects without running into 

rounding issues, especially when importing large drawings. 

Network Awareness 

DataCAD can query other instances of DataCAD running on a network to determine whether a 

file is “in-use.”  Every time you open a drawing, DataCAD records the date, time, username, 

and workstation name in a corresponding user (.U$R) file.  If you try to open a drawing file that 

is “in-use,” DataCAD will only allow you to open a copy of the file. 

Backup and Recovery 

We revamped DataCAD’s backup and recovery process to be more reliable and less confusing.  

Whenever you exit a drawing abnormally, DataCAD will automatically try to recover the most 

recent version of your file without prompting you with unnecessary warnings and options. 

File Purge 

DataCAD files are automatically purged of any unused data each time you exit and save your 

drawing.  In addition, a Purge dialog replaces the Layer Utility macro, allowing you to create 

new drawings based on a sub-set of an existing drawing. 

Compressed Drawing Files 

DataCAD 11 drawings are now stored in a compressed format making them roughly 1/5 the 

size of previous versions. 

Drawing Session Backups 

Drawing session backups is a new feature that allows you to configure DataCAD to 

automatically save up to 10 incrementally named backup drawings.  Session backups are only 

created each time you exit and save your drawing. 

Program Interface 

DataCAD 11 features an updated program interface that provides Windows 2000-style 

properties and support for Windows XP Themes and "Skins".  You can position toolbars and 

menus where you want by tearing them off and docking them to the top, bottom, left, or right 

side of the application window.  You can also place toolbars and menus outside of DataCAD to 

"float" on the desktop, allowing you to resize the drawing area without adversely affecting the 

user interface and to take advantage of dual monitor displays.  In addition, all the interface 

elements in DataCAD 11 will inherit the visual style of your current desktop theme.  For more 

information about Windows XP Themes, go to http://www.themexp.org. 



282 | DataCAD 11 

DataCAD 11 New Features and Enhancements 

Symbol Browser 

DataCAD 11 introduces an easier way to browse, select, and manage symbols.  The new Symbol 

Browser allows you to rapidly find, place, customize, and manage symbols that you use in your 

drawings.  Inserting a symbol into your drawing involves little more than selecting it from the 

Symbol Browser and dropping it where you want it.  With just a few mouse clicks, you can 

open the appropriate folder, display the symbols in the browser, and select the ones you want 

to use into your drawing. If you developed custom templates with older versions of DataCAD, 

you can open them in the Symbol Browser, too. In effect, the Symbol Browser treats file folders 

as templates that contain collections of symbols. 

Symbol Reporting 

We have enhanced symbol reporting so you can run reports on all symbols in the drawing 

instead of just the symbols in the active template.  A new dialog gives you access to report 

forms and displays an on-the-fly preview of the results. 

Symbol Fields 

It is now possible to assign an unlimited number of user-defined fields to symbols for enhanced 

reporting.  You are no longer limited to the five default fields. 

Symbol Attributes 

Text attributes can be defined and added to symbols. This lets you use the same symbol 

multiple times, supplying a unique text string for each one.  For example, you could use one 

desk symbol several times and label them “Jim’s desk,” “Nancy’s desk,” and “Bob’s desk.” 

Drop Symbols On Polygons 

A new option available for inserting symbols allows you to drop any item such as a tree directly 

on the surface of a polygon. 

TIN Surface Modeler 

A new TIN  (Triangulated Irregular Network) surface modeler provides a comprehensive array 

of three-dimensional site modeling tools.  The TIN modeler can connect a random series of 

survey points (3D markers) with triangular polygons. Once the polygons are generated, you can 

calculate the surface area of TIN models, use the flip valley option to “flip” the valley between 

coincident polygon edges, or create roads, foundation cuts, etc. with the 3D Knife.  The drop 

point option lets you place 3D markers on the surface of inclined polygons. You can create 

polyline contours from polygon site models. 

Drop Point 

You can place a three-dimensional marker on a polygon at an inclined point. 

Make Contours 

You can make a topological contour map based on a group of three-dimensional points or 

polygons. 
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Ruled Surface Modeler 

A ruled surface function allows you to mesh polygon surfaces between polylines and contours. 

3D Knife 

A three-dimensional knife allows you to interact with TIN surfaces to create roads, sidewalks, 

and foundation cuts. 

Sectioning Tool 

You can easily create two-dimensional sections from three-dimensional models using the new 

sectioning tool.  Advanced options allow for automatically hatching and updating sections.  

You can also create hidden line sections.  Straight, offset, and curved section paths are 

supported. 

Multi-View Windows 

All-new multi-view windows provide up to 10 tear-off, resizable windows you can use to store 

and display various views of your project. 

Expanded Bitmap Support 

The number of supported image formats has been increased to include BMP, JPG, GIF, TIF, 

TGA, PNG, PCX, EPS, and PCD files. 

Stereolithography 

You can export your DataCAD models to STL format for use with rapid prototyping machines 

including 3D printers.  You can also import STL files into DataCAD from other programs. 

3D Studio 

You can import 3DS files into your DataCAD drawings. 

WHIP! 

DataCAD 11 adds support for DWF format so you can view and distribute your drawings via 

the Internet. 

o2c Rendering 

We have enhanced the interface for assigning materials to o2c objects so you can control the 

origin, angle, and scale of any bitmap texture.  In addition, you are no longer limited to 32,768 

polygons per material. 

PDF Files w/ Layers 

Drawing layers can now be included when you create a PDF file directly from DataCAD. 

Note: Requires Adobe Reader version 6 to view layers.  However, PDF files created by DataCAD 11 can be 

read by Adobe Reader versions 4 and 5. 

Context-sensitive Toolbar 

A user-definable, context-sensitive toolbar automatically changes to present related icons based 

on the menu you choose.  A configuration dialog allows you to easily set which toolbar is 

related to a menu selection. 
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Enhanced Keyboard Macros 

User-defined keyboard macro sequences can now include up to 1,024 commands and there is no 

limit to the number of characters you can use in the sequence.  We have also added a special 

PAUSE character so you can tell the macro to wait until you do something such as click or type. 

Nested Aliases 

You can call a command line alias by name when you define a macro sequence so you can take 

advantage of existing aliases. 

 

Fixes 

1. Drawing file previews would not display for drawing files that included a period in the 

name.  This problem has been corrected. 

2. Changing either the Div-X or Div-Y value for DropMesh would set both to the same 

value.  This problem has been corrected. 

3. The bounding box for dragging TrueType text would not display when the background 

color was set to white.  This problem has been corrected. 

4. Angular, radius, and diameter dimensions with filled arrow heads would not display 

correctly when contained within a clip cube.  This problem has been corrected. 

5. The preview image for JPEG files would not display when highlighted in the File I/O 

dialog.  This problem has been corrected. 

6. Curved walls created in DataCAD Plus using the Gen2D feature would not display 

correctly when opened in DataCAD.  This problem has been corrected. 

7. DataCAD files will now launch properly when you double-click on them via Windows 

Explorer, even if DataCAD is already running. 

8. If you bound an XREF that was not inserted at absolute zero, and it contained dimension 

text that you placed manually, the dimension text would return to its original position 

relative to absolute zero.  This problem has been corrected. 

9. If you bound an XREF that you mirrored after you inserted it into your drawing, and it 

contained polylines and/or hatches, the polylines and/or hatches would flip.  This 

problem has been corrected. 
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Fixes 

1. Fills applied to arcs, circles, ellipses and partial ellipses were automatically cleared upon 

re-opening a drawing due to a correction made in version 10.05.01 to automatically clear 

fills that were unknowingly applied to arcs, circles, ellipses and partial ellipses in 

10.04.01 and prior 10.x versions. This problem has been corrected. 

2. The color tables in the DXF/DWG Color Map dialog were not refreshed when switching 

between "DataCAD to DXF/DWG" and DXF/DWG to DataCAD".  This problem has been 

corrected. 

 

10.05.01 

Fixes 

1. Arcs, circles, ellipses, and partial ellipses that were unknowingly SPB-Fill'ed in 

DataCAD 10.04.01 and prior 10.x versions (before the feature was added) would appear 

filled when viewed in DataCAD 10.05.00.  This problem has been corrected. 

2. Dimension text would not appear on dimensions saved as symbols.  This problem has 

been corrected. 

3. The Replace, All option in the Template menu was not replacing all symbols in the 

drawing.  This problem has been corrected.  In addition, two new options have been 

added.  AllOn replaces all symbols in "On" layers and ActvOnly replaces all symbols in 

the "Active" layer. 

4. The reference point for dimension text would not get updated properly when stretching 

or moving dimension text.  This problem has been corrected. 

5. Layer attributes were being ignored when binding XREFs.  This problem has been 

corrected. 

6. A new entry can be added to the [General] section of the DCADWIN.ini file to prevent 

DataCAD from automatically disabling grid snap during selection and Window In. 

[General] 

NoGridlnSelect=FALSE 
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New Features 

1. A new option, Filled, has been added to the Arrow and Dot dimension and text arrow 

styles. These new arrow styles also export via DXF/DWG. 

2. Solid, Pattern, and Bitmap fills may now be applied to arcs, circles, ellipses, and partial 

ellipses. 

3. A new option, Styles has been added to the Dimension, Linear menu. You can save 

dimension settings to a dimension style file (.dimstyle) for future recall. Dimension style 

files can be called from either a keyboard macro, toolbar, or command line alias using 

any one of the following formats. 

by Name: 

^my_dimstyle$ 

by Name and Extension: 

^my_dimstyle.dimstyle$ 

by Fully Qualified Path: 

^z:\datacad\sup\my_dimstyle.dimstyle$ 

Note to Windows 95 users regarding the .dimstyle file extension: 

You may need to enter the dimension style file name along with the extension (i.e. 

my_dimstyle.dimstyle) when saving a dimension style to prevent Windows 95 from 

truncating the extension to .dim.  You can also modify line 4057 in the DCADWIN.MSG 

file to customize the extension used for dimension style files. 

4. A (non-shadow casting) sunlight source has been added to the OpenGL shader to 

provide an infinite, parallel light source to ensure a model will render adequately 

regardless of viewing position. One of eight light source directions may be used. 

Top Left 

Top 

Top Right 

Right 

Bottom Right 

Bottom 

Bottom Left 

Left 

5. The Tools, Generate TBL File menu has been renamed to DXF/DWG Color Map. When 

selected, a color mapping table (.TBL) corresponding to the active color palette (.RGB) is 
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either generated on-the-fly if one does not already exist or is automatically loaded if one 

already exists. 

The Update, Create, and Close options have been replaced with two options, OK and 

Cancel. OK saves any changes that have been made and closes the dialog and Cancel 

discards any changes that have been made. If the Translate colors using color mapping 

table option is active during DXF/DWG export and a corresponding .TBL file does not 

exist, DataCAD will automatically map DataCAD's colors to the nearest color in the 

DXF/DWG palette. 

6. Grid Snap is now automatically disabled during selection, and Window In. 

7. You can now snap to the intersection of lines and ellipses. 

8. The online help system (DCADWIN.HLP) has been replaced with a portable document 

file (DataCAD10_Manual.PDF).  Accessing help from the pull-down menu or via the 

[CTRL] + [F1] shortcut now opens DataCAD10_Manual.PDF instead of 

DCADWIN.HLP.  If you would prefer to access to the old help system, you can add the 

following entry to the [General] section of the DCADWIN.ini file. 

OldHelp=True 

9. Two ASCII character codes have been added to set the status of filled text and 

dimension arrow heads. 

[Alt] + 0246 [ö] : Filled Arrow Heads On 

[Alt] + 0247 [÷] : Filled Arrow Heads Off 

10. Two ASCII character codes have been added to either refresh or re-load XREFs. 

[Alt] + 0248 [ø] : Refresh XREFs 

[Alt] + 0249 [ù] : Re-load XREFs 

11. Direct Distance Input -- It is now possible to enter distance values directly simply by 

typing the desired value.  You no longer must press the spacebar first to enter a distance.  

To enter a value that begins with a decimal point, type zero first (i.e. 0.6 for 6").  To enter 

a negative distance directly, you will need to set the following DCADWIN.ini entry in 

the [General] section to False. 

[General] 

MinusKeyTogglesOvershoot=False 

 

Fixes 

1. Characters following a dash in layer names were being truncated during DXF/DWG 

import. This problem has been corrected. 



288 | DataCAD 10 

10.05.00 

2. The Z-axis of DXF/DWG blocks (symbols) were being set to a Z-base of zero during 

DXF/DWG import. This problem has been corrected. 

3. The first character of a DXF/DWG block (symbol) name was being truncated during 

DXF/DWG import. This problem has been corrected. 

4. XREF path names greater than 80 characters were being truncated upon DXF/DWG 

export. This limit has been increased to 160 characters. 

5. Custom line types assigned by layer in a DXF/DWG file were importing as solid lines. 

This problem has been corrected. 

6. An error would occur when trying to access a pen table that no longer existed. This 

problem has been corrected. 

7. In dimensioning with ScaleTyp set to Inch/Fraction, dimensions less than 1 inch were 

being displayed with a leading zero.  The leading zero is no longer displayed. 

8. An error in TrueType Font identification has been corrected. 

9. A correction has been made to the polygon triangulation routines. 

10. PDF files would sometimes appear blank when a bitmap in the drawing was outside the 

plotting area even though the file would plot correctly and preview correctly.  This 

problem has been corrected. 

11. Opening a DataCAD drawing that was configured for an unavailable printer would 

cause an exception error on Windows XP.  This problem has been corrected. 

12. Changing dimension text using a TrueType font would ignore the selected font by 

reverting to the currently configured TrueType font.  This problem has been corrected. 

13. The XREF highlight spacing setting was not being retained when performing a Save As 

on a drawing that contained self-referencing XREFs.  This problem has been corrected. 

14. In certain cases (most notably in the FrameIt macro), polyline rubber-banding was 

dragging from the wrong point. This problem has been corrected. 

15. A bug that would cause an access violation when importing DXF/DWG hatch 

boundaries containing splines has been corrected. 

16. DXF/DWG leader entities now round-trip more completely. 
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New Features 

1. Two stamps have been added for User Logon Name and Computer Name. 

2. A new option has been added to the redefine XREF routine for preserving layer settings. 

This is useful when an XREF'ed file has been renamed. 

3. The message prompt for inserting text, when Text Scale is on and the program 

preference for PgUp/PgDn in Text Menu is set to change plot scale if Text Scale is on, has 

been expanded to be more useful. For example, the message line might display the 

following. 

This text will print 1/8" high at the current plot scale of 1/4" 

The Identify command will now return the corresponding message: 

This text will print 1/8" high at the current plot scale of 1/4" (real world size=6") 

4. Dimension text and arrows now support custom colors. 

5. Menu Separators added to Stamp menu to provide logical/visual separation between 

groups of different stamp 'types'. 

6. DCAL support for plotting reinstated via new/updated function calls (this enhancement 

occurred in DataCAD 10.04 but was not mentioned in the release notes). 

 

Fixes 

1. Selecting NoChange in the Display/BoxColor menu will now reset TextOff extents boxes 

to be drawn in their parent entity color. Previously, once a color had been assigned to 

text boxes, there was no way to reset it to the entity color. 

2. Fixes related to renamed, orphaned XREFs that have been moved to new directories. 

3. Fixes related to layer search toggle status. 

4. Correction to installation routine to correct problem with updating the DCADWIN.mnu 

file properly for stamps. 

5. Corrections related to object snapping to XREFs. 

6. Drawing tangent arcs with "centerline" walls turned on was creating walls by "sides". 

This problem has been corrected. 
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7. The Layer Utility macro would always crash during layer load when trying to read 

DataCAD Plus database attributes. This problem has been corrected in LYRUTIL.DCX 

version 2.62 included with this update. 

8. A problem of polylines and/or invisible hatch boundaries not displaying despite being 

contained within the Z extents of the current Clip Cube has been corrected. 

9. Fixed a problem of crashes occurring when a drawing contained XREF's which had all 

layers toggled off. 

10. Fixed an occasional problem of bitmaps previewing and plotting correctly but 

disappearing in a PDF file when bitmaps are set to draw last in the PenTable. 

11. Fatal diagnostic errors could result from 1) going into the ObjectViewer or Shader when 

there were TrueType fonts being displayed, and 2) doing an Undo. This problem has 

been corrected. 

12. DCAL changes to fix problems reading, writing, and creating associative dimension 

entities. 

13. Fixed a crash that could occur in some circumstances when entering right- or center-

justified text with Dynamic off. 

14. Fixed a problem where using the FixedRef option in the Settings menu, then turning it 

off, resulted in Absolute Cartesian and Absolute Polar coordinate entry to malfunction. 

 

10.04.00 

New Features 

1. A Curves submenu has been added to the Curves, Polyline menu. This helps you 

develop curved polylines using standard curve creation methods. 

2. Two mutually exclusive options, Draw Marks and Draw Lines have been added to the 

Multi-scale Plotting Layout menu. These mutually exclusive toggles control the 

appearance of the layout grid. 

3. An Insertion Point option has been added to the Plotter, Multi-layout, Layout menu. 

Choosing this option prompts you to select or snap to a specific point within the 

drawing to use as the insertion point for the detail. 

4. Change the "handle" to position a multi-scale plotting detail on-the-fly by using the 

arrow keys during layout. 
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Upper Left Upper Middle Upper Right 

Left Middle Right 

Lower Left Lower Middle Lower Right 

5. Two mutually exclusive toggles, CC Exts and Ent Exts, have been added to the Multi-

scale Plotting, Layout menu. When you toggle on ClipCube Extents (CC Exts), the layout 

box will reflect the extents of the ClipCube (which may not correspond with the extents 

of the entities contained within it). If you toggle on Entity Extents (Ent Exts), the Layout 

box will reflect the extents of the entities (which may not correspond with the extents of 

the ClipCube surrounding them). 

6. A new option, AutoCalc, has been added to the Multi-scale Plotting Layout menu. When 

this option is toggled on, DataCAD will automatically recalculate the extents of a detail 

before you place it on the sheet. If this option is toggled off, you may need to use the 

ReCalc option for the layout box to accurately represent the extents of the detail. 

7. The Layout Divisions values may now be set independently for Quick Layout and 

Multi-scale Plotting Layout. 

8. Recalculating the extents of drawing data takes less time. 

9. A corresponding file hyperlink is now automatically added to an XREF upon insertion. 

10. The drawing file size limit has been increased to 128MB. 

11. The Layer Utility macro has been updated to support view names that contain spaces. 

12. If you try to open a file that you already have open, DataCAD will now make that the 

active document window instead of just telling you "Drawing is already open". This 

applies to files you select from the Recent File List, File/Open dialog, or Hyperlink to 

file. 

13. If you try to launch a DCAL macro with a read-only attribute, DataCAD will now 

attempt to clear the attribute and run the macro. However, if DataCAD is unable to clear 

the read-only attribute, you will be alerted accordingly, and the macro will not run. 

14. When you enable the option to display ClipCubes in the main drawing window, 

DataCAD will use the ClipCube extents when you perform a WindowIn, ReCalc. 

Otherwise, DataCAD will use the entity extents. 

15. Manage an XREF by using [CTRL] + Right-click to display a popup menu; then, select 

Reference File Manager. Choosing this option after [CTRL] + Right-clicking on an XREF 

takes you directly to the Reference File Manager with the corresponding XREF 

highlighted. 
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16. The new option, Virtual, has been added to the Object Snap menu and applies only to 

Nearest, Intersection, and Perpendicular snapping methods. When this option is turned 

off, DataCAD's object snapping mechanism will only return points that lie on line 

segments passing through the current Miss Distance (a.k.a snap aperture) and will not 

return either intersections or perpendiculars that lie beyond the endpoints of these lines. 

The default value for Virtual Snapping is Off, including pre-10.04.00 drawings that are 

opened for the first time. 

Note: I you want the Virtual Snapping option default to be On when you open pre-10.04.00 

drawings for the first time, you can add the following entry to the [General] section of the 

DCADWIN.ini file: 

[General] 

Virtual Snapping=TRUE 

17. Two ASCII character codes have been added to set the state of Virtual Snapping: 

[Alt] + 0244 [ô] : Turns Virtual Snapping On 

[Alt] + 0245 [õ] : Turns Virtual Snapping Off 

 

10.03.00 

Fixes 

1. Calculating XClip extents has been corrected to accurately represent the extents of the 

clipped geometry (i.e., not the extents of the clip cube boundary). 

2. You can now change the preview object in the Viewer/Shader Color Map dialog. 

3. In the DCADWIN.ini file, the FitTo Adjustment value is now applied when the New 

FitTo value is set to False. Previously, the FitTo Adjustment value would only be applied 

when the New FitTo value was set to True. 

4. We corrected a bug that locked up the program when you attempt to define an XClip on 

a reference file that had either never had a clip cube defined or had an invalid clip cube 

defined. 

5. Open polylines will no longer close when viewed in the o2c Player. 

 

New Features 

1. o2c Viewer/Shader Color Map Dialog Enhancements 

The o2c Viewer/Shader Color Map dialog has been enhanced to provide direct access to 

the extended material and texture capabilities supported by the o2c format. Applying 
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color to material/texture mapping in conjunction with the o2c Player, you can create 

high-quality, photo-realistic renderings from DataCAD models. These new options and 

elements have been added: 

Dynamic 3D material preview 

Diffuse color proportion 

Ambient proportion 

Reflective proportion 

Highlight size 

Opacity 

Refractive index 

Self-illuminate 

Render backface 

Smoothing 

Apply texture 

Texture masks object 

Mix texture with rendered color 

Apply texture as reflection map 

Background color 

Background image 

Matte, Glossy, and Glass presets 

Load and save individual material definitions 

Load and Save color to material assignments 

Note: The o2c.ini file has been replaced with new .dmf file 

2. o2c Player Toolbar Interface Enhancements 

A toolbar interface has been added to the built-in o2c Player interface to make it more 

useful for architectural view manipulation and image processing. Icons on the toolbar 

provide direct access to the following options: 

Sunlight On/Off (shadow casting) 

Ambient #1 On/Off 

Ambient #2 On/Off 

Ambient #3 On/Off 

Lamps On/Off (shadow casting) 

Daytime/Nighttime View 

Toggle Perspective/Parallel View 

Rotate clockwise about the Z-axis 

Rotate counter-clockwise about the Z-axis 

Reduce the field of view 

Increase the field of view 

Plan 
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Left Elevation 

Right Elevation 

Front Elevation 

Back Elevation 

Isometric 

Axonometric 

3. o2c Lamps (user-defined lights) 

Shader lights are now written into the o2c Player. 

4. o2c Export/Object Viewer Optimization 

The o2c export and object viewer routines have been optimized so that all entities of the 

same color (i.e., same material) are now converted as a single object with a single 

material definition. The result is much faster conversion times (i.e., 15 seconds vs. 15 

minutes on a large TIN model) and much smaller file sizes (i.e., 1/3 the size on average). 

5. New o2c Materials/Textures 

We added a small sampling of textures and 133 each of matte, glossy, and glass 

materials based on the Prizma palette. You can use these with the o2c color mapping 

feature. 

6. Two INI settings have been added to set the proximity and angle values for the new o2c 

smoothing option. 

[o2cViewer] 

Smooth Distance=0 

Smooth Angle=30 

Smooth Distance determines how close adjacent polygons must be to be considered for 

smoothing. Smooth Angle sets the maximum angle for adjacent polygons to be 

considered for smoothing. 

7. The OpenGL triangulation routine has been incorporated into all functions that require 

polygons with more than 4 sides to be triangulated prior to processing. 

OpenGL Shader 

Hidden Line Removal 

o2c Player 

o2c Export 

DXF/DWG Export 

Explode to polygons 

Explode to slabs 
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As a result, polygons and slabs with voids are recognized properly when exploded. In 

addition, the o2c Player/Export routines now support TrueType Fonts and covered 

polylines. 

A related setting has been added to the [General] section of the DCADWIN.ini file. 

[General] 

CoplanarCheck=FALSE 

Setting this value to TRUE forces the vertices on polygons with more than 3 sides to be 

coplanar based on the first three non-collinear vertices. 

8. A new toggle has been added to the Pen Table dialog - "Map fill colors to pen colors." 

Previously, solid fill colors were always mapped to pen colors, at times making it 

difficult to get desired results. This toggle lets you control whether this mapping takes 

place or not. With "Map fill colors to pen colors" toggled ON (the default), color 

mapping works as it always has and on-screen fill colors will be plotted in the color of 

the pen that screen color is assigned to. With it toggled OFF, the on-screen color of the 

fill will be used to plot the fill on paper (no color mapping will take place). The setting of 

this toggle is saved with the pen table file. 

9. Polygon normals within triangulated slabs and covered polylines are now checked and 

"corrected" to point outward from the boundary and inward to the center of voids. 

10. Polylines' entities may now be offset using the Geometry, Offset command. 

11. The Layer Utility macro has been enhanced to remember long layer names and restore 

saved views and details that utilize them. Additionally, the input mode is now restored 

to match the source drawing. Compatibility for self-referencing files has also been 

added. 

12. The Layer Utility macro now uses the path specified for layer files in the program 

preferences dialog. 

13. The previous paths used for Pen Table Load/SaveAs and XREF Insert are now retained 

with entries in the DCADWIN.ini file. 

14. A new Toggle Cover option has been added to the Curves, Polyline, Edit menu for 

adding or removing a top/bottom cover to/from an existing polyline. 

15. An Explode to Points option has been added to the 3D Explode menu. 

16. A new toggle, Snap2Div (Snap to Layout Divisions), has been added to the Plotter, 

Multi-layout, Layout Settings menu. When toggled on, detail placement is constrained 

to the sheet layout divisions. 
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Fixes 

1. DXF/DWG Translation 

The dxf/dwg translator has been corrected and enhanced to provide comprehensive 

support for metric-based drawings and to minimize the user-intervention required 

when round-tripping drawing files to and from AutoCAD. 

DXF/DWG Export: 

DataCAD will default to one of the following export unit types based on the current 

drawing scale type. You can override the default setting by selecting the corresponding 

radio button prior to export. Most importantly, you now can export drawings in either 

millimeters, centimeters, or meters. 

DataCAD Scale Type → Export Unit → DXF/DWG LUnit 

Architectural → Architectural → Architectural 

Engineering → Engineering → Engineering 

Millimeters → Millimeters → Metric 

Centimeters → Centimeters → Metric 

Meters → Meters → Metric 

DXF/DWG Import: 

DataCAD will default to one of the following base unit values, depending on the 

DXF/DWG file LUnit value. You can override the default setting by selecting the desired 

unit value type from the drop-down combo box prior to import. 

Base Unit → DXF/DWG LUnit → DataCAD Scale Type 

1 Inch → Architectural → Architectural 

1 Foot → Engineering → Engineering 

1 Millimeter → Metric → Millimeters 

1 Centimeter → N/A → Centimeters 

1 Meter → N/A → Meters 

If you use the same scale type that you did for export (from DataCAD) and import (from 

AutoCAD), the drawing should scale properly in DataCAD (i.e., round-trip). However, 

if the drawing originated from AutoCAD, the scale type is indeterminate. To 

compensate for drawings that do not scale as desired, we added an enlargement field. 

For example: 

If you select Centimeters as the import scale type and a line that should measure 100cm 

measures 10 cm, then you can set the enlargement field to 10. 
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If the import scale type is set to meters and the drawing was originally exported from 

DataCAD in meters, a 1-meter long line will measure 1 meter. If the import scale type is 

set to Centimeters for the same drawing, that same line will measure 1 centimeter. If the 

import scale type is set to Millimeters for the same drawing, that same line will measure 

1 millimeter. 

2. We corrected a bug that made Fills and/or Bitmaps disappear from a Polyline 

constructed of only bulges when a ClipCube was used. 

3. A fatal error in ViewLyr with Extents toggled off has been corrected. 

4. The INI file entry PenFile was being ignored. This problem has been corrected. 

5. A problem with drawings imported from DXF files in older versions of DataCAD has 

been fixed. These files would fail to open and give an error: "DataCAD Internal 

Diagnostics) Fault 19 Error From: 736" 

6. A problem of Stamps appearing as keyword text such as '@PLTDATE' instead of the 

stamp value has been fixed. 

7. We fixed a problem of drawing files previewing and plotting correctly but creating a 

partially or completely blank PDF file when saved to PDF. (This problem would occur in 

drawings with orphaned bitmap files). 

8. In some cases, drawings with multiple and/or large bitmaps would not display in the 

print preview. This problem has been corrected. 

9. The FitTo factor calculation has been changed. In previous versions, this factor was 

obtained by using the ratios of the physical paper sizes involved. Now, this calculation is 

based upon the printable area of these paper sizes. This should yield more accurate 

results. 

10. The new FitTo calculation has an additional setting in the INI file. In the [Printer] section 

is the entry: 

[Printer] 

FitTo Adjustment=0 

If you find that the new calculation is always off by 1 or 2 percent, you may enter an 

adjustment percentage in this entry. This can be any positive or negative whole number. 

11. A new INI file entry has been added to the [Printer] section of the DCADWIN.ini file: 

[Printer] 

New FitTo=TRUE 

If this is set to FALSE, the old FitTo calculation will be used. 
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12. Extended characters beyond 128 now paste into drawings correctly. These corrections 

made to text file insertion and clipboard paste allow foreign language characters to read 

and display properly. 

13. The last path used for Insert Symbol is now remembered. 

14. New hatching logic in DataCAD 10 caused a situation where a 'floating point division 

by zero' error would occur when loading a drawing that contains entities hatched with 

an improperly defined custom associative hatch pattern created in DataCAD 9 or earlier. 

The problem has been corrected so that this error will not occur, and the pattern should 

display as it did in DataCAD 9 and earlier. 

15. The warning for circular XREFs has been changed to only appear once, listing the 

offending XREFs in a single message box. 

16. A bug in 3D Mirror, Previous Line has been fixed. 

17. A bug related to opening a self-referencing drawing that is opened from a directory 

other than the one it was originally saved to has been corrected. 

18. A bug related to opening a file containing XREFs from a CD-ROM or other read-only 

media has been fixed. 

19. Associative dimensions that use TrueType Fonts now explode correctly. In prior 

versions of DataCAD, the TrueType Font would revert to a CHR font. 

 

10.02.01 

Fixes 

1. Self-referencing XREFs (i.e. drawing A referenced into drawing A) are now supported. 

2. A correction has been made to "Circular" XREFs to avoid the endless-loop swap file 

creation. 

3. A new setting has been added to the [General] section of DCADWIN.ini: 

CapsLock=FALSE 

If this is set to TRUE, the AllCaps toggle operates like CapsLock instead of forcing all 

uppercase letters. 

4. A correction has been made in the Pattern menu of Hatch so that selecting an 8-character 

pattern name does not truncate the last character of the name. 
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5. The DataCAD Color Picker now allows double-clicking to select a color and dismiss the 

dialog in one step. 

6. Associative Hatch that is contained in an XREF that has been scaled or rotated will now 

bind with the proper scale and rotation. 

7. When inserting stamps, a new option sets the inserted stamp display in AllCaps. This 

setting applies to each stamp as it is inserted. 

8. User-definable stamp settings have been enabled within the DCADWIN.ini file to allow 

them to appear on the Insert, Stamp menu. A custom date, time, or "special" stamp may 

be defined. 

9. DataCAD will now try to resolve invalid reference file paths by checking the current 

drawing file folder for valid references. If a valid reference file is found in the current 

drawing file folder, it will be used instead of the file designated in the original path. 

However, the original path will be retained. 

10. Self-referencing XREFs are now automatically redefined to reflect the new drawing file 

name when a Save As is performed. 

11. Nested XREFs will now bind properly in accordance with the On Only setting in the 

XREF Manager. 

12. A problem with color names changing when a Layer Utility is performed has been 

corrected. 

13. TrueType font settings for dimensions are now saved with the drawing file. 

14. A problem with TrueType font settings being lost when switching to a CHR font has 

been corrected. 

 

10.02.00 

New Features 

1. User-defined line types now display and plot more smoothly on 2D curves (Arcs, 

Circles, Ellipses, Polylines). 

2. The hatch Preview now displays the pattern as it will appear in the drawing given the 

current Hatch and Display scale. 

3. A new PrevSize (Preview Size) button has been added to the Hatch menu. You can 

specify the size of the Preview Window in pixels (Valid range is 50 - 500). This button 

also appears in the line type menu. 
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4. A new toggle for Scl2View (Scale to View) has been added to the Hatch/ Pattern menu. If 

this is On, the previews will be drawn according to the current display scale. If it is Off, 

another button called DispScal (Display Scale) appears. DispScal allows you to specify 

the display scale for drawing that pattern in the preview window. This display scale is 

remembered on a pattern by pattern basis. 

5. A new Send to ezMeeting option has been added to the View pull-down menu in the 

Print Preview dialog. It lets you launch the active preview as a PDF file. This is useful 

for launching multi-scale plotting sheets into an ezMeeting conference. 

6. A new Stamp option has been added to the Insert menu. Choose from more than a 

dozen pre-formatted Date, Time, and File-related stamps to insert in your drawing. The 

examples in the Stamp selection menu are based on the current date, time, and file 

settings as they will appear in the drawing. The values are updated when the display is 

regenerated and when the drawing is printed. Since a Stamp is really an ordinary 

DataCAD text entity that contains a special formatting string, it has all the font, sizing, 

and style options of ordinary DataCAD text strings. Also, you can further customize 

how you want stamps to appear in your drawing by doing a change/text/content and 

adding text around the special strings. Stamp text can be used in XREFs and symbols. 

The values will update as well, making a Stamp even more flexible." 

An Expand stamps to values option has been added to the Copy to Clipboard section of 

the Misc tab and the Other section of the DXF/DWG tab of Program Preferences to 

determine the format of stamps when they are either copied to the clipboard or exported 

via DXF/DWG. 

When Expand stamps to values is unchecked the stamp will export in its raw token 

format (i.e. @PLTTIME). 

When Expand stamps to values is checked the stamp will export as it appears in 

DataCAD (i.e. 12:00 PM). 

7. A new INI setting (ShowWinCursor=TRUE) activates the Windows system crosshair 

cursor coincident with the DataCAD cursor. This is useful when using screen capture 

programs that record the movement of the Windows system cursor. 

[General] 

ShowWinCursor=TRUE 

 

Fixes 

1. When re-locating existing MSP details, the details no longer shift nor appear at a smaller 

scale. 

2. The previous view buffer ("P" key) is no longer cleared after an autosave. 
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3. The current plot scale is no longer overwritten by the distance readout in MSP Layout 

and the Text and Dimension Text Style menus. 

4. The polyline boundary was not being displayed in Measures, Area Per. This problem 

has been corrected. 

5. If the last Detail added in Multi-scale Plotting used a ClipCube, the ClipCube would be 

turned on in the drawing when it was loaded. This problem has been corrected. 

6. Solid fills contained in XREFs and Symbols would not clip properly when a ClipCube 

was employed. This problem has been corrected. 

7. The 1 Line Trim command was not undoable until you left the 1 Line Trim operation 

completely. This was corrected. 

8. The Edge Only option would cause the OpenGL Shader to render incorrectly. This was 

corrected. 

9. The Show Edge option would render polygon edges that should have been invisible. 

This was corrected. 

10. The percent status would show more than 100% complete while importing or exporting 

DXF/DWG files. This was corrected. 

11. Bitmaps and Fills contained within XREFs and Symbols will now print according to the 

"Print First/Print Last" setting in the Pen Table. 

 

10.01.00 

New Features 

1. XREF Clipping 

Referenced files may now have unique clipping boundaries. 

2. Batch Plot Scripting 

An enhanced scripting language allows larger firms to develop custom automated batch 

plotting routines. 

3. Batch Plotting to PDF 

In addition to direct printing and plot files, drawings may now be batch plotted to 

Adobe Acrobat format directly from DataCAD. 
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4. The [Delete] and [Insert] keys now initiate layer delete and layer add respectively in the 

Layer Manager. 

5. Enhanced Perspective Navigation Controls 

New hotkeys and MouseWheel controls have been added to automate perspective setup 

and navigation using video game-style controls. 

[PgUp] Walk Backward 

[PgDn] Walk Forward 

MouseWheel Walk Forward/Backward 

[Up Arrow] Walk Forward 

[Dn Arrow] Walk Backward 

[Right Arrow] Step Right 

[Left Arrow] Step Left 

[SHIFT] + [Up Arrow] Look Up 

[SHIFT] + [Dn Arrow] Look Down 

[SHIFT] + [Right Arrow] Turn Right 

[SHIFT] + [Left Arrow] Turn Left 

Use the walk-through hotkeys in any perspective view. 

A new WalkThru, Options menu allows you to customize the way you navigate. When 

FixFocal is toggled on you will always look at the same point in your model while 

navigating. When FixFocal is toggled off your focal point will move the same distance as 

your eye point while navigating. When FixFocal and FixDist are toggled on you will 

navigate spherically around a fixed focal point while navigating. It is not possible to 

turn off FixFocal and FixDist at the same time. 

Turning PanView on disables the walk-through controls so you can pan and zoom your 

perspective view as if it were a two-dimensional drawing. 

 

Fixes 

1. A problem with the AutoSave function that causes the loss of drawing settings such as 

pen table, printer configuration and similar settings has been fixed. 

2. A problem with bitmaps not printing when using some printers most notably HP 

DeskJet 1120c and similar models has been fixed. 

3. Multi-scale Plotting details created in a DataCAD 10 drawing that were subsequently 

edited or added in a prior version of DataCAD would cause DataCAD 10 to crash with a 

Floating-Point Divide by Zero error while using the Multi- scale Plotting interface. This 
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problem has been corrected. The error would manifest itself as a Floating-Point Divide 

by Zero by following these steps: 

a. Open/Create a drawing in DataCAD 10 that contains MSP details. 

b. Subsequently open the drawing in a previous version of DataCAD and either add 

new or modify existing MSP details. 

c. Open the drawing again in DataCAD 10 and attempt to access/display an MSP sheet 

that was created/modified in step b. 

4. Editing operations performed on polygons or slabs with voids would cause the 

Undo/Redo function to crash the program under some circumstances. This problem has 

been corrected. 

5. TrueType fonts created with outlines only (no fill) would preview and plot but would 

not save to PDF. This problem has been corrected. 

6. A problem with the display of highlighted (i.e. when using Identify) TrueType fonts 

with outlines only (no fill) has been corrected. 

7. TrueType fonts and Metafile Fills with a black color setting (or a color setting equal to 

the DataCAD background color) are set to Color 1 when copied from a Windows 

application such as Word to DataCAD so that they will display in a color that is inverse 

to the DataCAD background color. TrueType font and Metafile fill colors other than 

black are compared to the first 15 DataCAD colors for an exact RGB color match and are 

mapped accordingly. 

8. An access violation error related to re-sorting by any column other than Name in the 

Layer Manger has been fixed. 

9. A problem with the display order of some dialogs such as the XREF Manager and 

Orphans has been corrected. 

10. A problem with 2-bit (black and white) bitmaps shifting, primarily on Windows 2000, 

has been corrected. 

11. Due to the Perspective Navigation enhancements (see enhancement #04) panned 

perspective views now shade correctly. 

12. Exporting to RAY file format would cause DataCAD to crash. This problem has been 

corrected. 

13. A list index out of bounds error related to TrueType fonts has been corrected. The error 

would manifest itself by performing the following steps: 
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a. Open a drawing that uses "Font-A" on a computer that does not have "Font-A". 

b. Selecting FontName in the Text menu would produce a list index out of bounds 

error. 

When the last font used in each drawing is not present on the current computer the 

font name will be set to the default font. 

14. A problem related to calculating shadows on coincident planes in perspective views has 

been corrected. 

15. A problem related to importing DXF/DWG files where the first entity of a hatch entity is 

a B-Spline has been corrected. 

 

DataCAD 10 New Features and Enhancements 

New Feature Highlights 

Program Launch 

DataCAD now launches sooner after double-clicking the program icon. 

Layer Manager 

A new Layer Manager adds support for long layer names and allows you to view, arrange, sort, 

and change layer settings within the drawing. 

TrueType Fonts 

In addition to single and multi-stroke, vector based DataCAD .CHR fonts, DataCAD 10 adds 

support for Windows TrueType Fonts. TrueType Fonts can also be converted to 3D for use in 

architectural models. 

Solid, Pattern, and Bitmap Fills 

In addition to vector based DataCAD .PAT hatch patterns, DataCAD 10 adds support for Solid, 

Pattern, and Bitmap Fills. 

Bitmap Import 

DataCAD 10 supports Windows bitmap (.BMP) and JPEG (.JPG) files which can be imported 

into DataCAD drawings. An unlimited number of Black and White, Greyscale, and 8 - 32-bit 

color images may be referenced. 

o2c Object Viewer 

An o2c-based Object Viewer has been added to the View pull-down menu to provide real-time, 

dynamic, shaded 3D views of DataCAD models. 

o2c / OpenGL Color Settings 

A new o2c Settings dialog determines how entity colors are rendered in the o2c Player and 

OpenGL shader. Options are provided for color, opacity, and reflection values. 
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eZ meeting 

DataCAD 10 adds direct support for eZ Meeting, a peer-to-peer Internet conferencing software 

for CADD drawings. From the View menu DataCAD users can launch the current view as 

either a 2D, 3D, or bitmap image into an eZ Meeting conference. 

OpenGL® Shader Enhancements 

Several new enhancements to the DataCAD OpenGL Shader provide options for creating 

preliminary architectural views of 3D models. 

Shadow casting 

Custom edge color and thickness 

Overshoot 

Bitmap background image 

Enlarge Command Enhancements 

New enlargement factor options have been added for calibrating imported bitmap and vector 

graphics to real-world scale. 

Enhanced Polyline Menu 

The polyline menu incorporates new options which make the creation and editing of polyline 

boundaries easier. 

Note: The Polyline Macro is no longer included with DataCAD 10. 

HyperLink Enhancements 

Using [CTRL] + Right-click to select an entity displays a new menu for creating and managing 

HyperLinks between drawing entities and GoTo Views, Internet URLs, and Programs. 

Drawing Navigation 

Use new shortcuts, [CTRL] + Left Arrow and [CTRL] + Right Arrow toggle between the 

previous and current view, respectively. 

Hotspots 

One click access to Color, Layer Manager, Scale, line type, and Selection Set menus from the 

status panel. 

Contour Search 

Automatically create a polyline boundary from entities that form a closed shape. 

Color Palette / Color Mixer 

A new color picker and mixer have been added for selecting and editing DataCAD color 

palettes. 
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Wheel Mouse Support 

Pressing the [CTRL] key while moving the mouse wheel zooms the display in/out. An option in 

Program Preferences determines whether the [CTRL] key is required for zooming with the 

mouse wheel. The zoom factor is hard-coded to +/- 25%. 

VRML Export 

DataCAD models can be exported to VRML 1.0 (Virtual Reality Markup Language). 

 

Miscellaneous Enhancements 

1. The last Go to View selected remains highlighted in the Go to View Menu 

2. Clicking in the Multi-View window now reads OUT the view vs. IN 

3. The maximum number of icons per Toolbar has been extended from 50 to 100 

4. Reference file names may now be redefined within the Reference File Manager 

5. DXF/DWG Improvements with support for... 

Solid fills 

TrueType fonts 

MText 

Polylines with voids 

Complex hatch patters such as StoneCAD 

6. Pen Table color picker now retains previously defined colors 

7. Reference files may now contain a fully qualified pathname 

(Drive+Path+Filename) of up to 160 characters. This was previously limited to 80 

characters. 

8. The Preview checkbox status in File I/O dialogs is now retained between program 

sessions. If un-checked, drawing file preview bitmaps are not created automatically. 

9. The Reference File Manager will now display a horizontal scroll bar when reference file 

names extend beyond the dialog window. 

10. DataCAD will now prompt for a file save when a system shutdown message is received. 

11. Reference files may now contain fully qualified pathnames [drive/path/filename] up to 

160 characters long. 

12. A new color translation table generator has been added for DXF/DWG file translation. 
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13. Hatching routines have been enhanced to support complex hatch patterns from 

manufacturers such as StoneCAD. 

14. [CTRL] + V (Paste from Clipboard) now remembers the last layer setting used (Original 

Layers or Active Layer) 

15. The maximum number of recognized Hatch Patterns has been increased from 128 to 256. 

16. Nearpoint snapping in the Template Window will always use Z coordinate value from 

the symbol definition for its insertion point. 

17. The 16 custom colors that can be defined using the Windows Color Picker from the Pen 

Table dialog are saved when DoCustomColors=TRUE in the [PaletteFile] section of the 

DCADWIN.ini file. 

18. A new toggle, ShowIt, has been added to the Hatch, Boundary menu to enable the 

display of hatch boundaries during their creation. 

19. The tooltips that display on layer menu names have been enhanced to show next to and 

aligned with the corresponding layer name. 

20. A new option has been added to Program Preferences to adjust the background color 

and delay for the display of tooltips. 

21. Due to popular demand, clicking on a Multi-View Window causes the view to be read 

from the Multi-View Window to the Drawing Window vs. the other way around. 

22. A new setting has been added to Program Preferences to allow nested XREFs to retain 

their highlight settings when inserted into another drawing file vs. the current drawings 

XREF highlight setting. 

23. DataCAD now uses the scale type setting from the DWG file upon import automatically. 

24. DWG → DataCAD 

Scientific/Decimal → Inch/Decimal 

Engineering → Engineering 

Architectural → Architectural 

Fractional → Inch/Fraction 

25. DataCAD now writes out the active Scale Type setting to the DWG file upon export 

automatically. 

DataCAD → DWG 

Inch/Decimal → Decimal 

Engineering → Engineering 

Architectural → Architectural 
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Inch/Fraction → Fractional 

Others → Decimal 

26. A Redefine option has been added to the Reference File Manager and Reference File 

Orphans dialogs allowing the user to redefine an XREF'd file that has been renamed. 

Redefined XREFs retain the previous XREFs position, scale, and rotation. 

27. The Preview checkbox in File I/O dialogs is now remembered. 

28. The Reference File Manager and Reference File Orphans dialogs will now display a 

horizontal scroll bar if the filename is too long to fit within the window. 

29. Polylines can now have a closed top/bottom surface. 

30. The DXF/DWG Import dialog now has local settings for Move to Origin and Use Color 

Table. 

31. The DXF/DWG Export dialog now has local settings for Translate custom lines to 

continuous, Use color table, Decompose 3D entities to faces, Export XREFs 

automatically. 

32. A Color Mapping Table generator is now available from the Tools, Generate TBL File 

pull-down menu to allow easier creation and customization of color mapping between 

DataCAD and DWG files. 

33. New and enhanced options in 3D Explode command. 

To Lines also converts TrueType fonts to lines 

To Polygons also converts TrueType fonts and Polylines to polygons 

To Slab also converts TrueType fonts and Polylines to slabs 

TTF to Polyline converts TrueType fonts to Polylines 

34. The Multi-scale Plotting Interface now supports sheet layouts at multiple resolutions 

and menu configurations. Existing drawings that include MSP Sheets must be opened 

on the computer where the layout display is correct (screen resolution and menu 

configuration) and saved before viewing/editing the MSP layouts on another computer. 

 

Fixes 

1. Multiple instances of the same XREF will no longer have the same layer set when batch 

exported then opened in AutoCAD. 

2. Highlighting in 1 Line Trim using Entity method has been corrected. 
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3. The Yes/No/Cancel dialog that prompts the user to save a drawing file upon exit now 

responds after the mouse is released vs. when the mouse is pressed allowing the user to 

cancel the selection by moving the cursor off the button prior to releasing the mouse 

button. 

4. The importation speed of DWG files containing entities outside of the X-Y plane has 

been improved. 

5. DataCAD will now prompt you to save your work if a system shutdown message is 

received. 

6. A bug in Measures has been corrected when taking the following steps: 

Open a new drawing. In Settings/ScaleType, turn StackFrac on. Draw a line whose 

length has a fractional component. Select Measure\Line choose the line and click 

ToDrawing. Click Angle and set an angle other than 0. Place the text. The fractional 

component would not use the specified angle setting. 

7. Degree symbols now transfer reliably via DXF/DWG. 

8. When using the Move to Origin option during DWG import, most entities lying in an 

extruded plane would not import properly. This has been fixed. 

9. Bi-directional support for associatively hatched circles, arcs and ellipses has been added 

to the DXF/DWG translator. 

10. Ellipses that lie outside of the X-Y plane are imported as a symbol and are exported as a 

symbol via DXF/DWG/ 

11. MText, and Text attributes that lie in an extruded plane import as symbols with the 

corresponding name "DC_CHARS_XXXXX" and are exported as Text. 

12. Import of Associative Hatch using B-Spline with weights caused the translator to crash. 

This has been fixed. 

13. Importing polylines via DWG would sometimes cause huge circles to show up. This has 

been fixed. 

14. A fix has been implemented to address hatch patterns with small hatch matrix values 

that would hang the DWG translator. 
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9.07.01 

New Features 

1. The Object Viewer window now remembers its last position and size. 

2. The ASCII character code [Alt] + 0243 [ó] opens the Object Viewer. 

 

Fixes 

1. Font previews restored. 

2. OpenGL Shader once again works on quadric entities. 

 

9.07.00 

New Features 

1. DataCAD 9.07 adds direct support for eZ meeting, a peer-to-peer internet conferencing 

software for CADD drawings. From the View menu DataCAD users can launch the 

current view as either a 2D, 3D, or bitmap image into an eZ meeting conference. 

2. An o2c-based Object Viewer has been added to the View pull-down menu to provide 

real-time, dynamic, shaded 3D views of DataCAD models. 

3. A new context-sensitive popup menu has been added to facilitate the assignment of 

entities to GoTo Views, Internet URL's, and Files. The Hyperlink popup menu can be 

accessed by [CTRL] + Right-clicking on any entity. 

4. Display of Hyperlinks. A Hyperlinks option has been added to the View pull-down 

menu to toggle on/off the highlighting of entities that contain either GoTo View, URL, or 

File hyperlinks. 

5. New hotkeys, [CTRL] + Left Arrow and [CTRL] + Right Arrow toggle between the 

previous and current view, respectively. 

 

Fixes 

1. Multi-weight 2D curves (Arcs, Circles and Polylines) with a line type of Dotted, Dashed 

or Dot-Dash are now smoothed according to the ArcFactr setting in the Display menu. 

This works even if ClipCubes are used. 

2. Associative dimensions will mirror correctly with FixText turned on. 
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3. Mirrored associative dimensions will now stretch correctly. 

4. All ASCII character codes may now be input using [ALT] + 0(Code). 

 

9.06.02 

Fixes 

1. A new setting has been added to the DCADWIN.ini file to "fix" fonts with zero-character 

width definitions. 

[General] 

FixFont=True 

The FixFont setting is off (or False) by default. 

Setting this value to true causes DataCAD to set zero-character width definitions to the 

average of the character width definitions within a given font. 

Setting FixFont to True allows DataCAD to calculate the text extents of fonts with 

invalid character width definitions correctly. However, if these "invalid" fonts have been 

used to dimension drawings prior to setting FixFont to True, setting FixFont to True 

may cause some existing dimension text to rotate 90 degrees (i.e. perpendicular to the 

dimension line). 

 

9.06.01 

Fixes 

1. CHR fonts that contain zero length character width definitions are corrected. 

 

9.06.00 

New Features 

1. The DXF/DWG translator now imports and exports associative hatch. 

2. The DXF/DWG translator can now export XREFs automatically. This is controlled by a 

new checkbox on the DXF/DWG tab of the Program Preferences dialog. 

3. An "Isometric View" checkbox has been added to the Insert Symbol dialog. 

4. o2c export has been added to the File/Export dropdown menu. The o2c viewer plug-in 

may be downloaded from http://o2c.de/en/download/o2c-download.html. 

5. o2c Object import has been added to the Insert dropdown menu. 

http://o2c.de/en/download/o2c-download.html
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6. Ortho mode may now be toggled on/off while in Tangents mode. 

7. A new Command Line Alias feature has been added to supplement keyboard macros. 

What it does: 

The new Command Line Alias feature allows you to assign a keyboard macro to a single 

or multi-character shortcut. The "Alias" is the other name you give for the command you 

are calling. 

Why it is cool: 

Now you can have an unlimited number of shortcuts for multi key-stroke commands. 

AutoCAD users, and ex-Generic CADD users, et al can create familiar shortcuts they are 

used to. 

How it works: 

Press [Ctrl] + [Spacebar] 

You are prompted to enter an Alias 

Type one in. For example, cr for Circle by Radius 

Press [Enter] 

----> The command is executed 

You can browse for Aliases by typing [?] and pressing [Enter]. You are then presented 

with a list to scroll through. Double click or press [Enter] to select and alias to execute. 

The number of lines shown in the list and its width can be adjusted in the [Alias] section 

of the DCADWIN.ini file. 

[Alias] 

Popup Width=300 

Popup Lines=4 

The Aliases are stored in a text file in your SUP folder called DCADWIN.DCA. Aliases 

use the same shorthand as custom keyboard macros. An item in the Alias file looks like 

this: 

[cr] 

comment=draw circle by radius 

alias=^;^S5^S1^ 

How to Make your own: 
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Let us say you want to make an Alias called ep that will take you to Erase, Partial. Here 

is all you do: 

Press [Ctrl] + [Spacebar] 

Pick Settings. A dialog appears 

In the Alias field, type the shortcut you want: ep 

In the Comment field, type a hint: Erase Partial (line break) 

In the Sequence field, type the required keyboard sequence for the command: 

^;^F7^F9^ 

Note that the format for a Command Line Alias is the same as a Keyboard Macro. 

You must separate each function with a carat [^]. 

Select Add to add the new Alias 

Select OK to exit. Your alias is now ready to use. Just press [CTRL] + 

[Spacebar], type ep and press [Enter] 

 

Fixes 

1. The Previous View Buffer ('P' key) is no longer cleared after a forced save (Shift + f). 

2. More "Invalid Floating-Point Operation" errors with certain printer drivers have been 

eliminated. 

3. PDF files are now generated with "Rounded" rather than "Mitered" corners. This 

alleviates the very "pointed" looking corners when using heavier line weights. 

4. The following actions that would create a corrupt layer has been corrected: 

a. Start a new drawing 

b. Draw a 3Point Arc 

c. Use 1LineTrim to cut out the center portion of the arc 

d. Erase one of the remaining sides 

5. Snapping to the endpoints of a partial ellipse has been corrected. 
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6. The On/Off status of layers within an XREF'd file was not being exported properly when 

written to a DWG file. This problem has been corrected. 

 

9.05.00 

New Features 

1. A Spell Checker has been added to the Tools pull-down menu. 

2. The current input mode is now displayed on the Distance Readout line. 

3. The .RAY file export function has been enhanced to include additional light sources: 1 

Sunlight and 7 Spotlights. 

 

Fixes 

1. An error in the PDF file generator has been corrected. 

2. An error with Text shifting within an XREF that was bound has been corrected. 

3. An additional vertex that was added when creating a Polyline with the rectangle 

method has been eliminated. 

4. Selecting Tangents (Shift-B) would change the current rubber-banding point. This 

problem has been corrected. 

5. The display of line type and Hatch Pattern previews are no longer affected by clip cubes. 

6. Plotting speeds should be back to normal. 

7. When using coordinate input (Relative Cart or Relative Polar) and reference points to 

create a horizontal slab or polygon, DataCAD would not use the selected reference 

point. This problem has been corrected. 

8. DataCAD will no longer crash when attempting to place an exploded symbol on a 

locked layer. 

9. The Reference Point function has been corrected. This problem was especially noticeable 

when using Reference Point within the Stretch function. 

10. Selecting the Root directory of a network drive while browsing paths within the 

Preferences dialog would add an extra '\' to the path. This problem has been corrected. 

11. Highlighted XREFs assigned to a zero-width pen would still plot. This problem has been 

corrected. 
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9.04.00 

Fixes 

1. Snapping within the Template window has been corrected. 

2. A problem with Backup when entering a polyline has been corrected. 

3. A line spacing problem when inserting XREFs has been corrected. For existing drawings 

with XREFs that have their line spacing appear incorrect, use Change/Spacing to set the 

XREF's line spacing to 1'-0" (metric users please use 304.8 mm). 

4. An error whereby turning on DrwMarks within the Reference Point command would 

also turn on DrwMarks in the Settings menu has been corrected. 

5. A fatal error in the Mirror commands has been fixed. 

6. Display anomalies, with certain video card and operating system combinations has been 

fixed. 

 

9.03.00 

New Features 

1. A new input mode (Direction\Distance) has been added. To use this method, set the 

input mode to Direction\Distance by pressing the [Insert] key on your keyboard or 

selecting it from the Tools pull-down menu. Enter the first point, then move your cursor 

in the direction of the line you wish to draw. Press the space bar and enter the relative 

distance. 

To set a reference point while in Direction\Distance mode, you must also indicate the 

reference angle using the mouse. To enter a reference point while using 

Direction/Distance mode, press the [`] key, select a reference point using the mouse, then 

indicate the reference angle using the mouse and left-click to finish the operation. 

2. An enhanced object snapping method has been added. Press and hold the [Shift] key on 

your keyboard, then click the middle mouse button to access the options "Get X," "Get 

Y," "Get Angle," "Get X + dist," "Get Y + dist," and "Get angle + angle." For detailed 

instructions on these new functions, visit the DataCAD Web site at www.datacad.com 

and select Technical Bulletins in the Support section. 

3. Snapping to nested symbols has been enhanced to include endpoints and points in the 

nested level. 

4. When enlarging an XREF, the line spacing is adjusted accordingly. 
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5. An option to display the boundary of a Clip Cube has been added. This setting is located 

on the Misc tab of the Program Preferences dialog box in the Tools pull-down menu. 

6. A conversion utility for batch converting legacy 2D go-to-views to the current go-to-

view format has been added. Access this function by pressing [Ctrl] + [F12] on your 

keyboard and selecting ConvTo3D. 

7. Display List functionality has been further optimized when Max Acceleration is toggled 

on. 

8. Rectangle option added in polyline creation (shows up in Hatch/Boundary, Area/Perim, 

Curves/Polyline, etc.). 

9. PrevLine option added to Mirror commands. 

10. An AllCaps option has been added to the Text menu. 

11. FileI/O has been removed from the Text menu. To import a text file, select the Insert/Text 

File drop down menu. To export text to a file, select File/Export/TXT. 

12. New ASCII character codes added: 

[Alt] + 0241 [ñ] : Turn Text AllCaps On 

[Alt] + 0242 [ò] : Turn Text AllCaps Off 

13. A new "AndCopy Toggles" option in Program Preferences has been added to the Misc. 

page. By un-checking "Remember On/Off Status", the AndCopy option in the Move, 

Rotate, Enlarge and Mirror menus will always be Off when the menu is entered. 

14. New "Drag" option is now available in the Copy menu. 

15. A toggle has been added for insertion point when Cutting\Copying information to the 

Windows Clipboard. If InsPoint is not used, DataCAD copies the information relative to 

Absolute Zero. If InsPoint is used, the user must specify a reference point after selecting 

Cut or Copy. 

16. A new option now appears when placing objects from the Windows Clipboard via Paste 

or Paste Special. The new toggle ByCenter allows placement by the extents of the objects 

or by the insertion point mentioned in #15 above. 

17. A new Match option has been added to the Selection Sets (SelSets) mask by color 

function. This new option allows you to pick an entity and use its color in the masking 

process. This method is handy for masking by a custom color. 

18. XREFs that have been mirrored and/or rotated will now bind more visually correct. 
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Fixes 

1. Entity grouping is retained after erasing entities within the group. 

2. A fatal error, which occurred when exiting a shaded image window and selecting "Back 

to DC5 (discard this image)", has been corrected. 

3. The settings for Paper Orientation at Device in the DataCAD Printer\Plotter setup 

dialog are correctly represented by the layout box. 

4. Clip Cube will no longer interfere with hatch pattern and line type previews. 

5. Pressing [F8] in the Settings menu no longer accesses a blank menu. 

6. An "Error in file, translation aborted" message, which occurred when importing 

DXF\DWG files containing associative hatch, has been corrected. 

7. Plot optimization enhancements have been added to reduce plot file sizes and to fix a 

problem with Plot Preview and/or plotting exceptionally large drawings with high 

vector counts. 

8. The backup option in Horizontal Slab and Horizontal Polygon has been corrected to 

update the reference point (previous point) properly. 

9. An access violation error related to having too many line type definitions has been 

corrected. 

10. A correction was made to binding a nested XREF which was copied at the nested level. 

11. A fatal error that occurred while attempting to clear certain selection sets has been 

corrected. 

 

9.02.00 

Fixes 

1. A Windows fatal error that occurred when entering the plotter menu and configuring 

HP DesignJet plotter drivers has been corrected. 

2. The status of the "W" in SWOTHLUD is correctly reflected when using the Create pull-

down menu to change from walls to lines. 

3. An error associated with using LinkEnts on an inactive layer when the active layer is 

locked has been fixed. 
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4. Selecting To File from the Plotter menu, then Cancel no longer causes the cursor to 

disappear. 

5. The Undo\Redo capability is no longer affected when you select Measure\Line, choose 

a line, and then begin a new function without properly exiting the Measures menu. 

6. Using Stretch\Z-Dist\Z-Only on a 3-sided horizontal polygon to stretch one corner now 

works properly. 

7. The Default.tbl Color Map Table has been adjusted for better translation of DataCAD 

colors to AutoCAD. 

8. Using a comma instead of a period in the Windows control panel Regional Settings no 

longer prevents the creation of .pdf files. 

 

9.01.00 

New Features 

1. XREFs may now be enlarged at the time of insertion. 

2. XREFs may now be rotated (by a specified angle or dynamically) at the time of insertion. 

3. XREFs may now be highlighted individually in the RFM (Reference File Manager). 

4. Previous View action (using the "P" key) can now be specified in the Program 

Preferences dialog to remember Free Zooms and/or Pans/Scrolls or not. 

5. "Right click to Exit" the Shader window setting has been added to the Program 

Preferences dialog. 

6. TxtScale entry from DCADWIN.ini has been added to the Preferences dialog. 

7. A new setting has been added to the DCADWIN.ini file to allow changing the 

HyperView shortcut from Alt+Left-click to Alt+Shift+Left-click. Valid entries are (In the 

[General] section of the DCADWIN.ini file): 

[General] 

HYPERVIEW=ALT 

This is the default 

 

HYPERVIEW=ALT+SHIFT 

Changes it to Alt+Shift+Left-click) 

8. New ASCII character codes added: 
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[Alt] + 0235 [ë] : Turn Plot Preview On 

[Alt] + 0236 [ì] : Turn Plot Preview Off 

[Alt] + 0237 [í] : Turn TxtScale On 

[Alt] + 0238 [î] : Turn TxtScale Off 

 

Fixes 

1. The extents of an XREF are now always correct regardless of the state of the file being 

referenced in. 

2. XREF snapping fixed. 

3. Scaled (enlarged) XREFs will now Bind correctly. 

4. The PenTable Load/Save dialog would occasionally be obscured by the PenTable dialog 

itself. This problem has been corrected. 

5. PgUp/PgDn for scrolling in GoTo View menu fixed. 

6. Corrected the segmentation of large radius, non-solid (dotted, dashed and dot- dashed) 

arcs when clip cubes are used. 

7. Duplicate system attributes are deleted when a drawing is loaded. 

8. LyrUtil of upper (9-15) selection set info fixed. 

9. Plot Rotated at Device fixed. 

10. A change was made to the PDF file generator to overcome a system limitation on very 

dense (i.e. with lots of hatch) files. 

 

DataCAD 9 New Features and Enhancements 

New Feature Highlights 

 

AutoCAD R2000 – R2002 Compatibility 

DataCAD 9 adds support for importing and exporting AutoCAD R2000 through R2002 files in 

DXF and DWG format. This enables you to collaborate and share files with associates who use 

the latest versions of AutoCAD. 

Multi-level Undo/Redo 

A new unlimited Undo/Redo feature allows you to draw and explore design ideas without 

hesitation. You can undo the last step you took, or undo several steps, all the way back to when 
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you opened the drawing. Undo one too many steps? Just choose Redo to restore the changes 

you made by one step. All DataCAD functions are supported, including the deletion of layers. 

Note: A new undo buffer is created when you open your drawing, but it is not retained after you close the 

file. So, you cannot undo changes you made to your drawing prior to opening it. 

External File Referencing (XREF's) 

DataCADs new File Referencing feature displays the geometry of referenced files in your 

current drawing without actually inserting that geometry into your drawing. Graphically refer 

to the information you need, without increasing your drawings file size beyond manageable 

limits. Now multiple designers in your office can work on floor plans, reflected ceiling plans, 

and enlarged details in a project -- all at the same time. A Reference File Manager not only lets 

you refresh, reload, delete, or bind reference files, it also lets you toggle reference file layers on 

and off and highlight reference file geometry with colors and line types to differentiate between 

multiple disciplines. 

Cut/Copy and Paste 

You can cut or copy both entities from a DataCAD file and text or metafile graphics from word 

processing, spreadsheet, and illustration programs, such as Microsoft Word, Excel, and 

CorelDRAW into DataCAD. Then the data can easily be pasted into another DataCAD drawing 

or into other Windows applications. DataCAD entities will even retain their layer formatting 

when pasted into other DataCAD drawings. 

MDI (Multiple Document Interface) 

DataCAD 9 can display an unlimited number of DataCAD drawings and bitmap images 

simultaneously for design coordination and to facilitate the exchange of drawing data between 

multiple documents via Cut/Copy and Paste. 

Batch Plotting 

The new Batch Plotting feature in DataCAD 9 saves valuable office time by letting you plot 

multiple sets of drawings instead of setting up and plotting each sheet one at a time. Using the 

Batch Plotting Setup dialog box, you can define sets of drawings for multiple projects and print 

them overnight. In addition to direct printing, batched sets may also be sent to plot files for use 

by plotting service bureaus. After plotting is complete, a summary report is displayed for 

quality control, and plotting information is saved to a .LOG file for later reference. 

OpenGL® Shader 

DataCAD 9 features an all-new, OpenGL-based shader that is faster and produces a higher 

quality image than the previous Quick Shader. The new shader supports all 256 colors in the 

user-defined DataCAD palette rendered in up to 16.8 million colors. There are seven custom 

lights as well as display settings so you can get the results you want. The new shader supports 

output resolutions of up to 8 million pixels for high quality printed output. An edge-only 

feature creates bitmap-based hidden line images in a fraction of the time it takes to create a 

standard vector-based HLR image. 
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HyperView Linking 

The new HyperView feature links drawing entities to DataCADs GoTo Views. Now you can 

click on drawing notations to automatically display the corresponding view. 

WYSIWYG Print Preview 

Use DataCADs new Plot Previewer to view an onscreen representation of your print, exactly as 

it will appear on paper. You can print directly from the Previewer or save as either an Adobe 

Acrobat (PDF) file or a Windows Metafile (WMF) for distribution over the Internet. 

Export to Adobe® Acrobat® (.PDF) 

 

Import/Export Windows® Metafile (.WMF) 

 

Export to DC Render (.RAY) 

DataCAD 9 can export a drawing directly to a DC Render (.RAY) file. DC Render Plus is an 

advanced rendering program for creating photorealistic still images and animations. 

Note: DataCAD 9 includes Renderize Live, a full-featured rendering program. 

View Sensitive Toolbars 

View Sensitive Toolbars have been added for quick access to frequently used viewing 

commands for orthographic (plan), parallel, and perspective views. Simply toggle the Viewer 

Toolbar on, and it changes automatically, depending on current view projection. 

Wall Style Manager 

A new Wall Style Manager has been added to the Architect menu, so you can change wall 

options from a single dialog box as well as create and load wall styles. 

User-definable Macro Menu 

 

New DCAL® Routines 

More than a dozen new procedures and functions requested by DataCAD macro authors have 

been added to the DCAL API. See our DataCAD Developers Network (DDN) web site for more 

information. 

Enhancements 

1. Drawing File Preview 

2. Symbol File Preview 

3. Hatch Pattern Preview 

4. Line Type Preview 
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5. Font Preview 

6. Expanded Pull-down Menus 

7. Resizable File I/O Dialogs 

File I/O dialog boxes in DataCAD 9, such as Open and Save dialogs, can be resized to 

display a greater number of files. The File/New dialog box has been enhanced with a 

drawing file preview and direct access to Default drawing selection. 

Minor Changes 

1. Enhanced object snapping within symbols 

2. Enhanced Previous View function 

3. New Directory Dialog 

4. Updated File New Dialog 

5. Updated Multi-view Windows 

6. New Extended Character Codes 

7. Updated DXF/DWG Import Dialog 

8. BitBlt Implementation 

9. Updated Program Preferences 

• Added path for RAY files 

• Added path for BMP files 

• Added folder browser to Pathnames tab 

• Added DC Render material assignments to Misc tab 

• Added Clipboard options to Misc tab 

• Added symbol preview options to Misc tab 

• Updated screenshot on Interface Settings tab 

• Added Move drawing to origin checkbox to DXF/DWG tab 

• Added Macros tab 
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10. Pro Pack enhanced with new extended character codes 

11. Modifications to Drawing Session Clock 

12. 2D GoTo Views replaced by 3D GoTo Views as GoTo Views 

 

Fixes 

1. Display anomalies when using the Quick Shader when Windows is set to use Large 

Fonts have been corrected. 

2. A bug where selecting DelSymb in an empty template window caused the template to 

malfunction has been corrected. 

3. Pen width scaling anomalies when turning Check Plot on and off have been corrected. 
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8.53.00 

Fixes 

1. A Windows fatal error that occurred when entering the plotter menu and configuring 

HP DesignJet plotter drivers has been corrected. 

2. The scaling of pen widths when using the Check Plot feature is canceled when Check 

Plot is disabled. 

 

8.52.00 

New Features 

AutoCAD R2000 Compatibility 

DataCAD 8.52.00 adds support for importing and exporting AutoCAD R2000 files in DXF and 

DWG format. This enables you to collaborate and share files with associates who use the latest 

versions of AutoCAD. 

1. The Pen Table will be scaled accordingly when using a check plotter and a scaling value. 

2. DataCAD Plus file read support. 

3. Export to .ray (DC Render) format. 

 

Fixes 

1. Using SaveAs to save a file to a floppy disk that does not have enough space, a warning 

message will now appear. 

2. When exploding text in a perspective view it will no longer be deleted. 

3. DXFing very small RevSurfs will no longer create Invalid Floating-Point Operation 

errors. 

4. The DXF/DWG Translator has been corrected to properly create R13 and R12 files. 

5. Choosing Delete from the TxtStyle menu will only remove the text style selected and not 

the entire file. 

6. The command line calculator has been corrected to accept the SQRT function. 

7. Arc and Circle center points will now display correctly in ClipCubes. 
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8. Right clicking the mouse when plotting will no longer crash DataCAD. 

 

8.50.07 

Fixes 

1. A memory leak that occurred when printing to certain printer drivers and using the 

driver's preview feature, has been corrected. 

 

8.50.06 

Fixes 

1. Invalid Floating-Point errors, when printing to some HP printer drivers, have been 

fixed. 

 

8.50.05 

Fixes 

1. Polylines will now be created using the proper Z information. 

2. Entities which have abnormally small or large Z-base or Z-heights will automatically be 

changed to 0, to correct Invalid Floating-Point errors. 

3. A problem when importing DXF or DWG files which had more than 99 duplicate layer 

names caused DataCAD to freeze and has been corrected. 

 

8.50.04 

Fixes 

1. A problem when exporting files to DXF/DWG that contained Associative Dimensions 

has been corrected. 

 

8.50.02 

Fixes 

1. A problem where pen assignments with the same widths were not using the percent 

density setting, has been corrected. 

2. The 3DViews/Controls menu will now display the proper menu button names. 
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8.50.01 

Fixes 

1. Symbols will now print using their line colors rather than their insertion color. 

2. Setting a -0" Tolerance in the DimStyle menu will no longer produce an error message. 

3. Template files can be named using long filenames and paths. 

4. Launching external programs from a DCAL script has been fixed. 

5. A problem when setting the Windows display to use Large or Custom fonts will now 

allow the drawing area to display correctly. 

6. Importing DWG files which contain multiple polygons in a symbol reference will not 

cause the translator to hang. 

 

DataCAD 8.5 New Features and Enhancements 

New Feature Highlights 

AutoCAD R12 – R14 Compatibility 

All new, OpenDWG-based DXF/DWG translator supports importing and exporting files up 

through AutoCAD Release 14 file formats. It will convert custom line types used in your 

DataCAD file to AutoCAD format, so your drawings will display in AutoCAD just as they do in 

DataCAD. The new translator also maps entity colors using color table (*.TBL) files located in 

the DATACAD\SUP\ folder. The automatic conversion of custom line types and the translation 

of colors using the color table file can both be disabled with a new option on the DXF/DWG tab 

in Preferences/Options dialog box. Please note that when exporting to Release 12 format, all 

custom line types are translated to a continuous line definition while maintaining the original 

line style name, because AutoCAD 12 does not support custom line types. 

Display List 

Display performance has been increased by the addition of a software Display List. DataCAD 

8.50 has faster refresh times, object snapping, entity selection, and panning and zooming. You 

can toggle Display List on or off on the Misc. tab of the Preferences/Options dialog box. 

Digital Terrain Modeler 

A new Digital Terrain Modeler (DTM) allows you to quickly model site plans by dropping a 

polygon mesh over survey data points or contour lines. Located in the 3D Polygons menu, this 

new feature has several options you can customize, allowing greater flexibility and creativity in 

producing realistic models and landscapes. 
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1,500 New 3D Symbols 

There are 1,500 new 3D symbols, including cars and trucks, outdoor lights, park benches, 

miscellaneous cityscape objects, kitchen and bathroom cabinetry, plumbing fixtures, and 

appliances. 

Estimator for Windows 

Estimator for Windows v.6 is included on the DataCAD CD-ROM; it integrates with DataCAD 

and supports Quicken and QuickBooks formats. 

WinHelp 2000 

DataCAD 8.50's new WinHelp 2000-based online help offers a dual-paned help window so you 

can view the Table of Contents simultaneously with topic information. Both the Reference 

Manual and online help have been restructured to reflect the way CAD users work. 

 

Fixes 

1. Drawings correctly store printer selection. 

2. Canceling File/Open when using the recent file list no longer fails. 

3. Drawing display anomalies in Windows NT have been fixed. 

4. Menu button highlight display anomalies in Windows 95 and Windows 98 have been 

fixed. 

5. Pixels are no longer dropped at vector endpoints. 

6. The automatic closure of horizontal slabs and polygons after the entry of the third point 

has been fixed. 

7. The Tab order has been fixed in the Preferences/Options dialog box. 

8. Problems with using the right mouse button to exit the current menu while the arrow 

cursor is positioned over a blank area of the menu have been fixed. 

9. The graphic state of the layer search button in both the menu and the Status Area will 

correctly reflect the state of the toggle. 

10. The Message Area is no longer erased after accessing the Preferences/Options dialog 

box. 

11. Problems with the modification of dimension text in non-associative dimensions have 

been fixed for linear, radius and diameter dimensions. 

12. The Check Plot, Use This Factor box will now use any whole number that is entered. 
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13. The ShowVals option under TxtStyle now displays all the text style settings. 

14. When opening the first file in a new DataCAD session, DataCAD will no longer load 

layers and then load the drawing to the screen; it will now load the file once. 

15. Cursor ghosting that occurred when using the middle mouse button to input 

coordinates or when pressing [Esc] while inputting coordinates has been corrected. 
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Fixes 

1. A memory leak that occurred when printing to certain printer drivers and using the 

driver's preview feature, has been corrected. 

2. Invalid Floating-Point errors, when printing to some HP printer drivers, have been 

fixed. 

3. Polylines will now be created using the proper Z information. 

4. Entities which have abnormally small or large Z-base or Z-heights will automatically be 

changed to 0, to correct Invalid Floating-Point errors. 

 

8.08.04 

Fixes 

1. A problem where pen assignments with the same widths not using the percent density 

setting, has been corrected. 

2. The 3DViews, Controls menu will now display the proper menu button names. 

 

8.08.03 

Fixes 

1. Symbols will now print using their line colors rather than their insertion color. 

2. Setting a -0" Tolerance in the DimStyle menu will no longer produce an error message. 

 

8.08.02 

Fixes 

1. The DataCAD executable is now looking for the correct online help filename. 

2. Template files can be named using long filenames and paths. 

3. Launching external programs from a DCAL script has been fixed. 
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8.08.01 

Fixes 

1. The first line drawn in a file will now print using the assigned values in the PenTable. 

 

8.08.00 

Fixes 

1. Drawings correctly store printer selection. 

2. Canceling File/Open when using the recent file list no longer fails. 

3. Drawing display anomalies in Windows NT have been fixed. 

4. Menu button highlight display anomalies in Windows 95 and Windows 98 have been 

fixed. 

5. Pixels are no longer dropped at vector endpoints. 

6. The automatic closure of horizontal slabs and polygons after the entry of the third point 

has been fixed. 

7. The Tab order has been fixed in the Preferences/Options dialog box. 

8. Problems with using the right mouse button to exit the current menu while the arrow 

cursor is positioned over a blank area of the menu have been fixed. 

9. The graphic state of the layer search button in both the menu and the Status Area will 

correctly reflect the state of the toggle. 

10. The Message Area is no longer erased after accessing the Preferences/Options dialog 

box. 

11. Problems with the modification of dimension text in non-associative dimensions have 

been fixed for linear, radius and diameter dimensions. 

12. The Check Plot, Use This Factor box will now use any whole number that is entered. 

13. The ShowVals option under TxtStyle now displays all the text style settings. 

14. When opening the first file in a new DataCAD session, DataCAD will no longer load 

layers and then load the drawing to the screen; it will now load the file once. 

15. Cursor ghosting that occurred when using the middle mouse button to input 

coordinates or when pressing [Esc] while inputting coordinates has been corrected. 
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8.07.00 

New Features 

1. New options in the Settings/ScaleTyp menu: 

a. DIN - This option presents dimensions in the form meters.centimeters with 

superscripted millimeters. 

b. AS1100 - This option presents dimensions in the form of millimeters with a space 

separating thousands, hundred thousands, millions and so on. Input is done in 

meters. 

c. StakFrac - This new option appears if the current scale type is Arch. When toggled 

on, fractions of an inch are displayed "stacked" rather than inline. 

Note: It was determined during the testing of this feature, that certain third-party fonts have 

improper character definitions which may cause the fraction to overwrite the non-fractional 

portion of the dimension. Should this occur, try using a different font. 

2. The decimal separator for all displayed dimensions and numbers is now determined by 

the value of the Windows Decimal Separator. To set this value, choose Control Panel 

from the Start/Settings menu on your Windows desktop. Choose Regional Settings. On 

the Number tab, set the Decimal symbol value. 

3. The scale type for area/perimeter calculations is now remembered independently from 

the current drawing scale type. 

4. The new setting AreaPrec controls the number of digits of precision to be displayed for 

area calculations when the ScaleTyp option in the Area/Per menu is set to Decimal, Inch 

Decimal, Meters, Centimeter, Millimeter, DIN, or AS1100. 

5. Mouse input has been enhanced as follows: 

Left Button = Pick/Select 

Middle Button = Object Snap 

[Shift] + Left Button = Object Snap 

[Ctrl] + Left Button = Reference Point 

[Ctrl] + [Shift] + Left Button = Object Snap Reference Point 

[Ctrl] + Middle Button = Object Snap Reference Point 

 

Fixes 

1. An anomaly when using the [N] key to object snap when orthogonal snapping was 

enabled has been corrected. 
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2. In dimensioning with ScaleTyp set to Arch, dimensions less than 1 inch were being 

displayed with a leading zero.  The leading zero is no longer displayed. 

3. Correction of a bug in which dimensions would automatically rotate has been reversed 

(or put back the way that it was), per user requests. 

 

8.06.00 

New Features 

1. New Print Setup dialog box. All settings in this dialog are now stored within the 

drawing file. 

2. A ToFile option has been added back to the Plotter menu. 

3. The SetPens menu has been expanded. All 255 colors may now be assigned to any of 15 

pens. All settings in this dialog are stored within the drawing. 

4. The AllBlack option has been moved from the Plotter menu to the SetPens dialog. 

5. A New option has been added to the File drop-down menu. 

6. A Close option has been added to the File drop-down menu. 

7. CAVWALL has been added to the General section of DCADWIN.ini. If true, insertion of 

doors and windows into cavity (4-line) walls trims the outer jamb lines to the cavity 

lines. 

8. TXTSCALE has been added to the General section of DCADWIN.ini. If true, PgUp and 

PgDn change the current plotting scale in the Text and Dmension/ TxtStyle menus. 

9. A recent file list has been added to the File drop-down menu. 

10. The number of displayable symbol names for a single template has been increased from 

100 to 500. 

11. The maximum number of user-defined line styles supported in DCADWIN.LIN has 

been increased from 50 to 175. 

 

Fixes 

1. Custom colors now plot correctly. 

2. HLR/Options/Join now works correctly. 
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3. Several instances of cursor ghosting have been corrected. 

4. The creation of Pocket and Overhead door styles when InWall and Cutout are off now 

works correctly. 

5. An error associated with the Fonts path changing has been corrected. This is related to 

accessing mapped network drives. 

6. Arcs now display correctly when dragging (the arc) in Dimension/Angular and 2Pt/3Pt 

arcs. 

7. DataCAD no longer prompts to save the file when a fatal error has occurred. This allows 

you to recover the autosave (.ASV) file in the event of a fatal error. 

8. The Template and Multi-View windows are no longer redrawn after the line type and 

Hatch Pattern preview window is closed. 

9. AutoHgt toggle in Slabs and Blocks now works correctly. 

10. The error that would allow symbol definitions to be purged when instances of those 

symbols were located on layers that were turned off has been corrected. 

11. The DEFAULT.PIF file used by the DWG translator has been changed so it will not 

prompt you to shut down and re-boot in MS-DOS mode. 

 

8.05.02 

Fixes 

1. Arrow ghosting, which occurred at times during editing commands like Move and 

Stretch, has been corrected. 

2. An error that caused DataCAD to misinterpret axes in predefined elevation views 

during some 3D editing commands has been corrected. 

3. While accessing drawings from a non-mapped network drive, the directory path in the 

Open dialog box was sometimes incorrect. The error has been corrected so that the 

drawing directory is always displayed in the Open dialog box. 

 

8.05.01 

New Features 

1. An Interface Settings tab has been added to the Preferences, Options dialog box. This tab 

contains an interactive copy of the DataCAD screen; move your mouse cursor over the 

different areas of this screen to see Tool Tips. You can turn the toolbar on or off; change 
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the font used on the menu buttons or the message prompts; move the Menu Window to 

the right side of the screen; or change the background color in the Drawing Window. 

Both the Navigation Pad and the Projection Pad will be displayed under the menu 

buttons if there is enough room. If the menu buttons require too much space for both 

pads to be displayed, only the Navigation Pad will be displayed. Projection options can 

still be accessed from the View pull-down menu on the Menu Bar. It is possible for the 

menu buttons to take up so much room that neither pad can be displayed, or even so 

that the menu buttons themselves are cut off at the top of the application window. 

Choose a smaller font if you would like one or both pads to be displayed. 

2. Additionally, the DCADWIN.ini file can be modified to adjust the spacing between 

buttons by changing the value (number of pixels) for the BTN_SPACING option. You 

can also add a line immediately below the BTN_SPACING option to adjust the width 

(number of pixels) of the menu buttons: 

BTN_WIDTH=x 

Substitute a positive or negative number for "x". 

A setting can also be added to the DCADWIN.ini file to adjust the template window 

width in pixels. Add the following lines to your DCADWIN.ini file: 

[Template Window] 

WIDTH=x 

Substitute a positive number for "x". 

3. Bitmap preview windows for line types and hatch patterns have been added. 

4. Menu buttons in the Menu Window now highlight as the mouse cursor passes over 

them. This has not yet been applied to the buttons in the multi-view windows. 

5. You can now set the background color for Quick Shading. Click on the colored box on 

the Misc tab in the Preferences, Options dialog box. Choose a new color and click OK. 

This background color is independent from the background color for the Drawing 

Window (which can be set on the Interface Settings tab). 

 

Fixes 

1. A Floating-Point Error related to selection has been fixed. 

2. A problem where text was being truncated to 12 characters instead of 255 when reading 

DXF files has been corrected. 

3. Cursor ghosting has been corrected. 
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4. A correction has been made to the Density setting in the Pen Table to prevent incorrect 

densities when choosing custom colors. 

5. Keyboard functions are now activated when you press the key down, instead of when 

you release the key. This will correct the slight delay you might experience when using 

the keyboard. 

6. The DataCAD screen is now only refreshed when it has focus, or in other words when it 

is the foreground application. 

7. When using [PgUp] or [PgDn] to window in on your drawing while FreeZoom is on, 

DataCAD cannot go beyond the largest and smallest defined scales; the program will 

now display a message informing you of this when appropriate. 

 

8.05.00 

New Features 

1. Adjust ambient light intensity in Quick Shader using the Intensity option. 

2. New Percent Density and Map to Color options in the Pen Table of the Plotter menu 

allow you to print screened colors as well as gray scale. 

3. Use the Save as Bitmap option in the Window menu to save the Drawing Window as a 

bitmap (.bmp) file. This option does not capture template windows, multi- view 

windows or any other part of the DataCAD screen. 

 

Fixes 

1. A correction for color mapping when using Map to Color in the plotter Pen Table. 

2. DCAL macros that extract polyline Z-base and Z-height information may return 

incorrect Z-base and Z-height values, even though this information is correct in the 

drawing database. 

 

8.04.00 

Fixes 

1. A correction for drawing octant arcs in text has been made. This anomaly could be 

observed when using the font ROMANS and adding the degrees symbol. The symbol 

would not draw correctly. This problem has been present since the support for octant 

arcs was added around version 4. 
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DataCAD 8 New Features and Enhancements 

New Feature Highlights 

1. Multi-scale plotting has been expanded to include Update, MakeCurr, LyrTogl, and 

GoToView. Update updates the layer settings in the selected detail based on the current 

view in the Drawing Window. MakeCurr allows you to make any detail the current 

view in the Drawing Window. LyrTogl dynamically toggles layers on and off within a 

detail. GoToView takes you to the 3D GoToView menu where you can choose any view 

to save it as a detail. 

2. Sheets (in the MltLyout menu) can now be renamed. 

3. A Match function has been added to the color menus. Whenever you are prompted to 

select a color, you can choose Match and select any exiting entity to use that entity's 

color. 

4. The DWG Translator has been enhanced to write associative dimensions and associative 

hatching without exploding either first. Associative dimensions are written as 

associative dimensions; associative hatching is written as a block. 

 

Fixes 

1. The icon toolbar now resets itself properly when you choose NewDwg from the File I/O 

menu. 

2. If Z-base and Z-height are equal, using clip cube results in the entity printing and 

displaying smoothly. 

3. After manually placing an associative dimension, the text will correctly display when 

dimension is changed. 

4. Icon toolbar operates correctly in a new drawing after scrolling through the icons and 

then using NewDwg. 

5. [PgUp] and [PgDn] can be used to scroll through go-to-views. 
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New Features 

1. Change/Undo - Undo the last change made to an entity, group, area, fence, or Selection 

Set. 

2. Layer/Match - Select layers by picking an entity on that drawing layer with your mouse. 

3. Color/Adjust - Control the way any screen color is displayed by adjusting its RGB 

values. The color is dynamically updated on the screen as new values are entered. 

4. Menu Scroll Forward/Back - Scroll forward and back through file listings in your menu 

with [PgUp] and [PgDn] on your keyboard. 

5. Display/MltiView - Display a column of Multi-View Windows that show four saved 

views of your drawing, allowing you to switch between one view quickly and easily and 

another. The views can even be displayed as shaded images. You can turn the Multi-

View Windows on and off through the Display/MltiView toggle or through the 

keyboard interrupt [Ctrl] + [w]. 

6. DoorSwng & Windows - Enter a door or window by the rough opening (JambIn) or by 

the finished opening. 

7. DoorSwng & Windows - Control the depth of jambs (MtchWall & JambDpth) such that 

they will either match the wall width or have a unique, independent value. 

8. DoorSwng/DoorStyl - Two new door styles: pocket doors & overhead  (garage) doors. 

9. DoorSwng/Thicknss - Control the thickness of all doors, including bi-fold and sliding. 

10. DoorSwng/Angle - Control the size of the opening for all door styles, except for 

overhead doors. 

11. DoorSwng/SwngStyl - Control the color of the door swing (MtchDoor & SwngColr) and 

how it is drawn (line, arc, or none). 

12. LyrSrch status toggle - Easily change or check the LyrSrch status with the addition of the 

layer search toggle in the lower-left of your  display next to the current display scale. 

13. On-line Calculator - Automatically calculate equations any time you are prompted to 

enter a value. 
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Fixes 

1. Template/SaveSymb Crash - When you are saving a symbol, you are prompted to "Select 

reference point for symbol." If you go to the ObjSnap Menu  using the [X] keyboard 

interrupt, then return to SaveSymb and enter the reference point, the program would 

generate a "Fatal Error 2101 Real  Math Overflow". 

2. WindowIn/Extents with ClipCube - When you perform a WindowIn/Extents  and the 

ClipCube is on, the extents of the ClipCube displays to the  extents of the drawing 

window. 

3. Icon Toolbar malfunction - When selecting toolbar buttons after scrolling the toolbar to 

the right and using a keyboard interrupt, DataCAD would not perform the appropriate 

function for the next button selected. 

Features Enabled Through Environment Variables 

There are switches that, when set, affect the way DataCAD performs several different functions. 

Each can be set through the addition of a line to your AUTOEXEC.BAT file. Once the 

appropriate line has been added, each time you boot your computer the environment variable 

will be set and DataCAD will behave according to the following descriptions: 

1. When the TxtScale toggle is on, text size can be set dynamically,  according to its plotted 

size on the page based upon the current plot scale. With TxtScale on, you can use [PgUp] 

and [PgDn] to scale the text size while dragging the text cursor. You can disable 

dynamic plot scale in Text menu by means of the following environment variable: 

SET DC-TXTSCALE=n 

n may be set to TRUE or FALSE. 

Dimension text size is also set dynamically when the TxtScale toggle is on. Other 

dimension settings which are relative to the text size, such as arrow size, are also 

affected. This feature works in the same manner as the text size feature. 

2. Mouse tracking speed may be adjusted by means of an environment variable. Setting 

this environment variable can compensate for the slow cursor experienced when you 

run DataCAD on a Windows 95 workstation. 

SET DC-MOUSE=n 

Where n is either 1,2,3 or 4 (1 is slowest, and 4 is fastest). 

For Windows 95 systems, a value of 4 is recommended. 

3. For problems with DWG Translator, use the following environment variable: 

SET DCAD_ROOT=C:\DATACAD 

Substitute your DataCAD directory name when appropriate. 
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4. Architct/4LnWalls - You can set the drawing method for 4-line wall  cutouts when using 

Windows, DoorSwng, and CutWall. When enabled through the following environment 

variable, the cutouts will be drawn with the ends of the inner and outer walls capped 

but with the cavity open. 

SET DC-CAVWALL=1 

 

7.10.00 

New Features 

1. The installation program now allows you to enter a destination pathname for DataCAD 

when performing an EXPRESS INSTALL. 

2. LYRUTIL macro now has toggles to disable the saving of 3D GoToViews and/or Multi-

scale plot details. 

3. Crossing feature in Area and Fence selection is a toggle that you can enable after picking 

the first point of the selection box. When enabled, Crossing will select any entity that 

crosses the selection box, along with any entities fully within the box. This works in all 

editing commands except for Stretch. 

4. New EZ Tools(TM) macro that automatically generates elevation drawings of doors, 

windows, and cabinets with numerous styles and options. It also generates cabinet 

section drawings and exterior elevations with details of various roof styles. 

Documentation for this new feature is found in the on-line documentation for Add-On 

Packages. 

5. New Palettes option in the Display menu allows you to load custom RGB and PAL files. 

Several sample RGB and PAL files have been included with DataCAD 7.10. They are 

installed in the \DATACAD\SUP directory. A sample drawing named 256CUBE.DC5 is 

installed in the \DATACAD\DWG\SAMPLES directory to illustrate the use of the 256 

color palettes. 

6. The display of arcs when using the ClipCube function has been improved. Clipped arcs 

are now displayed using the ArcFactor setting, rather than  being displayed and plotted 

in a segmented fashion. 

7. Dimension arrow color and weight are now separate settings from text arrow color and 

weight. 

 

Fixes 

1. Problems with erratic cursor after shelling out of DataCAD in Windows 95 environment 

have been fixed. 
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2. Problems with RoundUp in Dimension Rounding have been fixed. 

3. For problems with DWG Translator, an environment variable has been added: 

SET DCAD_ROOT=C:\DATACAD 

Substitute your DataCAD pathname if appropriate. 

4. A new version of the DWG translator is included that fixes several errors that occurred 

when writing and reading DWG files. 

5. Fatal errors caused by stretching or moving slabs and polygons with voids after running 

the drawing through the LYRUTIL macro have been fixed. 

 

7.04.00 

New Features 

1. LYRUTIL macro now has option for deletion of layer files. 

2. AEC_MODL macro automatically creates voids in slabs for windows and doors. 

3. Current drawing name is always displayed on screen in menu area. 

4. Dimension text rounding option in DimStyl menu, rounds up, down, and performs 

bankers rounding. 

5. Two new arrow styles in Text menu, Dot & Tick. 

6. Text arrow and Dimension arrow share the same settings for arrowhead color  and 

weight. 

7. User defined line types are supported on 2D arcs, circles, Béziers, b-splines, ellipses, and 

polylines. 

8. Hither clip plane is displayed on cone of vision in SetPersp. 

9. Ability to adjust mouse speed via environment variable: 

SET DC-MOUSE=n 

n may be set from 1 to 4, 1 is slowest, 4 is fastest. 

10. Ability to disable dynamic plot scale (PageUp/PageDown) in Text menu via 

environment variable. 

SET DC-TXTSCALE=n 

n may be set to TRUE or FALSE. 
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11. 2 line and 3-line wall creation, by centers, no longer prompts for inside/outside of wall 

when highlight is off. 

12. Pictograms are saved to current drawing directory. 

13. FRAMEIT macro has been enhanced to allow adjustment of box headers. 

 

Fixes 

1. Layers containing polygons and/or slabs with voids will both save and load using 

LYRUTIL macro. 

2. An error in automatic T-intersection cleanup (Clean toggle in Architct menu) that could 

cause database corruption has been corrected. 

3. An error in the Remove function in DoorSwng, Window, CutWall that could cause 

database corruption has been corrected. 

4. An error in the WeldWall function in Cleanup that could cause database corruption has 

been corrected. 

5. Corrections have been made to both the VIEWMAST and LYRUTIL macros for the 

creation and saving of 3D GoToViews and Multi-layout Details. 

6. 2D Polygons, created with RectAngl off, will be recognized as wall lines. 

 

7.02.00 

New Features 

1. WallStyl function in the Architect menu allows saving, loading, and displaying of multi-

line wall settings. 

2. LIN2WALL macro to convert between the various multi-line wall types. 

3. Dynamic toggles in 2D and 3D now operate independently. 

4. MultiScale plotting now supports 256 sheets per drawing. 

5. Line spacing has been added to the settings for 3- and 4-line walls. 

 



344 | DataCAD 7 

7.01.00 

Fixes 

1. The DCAD_AEC macro had uninitialized font names in the column grid and the room 

label features. This could cause a Fatal Error 2000 Stack Overflow when performing an 

L-intersection cleanup of two walls. 

2. The Remove function in DoorSwng / Windows / CutWall, and the WeldWall function 

were leaving a ghost entity behind. Selecting one of these entities could cause Internal 

Diagnostic Fault 3. 

3. DataCAD 7 was not properly initializing all wall settings in some drawings created in 

previous versions of DataCAD. This was causing Fatal Error 2136 when entering walls. 

4. If a template was on when going into WallStyl / ShowVals, upon exiting the text screen 

the template was not displayed and the drawing area was distorted. 

 

7.01.00 

Fixes 

1. A bug in the Plotter / Print / SetSheet menu has been corrected. 

2. A fatal error would occur when drawing walls and the following steps were taken: 

a. Enter first point of wall line. 

b. Release rubber-band line (right mouse button). 

c. Fatal error 

3. Parallel lines drawn outside of the Walls function now behave as they did in prior 

versions. 

4. SYMEXP macro no longer generates a fatal error. 

5. Identify / SetAll now works properly for Associative Dimensions. 

6. QwkLyout now functions as it did in prior versions with the return of Layout %, 

LyoutDiv and Extents to that function. 

7. A bug with Mirrored Associative Dimensions has been corrected. 

8. A bug in Template / SaveSym / AutoPath whereby a backslash was being omitted has 

been corrected. 

9. The [Ctrl] + [F11] function key now toggles the Toolbar on & off. 
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10. A problem with the ClipIt undo buffer and LyrUtil macro has been corrected. 

11. "Internal Stack Overflow -- Buffer Cleared" when attempting to enter the Dimension / 

Linear / Change / TextStyl / FontName menu has been corrected. 

Undocumented Features 

1. Text size can now be set dynamically when the TxtScale toggle is on. When TxtScale is 

turned on, text size is set according to its plotted size on the page based upon the current 

plot scale. With TxtScale on, you can use the [PgUp] and [PgDn] keys to scale the text 

size while dragging the text cursor. 

2. Dimension text size can also be set dynamically when the TxtScale toggle is on. Other 

dimension settings which are relative to the text size, such as arrow size, are also 

affected. This feature works similarly to the text size feature. 

3. Mouse speed may be adjusted by means of an environment variable. This is 

accomplished by adding the following statement to either your AUTOEXEC.BAT or 

RUNDCAD.BAT files: 

SET DC-MOUSE=N 

Where N is either 1, 2, 3, or 4 (1 being normal mouse operation and 4 being 4 times as 

fast). 

   

DataCAD 7 New Features and Enhancements 

Multi-scale plotting 

Multi-scale plotting allows you to print several differently-scaled details of your drawing on the 

same sheet. There is no practical limit to the number of details you can place, and you hca have 

up to 256 custom layouts per drawing. 

Multi-line walls 

Create 2-, 3-, or 4-line wall types with automatic cleanup. You can save and load custom wall 

styles for future use. 

AutoCAD R12 Compatibility 

DataCAD 7 supports the ability to import and export AutoCAD R12 files in DXF and DWG 

format. This enables you to collaborate and share files with associates who use AutoCAD. 

PrintAPlot Pro® 

PrintAPlot Pro provides you with direct support for more than 1,500 printers and plotters. So, 

you'll be able to print and plot your drawings to most of the commercially available devices on 

the market. You can also tile larger sheets to letter-sized paper for faxing. 
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Network File locking 

Layer locking 

You can lock a layer to prevent making changes to the entities on that layer. 

Full screen capture via [Ctrl] [F10] 

CSI formatted Template directories 

Read-only symbol support 

Estimator Link utility (Estimator sold separately) 

Custom sized icons 

New tutorial 

3D roof framing 

The FrameIt macro has been enhanced to provide roof framing in addition to floor, and wall 

framing. 

Support for 50 line types 

The limit on the number of line types that can be loaded has been increased from 20 to 50. 

Template file binding to icons 

A new toolbar action code, T, has been added so templates can be called from a toolbar icon. 

Updated program defaults 

DataCAD's default program and drawing settings have been updated for greater ease-of-use. 

Icons per Toolbar increased to 50 

Enhanced Dimension menu to support TextScale and [PgUp], [PgDn] 

You can now use the [Page Up] and [Page Down] keys to set the real-world size of dimension 

text relative to the current plot scale. 

Text menu enhanced to support [PgUp], [PgDn] scaling 

Display of current path in "Search" menus 

 



DataCAD 6 | 347 

 

DataCAD 6 

DataCAD 6 New Features and Enhancements 

New Features and Fixes 

1. Icon Toolbar added. 

2. RenderStar 2 eXtension-24 added. 

3. Velocity removed. 

4. FrameIt macro added. 

5. Function FreeTrim added. 

6. Layer Filter added. 

7. Scaletype Metric corrected. 

8. Additional corrections to DXF interpreter for 2D/3D line data. 

9. User defined lines no longer have a "tail". 

10. LyrUtil macro enhanced to save and retrieve 3D views. 

11. Path names in template files corrected. 

12. Error in ClipCube corrected. 

13. Bug in the SetAll function of Identify when used on Hatching is corrected. 

14. When entering coordinate data in Bearing Mode, the program would display a "Syntax 

Error" message although the data would be entered correctly. 

15. Cones and Truncated Cones created with 36 divisions would not Hide, Shade or 

Explode (to polygons) correctly. The last facet would not be processed. 

16. Dimensioning by Entity with associative off would not prompt for the distance before 

adding the dimension. 

17. When configured for the DGIS graphics driver, DataCAD's display would not be legible 

if the CONFIG program had not been run first. 

18. Writing a DXF file after an HLR had been performed would cause DataCAD to crash 

under certain circumstances. 
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19. All lines in a DXF file created by AutoCAD R12 would be interpreted by DataCAD as 

3D-Lines. This has been changed so that lines that are parallel to the XY plane and have 

an extrusion distance associated with them are read into DataCAD as 2D-Lines. 

20. Hatching multiple boundaries would cause the program to crash if the Hatch menu 

were not exited and re-entered (or the Clear button selected) between boundary 

specifications. 

21. Hatching several times without leaving the Hatch menu would cause all hatching 

created in that session to be grouped together. 

22. Identify would always report entities as having positive Z extents information. 

23. When in the Layers/On Off menu, the Tab key would not advance the Active layer. 

24. Measures/Takeoffs would flash the result on screen too quickly for anyone but 

Superman to read. 

25. Various problems associated with AutoPath when saving symbols. 

26. Reading in scale files would cause erroneous results. 

27. Entering text with an aspect ratio of 0 would cause the software to bomb. 

28. The Encapsulated Postscript plotter driver has been completely re-written. 

29. The HPGL-2 plotter driver has been corrected for rotated plots. 

30. Support for the Summagraphics MM series and Kurta III digitizers has been added. 

31. The ability to add temporary reference marks has been added to the DoorSwng, 

Window and CutWall functions. 

32. In all menus displaying file names, the first file name displayed would not always be the 

first alphabetically. 

33. When identifying hatch entities, the Identify function would not update the current 

hatch settings correctly. 

34. Navigation controls (panning, scrolling, zooming, etc.) were not being trapped properly 

while in Plotter/Layout. 

35. Slabs/Polygons with voids were not being redrawn properly after they were stretched, a 

Regen would have to be performed. 
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36. A rather obscure bug in the Remove function of DoorSwng, Window and CutWall that 

would erase all the entities previously acted upon within the ClipIt macro. 

37. Many corrections to the DCAL run-time system to correct bugs associated with PrintStr, 

InputAt and LblMsg. These corrections do not affect the compiler. 

38. Several changes to improve cursor speed and response time. 

39. Certain text fonts (those with arcs in their definition) would  display incorrectly when 

viewed in anything but an ortho (plan) projection. 

40. The navigation pad now works correctly when in the RoofIt macro. 

41. The Forms function in the AEC_Modl and 3DStairs macros now works correctly. 

 





DataCAD 5 | 351 

 

DataCAD 5 

DataCAD 5 New Features and Enhancements 

Graphical User Interface 

• Navigation Pad 

• Projection pad 

 

AutoCAD R11 - R12 Compatibility 

DataCAD 5 supports the ability to import and export AutoCAD R12 files in DXF format. This 

enables you to collaborate and share files with associates who use AutoCAD. 

• Support for R11 & R12 format 

• Slabs (including voids) are triangulated during export 

• Text adjustment factor handled by definition file 

• Correction of mirrored instance geometry 

 

New Hidden Line Removal Options 

• Delete duplicate lines 

• Join or combine lines 

• Backfacing option for faster hides 

• Hide edges of 3D primitives 

• Support for ClipCube 

• Save Image feature saves partial hides 

 

Quick Shader 

• Three light sources 

• Backfacing option for faster shading 

• Customize display of edges (black, none, original color, only edges) 

• Shade on layers, active layer only, or selection sets 
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• POF (Pixel Out File) Bitmap Output 

• Save drawing window or shaded view 

• Print drawing window or shaded view 

Drawing file preview 

 

Line Type, Hatch Pattern, and Text previews 

 

Command-line converters: POF to TGA, POF to 2RN, and POF to PCX 

 

Printing and Plotting 

• Support for up to three printers/plotters 

• HPGL/2 Driver 

• EPS (Postscript) Driver 

• PCL printer language output 

• Print multiple copies 

• Define up to 256 pens (one per color) 

 

DOS Shell 

• Launch DOS window from while running DataCAD 

 

Drawing Files 

• Increased file size limit to 8MB 

• Backward compatible with prior DC3 format 

 

Associative Hatching 

• Support for polylines, circles, polygons, slabs, and blocks 
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Drawing Functions 

• For parity reasons, Undo has been moved to [F6] 

• (Move, Copy, Rotate, Mirror, Stretch, and Enlarge) 

 

Display 

• Freehand option remembers last entity type selected 

• Free Zoom (not to closest display scale) 

• Marker in view sphere indicates current view position 

 

Keyboard Shortcuts 

• [F11] calls right elevation 

• [F12] calls left elevation 

• [Ctrl] + [↑] increases the cursor speed 

• [Ctrl] + [↓] decreases the cursor speed 

• hard copy output to file/paper 

• [Alt] + [/] allows selection of GUI 

• changes between 'classic' and new GUI 

• [Ctrl] + [F12] launch DOS shell 

 

Documentation 

• Perfect bound manuals 

 

Included Add-Ons 

• Velocity photo-realistic rendering program 

• DCAL (DataCAD Application Language) 

• DCPrint printer utility 
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4.06.00 

Fixes 

1. Several problems associated with the angle type Bearings have been corrected. 

2. The text font ROMANS.CHR has been fixed. 

3. There was a configuration problem associated with plotting if configured for a bus type 

mouse. 

4. Copy/Rectangular Array/Angular had unpredictable results. 

5. The CONFIGuration program was not saving the plotter baud rate 19,200. 

6. The copy command would get stuck in an infinite loop under certain cases if LyrSrch 

was on. 

7. When configured for a display list (software, not hardware), the status indicator 

(Display/Displist/Status) would occasionally show negative values. 

8. The "Not ready error on drive XX" would not always display the correct drive letter. 

9. Using keyboard input for non-associative string line dimensions would give incorrect 

results. 

10. The third point in Slabs/Inclined/4EdgTrap was being entered relative to the first point 

entered rather than the current reference point. 

11. Occasionally, drawings created in DataCAD v3.6 would generate a "Fatal Error 2136" 

when loaded into v4.00. 

12. Occasionally, drawings created in DataCAD v3.6 would generate a "Fatal Error 2100" 

when loaded into v4.00 and Enlarge/NewCenter/Invert was selected. 

13. Appending to the active selection set did not work in Geometry/Offset. 

14. Changing the grid angle would not work under some conditions. 

15. Reading a DataCAD generated DXF file into another CAD system would generate an 

"Undefined Block" error message if the drawing contained associative dimension nested 

inside a symbol. 

16. Dynamic rotation gave opposite results if using angle type Bearings. 
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17. If a drawing created in DataCAD v3.6 were set to angle type Bearings and loaded into 

v4.00, the North direction was incorrect. 

18. LyrSrch was not functioning properly in Cleanup/WeldWall. 

19. The center points of 2D curves and control points of associative dimensions would plot 

if turned on in the Display menu. 

20. Linear dimensions did not add tic marks if a leader was added. 

21. Area calculations of areas bounded by arc segments of exceptionally large radius gave 

only approximate results. 

22. 1LnTrim has been changed to feature an Undo option instead of the previous Yes/No 

query. 

 

DataCAD 4 New Features and Enhancements 

Features 

1. The option PrevCntr (previous center) has been add to the Enlarge and Rotate functions. 

2. The function Match has been added to the 2D change menu. This allows changing to 

match a selected entity's attributes. 

3. Change/Text/Contents has been enhanced to allow editing a line of text up to 132 

characters in length by means of scrolling the command line. 

4. The toggle TextScal has been added to the Settings and Text menus.  This controls the 

scaling of text. If off, text is scaled in absolute world coordinates just as it has been since 

version 3.0. If on, text is scaled relative to the current plotting scale as selected in the plot 

menu. Those of you who have been using DataCAD since the days of version 2.0, will 

remember this as the way it was way back then. 

5. TxtStyls has been added to the Text menu. This function allows the saving, loading, and 

viewing of a "Rack" of text settings such as: 

a. Size 

b. Angle 

c. Weight 

d. Aspect ratio 

e. Line feed factor 
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f. Font name 

g. Text scaling (either absolute world coordinates or relative to the current plotting 

scale) 

6. The inputting of text has been enhanced by the addition of the toggle Dynamic in the 

text menu. When turned on, text can be entered just as before. When off, the text string is 

displayed on the command line before it is entered into the drawing. 

7. The menu File I/O has been added to the text menu. 

8. TextFile has been renamed to FromFile and moved to the File I/O menu off the main 

Text menu. 

9. To File has been added to the Text/File I/O menu. This allows selecting text entities from 

within a drawing file to export into a specified text file. 

10. Template/Re-Load/All has been added to allow easier re-loading of all the symbols in a 

drawing file. 

11. Hatch/Boundary has been added. This function allows hatching to any arbitrary polyline 

defined dynamically from within the Hatch menu. 

12. The new toggle DimmPts has been added to the Display menu. This controls the 

displaying of an associative dimension's control points. 

13. A Color option has been added to TextStyl and ArroStyl in the dimensioning menus. 

This allows assigning separate colors for these portions of a dimension. 

14. The toggles Limits and Tolrance have been added to the DimStyle menu in DataCAD's 

dimensioning system. These allow the definition and addition of limits or tolerances to 

any of DataCAD's dimension types. These options also appear in the 

Dimension/Linear/Change menu to allow adding them to associative dimensions that 

already exist in a drawing. 

15. Two new angle styles have been added. Dec Deg (decimal degrees) and Grads 

(gradians) can be found in the Settings/AngleTyp menu. 

16. The new keyboard interrupt "F" (shift f) has been added. This forces DataCAD to save 

the current drawing file just as SaveFile in the File I/O menu. 

17. "Undo" has been added to the 2D Stretch menu. 

18. The new toggle "Clkwise" has been added to the AngleTyp menu. Also, "StrtAngl" has 

been added to allow the user to enter a vector defining the angle "Zero" for the 

coordinate system currently in use. 
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19. "FreeHand" has been re-written to allow selection of the type of entities to be added, 2d-

lines, 3d-lines, or a polyline. 

20. The function Division, in the Geometry menu, has been enhanced to allow division of 

arcs and circles. Also, division specified by number of and distance between divisions is 

now possible. 

21. A "Critical Error Handler" has been written into DataCAD to deal with problems such as 

"Drive not ready" errors. 

22. Undo Erase has been re-written so that the undone entities return to their original layers, 

not just the currently active layer. 

23. WeldWall has been added to the Cleanup menu. 

24. The function Remove has been added to the Doorswng, Windows and Cut Wall menus. 

This function allows removing a previously inserted door, window or wall cut and re-

constructing the wall in which they were placed. 

25. The option Angular has been added to the rectangular array menu. This allows creating 

a rectangular array at a user specified angle. 

26. The toggle Array has been added to the copy menu. This allows creating a single 

dimensional array. 

27. The toggle CrvCtrs has been added to the Display menu. This controls the displaying of 

center points for 2D curves. 

28. The LyrSrch toggle has been added to the Angular, Radius and Diameter dimensioning 

menus. 

29. Bézier and B-Spline curves may now be defined dynamically. 

30. The option Select has been added to the Area/Perimeter menu. This allows easier 

measuring of a previously defined polyline. 

31. The ability to Pan, Scroll, Scale and Refresh while entering text has been added. 

32. Plotting has been changed to allow sending a plot to a file while a background plot is 

active. 

33. The function key position of Yes and No may now be changed by specifying their 

numerical position on lines 1776 and 1777 of the file DCAD.MSG. 

34. The new option Dynamic now appears in the Rotate menu. 
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35. Added support for 19.2k baud serial communications. 

36. Added support for plotter output to LPT1, LPT2 or LPT3. 

37. The new menu Configure has been added to the Plotter menu. This allows changing the 

plotter port parameters Port number, Baud rate, Parity and Data word size from within 

DataCAD. 

38. The function New Path has been enhanced to display available sub-directories. 

39. The Layout function, in the Plotter menu, may now be set to layout the extents of a 

drawing only, or the entire drawing in detail as before. Also, the new menu LyoutSet 

has been added to the plotter menu. Lyout Sz, LyoutDiv and Extents are found in this 

new menu. 

40. The new toggle LayrOrdr has been added to the Display menu. This switch controls the 

order in which layers are redrawn. 

41. The function SysPaths has been added to the directory menu. This displays the current 

DataCAD system path settings. 

42. Template/Reports has been changed to handle multiple pages of information correctly 

by means of scroll forward/backward options. 

43. Geometry/Offset now operates on ellipses. 

44. Several changes have been made to DXF transfer: 

a. All 15 of DataCAD's colors are written and read-in correctly. 

b. Text aspect ratio is now compensated to approximate their scheme more closely at 

the time of transfer. 

c. Text slant is now supported in both directions. 

d. An interactive write mode is now offered to allow specifying the line spacing to use 

for Dashed, Dotted and Dot-Dash line styles. 

e. Associative dimensions are now transferred in both directions without the need to 

explode them into lines and text. 

45. A separate Enlargement menu has been added to the Enlarge menu. 

46. Maximum drawing file size has been increased from 4Mb to 8Mb. 

47. The version number of DataCAD may now be found in the directory menu. 
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48. An elapsed time counter has been added to the Plot function. 

49. A 3D Cursor option now appears in the Measures/Pnt2Pnt function. 

50. The Fence option has been added to 2D stretch. 

51. DataCAD may now be run with a software display list. This increases the speed of 

redraws, pans, zooms and picking significantly. This option is selected in the all new 

CONFIG program. 

52. Measures/TakeOffs has been enhanced to give vertical area. 

53. Measures/Area/Perimeter has been enhanced to allow specifying the ScaleType to use 

for the output of the calculation. 

54. The number of supported display devices has been increased from 30 to more than 80. 

 

Fixes 

1. There was a bug associated with the LyrSearch option in DoorSwng, Windows and 

Cutout in the Achitect menu. If this were set to a layer that was later deleted, it may 

have caused a fatal error upon re-entry into the LyrSearch menu. 

2. NewDwg in the FileI/O menu caused an error on certain machines, this problem has 

been corrected. 

3. The Acres option in the Area/Perimeter measures menu gave incorrect results. 

4. Turning on AndCopy in the 3D Mirror function and selecting by area would cause the 

program to seemingly hang. This loop could in fact be exited by pressing the End or Del 

key. 

5. If a drawing created in 3.6 containing snap points were loaded, the snap points would 

not display. 

6. A problem that only showed up when using an Nth Engine concerned the display list 

not being updated correctly when Doors and Windows were inserted with the CutWall 

option on. 

7. Dimensioning Dots would occasionally be inserted in the wrong color. 

8. 3DViews/SaveImage/ToLayerFile would sometimes give an erroneous message 

indicating the number of lines saved. If this layer file were then loaded into a new 

drawing, its layer name would become "INVALID". 
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9. The LayerSet toggle in the 2D GoToView menu did not function. 

10. InclAngle/ExclAngle in the Measures menu would insert the wrong character, on the 

message line, for the degrees symbol. 

11. The Add/Subtract Area/Perimeter toggles did not operate as would be expected. 

12. There was a problem in the column grid portion of DCAD_AEC concerning certain 

numbering schemes. 

13. Deleting a layer, that was part of a saved 3D view, would cause an error upon returning 

to that saved view. 
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3.6e (After 10 March 1989) 

Fixes 

1. Correction to acres calculation in area/perimeter. 

2. Dimensioning "dots" would occasionally plot in the improper color, this problem has 

been corrected. 

 

3.6e (After 1 November 1988) 

Fixes 

1. Correction to link between DataCAD and DataMERGE. 

2. Area/Perimeter changed to use standard polyline interface. 

3. Drawing of weighted 2d arcs, circles and ellipses changed to produce better continuity 

of thickness when plotted. 

4. The drawing of windows with Cutout and InWall toggled off has been re-written to give 

results more like the insertion of windows with the aforementioned toggles turned on. 

5. Three problems associated with DXF transfer have been corrected. The first deals with 

an extremely long text string. The second, arose from attempting to load a file containing 

symbols with an enlargement factor of zero. The third dealt with losing some info 

associated with associative dimensions. 

6. The use of a default drawing under certain circumstances would cause the distance 

readout to lock at zero until the snap grid was toggled on and off. This problem has been 

corrected. 

 

3.6e 

Fixes 

1. Corrected erroneous distance string for vertical and horizontal dimensioning. 

 

3.6d 

Fixes 

1. Enhanced "Identify" to include "Set All" which has the effect of choosing all the available 

selections once an entity has been identified. Also, "Identify" is now available via an 
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interrupt key. "I" (shift i) will now invoke the "Identify" function from anywhere in the 

program. 

2. A reported problem with drawing "Side" walls with the "Clean" option toggled on has 

been corrected. 

3. The messages associated with the automatic save function have been moved from the 

error line to the distance readout line, as requested by many end users. 

4. A reported problem of the placement of the text string of a vertical associative 

dimension when a leader has been added has been corrected. 

5. The "LyrSrch" option has been added to "Cut Wall". This works just as the same option 

in "DoorSwng" and "Windows". It has also been changed to disallow searching a layer 

that is currently turned off. 

6. Dimension/Angular has been enhanced to reset the previous arrow style upon exit. 

7. A problem of not being able to add additional symbols to a drawing was reported by 

several users. This problem has been corrected. 

8. A problem with the feature "DoFloat/SigDigits", found in the "ScaleType" menu, 

characterized by "garbage" in place of the normal distance readout, has been corrected. 

9. An "Intersect" nearpoint-snap problem has been corrected. 

10. Several reported problems in "DCAD_AEC" have been corrected. 

11. An additional driver for the Calcomp 104x series plotters has been included. This driver 

has, in Beta testing, proven to cure plotter initialization problems that several sites had 

reported. 

 

3.6c 

Fixes 

1. Corrected drawing of "Dots" arrow style in dimensioning. 

2. Added the ability to change the text location of associative dimensions in the 

Dimension/Linear/Change menu. 

3. Several corrections made to DXF transfer. 

4. A reported problem with plotting multi-weight text has been corrected. 
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5. The active selection set may now be toggled off by way of the keyboard interrupts Alt-1 

thru Alt-8. 

6. Walls that are joined, not at a corner, are now cleaned correctly. 

7. LineAngl option added to the Measures menu. 

8. Corrected NumSides in 2D Polygons menu. 

 

3.6b 

Fixes 

1. The new function "X Intsct" has been added to the Cleanup menu. This function allows 

cross intersecting walls to be cleaned automatically. 

2. Several bugs reported with the drawing of walls on the Nth Graphics Nth Engine 

display controller have been fixed. 

3. An error in the plumbing section of the DataCAD AEC macro has been corrected. 

4. Template/Enlarge is now a sub-menu. This allows the setting of just one of the 

enlargement directions or all at once. 

5. Clearing of selection sets has speeded up by a factor of 300%. This is most noticeable 

where temporary selection sets are used as an UNDO buffer, as in Move, Copy, Rotate, 

etc. 

6. The additional toggle "RgnWarn" has been added to the DispList menu found under the 

Display menu when running the Nth Engine. This toggle controls whether DataCAD 

will issue warnings for screen manipulations that require a regeneration of the display 

list. 

7. A bug reported with the OutHoriz toggle in linear dimensioning has been corrected. 

8. The selection of certain 3D entities by area has been corrected. 

 

3.6a 

Changes 

1. Entity selection routines, (Entity, Group, Area), in the editing functions of DataCAD and 

DC-Modeler have been combined. This allows the use of "Fence" in DataCAD, and the 

use of "SelSets" in DC-Modeler. 



366 | DataCAD 3 

3.6a 

2. The memory management of Templates has been completely re-written. By doing this, 

we have been able to dramatically decrease the loading time of templates into DataCAD. 

Also, this has the effect of not increasing drawing file size until a symbol is placed into 

the drawing. 

3. DataCAD's hatching algorithms have been re-designed. This causes Hatch to work 

correctly if the pattern is rotated and/or if the hatch origin is re-located. 

4. The new entity Polyline has been added. These can be created in the Curves menu. 

5. EditSets menu has been further enhanced to allow switching between Add To and Del 

From without having to re-select the set that is being acted upon. 

6. Line drawing speed for the cursor has been increased. This mainly effects our friends 

still using non-"AT Class" type computers. 

7. Text/Textfile has been enhanced to allow specification of the file extension to search for. 

This allows this function to operate just like the rest of DataCAD, where a file name is 

being asked for. 

8. The Layers menu has been completely re-engineered with the following additional 

functions: 

a. "All On" - This allows all layers to be turned on with one key press. 

b. "ActvOnly" - By selecting this function, all layers are turned off except the one 

selected, which becomes the active layer. 

c. "DelLayer" - This command completely removes a layer from the drawing database. 

d. "ViewLayr" - Allows selecting a layer, in the current drawing, and displaying only it 

on screen. This action is reversed when the screen is refreshed. 

e. "ViewFile" - This is like "ViewLayr", except that it displays a previously saved layer 

file. 

9. Template/SaveSymb/AutoPth has been added. When this toggle is on, symbols are 

saved into a sub-directory whose name is associated with the parent template file. 

10. Plotter drivers have been made external to the main program. This will have the net 

effect of increasing the number of plotters we support by allowing hardware 

manufacturers to write their own drivers for DataCAD. 

11. Copy Dwg has been added back to the File I/O menu, due to popular demand. This 

command allows copying the current drawing, in it is current state, to another file 

and/or another disk drive. 
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12. Directry/SymFiles/PurgeSym has been added to allow purging unused symbols from 

your drawing without having to load a template file. 

13. Plotting has been totally re-engineered. This should alleviate the problems previously 

associated with plotting. 

14. The toggle DisSync has been added to the Settings menu. This new toggle, when on, 

causes DataCAD's distance readout to be synchronized with the current cursor rotation. 

15. The toggle DynmRot has been added to the main Template menu. This toggle allows 

symbol rotation to be specified dynamically upon insertion. 

16. Area/Perimeter calculations have been changed to allow adding or subtracting of 

perimeters and areas individually. 

17. Move/Drag/MaxLines has been changed so that when set to 0, the extents box is always 

used. 

18. Partial plotting may now be used if DataCAD is configured for only one COM port. 

19. The toggle ShwAtrs has been added to the Display menu. This controlling the display of 

Visible Attributes that have been added thru a DCAL macro. 

20. The variables in DXF Read/Write such as Scale, Auto/Intract are now remembered. 

21. DataCAD is no longer forced back into an orthographic projection when exiting the 

Modeler. The current projection is preserved until an editing function requiring 2D 

input is selected. At that time, the view is automatically forced back to ortho. 

22. New keyboard interrupts: 

a. " (double quote key) has been added. This allows specifying a symbol to insert even 

if there is no template currently active. 

b. Alt-9 restores the last Parallel projection. 

c. Alt-0 restores the last Orthographic projection. 

d. Uppercase (Shift) V goes to the 3D Viewer. 

23. The user interface of Move/Drag has been re-designed to increase its utility. After 

selecting the entities to move, the user is prompted to enter the point to drag from. 

24. 3dArc has been move from the Curves menu to the DCAD 3D/Entities menu. 
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25. The toggle SnglPen has been added to the Plotter menu. This allows more control over 

plotting by allowing the user to specify whether a single-pen or multi-pen plotter is 

being used. By specifying a single pen plotter when doing a color plot, the plotter is 

paused, and the user is prompted to install the appropriate pen when pen changes are 

encountered. 

26. In Settings/ScaleTyp menu, the toggle "DoFloat" has been added. This toggle will show 

only if using one of the following scale types: 

a. Decimal 

b. InchDec 

c. Meters 

d. CentMtr 

e. MillMtr 

The purpose of this toggle is to allow setting the number of digits to display, to the 

right of the decimal point, for all DataCAD's distance readouts. If the toggle is on, 

the distance readouts will operate just as they always have. If the toggle is turned off, 

the user is asked to enter the number of significant digits to display. This number 

must be in the range of 0 to 3. 

27. The status line in Move, Copy and Stretch has been enhanced to show not only the 

distance being used, but the angle as well. 

28. A line spacing enlargement factor has been added to Enlarge. This new feature allows 

the user to maintain the proper relationship of non-solid lines to the entity when the 

entity is enlarged. 

29. Symbols may now be added to the drawing in either an orthographic or a parallel 

projection. This applies to both the Template menu, and keyboard entry of a symbol via 

the " keyboard interrupt. 

Note: Symbols may be exploded (NOT databased) ONLY in an orthographic projection. 

30. In many of the 2D editing functions (move, copy, erase), entities may be SELECTED via 

Entity, Group, Area or Fence in any projection. Therefore, during the 2D Move 

command, once the two points defining the distance to move have been entered, the 

viewer may be called via the Shift-V keyboard interrupt, the drawing placed in a 

parallel, oblique, or perspective projection and the entities to move then selected. 
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Changes Affecting DataCAD 3D Only 

1. In Version 3.5, there is a difference in snapping between the 3D editing functions and the 

2D editing functions. In Version 3.6, a difference still exists, but is instead between 

orthographic projections and all other projections. The result of this is that when editing 

in the 3D portions of the program, in an orthographic projection, all the object snapping 

options apply such as intersect, n-points, etc. 

2. The main 3D Views menu has been re-engineered and simplified. No longer are there 

four separate menus for the four separate types of projections. If you select a viewing 

function which requires a projection other than the current projection type, the screen 

will be refreshed automatically in the correct projection type for the selected function. 

3. The new entity type Surface of Revolution has been added. This is entered in the 

Modeler 3D Entity/Rev Surf menu, by specifying a profile (Polyline) and an axis of 

revolution. 

4. The result of Hidden Line Removal/SaveImag and 3D Views/SaveImag may now be 

directed to a layer file. 

5. 3D GoToView can now turn layers on and off with saved views as in the 2D GoToView 

menu. 

6. #D Views/Perspective now allows the specification of a fixed cone of vision OR a 

"Camera Lens" focal length. 

7. Hidden line removal now has a toggle *CropImg. If the *CropImg toggle is turned on 

and the image is being saved, then the resulting image is clipped to the limits of the 

screen. In this way, images which may be excessively large (particularly perspective) 

may be cropped to the shape of the screen prior to being saved to a layer or layer file. 

8. Hidden line removal of interior perspective images has been enhanced to calculate these 

images more correctly. An additional step is now performed during pass 1 of hidden 

line removal to recalculate the vertices of polygons which pass through the hither 

clipping plane. 

9. The function AddView has been added to many viewer menus as a convenience so that 

views may be saved without having to access the 3D GoTo View menu first. 

10. DCAL macros now have nearly complete access to all the three- dimensional functions, 

entities, and menus. DCAL programmers may now create macro programs which do 

operations like the DC-Modeler functions. 

11. Included with the DC-Modeler is a macro named VIEWMAST. This macro contains the 

following viewing functions: 
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a. An alternative user interface to the 3D saved view data manager. 

b. Addition view definition functions which augment the standard 3D Views function 

in DataCAD. 

c. AutoView - allows automatic cycling through a selected series of saved views. The 

cycle time and continuous toggles may be controlled. 

d. AutoHide - allows batch hidden-line-removal processing of saved views. Resulting 

images may be directed to the screen, separate layers, or layer files. 

e. Slides - allows management of saved layer files (typically saved images) and the 

viewing of these images like the AutoView function. Slide shows may be saved to 

files, reloaded, played back, and edited. 

f. Fly Thru - allows the creation of a series of perspective views by defining a sequence 

of steps and then playing back the sequence. Fly thru views may then be added to 

the database for HLR batch processing via the AutoHide function. 

12. The all-important 3D Pause function has been enhanced. 

 

3.5d 

Changes 

1. Template/Enlarge corrected. 

2. Corrected problem when: 

a. FastSym in ObjSnap was turned off. 

AND 

b. Drawing contained symbols that contained 2D arcs or circles. 

AND 

c. Nearpoint snapping was used. 

This sequence would have caused the aforementioned symbols to be undrawn, although 

no drawing data would be lost. 

3. Reading DXF files that contain Polylines may have lost some "Z" information. This 

problem has been corrected. 

4. Volume calculations, when using metric scales, have been corrected. 

5. When entering text, with either center or right justification, has been changed. The first 

line of text is now justified to the insertion point. 
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6. Text line feeds now no longer use text slant. This means when entering multiple lines of 

text, it is no longer necessary to re-justify the text after entering it. 

 

Changes Affecting DataCAD 3D Only 

1. Ortho ClipCubes are now correctly turned off when exiting DC-Modeler. 

 

3.5c 

Changes 

1. AddTo/DelFrom in EditSets now allows more creative and specific building of the user 

defined Selection Sets by the addition of the Mask function. This new function allows 

selection of entities not only by Entity/Shape/Area, but additionally by Entity-type, 

Color, Line type and Line weight. 

2. The ability to abort plotting to a file has been added. This works just as it does in a 

normal plot. That is, by pressing the End or Del keys. 

3. Mirroring of partially erased ellipses now works properly. 

4. Speed of executing keyboard "Interrupts" increased. 

5. The drawing of weighted text is now handled correctly. 

6. Dimension/Linear/Explode now works properly with LyrSrch turned on. 

7. Many plotting problems were reported in previous versions of DataCAD 3.5, these have 

been corrected. Most of these problems related to the plotting of Text and Symbols. 

8. A line spacing enlargement factor has been added to Template/Enlarge. This new 

feature allows the user to maintain the proper relationship of non-solid lines to the 

symbol when the symbol is entered into the drawing with an enlargement factor other 

than 1. 

9. Refresh speed of symbols that have not been rotated about the "X" or "Y" axis has been 

increased by up to 250 percent. 

10. Saving symbols into template files has been corrected so as not to change "Z" 

information. 

11. The ObjSnap menu has been enhanced to include: 

a. Fast3D - This toggle operates identically to the *QckSrch toggle in the 3D settings 

menu. If the toggle on, any circular 3D entity (3D arc, cylinder, cone, truncated cone, 
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dome, torus) or contour curve may be selected ONLY by pointing to a center axis 

marker or control point. This speeds up the searching process significantly when 

there are many of these 3D entities in your drawing. BE CAREFUL: if the *Fast3D 

toggle is turned on, only the center axis markers or control points need be enclosed 

within the box when selecting entities by AREA. For example, in the case of a 3D arc, 

and if the *Fast3D toggle is turned on, the entire arc might lie outside of the box, but 

if the center marker is within the box, the arc WILL be selected. 

b. FastSym - This toggle, when on, allows snapping to the insertion point of a symbol 

only. This speeds up snapping in drawings that contain symbols dramatically. 

Several changes have been made to speed up snapping to 3D entities, particularly 

while operating in the 2D menus. Snapping to a 3D entity in any 2D menu as well as 

any 3D menu is sensitive to the *QckSnap toggle found on the 3D Settings menu. 

Previously, this toggle affected only snapping while in a 3D menu. It now affects 

snapping to a 3D entity in ANY menu. In addition, if the *QckSnap toggle is turned 

on, previously you could only snap to the center axis markers of any 3D circular 

entity. Now you can snap to the end point of a curve, or the corners of a surface in 

addition to the center axis marker. In this way, it should be possible to leave the 

*QckSnap toggle on more frequently, since only in certain cases is it ordinarily 

desired to snap to the intermediate line segments of a circular entity. The time 

savings of having the *QckSnap toggle are significant. 

12. At the main DataCAD screen, when the user is prompted for the drawing file name, a 

new option has been added. The "Default" option allows changing the name of the 

default drawing to use. 

13. When the current angle style is set to either "Bearings" or "Compass", rotation angles 

entered in the 2D and 3D "Rotate" function are operated on in a clockwise direction. 

 

Changes Affecting DataCAD 3D Only 

1. SLABS - The refresh of slabs which have their reference face parallel to the xy-plane 

while in an orthographic projection has been speeded up significantly. 

2. CONTOUR CURVES - You may now enter contour curves by using the 3D cursor and 

3D snapping mode. This allows creating three-dimensional meshes of contour curves 

much more easily. Remember, the contour curve is parameterized in three-dimensions, 

and can define a curve which "winds" through space. The control points need not be 

coplanar. 

3. SETTINGS - You may now draw lines (walls and enter symbols) while in the 3D Settings 

menu and in an orthographic projection. 
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4. HIDDEN LINE REMOVAL - You may now select between hiding all layers which are 

on, only the active layer, or only the active selection set when using the HLR system. In 

this way, you need not turn layers on and off so frequently during the creation of a 

model which requires frequent checking with the HLR system. 

5. POLYGON/SLAB PARTIAL - Polygon or Slab menu, Partial submenu, AddVertx or 

MovVertx submenus: In some of these menus, the keyboard interrupts were not 

accessible. This problem has been corrected. Keyboard interrupts are now accessible 

from all menus from within the Partial submenu. 

6. GLOBE - Globe submenu: In DataCAD systems without the DC Modeler, an 

unrecoverable error would occur if you attempted to redefine the globe icon. This 

problem has been corrected. 

7. PERSPECTIVE - Perspective menu, SetPersp submenu: If you had previously set up a 

perspective projection via the globe or WalkThru menu, then selected SetPersp and then 

Exit, your previous perspective view was not always restored correctly. This has been 

corrected. There is usually a distinct difference between selecting Exit or Reset is you 

have used the globe or the WalkThru menu since defining the last perspective view. 

8. CONTOUR CURVES - When entering a contour curve in many parallel projections, 

stray square markers would appear on the screen. The curve would be entered correctly, 

but a refresh would be required to clean up the spurious markers. This problem has 

been corrected. 

9. SAVING IMAGES - SavImag menu: After hidden line removal with the *SavImag toggle 

on, saving to the active layer, then saving to the active layer a second time would 

produce a Fatal Error 11. This problem has been corrected. 

10. CLIPPING CUBES - A variety of problems associated with the definition and 

manipulation of clipping cubes have been reported. All of these have been corrected. 

Please note that EACH projection type has its own individual clipping cube associated 

with it. 

11. ENTERING LINES - The message prompt in the main 3D Edit and 3DEntity menus 

when in Ortho mode read "... or enter 3D line." This was incorrect. You may enter 2D 

lines when in Ortho mode while in either of these two menus, not 3D lines. To enter 3D 

lines, select the 3D Line menu from the 3DEntity main menu. The messages have been 

corrected. 
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3.5b 

Changes 

1. Built-in drawing file conversion disabled and replaced by the program 

"CONVERT.EXE" 

2. The help macro (Alt H) corrected. 

 

3.5a (Since 3.1b) 

Changes 

1. DataCAD now uses the virtual memory manager to allow up to 4Mb DCAD macros. 

2. Menus re-organized more logically (hopefully). 

3. Line/Shape/Area changed to Entity/Group/Area. 

4. LyrSrch, ability to edit across layers, added. 

5. Support for multiple text fonts added. 

6. Expanded support for macros. 

7. AndCopy added to Move, Rotate, Mirror, and Enlarge. 

8. Undo added to Move, Copy, Rotate, Mirror, and Enlarge. 

9. PrevDist added to Move, Copy and Stretch. 

10. Unlink added to LinkEnts. 

11. 8 user definable Selection Sets for use with editing functions. 

12. Goodies renamed to Architct. 

13. DataCAD symbols can now be nested five (5) levels deep. 

14. Text aspect ratio now changes width, not height. 

15. Identify enhanced to include: 

a. Entity type. 

b. Selection set membership. 

c. Font name. 

d. "Z Min/Z Max" for 3D entities. 

e. "Voids" identification. 
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16. LyrRfsh added to Layers menu to suppress layer redraw when turning layers on and off. 

17. SaveLayr now allows saving any layer, not just the active layer. 

18. Layer On/Off allows the active layer to be turned off. 

19. Area/Per enhanced to calculate areas with curves. Also, the ability to add and subtract 

areas. Plus, display the Centroid of a specified area. 

20. Dimensioning allows freer placement of text string. 

21. ArcFactr added in Display to control precision of curves. 

22. ShowIns added to Display to control drawing of symbol insertion points. 

23. LyrSnap replaces LyrSrch in ObjSnap. Allows separate control of layer searching in 

editing and snapping functions. 

24. Much greater compatibility with THEM in "DXF" file reading and writing. 

25. Directory enhanced to include: 

a. Current drawing file name. 

b. Current drawing file size. 

c. Free disk space for drawing and virtual files. 

26. Backgrnd plotting enhanced: 

a. FromFile allows selecting a previously created plot file to plot from. 

b. Auto works just as Backgrnd did in version 3.1. 

c. MultiPlt allows queuing up to 25 plot files to be plotted in sequence. 

27. 3D Views accessible from the Plot menu. 

28. Geometry menu added. 

29. Offset function added to Geometry menu. 

30. Support for multi-weight, non-solid straight lines added. 

31. A "Hi_Lite" line type is now used throughout the program to identify entities that will 

be operated upon. 

32. Partial erase of ellipses is now allowed. 

33. Change/Text/Content corrected to work on multiple lines of text. 

34. "Is this correct" added to 1LnTrim to help keep from trimming an entire drawing. 
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35. Message for distance to Move, Copy and Stretch added. 

36. Multicolor instanced symbols now plot in their correct colors. 

37. Square Feet/Acres toggle added to Area/Per. 

38. Hatch moved to the Utility menu. 

39. LinkLine renamed to LinkEnts and moved to the Edit menu. 

40. Un-Link added to LinkEnts. 

41. Divide, Intrsect and Tangents moved to the Geometry menu. 

42. Quit now only available from the Utility menu. 

43. DoorSwng and Windows menus re-arranged to group all on/off toggles together. 

44. EditSets added to allow configuration of user definable "Selection Sets". 

45. Move, Copy and Stretch now use a rubber band arrow when defining the distance to 

use. 

46. WindowIn removed from the Edit menu. 

47. LyrSwch in GoToView renamed to LayrSet. 

48. Grids menu re-organized to put the most often used functions in the root menu. 

49. Templates completely re-written. 

50. Template/Forms renamed to Reports. 

51. Template/Reports form files re-designed to use a more logical definition format. 

52. Settings menu re-arranged to separate toggles from those functions that require input. 

53. Settings/SrchHch move to Obj Snap menu. 

54. FixdRef moved from Utility menu to the Settings menu. 

55. Settings/EditStuf renamed to EditDefs. 

56. Dmension/Linear/TextStyl/Auto toggle added to allow manual placement of text string. 

57. Dimensioning may now have a separate font style. 

58. Linear dimensioning now features dynamic placement of dimension line. 
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59. Macros moved to the Edit menu. 

60. Plotter/PaperSiz displays the maximum effective plotting area for the sheet size selected. 

61. Copy Dwg in File I/O renamed to Copy and now allows copying of any of the file types 

listed in File I/O. 

62. The user is now alerted to the presence of an Autosave file for the selected drawing 

when entering DataCAD. At that point, the option is given to ignore the warning, or to 

rename the autosave file to a ".DC3" (drawing) file. 

63. Nearpoint snap now works with Move/Drag as it does in the rest of the program. 
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Added features 

1. The Calcomp 104x plotter driver is finished. To connect the Calcomp to your computer, 

use the cable that comes with the plotter to the DTE connector on the back of the plotter. 

The DIP switches on the back of the plotter should all be open (0), except number five 

which is closed (1). The setup parameters as the plotter comes out of the box are correct, 

so no keyboard setup needs to be done. For reference, the parameters are: 

Parity 0 

Bits/char 8 

Stop bit 1 

Clock 0 int 

Interface 0 serial 

Baud 9600 

Mode 0 PCI 

Term muting No 

Checksum Yes 

Isochronous No 

End of Msg 03 

Direct Cntrl No 

Xon/Xoff No 

Sync Codes 1 

Sync Code Value 02 

2. Partial delete of arcs and circles is now supported. 

3. Using the 'Change' function on the utility menu, you can now change the attributes (line 

type, line weight, color, spacing, z base and z height) of a line, shape, or area. Selecting 

an object (or series of objects) causes them to take on the current set of attributes. 

4. The nearpoint feature now snaps to the center of arcs and circles. 

5. Holding down shift and pressing the tab key now moves backward through the layers 

that are turned on. 

6. [q] moves forward through line types, [Q] now moves backward through line types. 

7. [k] moves forward through colors, [K] moves backward through colors. 

8. [x] or [X] toggles the snap grid on and off. 
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9. The relative size of the paper in the plotter layout function can now be adjusted. The 

default is 20% of the screen size. It can be adjusted upward to make the layout larger on 

the screen to make more accurate layouts. In addition, line weights are no longer shown 

when in layout. All lines are shown with a weight of one while in layout. 

10. The toggle 'Show Wgt' on the settings menu has been added to determine if line weights 

are shown. If it is off, lines that have weights will show only as single lines. 

11. Text files can now be loaded onto the drawing, much like forms are placed in the 

drawing. The function 'TextFile' is on the text menu. Specify the file name to be loaded 

and then its location on the drawing. This allows you to load specs, schedules, etc. 

12. Open arrows, closed arrows, and bridge arrows (with arcs on the end) have been added 

in arrows in the text menu. In addition, open and closed arrows now support varying 

aspect ratios. 

13. The 'UserLins' toggle now appears in the line type menu as well as the settings menu. 

14. Typing 'set dc-backup=off' at the MS-DOS level will turn the automatic file backup 

feature off. Therefore, '.bak' files will not be created. This speeds up the program when 

starting a drawing but is more dangerous. Use this feature at your discretion. Typing 'set 

dc-backup=' at the MS-DOS level will turn this feature back on. 

15. For those of you using the 19" (1024x1024) Artist version, there is now a choice between 

a large and small menu. The large menu is more readable but results in fewer pixels 

being available for the drawing. 

Other changes 

1. Scale up and scale down have been removed from the utility menu to make room for the 

change feature. They may still be used from the keyboard ('U' and 'D') or from the screen 

icons. 

2. Setting a pen speed of zero in the plotter menu will cause DataCAD2 to NOT send any 

plotter speed information to the plotter. The default pen speed for the plotter will be 

used instead. This is especially useful with plotters that determine the pen speed by 

themselves (i.e. HP plotters). 

3. The file 'volumes.txt' is no longer shipped with DataCAD2. Instead, path names of files 

can be set in DataCAD2 or in the configuration program. The default is to look in the 

current directory for all files. 

Note to users of versions prior to 2.0a 

Versions 2.0a and above use a different drawing file format than earlier versions. You must 

convert your old files ('.drw') to the new format ('.cad') using the program CONVERT.EXE, 
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which is supplied on diskette one. You must run this program for every old drawing file you 

wish to use with version 2.0. 
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